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CHAPTER

Introduction to
mikroC PRO for PIC

The mikroC PRO for PIC is a powerful, feature-rich development tool for PIC
microcontrollers. It is designed to provide the programmer with the easiest possi-

ble solution to developing applications for embedded systems, without compromis-
ing performance or control.
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mikroC PRO for PIC IDE

PIC and C fit together well: PIC is the most popular 8-bit chip in the world, used in
a wide variety of applications, and C, prized for its efficiency, is the natural choice
for developing embedded systems. mikroC PRO for PIC provides a successful
match featuring highly advanced IDE, ANSI compliant compiler, broad set of hard-
ware libraries, comprehensive documentation, and plenty of ready-to-run examples.

Features
mikroC PRO for PIC allows you to quickly develop and deploy complex applications:

B Write your C source code using the built-in Code Editor (Code and Parameter
Assistants, Code Folding, Syntax Highlighting, Auto Correct, Code Templates,
and more.)

B Use included mikroC PRO for PIC libraries to dramatically speed up the devel
opment: data acquisition, memory, displays, conversions, communication etc.

B Monitor your program structure, variables, and functions in the Code Explorer.

B Generate commented, human-readable assembly, and standard HEX compati
ble with all programmers.

B Use the integrated mikrolCD (In-Circuit Debugger) Real-Time debugging tool to
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monitor program execution on the hardware level.

Inspect program flow and debug executable logic with the integrated Software
Simulator.

Get detailed reports and graphs: RAM and ROM map, code statistics, assembly
listing, calling tree, and more.

mikroC PRO for PIC provides plenty of examples to expand, develop, and use
as building bricks in your projects. Copy them entirely if you deem fit — that's why
we included them with the compiler.

Where to Start

In case that you’re a beginner in programming PIC microcontrollers, read care
fully the PIC Specifics chapter. It might give you some useful pointers on PIC
constraints, code portability, and good programming practices.

If you are experienced in C programming, you will probably want to consult
mikroC PRO for PIC Specifics first. For language issues, you can always refer to
the comprehensive Language Reference. A complete list of included libraries is
available at mikroC PRO for PIC Libraries.

If you are not very experienced in C programming, don’t panic! mikroC PRO for
PIC provides plenty of examples making it easy for you to go quickly. We sug
gest that you first consult Projects and Source Files, and then start browsing the
examples that you're the most interested in.

MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD 3



CHAPTER 1
Introduction mikroC PRO for PIC

MIKROELEKTRONIKA ASSOCIATES LICENSE STATEMENT AND
LIMITED WARRANTY

IMPORTANT - READ CAREFULLY

This license statement and limited warranty constitute a legal agreement (“License
Agreement”) between you (either as an individual or a single entity) and mikroElek-
tronika (“mikroElektronika Associates”) for software product (“Software”) identified
above, including any software, media, and accompanying on-line or printed docu-
mentation.

BY INSTALLING, COPYING, OR OTHERWISE USING SOFTWARE, YOU AGREE
TO BE BOUND BY ALL TERMS AND CONDITIONS OF THE LICENSE
AGREEMENT.

Upon your acceptance of the terms and conditions of the License Agreement,
mikroElektronika Associates grants you the right to use Software in a way provided
below.

This Software is owned by mikroElektronika Associates and is protected by copy-
right law and international copyright treaty. Therefore, you must treat this Software
like any other copyright material (e.g., a book).

You may transfer Software and documentation on a permanent basis provided. You
retain no copies and the recipient agrees to the terms of the License Agreement.
Except as provided in the License Agreement, you may not transfer, rent, lease,
lend, copy, modify, translate, sublicense, time-share or electronically transmit or
receive Software, media or documentation. You acknowledge that Software in the
source code form remains a confidential trade secret of mikroElektronika Associates
and therefore you agree not to modify Software or attempt to reverse engineer,
decompile, or disassemble it, except and only to the extent that such activity is
expressly permitted by applicable law notwithstanding this limitation.

If you have purchased an upgrade version of Software, it constitutes a single prod-
uct with the mikroElektronika Associates software that you upgraded. You may use
the upgrade version of Software only in accordance with the License Agreement.
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LIMITED WARRANTY

Respectfully excepting the Redistributables, which are provided “as is”, without war-
ranty of any kind, mikroElektronika Associates warrants that Software, once updat-
ed and properly used, will perform substantially in accordance with the accompany-
ing documentation, and Software media will be free from defects in materials and
workmanship, for a period of ninety (90) days from the date of receipt. Any implied
warranties on Software are limited to ninety (90) days.

mikroElektronika Associates’ and its suppliers’ entire liability and your exclusive
remedy shall be, at mikroElektronika Associates’ option, either (a) return of the price
paid, or (b) repair or replacement of Software that does not meet mikroElektronika
Associates’ Limited Warranty and which is returned to mikroElektronika Associates
with a copy of your receipt. DO NOT RETURN ANY PRODUCT UNTIL YOU HAVE
CALLED MIKROELEKTRONIKAASSOCIATES FIRST AND OBTAINED A RETURN
AUTHORIZATION NUMBER. This Limited Warranty is void if failure of Software has
resulted from an accident, abuse, or misapplication. Any replacement of Software
will be warranted for the rest of the original warranty period or thirty (30) days,
whichever is longer.

TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW,
MIKROELEKTRONIKA ASSOCIATES AND ITS SUPPLIERS DISCLAIM ALL
OTHER WARRANTIES AND CONDITIONS, EITHER EXPRESSED OR IMPLIED,
INCLUDED, BUT NOT LIMITED TO IMPLIED WARRANTIES OF
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, TITLE, AND
NON-INFRINGEMENT, WITH REGARD TO SOFTWARE, AND THE PROVISION
OF OR FAILURE TO PROVIDE SUPPORT SERVICES.

IN NO EVENT SHALL MIKROELEKTRONIKA ASSOCIATES OR ITS SUPPLIERS
BE LIABLE FOR ANY SPECIAL, INCIDENTAL, INDIRECT, OR CONSEQUENTIAL
DAMAGES WHATSOEVER (INCLUDING, WITHOUT LIMITATION, DAMAGES
FOR LOSS OF BUSINESS PROFITS AND BUSINESS INFORMATION, BUSINESS
INTERRUPTION, OR ANY OTHER PECUNIARY LOSS) ARISING OUT OF THE
USE OF OR INABILITY TO USE SOFTWARE PRODUCT OR THE PROVISION OF
OR FAILURE TO PROVIDE SUPPORT SERVICES, EVEN IF
MIKROELEKTRONIKAASSOCIATES HAS BEEN ADVISED OF THE POSSIBILITY
OF SUCH DAMAGES. IN ANY CASE, MIKROELEKTRONIKA ASSOCIATES’
ENTIRE LIABILITY UNDER ANY PROVISION OF THIS LICENSE AGREEMENT
SHALL BE LIMITED TO THE AMOUNT ACTUALLY PAID BY YOU FOR
SOFTWARE PRODUCT PROVIDED, HOWEVER, IF YOU HAVE ENTERED INTO
A MIKROELEKTRONIKA ASSOCIATES SUPPORT SERVICES AGREEMENT,
MIKROELEKTRONIKA ASSOCIATES’ ENTIRE LIABILITY REGARDING
SUPPORT SERVICES SHALL BE GOVERNED BY THE TERMS OF THAT
AGREEMENT.
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HIGH RISK ACTIVITIES

Software is not fault-tolerant and is not designed, manufactured or intended for use
or resale as on-line control equipment in hazardous environments requiring fail-safe
performance, such as in the operation of nuclear facilities, aircraft navigation or
communication systems, air traffic control, direct life support machines, or weapons
systems, in which the failure of Software could lead directly to death, personal injury,
or severe physical or environmental damage (“High Risk Activities”). mikroElektron-
ika Associates and its suppliers specifically disclaim any expressed or implied war-
ranty of fitness for High Risk Activities.

GENERAL PROVISIONS

This statement may only be modified in writing signed by you and an authorised offi-
cer of mikroElektronika Associates. If any provision of this statement is found void
or unenforceable, the remainder will remain valid and enforceable according to its
terms. If any remedy provided is determined to have failed for its essential purpose,
all limitations of liability and exclusions of damages set forth in the Limited Warran-
ty shall remain in effect.

This statement gives you specific legal rights; you may have others, which vary, from
country to country. mikroElektronika Associates reserves all rights not specifically
granted in this statement.

mikroElektronika
Visegradska 1A,
11000 Belgrade,
Europe.

Phone: + 381 11 36 28 830
Fax: +381 11 36 28 831
Web: www.mikroe.com
E-mail: office@mikroe.com

6 MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD



CHAPTER 1
mikroC PRO for PIC Introduction

TECHNICAL SUPPORT

In case you encounter any problem, you are welcome to our support forums at
www.mikroe.com/forum/. Here, you may also find helpful information, hardware tips,
and practical code snippets. Your comments and suggestions on future develop-
ment of the mikroC PRO for PIC are always appreciated — feel free to drop a note
or two on our Wishlist.

In our Knowledge Base www.mikroe.com/en/kb/ you can find the answers to Fre-
quently Asked Questions and solutions to known problems. If you can not find the
solution to your problem in Knowledge Base then report it to Support Desk
www.mikroe.com/en/support/. In this way, we can record and track down bugs more
efficiently, which is in our mutual interest. We respond to every bug report and ques-
tion in a suitable manner, ever improving our technical support.
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HOW TO REGISTER

The latest version of the mikroC PRO for PIC is always available for downloading
from our website. It is a fully functional software libraries, examples, and compre-
hensive help included.

The only limitation of the free version is that it cannot generate hex output over 2
KB. Although it might sound restrictive, this margin allows you to develop practical,
working applications with no thinking of demo limit. If you intend to develop really
complex projects in the mikroC PRO for PIC, then you should consider the possibil-
ity of purchasing the license key.

Who Gets the License Key
Buyers of the mikroC PRO for PIC are entitled to the license key. After you have
completed the payment procedure, you have an option of registering your mikroC

PRO. In this way you can generate hex output without any limitations.

How to Get License Key

After you have completed the payment procedure, start the program. Select Help » How
to Register from the drop-down menu or click the How To Register lcon | .= . Fill out the
registration form (figure below), select your distributor, and click the Send button.
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[ How Ta Register o] @ ==

Step 1. Fill in the form below, Please, make sure you fill in all required fields.

Step Z. Make sure that you provided a walid email address in the "EMAIL" edit box, This email will be used for
sending you the activation key.

Step 3. Make sure you select a correct distributor which will make the registration process faster. If your
distributor is not on the list then select "Other" and type in distributor's email address in the box below.

Step 4. Press the SEMD button to send key reguest, & default email client will open with ready-to-send message,
Mate: If ernail client does not open, you rmay copy text of the message and paste it rmanually into a new email
message before sending it to your distributer's email.

| NAME* Marko Jovanovic

ADDRESS Enter your address
INVOICE Enter invoice number if available in the Form AaAa4 BE

20 Mumber Enter 2Checkout Crder Mumber if available {10 digits)

’W rnarka@rnikyas,com

,W marka@mikroe.cam

,W Enter company name

| PRODUCTID | 515C-557263-6F6072-5751

,W Enter comments on your order

DISTRIBUTOR™ | mikroElektronika key@mikroe.cam hd

* Required fields
1 have made the payment and I wish ko request ackivation key For mikroC PRO For PIC

Name:
Marka Jovanowvic

Address:

Invoice number:

ZCheckOut order number:
Company:
E-Mail:

marka@mikroe.com

Product key:
515C-557269-6FE072-5751

E:Q Copy to clipboard (4 senp Cancel

This will start your e-mail client with message ready for sending. Review the infor-
mation you have entered, and add the comment if you deem it necessary. Please,
do not modify the subject line.

Upon receiving and verifying your request, we will send the license key to the e-mail
address you specified in the form.

MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD 9
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After Receiving the License Key

The license key comes as a small autoextracting file — just start it anywhere on your
computer in order to activate your copy of compiler and remove the demo limit. You
do not need to restart your computer or install any additional components. Also,
there is no need to run the mikroC PRO for PIC at the time of activation.

Notes:

B The license key is valid until you format your hard disk. In case you need to for
mat the hard disk, you should request a new activation key.

B Please keep the activation program in a safe place. Every time you upgrade the
compiler you should start this program again in order to reactivate the license.

10 MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD
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Environment

The mikroC PRO for PIC is an user-friendly and intuitive environment.
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IDE Overview
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B The Code Editor features adjustable Syntax Highlighting, Code Folding, Code
Assistant, Parameters Assistant, Auto Correct for common typos and Code Tem
plates (Auto Complete).

B The Code Explorer is at your disposal for easier project management.

The Project Manager alows multiple project management

B General project settings can be made in the Project Settings window
Library manager enables simple handling libraries being used in a project

B The Error Window displays all errors detected during compiling and linking.

B The source-level Software Simulator lets you debug executable logic step-by-
step by watching the program flow.

B The New Project Wizard is a fast, reliable, and easy way to create a project.

B Help files are syntax and context sensitive.

B Like in any modern Windows application, you may customize the layout of
mikroC PRO for PIC to suit your needs best.

B Spell checker underlines identifiers which are unknown to the project. In this way
it helps the programmer to spot potential problems early, much before the proj
ect is compiled.

B Spell checker can be disabled by choosing the option in the Preferences dialog
(F12).
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MAIN MENU OPTIONS

Available Main Menu options are:

Related topics: Keyboard shortcuts
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FILE MENU OPTIONS

The File menu is the main entry point for manipulation with the source files.

|1 MewUnit  Ctrl+n
(2 Open Chrl-0

Recent Files »
H save ChrH5
H Save 4s. ..
1 Close Ctrl+F4
¢ Print..  CtrhP
B Exit Alt+

File Description

few Unit  Ctrl+M | Open a new editor window.

|

Open Ctrl+0 | Open source file for editing or image file for viewing.
Recent Files k| Reopen recently used file.

H zave iCtrl+5 |Save changes for active editor.

B savess.. Save the act_ive source file with the different name or

- = change the file type.

Ll Close Alk+F4 | Close active source file.

s Print.. Ckrl+P | Print Preview.

B Exit alt+x | Exit IDE.

Related topics: Keyboard shortcuts, File Toolbar, Managing Source Files
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EDIT MENU OPTIONS

43 Undo Chrl+Z
fr Redo Shift+Ctrl+2
S Cut Chrl+x
5 Copy Chr-C
[F) Paste il
X Delete

Select all Chrl+a
A Eind... Chrl+F
S Find Hext F3
43 Find Previous  Shift+F3
)ﬁ Replace. .. Chrl+R
[d] FindinFies..  Alk+F3
%] GotoLine... CrkG

Advanced »

Edit Description
43 Undo Ctrl+Z |Undo last change.
iy Redo shift-+Ctr+Z | Redo last change.
g Cut Ctrl+% | Cut selected text to clipboard.
Ee Copy Ctrl+C | Copy selected text to clipboard.
= Paste Ctrl+y | Paste text from clipboard.
X Delete Delete selected text.
Select Al Ctrl+4a | Select all text in active editor.
A Find... Ctrl+F |Find text in active editor.
< Find et F3 |Find next occurence of text in active editor.
{}3 Find Prewious  Shift+F3 | Find previous occurence of text in active editor.
)ﬁ Replace. .. _trl+R. |Replace text in active editor.
Fin in current file, i i in fi
@ FindIn Files...  Al+F3 ind text_l current file, in all opened files, or in files
from desired folder.
ﬂ Goko Line. .. trl+3 | Goto to the desired line in active editor.
Advanced k| Advanced Code Editor options

MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD 15
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mikroC PRO for PIC

Advanced »

Description

1.} Comment

Shift+CErl+.

Comment selected code or put single line com-
ment if there is no selection.

Uncomment selected code or remove single line

L.} Uncomment  Shift-+Ctri+, comment if there is no selection.

25 Indent shift+Ctrl+I | Indent selected code.

=% OQutdent shift+Ctrl+U | Outdent selected code.

@ Lowercase Ctrl+alk+L | Changes selected text case to lowercase.
af| Uppercase Chrl+alk+0 | Changes selected text case to uppercase.
@ Titlecase Ctrl+alt+T | Changes selected text case to titlercase.
Find Text

Dialog box for searching the document for the specified text. The search is per-
formed in the direction specified. If the string is not found a message is displayed.

Find Text @
Search for: init] -
—Options Direction

Case sensitivity @ Forward

Whaole wards only

Search from caret - Backward

Selected text only

Regular expression Ok Cancel

16 MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD
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Replace Text

Dialog box for searching for a text string in file and replacing it with another text string.

o

-

4 Replace Text E\@
Search for: mikroE lektronika -
Beplace with: rrik.roE -
— O ption —Direction

@ Fonward
“Whole words only
Search from caret - Backward
Selected text only
Beqular expression ak. Cancel

Find In Files

Dialog box for searching for a text string in current file, all opened files, or in files on a disk.

The string to search for is specified in the Text to find field. If Search in directories option

is selected, The files to search are specified in the Files mask and Path fields.

Grep search

EX5)

—COptions

Case sensitive

Wwhole waords

QI-Fad il rnil:roElelktronil:a

Where

-

! Current file

! All opened files
@ Search in directories

—Search directory options

Files mask: *.*

Path: CiAvProgram filesh,

Include subdirectories

QK

Cancel

MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD 17
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mikroC PRO for PIC

Go To Line

Dialog box that allows the user to specify the line number at which the cursor should

be positioned.

Go To Line

OK Cancel

Go To Line Nuber =

&

Regular expressions option

By checking this box, you will be able to advance your search, through Regular

expressions.

Find Text @
Search for: unsignedix20int -
—Options Direction

Case sensitivity @ Forward

wwhole words only

Search from caret A

Selected text anly

+ Regular expression (0] Cancel

Related topics: Keyboard shortcuts, Edit Toolbar, Advanced Edit Toolbar
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VIEW MENU OPTIONS

Toolbars

Debug Windows

T Routine List
Project Settings

T8 Code Explarer
Project Manager
Library Manager
Bookmarks
Messages

Macra Editar

Shift+Chrl+F11

Chrl+L

7| Windows

File

Description

Toolbars

Show/Hide toolbars.

Debug Windows

Show/Hide debug windows.

m Routines Lisk

Show/Hide Routine List in active editor.

Project Setkings

Show/Hide Project Settings window.

T:E Code Explarer

Show/Hide Code Explorer window.

Praoject Managet

Shift+CErl+H

Show/Hide Project Manager window.

Library Manager Show/Hide Library Manager window.
Bookmarks Show/Hide Bookmarks window.
Messages Show/Hide Error Messages window.

Macro Editor

Show/Hide Macro Editor window.

Windows

Show Window List window.

MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD
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mikroC PRO for PIC

TOOLBARS
File Toolbar
P RPN

File Toolbar is a standard toolbar with following options:

Icon

Description

]

Opens a new editor window.

B

Open source file for editing or image file for viewing.

Save changes for active window.

Save changes in all opened windows.

LD

Close current editor.

k.

Close all editors.

=

Print Preview.

Edit Toolbar
<A

Ie

Edit Toolbar is a standard toolbar with following options:

Description

Undo last change.

Redo last change.

Cut selected text to clipboard.

Copy selected text to clipboard.

Paste text from clipboard.

20
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Advanced Edit Toolbar
i) Sk

Advanced Edit Toolbar comes with following options:

M
Il

|

Icon Description

{..} |Comment selected code or put single line comment if there is no selection

Uncomment selected code or remove single line comment if there is
o no selection.

EEGI

Select text from starting delimiter to ending delimiter.

Go to ending delimiter.

Go to line.

Indent selected code lines.

Outdent selected code lines.

Generate HTML code suitable for publishing current source code on

EHD
EE=I
EHD]
3]
5y
=
'='E the web.

Find/Replace Toolbar

2 2 32 e

Find/Replace Toolbar is a standard toolbar with following options:

Description

Find text in current editor.

Find next occurence.

Find previous occurence.

Replace text.

Find text in files.

Do ||| §
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Project Toolbar
i e S E N e IRRECN e s N A

Project Toolbar comes with following options:

Icon Description
'i_i'l New project
% + |Open Project

Save Project

Ky

Close current project.

Edit project settings.

Add existing project to project group.

Remove existing project from project group.

Add File To Project

Remove File From Project

Build Toolbar
A 0% S E0E

Build Toolbar comes with the following options:

Icon Description

Build current project.

Build all opened projects.

Build and program active project.

Start programmer and load current HEX file.

Open assembly code in editor.

Open lisitng file in editor.

View statistics for current project.

80w & e
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Debugger

BBy o #y o el | @ [F &
Debugger Toolbar comes with following options:

@

Icon Description

@

Start Software Simulator or mikrolCD (In-Circuit Debugger).

L]

i Run/Pause debugger.

|'_;—?3 Stop debugger.
gl

Step into.

@, |Step over.

LI Step out.

-+ Run to cursor.

O] Toggle breakpoint.

é Toggle breakpoints.

rl% Clear breakpoints.
&d” | View watch window

U |View stopwatch window

Styles Toolbar

Office 2003 Blue ™

Office 2003 5
Office 2003 Olive
Office ®P
Chocolate

Archic

Sikverfom

Soft zand [V

Styles toolbar allows you to easily customize your workspace.
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Tools Toolbar
B3 A FPd

Tools Toolbar comes with following default options:

Icon Description

EI Run USART Terminal

| |EEPROM

ASCII Chart

g
= L

IE" Seven segment decoder tool.

E Options menu

The Tools toolbar can easily be customized by adding new tools in Options (F12)
window.

Related topics: Keyboard shortcuts, Integrated Tools, Debugger Windows
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PROJECT MENU OPTIONS

B ¥ &

L OB 8 R Cp 0P e Oy Op [0

(i

Build ChrHF9
Build All Projects Shift+F2
Build + Program Chrl+F11

Yiew Assembly
Edit Search Paths. ..

Clean Project Folder, ..

Add File Ta Project. ..

Remove File From Project

Import Project... Chrl+I

Mew Project... Shift-+CErl-Hr
Cpen Project,..  Shift+CEr+O
Save Project

Edit Project. .. Shift+Ctrl+E
Open Project Group,..

Close Project Group

Save Project As...

Recent Projects

Close Project
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mikroC PRO for PIC

Project

Description

Build ChrlHFD

Build active project.

Build &ll Projects

Shift+F3

Build all projects.

Build + Program

Chrl+F11

Build and program active project.

[ || || | o

Wiew Assembly

View Assembly.

Edit Search Paths. ..

Edit search paths.

Open Project Group. ..

Open project group.

Close Project Group

Close project group.

Sawve Projeck As. ..

=} Clean Project Folder, .. Clean Project Folder

i add File To Project..,. Add file to project.

;,_—,t’f Remove File From Project Remove file from project.

1, Import Project. ., iZkrl+1 |Import projects from previous versions of mikroC.
31, Mew Project. .. Open New Project Wizard

.:% Open Project..,  Shift+Ctrl+2 | Open existing project.

M save Project Save current project.

5 EditProject...  shift+Cl+E  [Edit project settings

3

HE

Save active project file with the different name.

Recent Projects

-

Open recently used project.

08

Close Project

Close active project.

Related topics: Keyboard shortcuts, Project Toolbar, Creating New Project, Project

Manager, Project Settings

26
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RUN MENU OPTIONS

E}; Start Debugger F2
=4 Stop Debugger Chrl4+F2
I'_é:]J Pause Debugger F&
g0l Skep Into F7
@, Step Over Fa
(g Step Ok Ctrl+Fa

Jurmnp Ta Inkerrupk Fz
E  Toggle Breakpoint FS
i=| Breakpoints Shift+F4
[y Clear Breakpoints  Shift+Ctri+Fs
&a” Wakch Window Shift+F5
lil-) Wiew Stopwatch

Disassembly mode Ale+Dr

Run Description
— Start Software Simulator or mikrolCD (In-
'5:}‘ gtart Debugger 7o Circuit Debugger).
|';=E] Stop Debugoger Ctrl+F2 | Stop debugger.
f_%l, Pause Debugger F& |Pause Debugger.
g0 Step Into F? |Step Into.
i, Step Over Fa |Step Over.
(1 Shep Ouk Ckrl+F3 | Step Out.
‘l Jurnp To Inkerrupk Fz |Jump to interrupt in current project.
=  Toggle Breakpoint F5 |Toggle Breakpoint.
i=| Show/Hide Breakpoints  Shift+F4 | Breakpoints.
[, Clear Breakpoints  Shife+Ctrl+FS | Clear Breakpoints.
g dakch Window shift+F5 | Show/Hide Watch Window
(5 Wiew Stopwatch Show/Hide Stopwatch Window
Toggle between Pascal source and disas-
Disassembly mode ChrlH-D 99

sembly.

Related topics: Keyboard shortcuts, Debug Toolbar
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TOOLS MENU OPTIONS

q% mE Programmer F11

Bl USART Terminal Chrl4+T
] EEPROM Editor

| Ascii Chart
@' Seven Segment Converkor
L] Export Code To HTML

LCD Custarn Character

(4 GLCD Bitmap Editor
HID Terminal
UDP Terminal

mikroBoatloader

gl Options F1z
Tools Description
% mE Programrmet F11 [[Run mikroElektronika Programmer
Bl UsaRT Terminal Ckrl+T | Run USART Terminal
[ EEPROM Editar Run EEPROM Editor
A Ascil Chart Run ASCII Chart
@ Seven Segment Convertor Run 7 Segment Display Converter

Generate HTML code suitable for publishing

il Export Code To HTML source code on the web.

LCD Custom Characker Run Lcd custom character.
(@ GLCD Bitmap Editor Run Glcd bitmap editor.
HID Terminal un HID Terminal.
LUDF Terminal Run UDP communication terminal.
mikroBootloader Run mikroBootloader.
&) Options F1z |Open Options window.

Related topics: Keyboard shortcuts, Tools Toolbar
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HELP MENU OPTIONS
&) Help F1

Migration Document

Check For Updates
mikroElektronika Support Forums
mikroElektronika Web Page

' How To Reqgister

About
Help Description
@ Help F1 |Open Help File.
Migration Document Open Code Migration Document.
i_heck For Updates Check if new compiler version is available.

Open mikroElektronika Support Forums in
a default browser.

Open mikroElektronika Web Page in a
default browser.

mikroElekkronika Support Forums

mikroElekkronika Web Page

2 How To Register Information on how to register

About Open About window.

Related topics: Keyboard shortcuts
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KEYBOARD SHORTCUTS
Below is a complete list of keyboard shortcuts available in mikroC PRO for PIC IDE.

IDE Shortcuts Ctrl+Shift+S Save All

F1 Help Ctrl+V Paste
Ctrl+N New Unit Ctrl+X Cut
Ctrl+O Open Ctrl+Y Delete entire line
Ctrl+Shift+O |Open Project Ctrl+Z Undo
Ctrl+Shift+N |New Project Ctrl+Shift+Z Redo
Ctri+K Close Project Advanced Editor Shortcuts
Ctrl+F4 Close Unit Ctrl+Space Code Assistant
Ctr+Shift+E |Edit Project Ctrl+Shift+Space |Parameters Assistant
Ctrl+F9 Build Ctrl+D Find declaration
Shift+F9 Build All Ctrl+E Incremental Search
Ctrl+F11 Build And Program Ctrl+L Routine List
Shift+F4 View Breakpoints Ctri+G Goto line
Ctrl+Shift+F5| Clear Breakpoints Ctrl+J Insert Code Template
F11 Start mE Programmer Ctrl+Shift+. Comment Code
Ctrl+Shift+F 1| Project Manager Ctrl+Shift+, Uncomment Code
F12 Options Ctrl+number Goto bookmark
Alt+X Close mikroC PRO for PIC Ctri+Shift+number |Set bookmark

Basic Editor Shortcuts Ctrl+Shift+ Indent selection
F3 Find, Find Next Ctrl+Shift+U Unindent selection
Shift+F3 Find Previous TAB Indent selection
Alt+F3 Grep Search, Find in Files Shift+TAB Unindent selection
Ctri+A Select Al Alt+Select Select columns
Ctrl+C Copy Ctrl+Alt+Select  |Select columns
Ctrl+F Find Ctrl+Alt+L gsvr;\;i;tssslection to
Ctrl+R Replace .
Ctri+P Print Ctri+Alt+U Sgggfcr;;:'ec“on to
Ctrl+S Save unit Ctrl+Alt+T Convert to Titlecase

30
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mikrolCD Debugger and Software

Simulator Shortcuts

F2 Jump to Interrupt

F4 Run to Cursor

F5 Toggle Breakpoint

F6 Run/Pause Debugger

F7 Step into

F8 Step over

F9 Debug

CtrlI+F2 Stop Debugger

Ctrl+F5 Add to Watch List

CtrlI+F8 Step out

Alt+D Dissasembly View

Shift+F5 Open Watch Window

CtrI+Shift+A | Show Advanced Breakpoints
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IDE OVERVIEW

The mikroC PRO for PIC is an user-friendly and intuitive environment:

Value: 8000000 WHz

= Bt Detaion Topm N !

T3 kot PR For e - CPragm RGTor I = % |
Tools

PRPA AN
ol R o e re|
e @
=

N —

- char exed(] = Sexampies
char 1
Cvld Hove Delay() |
I Delay_ma(500)
- 15
- Ewaid main( (

fnie () 5
Lod_Cud {LED_CLELR) ;
Led_Cnd (LCD_CURSOR_OFF) 5

Lod_Oue (1, 6,6x63) 1
Loa_owE (2,5, EXe4)
belay_ws (2000 1

o _Cre (LED_CLEAR) 2

Lod_oue (1,1, 8xe1) 1
Lo OuK {2, 4, EXE2) 5
by e (2000) 2

BC= 880041 Cughy= 41200
// Move text to the cight 4 times

Hove_belayl) s
)

whilelt) (
For{1=0: 4<7: 4e4) (

B Lea_cud (LCB_SHIFT_LEFT) :
Hove_Delay():

B Type
o Relsase ICD Debug

B .

Detugger
8 Sowue i)

D messre it

=

] Erors 1 warings ] nts

o M. Masiage Teok
mhroCPICIGND, ave-HSF -08G SPIGFENT I - Y 0L 1111114 408 A7 rog e Fiesn

Low: 49 Loman
w45 Cotove_pelay

- et PR e pICUDwter STCHE

T Insert Compiled =

B The Code Editor features adjustable Syntax Highlighting, Code Folding, Code

Assistant, Parameters Assistant, Auto Correct for common typos and Code Tem
plates (Auto Complete).

The Code Explorer is at your disposal for easier project management.

The Project Manager alows multiple project management

General project settings can be made in the Project Settings window

Library manager enables simple handling libraries being used in a project
The Error Window displays all errors detected during compiling and linking.
The source-level Software Simulator lets you debug executable logic step-by-
step by watching the program flow.

The New Project Wizard is a fast, reliable, and easy way to create a project.
Help files are syntax and context sensitive.

B Like in any modern Windows application, you may customize the layout of

mikroC PRO for PIC to suit your needs best.

B Spell checker underlines identifiers which are unknown to the project. In this way

it helps the programmer to spot potential problems early, much before the proj-
ect is compiled. Spell checker can be disabled by choosing the option in the
Preferences dialog (F12).
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CUSTOMIZING IDE LAYOUT

Docking Windows

You can increase the viewing and editing space for code, depending on how you
arrange the windows in the IDE.

Step 1: Click the window you want to dock, to give it focus.

e

4 E‘hj LedBlinking.mcppi
47 Sources

: LedBlinking.c

-IC=) Header Files

El Project level defines
{21 Image Files

----- £ Output Files

Step 2: Drag the tool window from its current location. A guide diamond appears.
The four arrows of the diamond point towards the four edges of the IDE.
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Step 3: Move the pointer over the corresponding portion of the guide diamond. An
outline of the window appears in the designated area.

Step 4: To dock the window in the position indicated, release the mouse button.

Tip: To move a dockable window without snapping it into place, press CTRL while
dragging it.

Saving Layout

Once you have a window layout that you like, you can save the layout by typing the
name for the layout and pressing the Save Layout Icon E .

To set the layout select the desired layout from the layout drop-down list and click
the Set Layout Icon .

To remove the layout from the drop-down list, select the desired layout from the list
and click the Delete Layout Icon .
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Auto Hide

Auto Hide enables you to see more of your code at one time by minimizing tool win-
dows along the edges of the IDE when not in use.

EClick the window you want to keep visible to give it focus.
EClick the Pushpin Icon Z on the title bar of the window.

(= e
=N
&=| Project Manager %]
iy s R s e ' ==
e — ==
A-é‘ﬁ_j FirstProject.mcppi E_E E Project Mana 5=
a7 Sources i " B e
E] secondProject.c |- |—|&% = %.
[ Header Files 4 4 ﬁi-, FirstPro = =
) Binaries ———E )T I
[ Project level defines |z =
[ Image Files ) Heac @ 3
] Output Files [ Binar §
[ Other Files ) Proje §
1 Imag [r]
3 [ Outp
Illllllllllllll:ﬂ ! _‘ Othe
-

When an auto-hidden window loses focus, it automatically slides back to its tab on
the edge of the IDE. While a window is auto-hidden, its name and icon are visible
on a tab at the edge of the IDE. To display an auto-hidden window, move your point-
er over the tab. The window slides back into view and is ready for use.
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ADVANCED CODE EDITOR

The Code Editor is advanced text editor fashioned to satisfy needs of professionals.
General code editing is the same as working with any standard text-editor, including
familiar Copy, Paste and Undo actions, common for Windows environment.

Advanced Editor Features

Adjustable Syntax Highlighting
Code Assistant

Code Folding

Parameter Assistant

Code Templates (Auto Complete)
Auto Correct for common typos
Spell Checker

Bookmarks and Goto Line
Comment / Uncomment

You can configure the Syntax Highlighting, Code Templates and Auto Correct from
the Editor Settings dialog. To access the Settings, click Tools » Options from the
drop-down menu, click the Show Options Icon §=| or press F12 key.

Options
W Edior A |
Editor Settings
Project Files
V' Restare Last Opened Project Restare All Opened Files
V' Save Breakpoints ¥ Save Bookmarks

If Opened File Is Externally Modified
((:‘ Erompt for action @ Reload file, but do not prompt ) Ignore externally made changes

Auto Save
W Enable Auto Save Timeout Interwal: 3 @ minukes
Highlighter
Highlight begin. .end pairs
V' Highlight brackets
Spelling

V' Check Speling

iZomment sty

@ Ji tsingle line)

Advanced Editor Options

(g' Open options dialog

Cade Folding
¥ Enable code Folding

Show Ident Guides

0K Apply Cancel
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Code Assistant

If you type the first few letters of a word and then press Ctrl+Space, all valid iden-
tifiers matching the letters you have typed will be prompted in a floating panel (see
the image below). Now you can keep typing to narrow the choice, or you can select
one from the list using the keyboard arrows and Enter.

wanable  sfr unzigned char 5P

varable  sfr unzigned char SPDR
variable  sfr unsigned char SPSR
variable  sfr unzsigned char SPCR

Code Folding

Code folding is IDE feature which allows users to selectively hide and display sec-
tions of a source file. In this way it is easier to manage large regions of code within
one window, while still viewing only those subsections of the code that are relevant
during a particular editing session.

While typing, the code folding symbol ( - and + ) appear automatically. Use the fold-
ing symbols to hide/unhide the code subsections.

%‘mid mainil {

FORTA o

FORTE = 0O;

Led Initi):
LCD_out{l,1,txc[0]);
LoD Out(2,1,txt[1]);
delay m=s(1000) ;

Led Cmdil):

LCD Outii,1,txt[1]);
LCD Qut(2,4,txt[2]);
delay_ms (500) ;

H

void main(]{ l:l

If you place a mouse cursor over the tooltip box, the collapsed text will be shown in
a tooltip style box.
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roid maini) { ;;)

woid main(){ e
FORTA = 0O:
FORTE = 0O

Led Init ()

LD Out(1,1,.txt[0]):
LeD out (2,1, txt[1]);
delay ms (1000) ;

Led Cmd (1)

LCD out (1,1,txt[1]);
LCD_Out (2,4,txt[2]);
delay m= (500 ;

Parameter Assistant

The Parameter Assistant will be automatically invoked when you open parenthesis
“(” or press Shift+Ctri+Space. If the name of a valid function precedes the paren-
thesis, then the expected parameters will be displayed in a floating panel. As you
type the actual parameter, the next expected parameter will become bold.

channel : char
ADC Rea

Code Templates (Auto Complete)

You can insert the Code Template by typing the name of the template (for instance,
whiles), then press Ctrl+J and the Code Editor will automatically generate a code.

You can add your own templates to the list. Select Tools » Options from the drop-down
menu, or click the Show Options Icon E and then select the Auto Complete Tab. Here
you can enter the appropriate keyword, description and code of your template.

Autocomplete macros can retreive system and project information:

- $DATES - current system date

- 3TIMES - current system time

- sDEVICES - device(MCU) name as specified in project settings
- 3DEVICE CLOCKS - clock as specified in project settings

- 3COMPILER% - current compiler version
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These macros can be used in template code, see template ptemplate provided with
mikroC PRO for PIC installation.

Auto Correct

The Auto Correct feature corrects common typing mistakes. To access the list of rec-
ognized typos, select Tools » Options from the drop-down menu, or click the Show
Options Icon g and then select the Auto Correct Tab. You can also add your own

preferences to the list.

Also, the Code Editor has a feature to comment or uncomment the selected code by sim-
ple click of a mouse, using the Comment Icon /1| and Uncomment Icon 1 from
the Code Toolbar.

Spell Checker

The Spell Checker underlines unknown objects in the code, so they can be easily
noticed and corrected before compiling your project.

Select Tools » Options from the drop-down menu, or click the Show Options Icon
g and then select the Spell Checker Tab.
Bookmarks

Bookmarks make navigation through a large code easier. To set a bookmark, use
Ctrl+Shift+number. To jump to a bookmark, use Ctrl+number.

Goto Line

The Goto Line option makes navigation through a large code easier. Use the short-
cut Ctrl+G to activate this option.

Comment / Uncomment
Also, the Code Editor has a feature to comment or uncomment the selected

code by simple click of a mouse, using the Comment Icon 0 and Uncom-

ment Icon {..} from the Code Toolbar.
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CODE EXPLORER

The Code Explorer gives clear view of each item declared inside the source code.
You can jump to a declaration of any item by right clicking it. Also, besides the list of
defined and declared objects, code explorer displays message about first error and
it's location in code.

Code Explorer [

T | e

4 Functions
“ Elmain
- Globals

-~ TypeDef
Tags

“ Includes

Following options are available in the Code Explorer:

Icon Description

E’ Expand/Collapse all nodes in tree.

e Locate declaration in code.
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ROUTINE LIST

Routine list diplays list of routines, and enables filtering routines by name. Routine
list window can be accessed by pressing Ctri+L.

You can jump to a desired routine by double clicking on it.

oo Messags Text e
Used ROM (optesl: 1029 (1%) Free ROM (bytesl: 7163 (87%) Used ROM (bytes): 1029 (13%) Free ROMbyte. .
Succasily ‘Soumd meri

Project Sournd meped completed: 1030 ms
Fished succassfully: 20 Jon 2006, 10:21:23 Sourd i
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PROJECT MANAGER

Project Manager is IDE feature which allows users to manage multiple projects.
Several projects which together make project group may be open at the same time.
Only one of them may be active at the moment.

Setting project in active mode is performed by double click on the desired project
in the Project Manager.

Project Manager =]
I 8 |0 6B ] 2 iy || ||| 9 |
AL—TL LedBlinking.mcppi
4] Sources
] LedBlinking.c
] Header Files
| Binaries
(1 Project level defines
']
|

Image Files

Qutput Files

| LedBlinking. hex

% LedBlinking, asm

E=| LedBlinking. st
[ Other Files

Following options are available in the Project Manager:
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Icon Description

Save project Group.

Open project group.

Close the active project.

Close project group.

Add project to the project group.

Remove project from the project group.

Add file to the active project.

Remove selected file from the project.

Build the active project.

57| o | | s | T | Cle | OB G| O | AP

Run mikroElektronika's Flash programmer.

For details about adding and removing files from project see Add/Remove Files from
Project.

Related topics: Project Settings, Project Menu Options, File Menu Options, Project
Toolbar, Build Toolbar, Add/Remove Files from Project
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PROJECT SETTINGS WINDOW

Following options are available in the Project Settings Window:

B Device - select the appropriate device from the device drop-down list.
B Oscillator - enter the oscillator frequency value.
B Build/Debugger Type - choose debugger type.

Project Settings
EI@ Device
Name: |p1eFoar v
EI@ Ciscillakbor
Value: | .000000 | MHz

(= Buildf Debugger Twpe

Build Type
@ Release () ICD Debug

Debugger

Related topics: Edit Project, Customizing Projects
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LIBRARY MANAGER

Library Manager enables simple handling libraries being used in a project. Library
Manager window lists all libraries (extencion .mcl) which are instantly stored in the
compiler Uses folder. The desirable library is added to the project by selecting check
box next to the library name.

In order to have all library functions accessible, simply press the button Check All
] and all libraries will be selected. In case none library is needed in a project,
press the button Clear All | | and all libraries will be cleared from the project.
Only the selected libraries will be linked.

Library Manager =]
e b | i o o
[ apc
- Eukkon
[ <_math
- [T ¢ _stdiib
[ ¢_string
Ol _Type
- [ can_sP1
- [7] Compact_Flash_FaT16
- [] Compact_Flash
- [ Conwersions
. [7] EEPROM
- [C] FLASH
[ led_Fonts
[ led
- [ 12€
- [V Kevpaddxd
|:| Led_Constants
[ Led
- [7] manchester
- [ tme_FaT16
[ e
- [T one_wire
- || Port_Expander
- [ rsz
[T pwmnz
[T pwimz
<[] Pimas
- [ r=48s
- [T Saftware_12C
- [ software_sPI
- [ Software_UART
+ || Sound
- [ sP1_Ethernet
- [ 5p1_cled
[ sp1_Led
[ 5P1_Leds
- [ sp1_TEo63C
- [9] 5p1
- [ sprintf
- [ sprinti
- [T sprintl
- [ Te9e3C
- [ Time:

- Trigonoretry
[CuarT
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Icon Description

Refresh Library by scanning files in "Uses" folder. Useful when new
libraries are added by copying files to "Uses" folder.

il

Rebuild all available libraries. Useful when library sources are available and
need refreshing.

Include all available libraries in current project.

No libraries from the list will be included in current project.

Co|CE|CE| &

Restore library to the state just before last project saving.

Related topics: mikroC PRO for PIC Libraries, Creating New Library
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ERROR WINDOW

In case that errors were encountered during compiling, the compiler will report them
and won’t generate a hex file. The Error Window will be prompted at the bottom of
the main window by default.

The Error Window is located under message tab, and displays location and type of
errors the compiler has encountered. The compiler also reports warnings, but these
do not affect the output; only errors can interefere with the generation of hex.

Messages
Errors

'arnings Hints

Line Message Mo,
1

125

121

399

399

368

593

102

O MM NN D OO

Message Text

mikroCPIC1618, exe -MSF -DEG -pP16FE87 -UICD -C -¥ -DL -011111114 -FoB -N"C:\Program FilesiMikroelekbronikaimikroC PRO For PIC\ExamplestSPT E
Al files Preprocessed in 1 ms

Compilstion Started

; Bxpected, buk hext’ found

; expected, but '=' found

Specifier neaded

Invalid declarator expected'(! or identifier

Finished {with errors): 09 Dec 2008, 10:04:01

i 3

Double click the message line in the Error Window to highlight the line where the
error was encountered.

Related topics: Error Messages
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STATISTICS

After successful compilation, you can review statistics of your code. Click the Statis-
tics Icon |

Memory Usage Windows

Provides overview of RAM and ROM usage in the various forms.

RAM Memory Usage

Displays RAM memory usage in a pie-like form.

Statistics
Prinkta file

RAM Memory
Usage

RAM Memory Usage
Used RAM
Locations

SR Locations EL

[l sec: 104 btes 21%
ROM Memory
Usage L] Fres: 391 brtes 79%
ROMMemory Total: 455 btes
Constants.
Functions Sorted
By Name
Functions Sorted

By Size

Functions Sorted
By Address

Functions Sorted
By Name Chart.

Functions Sorted
By Siza Chart
Functions Sorted
By Address Chart
Functions Tree

Summary

Project Name: C:Program FiesiMisoelektronkaymikroC FRO. Tine: 2{24]2000 8:47:11 Al
for, i

PICIE
Systems|EsyPICSIGcdiGled mepi e o o0
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Used RAM Locations
Displays used RAM memory locations and their names.

SFR Locations
Displays list of used SFR locations.

SFR Locations

SFRLocations.
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ROM Memory Usage
Displays ROM memory space usage in a pie-like form.

Statistics
Print to file

RAMMemory
Usage

Used RAM
Locations.

SFRLocations

ROMMemary
Usage

ROMMemory
Constants.

Functions Sorted
By Name

Functions Sorted
By Size

Functions Sorted
By Address

Funtions Sorted
By Name Chart

Functions Sorted
By Size Chart

Functions Sorted
By Address Chart

Functions Tree

Summary.

ROM Memory Usage

ROM Usage
m Used: 5758 bytes 70 %
[ Fee: 2433 bytes 30%
Totak: 8191 bytes
P&r'upu(l‘lE\lmm Ci\frogram Fies\MikroslekizronaimikroC RO Time: 2(24/2009 8:47:11 Al
PIC|Examples|Development
Systems\EasyPICSIGIcciGled mepei Aevews Ik oRcon,

ROM Memory Constants
Displays ROM memory constants and their addresses.

Statistics
Prin to file

RAMMemery
Usage

Used RAM
Locations

SFRLocations

ROMMemary
Usage

ROMMemary
Constants.

Functions Serted
By Name

Fungtions Sorted
By Size
Functions Sorted
By Address

Functions Sorted
By Name Chart

Functions Sorted
By Size Chart.

Functions Sorted
By Address Chart

Funetions Tree

Summary

ROM Memory Constants

Address Name
0x0780 2ICS2lsir]_Gled
0x0787 ?1CS?Istr2_Gled
0x0790 71C57Iste3_Gled
0x0742 21C5?I5trd_Gled
0x0748 2ICS?Istr5_Gled
0x0800 Characterx?
0x15EA font5x7
0x1400 FontSystemSx7_v2
0x0680 System3xs.
0x1000 Tick_bmp
Project Name: C:|Program Fies\MibroelekironialmikroC PRO Tene: 2/24/2009 8:47:11 AM
For PIC|Examgles|Development
Systems\EasyPICS\GlediGled meppi ‘whew. miros.com
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Function Sorted by Name
Sorts and displays functions by their addresses, symbolic names, and unique
assembler names.

it e

Brinkta file

Functions Sorted By Name

Functions Sorted by Size
Sorts and displays functions by their size, in the ascending order.

Functions Sorted By Size

MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD 51



CHAPTER 2
Environment

mikroC PRO for PIC

Functions Sorted by Addresses
Sorts and displays functions by their addresses, in the ascending order.

Statistics
Print to file
RAM Memory
Usage
Functions Sorted By Address
Used RAM
Locations
Address. LEL Unique Assembler Name
SFRLocations
0x0005 Delay_10us _Delay_l0us
ROM Memory. 0xD00E Strobe __Lib_Glcd_strobe
Uzaoe 0x0013 Delay_S0us _Delay_50us
ROM Mo 0x0018. Glcd_Set_Page _Glcd_Set_Page
Constants: 0x0023 Gled_Set_side _Glcd_Set_Side
0x0034 Gled_Read_Data _Gled_Read_Data
Dot sared 00D |Gld set X _Gled_set X
0x0064 Gled_Writa_Data _lcd_Write_Data
e 0x006F ___DolcP ___DoicP
00076 Mul_16x16_U _Mul_16x16_U
Funetions Sorted Ox00A1 Gled_Dat _Glcd_Dot
ErAddcess 0XDOFD Gled_V_Line _Glcd_V_Line
m 00118 Delay_lus _Delay_lus
By Name Chart OxDL1E Glcd_Write_Char _Glcd_Write_Char
0xD1EB Gled_H_Line _Gled_H_Line
sk w06 |_ccoow __ccow
OxD1E2 Glcd_Rectangle _Gled_Rectangle
;ﬁ::s?cr::‘: 0228 Glcd_Image _Glcd_Image
0x0283 Glcd_Circle _Glcd_Circle
Functions Tree D glot. e ~Cled bine
0x0481 Gled_Init _glcd_Init
OxD4EE. Gled_Write_Text _Glcd_Write_Text
Summary 0x0508 Mul_8xg_U _Mul_8xB_U
0x0524 Gled_Box _Gled_Box
0x0540 delay2s _delay2s
0x054E Gled_Set_Font _Glcd_set_Font

I

Functions Sorted by Name Chart
Sorts and displays functions by their names in a chart-like form.

Statistics
Print to file

RAMMemory
Usage

Used RAM
Locations

SR Locations

ROM Memary
Usage

ROMMemory
Canstams.
Functions Serted
By Name
Functions Sarted
By Size.
Functians Sorted
By Address

Functions Sorted
By Name Chart

Functions Sorted
By Size Chart
Functions Sorted
By Address Chart
Functions Tree

Summary

Functions sorted by Name

—pack
_eczon {23
Delay_10us
Delay_lus
Belay_Sus <
celay2s {20 i [T4totes) |1

oied pox L0 [28 (hien)
Gicd_Crcle
Gledt_Dot

1 [Szmes]} -
L —————— ]
Gied_H Line [l R A
Gicd_image | - — N T TTT]

[T § —

T ] R

Gled_Line

Gled_Rend Dot
Gled_Rectange |
Gled_Se_Fent
Gicd_Sel_Fage
Gled_Set_Side
Gicd_Set
Glcd_V_Line

= (o]
—

Glod White_Char
Glod_Vike Data
Gled_te_Text

main

Mul_16x16_U |
Mul_gicB
Strabe

Project Name: C:|Frogram Fies\MibroelekironialmibroC PRO
for PIC|E xamgles|Development
SystemsiEasyPICS|Gled|Gled meppi

Time: 2(24/2009 8:47:11 AM
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Functions Sorted by Size Chart
Sorts and displays functions by their sizes in a chart-like form.

Statistics
Printto file
RAMMemory
Usage. Functions sorted by size
el par Deley_tus {1 [Eiortes] oo
Locations Detay_50us £ 5 (oytes) | d
Desay_10us £ [[6 (ytes) i
FRLocations —pace (1 iy’
svone (3 -
HE cka vwie paa ] [11 byes) ] -
emory
il EETET N = I e
—ccaoni = [2mes) ]
ROMMemory aeiy2s ] [iagten] -+
Constants icd_Set_Fort L0 [15 brtes) ] -1
Gcrl_Set_Sie o] i
;’:J::Smd o Sel ¢ ] [Blgen] -
Gled_Rend Data L] [Bopes] -
Gked_Rend_Da .
DI | Read_Data ]
By Size. Gied_V_Line
Giod ¥ Line
Funetions Serted Glod_Box
BrAddress o Wite_Tet
e Ml _16x16_U
Functians 5o §
By - Gled_Fil
Gled_ind
Functions Sorted Glod Reclengle
By Size Chart Glcd_Image
—_— Gled_Dot : :
Functions Sorted Qe Yte_Char 1 [GE0 (tes)]: + { P i 1
By Address Chart Gled_Circle — 1 [Z3imaen )i eeee E
man - - -
Functions Tree G _Line | @m 1l
0 0 a0 60 e 100 120 40 0 180 200 20 20 260 80 X0 30 M0
Summary
Praject Name: C:1Program FiesiMisoslektronkaimikraC FRO. Tie: 2{242000 8:57:44 Al
for PICIE xamples|Devalopmant
SystemsiEasyPICSIElcd|Glod meppi -

Functions sorted by Address Chart
Sorts and displays functions by their addresses in a chart-like form.

Statistics
Brintto file

Rammemey
Usage

Functians sorted by Address

Used RaM
Locations
SFRLocations

ROM Memory
Usage

ROM Memory
Constants:

Functions Sorted
By Name

Fundtions Sorted  Gicd Wiite_Char
S Delay_fus 3
Gicd_v_Line J--c-oocd

o
[PVR. VL e N TSN PRPHPRSS: SR NRPISE RSN PRSP SRR, FURSTRUNE: NUNNRA SRR BN
Fundtions Sarted — Do
S E Giea Wite Data |-
G Set_x |-
;“;:’;:,‘{“" Gle_Rend_Dota
Gica_set_sice f--
Functians Sorted G Set_Page i
By Address Char P B
——— [ ) S SO
Functians Tree Doy 1us
W0 1000 1400 120 1300 1400
Summary
Proec Nome: CHfrog o Fis e cseentaikot RO Time: 2124]2009 8157144 W

camgles\Developmens
Systemns\EasyPICS\GlecGled cppi techailotsen
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Function Tree
Displays Function Tree with the relevant data for each function.

Functions Tree
Unik; _tbib_Gkd.c
Routine Hame: _6lcd_Crcle
Real Routine Name: Ged_Crde
Rouine Size (bytes): 22
Return type: void
Routine Start Address: 643 - 0263
RoutineEnd Address: 635 = 003
Current Depth: 1
Mz Stack Depth: 6
bt A oo
| Delsy_tous
Functions Sorted H 4-Gkd_Read_Dats
By Address Chart | Delay_50us
| a-Gkd_winte Data
| 4 Strobe L
Fungtions Tree | Delay_tous
4 _cceow
| __pexcp
‘Summary M &8 U 2
ProjetHates Cilfro an Fesi s ceieirnibaii ot FRO Tine: 212472009 815744 A
PICIExangles|Development
e s by e com

Memory Summary
Displays summary of RAM and ROM memory in a pie-like form.

Print ta file
Summary
DATA
] used: 104 bites 21%
B Fre 301 bytes 79%
Tatak: 495 bites
ROM Usage:
o v bytes 5758 o 70
] Fre= bvtes 2433 % 30
Totd bvtes 8191
Functions Tree
Summary
Project Name: Ci\Program Fles\MioslektronbalmikanC PRO Tiwe! 2{24]2000 857144 AM
for
SystemeiEss PICS\Gkdikamecpi e arveEn
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MACRO EDITOR

A macro is a series of keystrokes that have been 'recorded' in the order performed.
A macro allows you to 'record' a series of keystrokes and then 'playback’, or repeat,

the recorded keystrokes.

Macros

& W2 |2 &

]

MNarne

Macrod

L

i | 3

The Macro offers the following commands:

Icon

Description

o

Starts 'recording’ keystrokes for later playback.

o

Stops capturing keystrokesthat was started when the Start Recordig com-
mand was selected.

s

Allows a macro that has been recorded to be replayed.

=%

New macro.

o

Delete macro.

Related topics: Advanced Code Editor, Code Templates
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INTEGRATED TOOLS

USART Terminal
The mikroC PRO for PIC includes the USART communication terminal for RS232

communication. You can launch it from the drop-down menu Tools » USART Termi-
nal or by clicking the USART Terminal Icon = from Tools toolbar.

R5232 Terminal =]

rSettings —Communication

vt T ([ Echo ey | ‘E'?"la
Baud: 2600 Y ||| Append: [ CR Send as typing [ it -
Stop Bits: |'3""'3 Stop Bit v|

LF Send as number

. Clear Histo
Parity: (o8 b . tistory
Check Parity F‘tecewe deti e . _
) : @ ASCII ! HE= ) DEE
Data bits: [Elght v]
[ EemmEmet Connected to COM3 -
RTS OTR Sent: Echo
@ Off @ Off
") on i On

Connect ' Lusconnact

—Status
Send Receive CTS DSR
[~ [~ L~ [+
—Log Files
qn
Read fram:
Write to:

J Append to ' Create file
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EEPROM Editor

The EEPROM Editor is used for manipulating MCU's EEPROM memory. You can
launch it from the drop-down menu Tools » EEPROM Editor. When Use this
EEPROM definition is checked compiler will generate Intel hex file
project name.ihex that contains data from EEPROM editor.

When you run mikroElektronika programmer software from mikroC PRO for PIC IDE
- project name.hex file will be loaded automatically while ihex file must be loaded
manually.

mikroElektranika EEPROM Toal (==

i//_l E E P Ro M Ed itor || Use Eeprom in project Help

Device: EEPROM Size: EEPROM Fill: EEPROM File

Cuskom - vislsztes ¥alue: Ox FF | FEill | | Load | | Save |

EEPROM Data

FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF G
FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF G
FF | FF | FF | FF | FF | FF | FF | FF | FF | FF | FF | FF [ FF | FF | FF ¥y
FF |FF (FF |FF |(FF |FF (FF (FF (FF | FF | FF | FF | FF | FF | FF VYV YYYYY
FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF G =
EEPROM Edit:
Input Format: Edit ¥alue:
D EEPROM Address: R a—

| Dec Hex No: Ox Edit

@ Hex Start Address: 0% FFFF

. Float 7l Size:

= oa [Blautaln: | Byte ) Word @ DWord

) S5tring
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ASCII Chart

The ASCII Chart is a handy tool, particularly useful when working with Lcd display.
You can launch it from the drop-down menu Tools » ASCII chart or by clicking the
View ASCII Chart Icon & from Tools toolbar.

Acscii Chart =]
] 1 2 3 4 5 i) Fi 8 a9 A B C D E F
0 NUL SOH STX ETX EOT |[ENQ |ACK BEL BS HT | LF ¥T | FF |CR S50  5I
0 1 2 3 4 5 & 7 g 9 10 11 1z 15 14 15
1 DLE DC1 DCZ DC3Z |DC4 NAK|SYN ETB |[CAM EM SUB ESC F5 G5 RS  US
16 |17 |18 [19 |20 [ 21 |22 |23 |24 | 25 |26 | 27 |28 | 29 [ 30 | 31
5 |SPC 1" # 5 | % S O T I (O I T I
32 33 340|035 | 36 | 37 | 35 | 39 | 40 | 41 42 45 44 45 | 46 | 47
3 1] 1 2 3 4 5 ] 7 8 a : ; < = = ?
48 | 49 | 50 | 51 [ 52 | 53 [ 54 |65 |56 |57 |58 |59 | 60 [ 61 | 62 | B3
4 WA B C D E F G H I ] K L | M 0
&g ] 65 | 67 | 65 | A9 | 7O | A s - -
s |PlQ|R[s[T|u|vIw x|y |2[[[\|[T1]|~]_
0 | 81 | 82 | &3 [ 84 | 85 [ @6 9z [ 93 | 94 [ 95
6 " a b ¢ d e f | m n o
5 a7 95 | 99 | 100 | 101 | 102 105 | 109 | 110 | 111
z|P a r s t u | w | ¥} ~ DEL
112 | 113 | 114 | 115 | 116 | 117 | 118 124 | 125 | 126 | 127
g E s N A E Z
125 [ 129 [ 150 [ 151 [ 152 [ 153 [ 154 [ 155 [ 156 [ 157 [ 155 [ 159 [ 140 [ 141 | 142 1_13
9 [ ] w » - — — ~ = & H o= Z ¥
144 | 145 | 146 | 147 | 148 | 149 | 160 | 151 | 152 | 153 | 154 | 155 | 156 | 157 | 158 | 159
A i I A : § |7 @ |3« | a0 - ®
160 [ 161 [ 162 [ 163 [ 164 [ 165 [ 166 [ 167 [ 165 [ 169 [ 170 [ 171 [ 172 [ 173 [ 174 [ 175
T A R TR N
176 | 177 | 178 | 179 | 180 | 181 | 182 | 183 | 184 [ 185 | 186 | 187 | 188 | 189 | 190 | 191
. AA A A A A|l®E C | E | E E|E I |T 1 1
192 123 1?4 1?5 1?6 12? 1_‘5!8 193 | 200 ZIEII ZIEIZ 293 294 ZIEIS 206 | 207
D b M 1] 1] ] 1] a ® @ u u u u ¥ [u} 1}
208 | 209 | 210 | 211 | 212 [ 213 | 214 | 215 | 216 | 217 | 218 | 219 | z20 | 221 | 222 | 223
E 4 a4/ a/alald a2 ¢ e e & & i i i )
224 | 225 [ 226 [ 227 [ 228 [ 229 [ 250 [ 251 [ 252 [ 253 [ 254 [ 255 [ 256 [ 257 [ 258 [ 259
F a A | b6 &6 &6 |6 6|+ @ |0 a a0 ¢ | p | %
240 | 241 | 242 | 243 | 294 [ 245 | 246 | 247 | 248 | 240 | 250 | 251 | 252 | 253 | 254 | 255
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Seven Segment Converter

The Seven Segment Convertor is a convenient visual panel which returns
decimal/hex value for any viable combination you would like to display on 7seg.
Click on the parts of 7 segment image to get the requested value in the edit boxes.
You can launch it from the drop-down menu Tools > 7 Segment Convertor or by
clicking the Seven Segment Convertor Icon E from Tools toolbar.

Seven Segment Editor =]

0x71

Camman ahode:
0x8E

' Camman cathode:

Decoding Format:
Decimal

LCD Custom Character

mikroC PRO for PIC includes the Lcd Custom Character. Output is mikroC PRO for
PIC compatible code. You can launch it from the drop-down menu Tools » Lcd Cus-
tom Character.

LCD custom character EI = @
X = — —
| l; [ 5] = = LI LI I:I
5x7 5x10 Save... Load.. Fill all Clear all Invert
Font Preview:

DDDDD @ Bx 7+ oursor Ing
LI | - svtoveme [HEE
HE N
DD.I:H:‘ CGRAM address:
..... Char:
DD.DD Char data row:
HE N
e GENERATE

[=1 =]
k| [4r
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Graphic LCD Bitmap Editor

The mikroC PRO for PIC includes the Graphic Lcd Bitmap Editor. Output is the
mikroC PRO for PIC compatible code. You can launch it from the drop-down menu
Tools > Glcd Bitmap Editor.

|mikroEIektronik,a Graphic LCD Bitmap generator

TR AT R A e |
File loaded: truck,.bmp LTI:I_;:' . ’-:'_'r's“‘/‘!‘/
o i

] Pickure preview — 1Z28x64 pix J bw

[ LoadEMP Ficture

[ Create CODE ]

[ invertPIcTURE |

GLCD Size | controller

i
## GLCD Picture name: truck.bmp
#7 GLCD Model: KS@188 128xh4

o

m| »

Copy CODE to Clipboard

const truck_bmp : arrayl1824]1 of hyte = <
5]

6. 8. 8. - - - - - » 8. 8. B, 12, 12, 12, 12.
12, 1@, 18, 18, 18, 18, 1@, P P P P - 2, -
2. o o - 9. o o » 9. 9.137.137,137.137.137.137.
137.137.137,137,137,.137.137. 9, 9. 2. 9. 9, 9. 9. 9. 9.
3, %, 1%,25%, 1%.193. 6@,25%, g. g, g. g. g, g. g. g,

ver 2,01 - 27012005 System status: Win NT like OS5
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HID Terminal

The mikroC PRO for PIC includes the HID communication terminal for USB commu-
nication. You can launch it from the drop-down menu Tools > HID Terminal.

S rmikroElektronika USE (HID) Terminal

(== ==
Terminal | Descriptor
HID Devices: 7
ABBAHOME
ABBAHOME

»

mikroE HID Library test |
Dell Premium USE Optical House

« [

Communication

|HID Read/Write Test

Send
o v Send as Typing
-

Format
+ ASCII

[T Send as Murmber

" HEX

" DEC Clear
HID Read/Write Test

MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD 61



CHAPTER 2

Environment mikroC PRO for PIC

UDP Terminal

The mikroC PRO for PIC includes the UDP Terminal. You can launch it from the
drop-down menu Tools » UDP Terminal.

25 UDP Communication Terminal 7| [z
Settings
|P ddress: [192.168.20.25

Port: 10001

Send:

| mikraE lekbrorika Send

Append: [ CR [~ Send az typing
[~ LF [~ Send as number

rikroE lektromik.a

Receive

v ASCI " HEX " DEC

Clear
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mikroBootloader

(From Microchip’s document AN732) The PIC16F87X family of microcontrollers has
the ability to write to their own program memory. This feature allows a small boot-
loader program to receive and write new firmware into memory. In its most simple
form, the bootloader starts the user code running, unless it finds that new firmware
should be downloaded. If there is new firmware to be downloaded, it gets the data
and writes it into program memory. There are many variations and additional fea-
tures that can be added to improve reliability and simplify the use of the bootloader.

Note: mikroBootloader can be used only with PIC MCUs that support flash write.
How to use mikroBootloader?

1. Load the PIC with the appropriate hex file using the conventional programming
techniques (e.g. for PIC16F877A use p16£877a.hex).

2. Start mikroBootloader from the drop-down menu Tools > Bootoader.

3. Click on Setup Port and select the COM port that will be used. Make sure that
BAUD is set to 9600 Kpbs.

4. Click on Open File and select the HEX file you would like to upload.

5. Since the bootcode in the PIC only gives the computer 4-5 sec to connect, you

should reset the PIC and then click on the Connect button within 4-5 seconds.

The last line in then history window should now read “Connected”.

. To start the upload, just click on the Start Bootloader button.

. Your program will written to the PIC flash. Bootloader will report an errors that

may occur.
9. Reset your PIC and start to execute.

o N

¢ i mikroElektronika i mikroBootloader »1.0.0.2 =] @ =3

[ Setup Part ]

[ Connect ]

[ OpenHExfile |

Terminal Window

[ Start bootioader ]

@ @ @

Connect  Ts R

[ ]

C:\Program Files\MikroglektranikasmikioC PRO far PICAE RamplesiDevelopment Systems \EazyPICEWLc 4
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Features

The boot code gives the computer 5 seconds to get connected to it. If not, it starts
running the existing user code. If there is a new user code to be downloaded, the
boot code receives and writes the data into program memory.

The more common features a bootloader may have are listed below:

Code at the Reset location.

Code elsewhere in a small area of memory.

Checks to see if the user wants new user code to be loaded.

Starts execution of the user code if no new user code is to be loaded.
Receives new user code via a communication channel if code is to be loaded.
Programs the new user code into memory.

Integrating User Code and Boot Code

The boot code almost always uses the Reset location and some additional program
memory. It is a simple piece of code that does not need to use interrupts; therefore,
the user code can use the normal interrupt vector at 0x0004. The boot code must
avoid using the interrupt vector, so it should have a program branch in the address
range 0x0000 to 0x0003. The boot code must be programmed into memory using
conventional programming techniques, and the configuration bits must be pro-
grammed at this time. The boot code is unable to access the configuration bits,
since they are not mapped into the program memory space.
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OPTIONS

Options menu consists of three tabs: Code Editor, Tools and Output settings.
Code editor

The Code Editor is advanced text editor fashioned to satisfy needs of professionals.
Tools

The mikroC PRO for PIC includes the Tools tab, which enables the use of shortcuts
to external programs, like Calculator or Notepad.

You can set up to 10 different shortcuts, by editing ToolO - Tool9.

Toal Name: Tool0

File Name: Press button to open file dislog

Parameters:

Shorteut: F11 -

| 98 Clear 2l fields

DOutput
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Output settings

By modifying Output Settings, user can configure the content of the output files.
You can enable or disable, for example, generation of ASM and List file.

Also, user can choose optimization level, and compiler specific settings, which
include case sensitivity, dynamic link for string literals setting (described in mikroC
PRO for PIC specifics).

Build all files as library enables user to use compiled library (* .mc1) on any PIC
MCU (when this box is checked), or for a selected PIC MCU (when this box is left
unchecked).

For more information on creating new libraries, see Creating New Library.

Options

Qutput Settings

Output ¥ Generate ASM file

: ¥ Include HE¥ oprodes

¥ Include ROM constants
¥ Include ROM Addresses

¥ Generate list fils

¥ Include debug info
¥ Indude source lines in output files

Optimization level:

Faur =

Compiler

W Case sensitive
W Drynamic link for string lierals

WV Build all files as library

0K Apphy Cancel
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REGULAR EXPRESSIONS

Introduction

Regular Expressions are a widely-used method of specifying patterns of text to
search for. Special metacharacters allow you to specify, for instance, that a particu-
lar string you are looking for, occurs at the beginning, or end of a line, or contains n
recurrences of a certain character.

Simple matches

Any single character matches itself, unless it is a metacharacter with a special
meaning described below. A series of characters matches that series of characters
in the target string, so the pattern "short" would match "short" in the target string.
You can cause characters that normally function as metacharacters or escape
sequences to be interpreted by preceding them with a backslash "\".

For instance, metacharacter "*" matches beginning of string, but "\*" matches
character "*", and "\\" matches "\", etc.

Examples:

unsigned matches string 'unsigned'

\*unsigned matches string '“unsigned'’
Escape sequences

Characters may be specified using a escape sequences: "\n" matches a newline,
"\t" a tab, etc. More generally, \xnn, where nn is a string of hexadecimal digits,
matches the character whose ASCII value is nn.

If you need wide (Unicode) character code, you can use '\x{nnnn}', where 'nnnn'
- one or more hexadecimal digits.

\xnn - char with hex code nn

\x {nnnn) - char with hex code nnnn (one byte for plain text and two bytes for Unicode)
\t - tab (HT/TAB), same as \x09

\n - newline (NL), same as \x0a

\r - car.return (CR), same as \x0d

\f - form feed (FF), same as \x0c

\a - alarm (bell) (BEL), same as \x07

\e - escape (ESC) , same as \x1b
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Examples:

unsigned\x20int matches 'unsigned int' (note space in the middle)
\tunsigned matches 'unsigned' (predecessed by tab)

Character classes
You can specify a character class, by enclosing a list of characters in [], which will

match any of the characters from the list. If the first character after the "[" is "*", the
class matches any character not in the list.

Examples:
count[aeiou]r finds strings 'countar', 'counter', etc.butnot
'countbr', 'countcr', etc.
count[*aeiou]r finds strings 'countbr', 'countcr', etc. butnot
'countar', 'counter', eftc.

Within a list, the "-" character is used to specify a range, so that a-z represents all
characters between "a" and "z", inclusive.

If you want "-" itself to be a member of a class, put it at the start or end of the list, or
precede it with a backslash.
If you want '], you may place it at the start of list or precede it with a backslash.

Examples:
[-az] matches 'a', 'z' and '-'
[az-] matches 'a', 'z' and '-'
[a\-z] matches 'a', 'z' and '-'

[a-z] matches all twenty six small characters from 'a' to 'z’
[\n-\x0D] matches any of #10,#11,#12,#13.

[\d-t] matches any digit, '-' or 't'.
[1-a] matches any char from ']'..'a".
Metacharacters

Metacharacters are special characters which are the essence of regular expres-
sions. There are different types of metacharacters, described below.
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Metacharacters - Line separators

A - start of line

$ - end of line

\A - start of text

\Z - end of text

. - any character in line

Examples:

APORTA - matches string ' PORTA ' only if it's at the beginning of line
PORTAS - matches string ' PORTA ' only if it's at the end of line
~PORTAS - matches string ' PORTA ' only if it's the only string in line
PORT.r - matches strings like 'PORTA', 'PORTB', 'PORT1' and soon

The "~" metacharacter by default is only guaranteed to match beginning of the input
string/text, and the "$" metacharacter only at the end. Embedded line separators
will not be matched by *" or "$".

You may, however, wish to treat a string as a multi-line buffer, such that the """ will
match after any line separator within the string, and "$" will match before any line
separator.

Regular expressions works with line separators as recommended at http://www.uni-
code.org/unicode/reports/tr18/

Metacharacters - Predefined classes

\w - an alphanumeric character (including " ")
\W - a nonalphanumeric character

\d - a numeric character

\D - a non-numeric character

\s - any space (same as [\t\n\r\f])

\S - a non space

You may use \w, \d and \s within custom character classes.

Example:
routi\de - matches strings like 'routile', 'routiée' and so on, but not
'routine', 'routime' and so on.
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Metacharacters - Word boundaries

A word boundary ("\b") is a spot between two characters that has an alphanumeric
character ("\w") on one side, and a nonalphanumeric character ("\W") on the other
side (in either order), counting the imaginary characters off the beginning and end
of the string as matching a "\W".

\b - match a word boundary)
\B - match a non-(word boundary)

Metacharacters - Iterators

Any item of a regular expression may be followed by another type of metacharac-
ters - iterators. Using this metacharacters,you can specify number of occurences of
previous character, metacharacter or subexpression.

* - zero or more ("greedy"), similar to {0,}

+ - one or more ("greedy"), similar to {1,}

? - zero or one ("greedy"), similar to {0,1}

{n} - exactly n times ("greedy")

{n,} - at least n times ("greedy")

{n,m} - at least n but not more than m times ("greedy")
*? - zero or more ("non-greedy"), similar to {0,}?

+7? - one or more ("non-greedy"), similar to {1,}?

?7? - zero or one ("non-greedy"), similar to {0,1}?

{n}? - exactly n times ("non-greedy")

{n,}? - at least n times ("non-greedy")

{n,m}? - at least n but not more than m times ("non-greedy")

So, digits in curly brackets of the form, {n,m}, specify the minimum number of times
to match the item n and the maximum m. The form {n} is equivalent to {n,n} and
matches exactly n times. The form {n,} matches n or more times. There is no limit
to the size of n or m, but large numbers will chew up more memory and slow down
execution.

So, digits in curly brackets of the form, {n,m}, specify the minimum number of times
to match the item n and the maximum m. The form {n} is equivalentto {n,n} and
matches exactly n times. The form {n, } matches n or more times. There is no limit
to the size of n or m, but large numbers will chew up more memory and slow down
execution.

If a curly bracket occurs in any other context, it is treated as a regular character.

70 MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD



CHAPTER 2

mikroC PRO for PIC Environment
Examples:

count.*r B- matches strings like 'counter', 'countelkjdflkj9r' and
'countr'’
count.+r - matches strings like 'counter', 'countelkjdflkj9r' but not
'countr'’
count.?r - matches strings like 'counter', 'countar' and 'countr' butnot
'countelkjOr’
counte{2}r - matches string 'counteer'
counte{2, }r - matches strings like 'counteer', 'counteeer', 'counteeer' efc.
counte{2,3}r - matches strings like 'counteer', or 'counteeer' but not
'counteeeer’

A little explanation about "greediness". "Greedy" takes as many as possible, "non-
greedy" takes as few as possible.

For example, 'b+' and 'b*' applied to string '‘abbbbc' return 'bbbb’, 'b+?' returns 'b’,
'b*?"' returns empty string, 'b{2,3}?' returns 'bb’, 'b{2,3} returns 'bbb'.

Metacharacters - Alternatives

You can specify a series of alternatives for a pattern using " |" to separate them,
so thatbit|bat|bot will match any of "bit", "bat", or "bot" in the target string
as would "b (i|a|o) t)". The first alternative includes everything from the last pat-
tern delimiter (" (", "[", or the beginning of the pattern) up to the first "|", and
the last alternative contains everything from the last " |" to the next pattern delim-
iter. For this reason, it's common practice to include alternatives in parentheses, to
minimize confusion about where they start and end.

Alternatives are tried from left to right, so the first alternative found for which the
entire expression matches, is the one that is chosen. This means that alternatives
are not necessarily greedy. For example: when matching rou|rout against "rou-
tine", only the "rou" part will match, as that is the first alternative tried, and it
successfuly matches the target string (this might not seem important, but it is impor-
tant when you are capturing matched text using parentheses). Also remember that
" | " is interpreted as a literal within square brackets, so if you write [ bit|bat|bot] ,
you're really only matching [biao]].

Examples:

rou(tine|te) - matches strings 'routine' or 'route'.
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Metacharacters - Subexpressions

The bracketing construct ( ... ) may also be used for define regular subexpres-
sions. Subexpressions are numbered based on the left to right order of their open-
ing parenthesis. First subexpression has number '1'.

Examples:
(int) {8,10} matches strings which contain 8, 9 or 10 instances of the 'int'
routi ([0-9] | a+) e matches 'routiOe', 'routile', 'routine', 'routinne’,
'routinnne' etc.
Metacharacters - Backreferences
Metacharacters \1 through \ 9 are interpreted as backreferences. \ matches previ-
ously matched subexpression #.
Examples:
(.)\1+ matches 'aaaa' and 'cc'.
(.+)\1+ matches 'abab' and '123123'

(['"1?) (\d+)\1 matches "13" (in double quotes), or '4' (in single quotes)
or 77 (without quotes) etc.
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mikroC PRO for PIC COMMAND LINE OPTIONS

Usage: mikroCPIC1618.exe [ -<opts> [ -<opts>]] [ <infile> [ —<opts>]] [ -
<opts>]] Infile can be of » .c, *.mc1 and * .pl1d type.

The following parameters and some more (see manual) are valid:
- p: MCU for which compilation will be done.
- ro: Set oscillator [in MHZz].
- sp: Add directory to the search path list.
- TF: Add directory to the #include search list.
- n: Output files generated to file path specified by filename.
- B: Save compiled binary files (* .mc1) to 'directory'.
- 0: Miscellaneous output options.
- pBG: Generate debug info.
- 1.: Check and rebuild new libraries.
- D: Build all files as libraries.
- v: Dynamic link for string literals.
- ¢: Turn on case sensitivity.
- UCD: ICD build type.

Example:

mikroCPIC1618.exe -MSF -DBG -pl6F887 -ES -C -011111114 -fo8 -
N"C:\Lcd\Lcd.mcppi" -SP"C:\Program Files\Mikroelektronika\mikroC PRO
for PIC\Defs\" -SP"C:\Program Files\Mikroelektronika\mikroC PRO for

PIC\Uses\P16\" -SP"C:\Lcd\" "Led.c" " Lib Math.mcl"
" _Lib MathDouble.mcl" " _Lib System.mcl" " _Lib Delays.mcl"
" Lib LcdConsts.mcl" "_ Lib Led.mel”

Parameters used in the example:

- MsF: Short Message Format; used for internal purposes by IDE.

- pBG: Generate debug info.

- p16r887: MCU 16F887 selected.

- ¢: Turn on case sensitivity.

-011111114: Miscellaneous output options.

- f010: Set oscillator frequency [in MHz].

-N"C:\Lcd\ Led.meppi" —-SP"C:\Program Files\Mikroelektronika\mikroC PRO
for pIC\defs\": Output files generated to file path specified by filename.

- -SP"C:\Program Files\Mikroelektronika\mikroC PRO for PIC\
defs\ ": Add directory to the search path list.

- SP"C:\Program Files\Mikroelektronika\mikroC PRO for PIC \uses\":
Add directory to the search path list.

- -sp"c:\Lcd\ ": Add directory to the search path list.

-"Lced.c" " Lib Math.mcl" " Lib MathDouble.mcl"

"AALibASySEgm.mEl" ”77Lib7DéIéySTﬁcl” " Lib LcdConsts.mcl"

"  Lib Led.mcl": Specify input files.
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PROJECTS

The mikroC PRO for PIC organizes applications into projects, consisting of a single
project file (extension .mcppi) and one or more source files (extension ). mikroC
PRO for PIC IDE allows you to manage multiple projects (see Project Manager).
Source files can be compiled only if they are part of a project.

The project file contains the following information:

- project name and optional description,

- target device,

- device flags (config word),

- device clock,

- list of the project source files with paths,
- header files (*.h),

- binary files (*.mcl),

- image files,

- other files.

Note that the project does not include files in the same way as preprocessor does,
see Add/Remove Files from Project.

New Project
The easiest way to create a project is by means of the New Project Wizard, drop-

down menu Project » New Project or by clicking the New Project lcon |2
from Project Toolbar. e
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New Project Wizard Steps

Start creating your New project, by clicking Next button:

Mew Project Wizard

Welcome to the New Project
Wizard

This wizard helps you:

e Create a new project

e Select the device for your project

. & Setup device clock and choose device flags
¢ Select desired memaory model

e Add project files

Click Next to continue

Bk Mext 5 Cancel

Step One - Select the device from the device drop-down list.

MNewy Project Wizard @

Select the device you want to use.

Device Mame:

4 Back Mext o Cancel
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Step Two - Enter the oscillator frequency value.
Mew Project Wifizard

Setup the clock, for example 11,0592 MHz.

Device Clock: 11.059200| MHz

4@ Back Mext 5

Cancel

==l

Step Three - Specify the location where your project will be saved.
MNews Project Wizard

50
Specify where your project will be saved.

Project File Name:

11\ ProjectsiFirstPrajectiFirstPraject . meppi

4 Back Next o

Cancel
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Step Four - Add project file to the project if they are avaiable at this point. You can
always add project files later using Project Manager.

Mew Project Yifizard [E5]

4dd project files if they are available at this point.
You can always add project files later using the Project Manager in IDE.

Add File To Project:

DudProjects|FirstProject|Definit.h ~ Add ¢
File: Mame
[\Projects\FirstProjectDefinit, b
Remove
Remove All
4 Back Next o Cancel
Step Five - Click Finish button to create your New Project.
Mew Project Wifizard =]

Step 575

You have successfully created a new project. Click Finish to save the changes
and to close the wizard.

- d

N

4@ Back Finish Cancel

Related topics: Project Manager, Project Settings
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PROJECTS

The mikroC PRO for PIC organizes applications into projects, consisting of a single
project file (extension .mcppi) and one or more source files (extension). mikroC
PRO for PIC IDE allows you to manage multiple projects (see Project Manager).
Source files can be compiled only if they are part of a project.

The project file contains the following information:

- project name and optional description,

- target device,

- device flags (config word),

- device clock,

- list of the project source files with paths,
- header files (+ .n),

- binary files (* .mc1),

- image files,

- other files.

Note that the project does not include files in the same way as preprocessor does,
see Add/Remove Files from Project.

New Project

The easiest way to create a project is by means of the New Project Wizard, drop-
down menu Project » New Project or by clicking the New Project Icon :L from
Project Toolbar.
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New Project Wizard Steps

Start creating your New project, by clicking Next button:

Mew Project Wizard

Welcome to the New Project
Wizard

This wizard helps you:

e Create a new project

e Select the device for your project

s Setup device clock and choose device flags
¢ Select desired memaory model

e Add project files

Click Next to continue

Bk Mext 5 Cancel

Step One - Select the device from the device drop-down list.

MNews Project YYizard @

Select the device you want to use.

Device Mame:

4 Back Next o Cancel
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Step Two - Enter the oscillator frequency value.
MNewy Project Wizard

(5

Setup the clock, for example 11,0592 MHz.

Device Clock: 11.0592EID| MHz

4@ Back Next &

Cancel

Step Three - Specify the location where your project will be saved
MNews Project Wizard

(=l
Specify where your project will be saved.

Project File Name:

)1\ ProjectsiFirstPrajectiFirstPraject moppi

4 Back Mext o

Cancel
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Step Four - Add project file to the project if they are avaiable at this point. You can
always add project files later using Project Manager.

MNewy Project Wizard @

Add project files if they are available at this point.
You can always add project files |later using the Project Manager in IDE.

Add File To Project:

Dr:\Projects)FirstProjectiDefinit.h E] - Add ¢

File: Marne

[v\Projects\FirstPraject\Definit. b
Remove
Remove All

4 Back Next o Cancel
Step Five - Click Finish button to create your New Project:
Mew Project Wifizard =3

Step 575

You have successfully created a new project. Click Finish to save the changes
and to close the wizard.

=

N

4 Back . FEinish Cancel
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CUSTOMIZING PROJECTS
Edit Project

You can change basic project settings in the Project Settings window. You can
change chip, and oscillator frequency. Any change in the Project Setting Window
affects currently active project only, so in case more than one project is open, you
have to ensure that exactly the desired project is set as active one in the Project
Manager. Also, you can change configuration bits of the selected chip in the Edit
Project window.

Managing Project Group

mikroC PRO for PIC IDE provides covenient option which enables several projects
to be open simultaneously. If you have several projects being connected in some
way, you can create a project group.

The project group may be saved by clicking the Save Project Group Icon % from
the Project Manager window. The project group may be reopend by clicking the
Open Project Group Icon % . All relevant data about the project group is stored in
the project group file (extension .mpgroup)

Add/Remove Files from Project
The project can contain the following file types:

- source files

- .h header files

- .mc1 binary files

- pl1d project level defines files

- image files

- .hex, .asm and . 1st files, see output files. These files can not be added or
removed from project.

- other files
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Project Manager (=]
A NEER

e | ]

i
¥

4-17, TE963IC_2401128. mcppi
4|7 Sources
E] 16963C_240x128.c
% bitrmap.c
4| Header Files
TE963C.H
4| Binaries
bitrap2.mcl
1 Project level defines
47 Image Files
sample.jpg
4] Dukput Files
B T6963C_240x128.hex
| T6963C_240x128.a5m
% Te963C_240x125.Ist
-\ Other Files
E] DATA - doc3zse, pdf

The list of relevant source files is stored in the project file (extension .mcppi).

To add source file to the project, click the Add File to Project Icon || . Each added
source file must be self-contained, i.e. it must have all necessary definitions after
preprocessing.

To remove file(s) from the project, click the Remove File from Project Icon || « i

Project Level Defines:

Project Level Defines (.p1d) files can also be added to project. Project level define
files enable you to have defines that are visible in all source files in the project. A file
must contain one definition per line in the following form:

<symbol>[ = <value>]]
<symbol (a,b)>[ =[ <value>]]

Define a macro named symbol. To specify a value, use =<value>. If =<value> is
omitted, 1 is assumed. Do not enter white-space characters immediately before the
"= _If a white-space character is entered immediately after the "=", the macro is
defined as zero token. This option can be specified repeatedly. Each appearance of
symbol will be replaced by the value before compilation.

There are two predefined project level defines. See predefined project level defines

Note: For inclusion of the header files (extension .h), use the preprocessor direc-
tive #include. See File Inclusion for more information.

Related topics: Project Manager, Project Settings, Edit Project
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SOURCE FILES

Source files containing C code should have the extension . The list of source files
relevant to the application is stored in project file with extension .mcppi, along with
other project information. You can compile source files only if they are part of the
project.

Use the preprocessor directive #include toinclude header files with the extension
.h. Do not rely on the preprocessor to include source files other than headers —
see Add/Remove Files from Project for more information.

Managing Source Files
Creating new source file

To create a new source file, do the following:

1. Select File » New Unit from the drop-down menu, or press Ctrl+N, or click the
New File Icon I_'] from the File Toolbar.

2. A new tab will be opened. This is a new source file. Select File » Save from the
drop-down menu, or press Ctrl+S, or click the Save File Icon [ from the File
Toolbar and name it as you want.

If you use the New Project Wizard, an empty source file, named after the project with

extension, will be created automatically. The mikroC PRO for PIC does not require you
to have a source file named the same as the project, it’s just a matter of convenience.

Opening an existing file

1. Select File » Open from the drop-down menu, or press Ctrl+0, or click the Open
File Icon é" from the File Toolbar. In Open Dialog browse to the location of the
file that you want to open, select it and click the Open button.

2. The selected file is displayed in its own tab. If the selected file is already open, its
current Editor tab will become active.

Printing an open file

1. Make sure that the window containing the file that you want to print is active.

2. Select File » Print from the drop-down menu, or press Ctrl+P.

3. In the Print Preview Window, set a desired layout of the document and click the
OK button. The file will be printed on the selected printer.
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Saving file

1. Make sure that the window containing the file that you want to save is active.
2. Select File » Save from the drop-down menu, or press Ctri+S, or click the Save

File Icon [ from the File Toolbar.

Saving file under a different name

1. Make sure that the window containing the file that you want to save is active.

2. Select File » Save As from the drop-down menu. The New File Name dialog will
be displayed.

3. In the dialog, browse to the folder where you want to save the file.

4. In the File Name field, modify the name of the file you want to save.

5. Click the Save button.

Closing file

1. Make sure that the tab containing the file that you want to close is the active tab.

2. Select File » Close from the drop-down menu, or right click the tab of the file that
you want to close and select Close option from the context menu.

3. If the file has been changed since it was last saved, you will be prompted to save
your changes.

Related topics:File Menu, File Toolbar, Project Manager, Project Settings,
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CLEAN PROJECT FOLDER

This menu gives you option to choose which files from your current project you want
to delete.

Files marked in bold can be easily recreated by building a project. Other files should
be marked for deletion only with a great care, because IDE cannot recover them.

Clean Project Folder &

Below is the list of all files in the project folder. Files in bold are those
generated by the compiler and they can be easily recreated when the
project is rebuilt,

Select which files you want to rermove from the project folder, Please
note that selected files will be permanently deleted from vour dislk if

-.[¥| spiEthernet.asm -
[ "] spiEthernet,c

- [”] spiEthernet.c.ini

-] spiEthernet.cp

-.[¥] SpiEthernet.dbg

--[¥] SpiEthernet.dct

-.[¥| spiEthernet.dit

-.[”] SpiEthernet.hex

-[¥] SpiEthernet.lst

-[I7] spiEthernet.mcl

-[”] spiEthernet.mcppi

--[¥] SpiEthernet.mcppi_callertable.txt
-[¥] spiEthernet.mil

-[”] spiEthernet, user, dic

Clean Cancel

CAProgram Files\Mikroelektronika\mikroC PROfor PICY

Related topics: Customizing Projects
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COMPILATION

When you have created the project and written the source code, it's time to compile
it. Select Project » Build from the drop-down menu, or click the Build Icon %  from
the Project Toolbar. If more more than one project is open you can compile all open
projects by selecting Project > Build All from the drop-down menu, or click the Build
All Icon .ﬁ,‘!‘.: from the Project Toolbar.

Progress bar will appear to inform you about the status of compiling. If there are

some errors, you will be notified in the Error Window. If no errors are encountered,
the mikroC PRO for PIC will generate output files.

Output Files
Upon successful compilation, the mikroC PRO for PIC will generate output files in

the project folder (folder which contains the project file .mcppi). Output files are
summarized in the table below:

Format Description File Type
Intel style hex records. Use this file to program -
Intel HEX PIC MCU. .hex
Bina mikro Compiled Library. Binary distribution of el
Y application that can be included in other projects. |-
I Overview of PIC memory allotment: instruction
List File ) . 1st
addresses, registers, routines and labels.
Assembler File Human readable assembly with symbolic names, em
extracted from the List File. U

Assembly View

After compiling the program in the mikroC PRO for PIC, you can click the View
Assembly icon || or select Project > View Assembly from the drop-down menu
to review the generated assembly code (.zsm file) in a new tab window. Assembly
is human-readable with symbolic names.

Related topics: Project Menu, Project Toolbar, Error Window, Project Manager, Pro-
ject Settings
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ERROR MESSAGES

Compiler Error Messages:

- Syntax error: Expected [ 2s] but[ 2s] found
- Array element cannot be function

- Function cannot return array

- Inconsistent storage class

- Inconsistent type

-[ 3s] tag redefined [ 2s]

- lllegal typecast [ ¢s] [ %s]

- "%s" is not valid identifier

- Invalid statement

- Constant expression required

- Internal error [ <s]

- Too many actual parameters

- Not enough parameters.

- Invalid expression

- Identifier expected, but[ <s] found

- Operator [ 2s] is not applicable to these operands [ ¢s]
- Assigning to non-lvalue [ %s]

- Cannot cast[ 2s] to[ 2s]

- Cannot assign [ ¢s] to[ 2s]

- Lvalue required

- Pointer required

- Argument is out of range

- Undeclared identifier [ >s] in expression

- Too many initializers

- Cannot establish this baud rate at [ *s] MHz clock
- Stack overflow

- Invalid operator [ %s]

- Expected variable, but constant [ %s] found

- Expected constant, but[ %s] found

-[ %s] cannot be used outside a loop

- Unknown type [ %s]

- Variable [ %s] is redeclared

- Undeclared identifier [ %s]

- Output limit has raised 2K words

-[ %s] has already been declared [ %s]

- Type mismatch: expected [ %s], but[ %s] found
- File [ %s] not found [ %s]

- There is not enough RAM space for all variables
- There is not enough ROM space

- Invalid type in Array

- Division by zero

- Incompatible types: [ $s] [ %s]

- Too many characters
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- Assembiler instruction [ 2s] was not found
- Project name must be specified

- Unknown command line Option: [ 2s]

- File extension missing: [ ¢s]

- Bad FO argument: [ 2s]

- Preprocessor exited with error code [ =s]
- Bad absolute address | %s]

- Recursion or cross-calling of [ 5]

- Reentrancy is not allowed: function; 2s] called from two threads
- no files specified

- Device parameter missing (for example -P16F...)
- Invalid parameter string

- Project name must be set

- Specifier needed

-[ 2s] notfound| %s)

- Index out of bounds

- Array dimension must be greater than 0

- Const expression expected

- Integer const expected

- Recursion in definition

- Array corrupted

- Arguments cannot be of void type

- Arguments cannot have explicit memory specificator
- Bad storage class

- Pointer to function required

- Function required

- lllegal pointer conversion to double

- Integer type needed

- Members cannot have memory specifier
- Members cannot be of bit or sbit type

- Too many initializers

- Too many initializers of subaggregate

- Already used | %s]

- lllegal expression with void

- Address must be greater than 0

-[ %s] Identifier redefined

- User abort
- Expression must be greater than 0
- Invalid declarator expected " (" or identifier

- typdef name redefined: [ %s]

- Declarator error

- Specifer/qualifier list expected

-[ 2s] already used

- ILevel can be used only with interrupt service routines
- ; expected, but| <s] found
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- Expected "{ "

-[ %s] ldentifier redefined

- " (" expected, but[ s} found

- ") " expected, but[ 2s] found

- "case" out of switch

- . expected, but[ ¢s] found

- "default" label out of switch

- switch expression must evaluate to integral type

- while expected, but[ <s] found

- void func cannot return values

- "continue" outside of loop

- Unreachable code

- Label redefined

- void type in expression

- Too many chars

- Unresolved type

- Arrays of objects containing zero-size arrays are illegal
- Invalid enumerator

- ILevel can be used only with interrupt service routines
- ILevel value must be integral constant

- ILevel out of range "0. . 4"

- " expected [ ¢s] found

- ") expected, but[ 2s] found

- "break" outside of loop or switch

- Empty char

- Nonexistent field [ 2 s]

- lllegal char representation: [ %s]

- Initializer syntax error: multidimensional array missing subscript
- Too many initializers of subaggregate

- At least one Search Path must be specified

- Not enough RAM for call stack

- Demo Limit

- Parameter [ ¢s] must not be of bit or sbit type

- Function must not have return value of bit or sbit type
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Compiler Warning Messages:

- Bad or missing fosc parameter. Default value 8MHz used

- Specified search path does not exist: [ %s]

- Specified include path does not exist: [ %s]

- Result is not defined in function: [ 2s]

- Initialization of extern object [ <s]

- Suspicious pointer conversion

- Implicit conversion of pointer to int

- Unknown pragma line ignored: [ %s]

- Implicit conversion of int to ptr

- Generated baud rate is [ s] bps (error =[ 2s] percent)

- Unknown memory model [ =s] , small memory model used instead
- IRP bit must be set manually for indirect access to [ <s] variable
- Variable [ =s] has been declared, but not used'

- lllegal file type: [ 2s]

Linker Error Messages:

- Redefinition of [ 2s] already defined in| %s]

- main function is not defined

- System routine is not found for initialization of: [ 2s]
- Bad aggregate definition [ 2s]

- Unresolved extern [ %s]

- Bad function absolute address [ ¢s]

- Not enough RAM [ <5]
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SOFTWARE SIMULATOR OVERVIEW

The Source-level Software Simulator is an integral component of the mikroC PRO
for PIC environment. It is designed to simulate operations of the PIC MCUs and
assist the users in debugging C code written for these devices.

Upon completion of writing your program, choose Release build Type in the Project
Settings window:

Project Settings
Sl Device

Name: |p1sFa77a -

B@Oscillatur
Choose Release type

if you want to use
b : Yalue: 2.,000000 | MHz
software simulator

1=l Buildf Debugger Twpe

i B K

Build Twpe

- @ Release () 1D Debug
Debugger
@ Software () rikrolCD

After you have successfuly compiled your project, you can run the Software Simu-
lator by selecting Run » Start Debugger from the drop-down menu, or by clicking
the Start Debugger Icon I'Eh from the Debugger Toolbar. Starting the Software Sim-
ulator makes more options available: Step Into, Step Over, Step Out, Run to Cursor,
etc. Line that is to be executed is color highlighted (blue by default).

Note: The Software Simulator simulates the program flow and execution of instruc-

tion lines, but it cannot fully emulate PIC device behavior, i.e. it doesn’t update
timers, interrupt flags, etc.
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Breakpoints Window

The Breakpoints window manages the list of currently set breakpoints in the project.
Doubleclicking the desired breakpoint will cause cursor to navigate to the correspon-

ding location in source code.

Breakpoaints

el

Line:
50
54
55
G
75
76

File Marne

Led.c
Lcd.c
Led.c
Led.c
Lcd.c
Led.c

Watch Window

The Software Simulator Watch Window is the main Software Simulator window
which allows you to monitor program items while simulating your program. To show
the Watch Window, select View > Debug Windows > Watch from the drop-down

menu.

The Watch Window displays variables and registers of the MCU, along with their

addresses and values.

There are two ways of adding variable/register to the watch list:

B by its real name (variable's name in "C" code). Just select desired variable/reg-

ister from Select variable from list drop-down menu and click the Add Button

8= Add
B by its name ID (assembly variable name). Simply type name ID of they

variable/register you want to display into Search the variable by assemby

name box and click the Add Button
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Variables can also be removed from the Watch window, just select the variable that
you want to remove and then click the Remove Button 4 Remove

Add All Button 4 Add aAll adds all variables.
Remove All Button . Remave &ll removes all variables.

You can also expand/collapse complex variables, i.e. struct type variables, strings...
Values are updated as you go through the simulation. Recently changed items are

colored red.

Miratch Walues =]
Eh B EY | oo ® o ol | @ [ g |
& Add 9 Remove < Properties kgl AddAll gl Remove All

Select variable from lizt:
r -

Search for variable by azzembly name:

FARG_TE3E3C_cicle+d @

| Peripherals Freeze V| Advance Breakpoints

Tame Value Address
pic 1] 00039
panel 1] 0051
TE963C_dataPort 1] 00050
Te963C_cntlrst u] 00094
TEEIC_griwidth u] 00020
start il 00048
made i} 00034
r 1] 00038

PC= 0x0009FE Cyile= 560,00

Double clicking a variable or clicking the Properties Button “* Properties  gpens
the Edit Value window in which you can assign a new value to the selected
variable/register. Also, you can choose the format of variable/register representation
between decimal, hexadecimal, binary, float or character. All representations except
float are unsigned by default. For signed representation click the check box next to
the Signed label.
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An item's value can be also changed by double clicking item's value field and typing
the new value directly.

[H Edit Walue: ACD [ | =[]
0100 0000 1000 0011 0001 001001101111
Representation
) Dec ) Hex @) Bin () Float (7 Char
Signed K H Canicel

View RAM Window

Debugger View RAM Window is available from the drop-down menu, View » Debug
Windows > View RAM.

The View RAM Window displays the map of PIC’'s RAM, with recently changed
items colored red.

RAM &
RAM | Hiskary

DDlDl|02|l33|04|DS|DBlU?|DS|09|DF\|UB|DC|DD|DE|UF|-‘15CH o

ooooy oo ooC ) 95 | OC 00 | OO0 3F 00 00 00 0O 00 00 oo DR 22

ooy oo o0 0o | DF 00 0 A0 00 00 00 00 C0 A0 00 00 | OF

Qozo| oo oo 04 oo oo EO a0 oo 0C a4 gl oo o1 05 z0 oo

ooso) 11 oo 25 oo 49 05 oo 40 04 oo 44 10 oo 10 oo oo

oo40) 00 a4 z0 oo 1z a0 oo 22 oo 10 oo o1 =] 04 oo 45

ooso) oo oo oo 04 oo oo z0 &0 o1 oo oo oo 0z oo o1 oo

ooeQf 4C 06 200 00 03 02 00 03 OF 4 01 1900 oo A

oovo) oo 08 15 |60 | 06 | o0 | 01 0 o0l Z1 6o 26| 50 00 00

oogof oo FF 95 | OC 00 | 3F 0 FF FF  FF  OF 00 00 | 00 o0 00 0o

ooeof oo oo FF o OO0 OO0 OO 00 00 O 00 OO 00 O o0 o0 0o

ooaoy =0 01 g4 00 40 20 | 03 00 | 00 04 00 & | oo 41 2000

ooeof o0 oo Ol ooz oo o0 00 o0 o0 o4 40 02 23 24 82

ooco) oo 22 of 11 o6 | 0 11 58 84 | 00 02 | o0 | 80 | 23 | &0

oopo) oo o0 ) ol Juli} o | oo 10 m | 4 04 00 o0 o0 | ool 40 | 84

O0EO | 00 oo 04 20 =) 0 oo a0 oo 40 40 a4 z1 14 a0 28

QoOFO) 00 05 15 B0 i) oo o1 05 10 o1 21 BE 26 S0 oo oo
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Stopwatch Window

The Software Simulator Stopwatch Window is available from the drop-down menu,
View > Debug Windows > Stopwatch.

The Stopwatch Window displays a current count of cycles/time since the last Soft-
ware Simulator action. Stopwatch measures the execution time (number of cycles)
from the moment Software Simulator has started and can be reset at any time. Delta
represents the number of cycles between the lines where Software Simulator action
has started and ended.

Note: The user can change the clock in the Stopwatch Window, which will recalcu-
late values for the latest specified frequency. Changing the clock in the Stopwatch
Window does not affect actual project settings — it only provides a simulation.

Stopwatch =]
Cyiles: Time:
Current Counts (2 9,60 us
Delka: g 2.40us
Skopwatch: = 9,60 us

Resek Ta Zero

Clock: 10 MHz
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CHAPTER 2

mikroC PRO for PIC Environment
SOFTWARE SIMULATOR OPTIONS
e Function | Toolbar
Name Description
Key Icon

Start . =
Debugger Start Software Simulator. [F9] Eb:
Run/Pause . -
Debugger Run or pause Software Simulator. [F6] IEJ_I
Stop . =
Debugger Stop Software Simulator. [CtrI+F2] IE—E]

Toggle breakpoint at the current cursor
el position. To view all breakpoints, select Run
Bogg c > View Breakpoints from the drop—down [F5] (=]

reakpoints C . .

menu. Double clicking an item in the Break-

points Window List locates the breakpoint.
rRun to cur- [Execute all instructions between the current

) : - [F4] |
sor instruction and cursor position.

Execute the current C (single or multi—cycle)
cien Tnio instruction, then halt. If the instruction is a rou- [F7] B3
oeer N tine call, enter the routine and halt at the first

instruction following the call.
- Execute the current C (single or &
rep Over multi—cycle) instruction, then halt. [F8] £

N Execute all remaining instructions in the

Shep out current routine, return and then halt. [Ctrl+F8] L1

Related topics: Run Menu, Debug Toolbar
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CREATING NEW LIBRARY

mikroC PRO for PIC allows you to create your own libraries. In order to create a
library in mikroC PRO for PIC follow the steps bellow:

1. Create a new C source file, see Managing Source Files

2. Save the file in one of the subfolders of the compiler's Uses folder:
DriveName:\ Program Files\Mikroelektronika\mikroC PRO for
PIC\ Uses\ P16\
DriveName:\ Program Files\Mikroelektronika\mikroC PRO for
PIC\ Uses\ P18\
If you are creating library for PIC16 MCU family the file should be saved in P16 folder.
If you are creating library for PIC18 MCU family the file should be saved in P18 fodler.
If you are creating library for PIC16 and PIC18 MCU families the file should be
saved in both folders.

3. Write a code for your library and save it.

4.Add 1ib Example file in some project, see Project Manager. Recompile the
project.
If you wish to use this library for all MCUs, then you should go to Tools > Options
» Output settings, and check Build all files as library box.
This will build libraries in a common form which will work with all MCUs. If this
box is not checked, then library will be built for selected MCU.
Bear in mind that compiler will report an error if a library built for specific MCU is
used for another one.

5. Compiled file 1ib Example.mcl should appearin ..\mikroC PRO for
pic\uses\ folder.

6. Open the definition file for the MCU that you want to use. This file is placed in the
compiler's Defs folder:

DriveName:\ Program Files\Mikroelektronika\mikroC PRO for
PIC\ Defs\

and it is named MCU NAME.mlk, forexample 16F887.mlk

7. Add the the following segment of code to <1.7BrRARTES> node of the definition
file (definition file is in XML format):
<LIB>
<ALIAS>Example Library</ALIAS>
<FILE> Lib Example</FILE>
<TYPE>REGULAR</TYPE>
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</LIB>

8. Add Library to mlk file for each MCU that you want to use with your library.

9. Click Refresh button in Library Manager

10. Example Library should appear in the Library manager window.

Multiple Library Versions

Library Alias represents unique name that is linked to corresponding Library .mc1
file. For example UART library for 16F887 is different from UART library for 18F4520
MCU. Therefore, two different UART Library versions were made, see n1k files for
these two MCUs. Note that these two libraries have the same Library Alias (UART)
in both m1x files. This approach enables you to have identical representation of

UART library for both MCUs in Library Manager.

Related topics: Library Manager, Project Manager, Managing Source Files
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MIKROICD (IN-CIRCUIT
DEBUGGER)

mikrolCD is highly effective tool for Real-Time debugging on hardware level. ICD
debugger enables you to execute a mikroC PRO for PIC program on a host PIC
microcontroller and view variable values, Special Function Registers (SFR), memo-
ry and EEPROM as the program is running.
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Step No. 1

If you have appropriate hardware and software for using mikrolCD, then, upon com-
pletion of writing your program, you will have to choose ICD Debug build type.

Project Settings ]
Sl Device -
Name: |p16Fa77a v

E@Oscillatnr -
Choose ICD Debug

Value: MHz type if you want

to use mikrolCD

1=l Build) Debugger Type - debug.
Build Type |
() Release @ ICDDebug -——
Debugger
() Software @ mikrolCD

Step No. 2

You can run the mikrolCD by selecting Run > Debug from the drop-down menu, or
by clicking Debug Icon I-Eh: . Starting the Debugger makes more options available:
Step Into, Step Over, Run to Cursor, etc. Line that is to be executed is color high-
lighted (blue by default). There is also notification about program execution and it
can be found on Watch Window (yellow status bar). Note that some functions take
time to execute, so running of program is indicated on Watch Window.
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= m—
ENE e T I A ) =
B zo TRISE = 0O ESEINE. e L = ™
° ANSEL = 0O; w Add 9 Remove <P g Add ANl fsl Remove All
° = 0.
LIS L g Select variable from list:
text -
& Led Init(): Search for vanable by assembly name:
° L Led Cmd (LCD_CLEAR) tent &)
° Lod Crd (LCD_CURSOR OFF) ; T —
L EH for(i = 1; i < 17; i++) { Mame Value Address
e Led Chr (i, i, text[i-11): PORTE a 00006
@ a0 ¥ TRISE 127 00086
] B AMSEL 255 0x0155
AMSELH 63 0x0189
4 kext {.} 0x0020
PC= 0x0000AF Cicle=0.00
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mikrolCD Debugger Options

Name Description Function Key
Debug Start Debugger. [FI]
Run/Pause
Debugger Run or pause Debugger. [F6]

Toggle breakpoint at the current cursor posi-
. | tion. To view all breakpoints, select Run >
Bogq ° View Breakpoints from the drop—down menu. [F5]
reakpoints

Double clicking an item in the Breakpoints
Window List locates the breakpoint.

Execute all instructions between the current
Run to cursor |. . " [F4]
instruction and cursor position.

Execute the current C (single or multi—cycle)
instruction, then halt. If the instruction is a routine

Step Into call, enter the routine and halt at the first instruc- [F71
tion following the call.
Execute the current C (single or multi-cycle)
instruction, then halt. If the instruction is a rou-

Step Over [F8]

tine call, skip it and halt at the first instruction
following the call.

Flush current PIC RAM. All variable values
Flush RAM will be changed according to values from N/A
watch window.

Disassembly Toggle between disassembly and C source

View view. [Alt+D]
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mikrolCD Debugger Examples

Here is a step by step mikrolCD Debugger Example.

Step No.1

First you have to write a program. We will show how mikrolCD works using this
example:

// LCD module connections
at RB4 bit;
at RB5 bit;
at RBO bit;
at RB1 bit;
at RB2 bit;
at RB3 bit;

sbit
sbit
sbit
sbit
sbit
sbit

sbit
sbit
sbit
sbit
sbit
sbit

LCD RS
LCD_EN
LCD_DA4
LCD_D5
LCD D6
LCD_D7

LCD RS _
LCD _EN
LCD D4
LCD D5
LCD D6
LCD D7 _

Direction
Direction
Direction
Direction
Direction
Direction

at
at
at
at
at
at

TRISB4 bit;
TRISB5 bit;
TRISBO bit;
TRISB1 bit;
TRISB2 bit;
TRISB3 bit;

// End LCD module connections

char text[ 17] = "mikroElektronika";

char

i;

void main (){

PORTB = 0;
TRISB = O0;
ANSEL = 0y
ANSELH = 0;
Led Init ()

Led Cmd ( LCD CLEAR) ;

Led Cmd (_LCD_CURSOR_OFF) ;

for(i = 1;

Lcd Chr (

i< 17;

it+)

{

1, i, text[1i-1]);
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Step No. 2

After successful compilation and PIC programming press F9 for starting mikrolCD.
After mikrolCD initialization blue active line should appear:

L g [F ol sEim) o Watch Values
j =h 2} [ [ =
e 20 TRISB = 0; 3 B Ba o0 o o0 ol | & [ iy
- ANSEL = 0; & add P Remove < Properties i Add All gl Remove All
° = 0; . .
AL g Select variable from list:
Texc b d
e Led Init(); Search far variable by assembly name:
° - Led Cmd (LCD_CLEAR) : _temt |'_.5|
° .
Lod Cwd (LCD_CURSOR_OFF) ; 7| Peripherals Fraeze
e sIE for(i = 1: i <« 17; i++] { Mame Value Address
e Led Chril, i, text[i-1]); PORTB 0 0x0006
@ =0 } TRISE 127 Ox0085
@ } AMSEL 255 Ox0165
AMSELH 63 0x0189
F o kext ook 0x0020
PC= 0x00004F Cycle= 0,00
Step No. 3

We will debug program line by line. Pressing F8 we are executing code line by line.
It is recommended that user does not use Step Into [F7] and Step Over [F8] over
Delays routines and routines containing delays. Instead use Run to cursor [F4] and
Breakpoints functions.

All changes are read from PIC and loaded into Watch Window. Note that PORTB,
TRISB, ANSEL and ANSELH changed its values. 255 to 0.

3 g [EoEc! sEim) § Watch Values
j Bl BB [+ =
B .. TRISB = D; Eh Bl Eh | o0 ®h oo ol | &8 [ u
= s ANSEL = 0; w Add ¥ Remove o Properties v Add Al Ll Remove All
@ =0 . )
ARk e Select variable from list:
text b d
4 Lod Init(); Search far vaniable by assembly name:
° - Led Cmd (LCD_CLEAR) : _temt |j!|
° .
Led Cwd (LCD CURSOR_OFF) ; 7| Peripherals Fraeze
e sIEH for(i = 1; i < 17; i++] | Mame Value Address
. Led Chr(l, i, text[i-1]); PORTE o 00006
@ a0 } TRISE 127 Ox0085
8 } AMSEL £55 Ox0188
AMSELH 63 0x0189
o kext {o} 0x0020
PC= 0:00004F Cycle=0.00
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Step No. 4

Step Into [F7] and Step Over [F8] are mikrolCD debugger functions that are used
in stepping mode. There is also Real-Time mode supported by mikrolCD. Functions
that are used in Real-Time mode are Run/ Pause Debugger [F6] and Run to cursor
[F4]. Pressing F4 goes to line selected by user. User just have to select line with
cursor and press F4, and code will be executed until selected line is reached.

e PORTE = 0O;

B -0 TRISE = 0;

e INSEL = 0O:

e ANSELH = 0O;

= z4 Led Init():

e - Lod Cmd (LCD CLEAR) ;

@ Led Cmd (LCD_CURSCOR_OFF)
e sIBH forii = 1; i < 17; i++) |
° Led Chr(l, i, text[i-1]):
B 50 }

" }

Step No. 5

*|BHroid main() {

Wiatch Yalues

=5 [ B [ 00 %6 a2 21 [ & [

% Add 3§ Remove <) Properties

Select variable from list:

text

Search far variable by assembly name:

_lest

| Peripherals Freeze

Mame Yalue Address
FORTE 123 0x000&
TRISB 64 0x0086
AMSEL o 0x0188
AMSELH 1) O0x0169

 bext . 0x0020

PC= 0000008 Cicle=0.00

™

v Add All Il Remove All

£

Run(Pause) Debugger [F6] and Toggle Breakpoints [F5] are mikrolCD debugger functions
that are used in Real-Time mode. Pressing F5 marks line selected by user for breakpoint.
F6 executes code until breakpoint is reached. After reaching breakpoint Debugger halts.
Here at our example we will use breakpoints for writing "mikroElektronika" on Lcd char by
char. Breakpoint is set on Lcd_Chr and program will stop everytime this function is reached.
After reaching breakpoint we must press F6 again for continuing program execution.

e o O o

*|BHvoid main(){

z0

PORTE = O:
TRISE = O;
ANSEL = 0O:

ANSELH = 0O:

Led Indc() !
Led Cmd(LCD CLEAR) :

forii = 1; i < 17; i++)

Wiatch Yalues

[ 2 B35 [ w0 & o0 0l | @ &

a Add 3 Remove <3 Properties

Select variable from list:

text

Search for variable by aszembly name:

_lest

| Peripherals Freeze

Mame VYalue Address
FORTE 129 0x0006
TRISE 64 0x0086
ANSEL o 0x0188
ANSELH [u] Ox0189

et E 0x0020

PC=0x0000DD Crycle=0.00

Iyl Add All fel Remove All

)
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Breakpoints has been separated into two groups. There are hardware and software
break points. Hardware breakpoints are placed in PIC and they provide fastest
debug. Number of hardware breakpoints is limited (1 for P16 and 1 or 3 for P18). If
all hardware brekpoints are used, next breakpoints that will be used are software
breakpoint. Those breakpoints are placed inside mikrolCD, and they simulate hard-
ware breakpoints. Software breakpoints are much slower than hardware break-
points. This differences between hardware and software differences are not visible
in mikrolCD software but their different timings are quite notable, so it is important
to know that there is two types of breakpoints.

. IR FR R R FER RN R

108 MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD
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mikrolCD (In-Circuit Debugger) Overview

Breakpoints Window

The Breakpoints window manages the list of currently set breakpoints in the project.
Doubleclicking the desired breakpoint will cause cursor to navigate to the correspon-

ding location in source code.

Breakpoints

B

Line
=]
54
55
64
75
76

File Mame

Ledc
Ledc
Ledc
Ledc
Ledc
Led.c

MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD 109



CHAPTER 3
mikrolCD mikroC PRO for PIC

Watch Window

Debugger Watch Window is the main Debugger window which allows you to moni-
tor program items while running your program. To show the Watch Window, select
View » Debug Windows » Watch Window from the drop-down menu.

The Watch Window displays variables and registers of PIC, with their addresses and
values. Values are updated as you go through the simulation. Use the drop-down
menu to add and remove the items that you want to monitor. Recently changed
items are colored red.

Yifatch Walues =
BBy | o0 os el | & [E

e Add M Remove <) Properties gl Add Al el Remove All

@:}

Select wariable from list:

AD'RESH -
Search for variable by azzembly name:

ADRESH !.a

Peripherals Freeze

Marne Yalue Address
CCP1CON 0 O0=0017
CYRCON 0 Oex0090
EEADR 55 0=0100
EECATA 255 D010
F5R, 0 O=0004
IMNTCON 0 O:x0008
PCL 150 O=0002
PCLATH 0 Oex00048
SSPCON 0 O=0014
SSPELUF 223 0013
THREG 0 O=0019
TMR2 0 0011
ADCOMND 0=0F 0=001F
ADCOML 0 O:x009F

PC= 0000005 Crecle=0.00
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Double clicking an item opens the Edit Value window in which you can assign a new
value to the selected variable/register. Also, you can change view to binary, hex,
char, or decimal for the selected item.

[H EditValue: £CD =R =N %2

0100 0000 1000 0011 0001 00100110 1111

Representation
Dec He:x @) Bin Float Char
Signed [ (o4 l [ Cancel

EEPROM Watch Window

mikrolCD EEPROM Watch Window is available from the drop-down menu, View >
Debug Windows > View EEPROM.

The EEPROM Watch window shows current values written into PIC internal
EEPROM memory. There are two action buttons concerning EEPROM Watch win-
dow - Write EEPROM and Read EEPROM. Write EEPROM writes data from
EEPROM Watch window into PIC internal EEPROM memory. Read EEPROM reads
data from PIC internal EEPROM memory and loads it up in EEPROM window.

EEPROM Wfatch (=]
Read EEPROM Write EEPROM
(i) | o1 | 0z | o3 | o4 | os | [ul:] I a7 I o3 I o9 | 04 | 0B | ac | oo | 0OE | oF I ASCIT | o

ool FF | FF | FF | FF | FF | FF | FF | FF | FF | FF | FF | FF | FF | FF | FF | FF
oo7o|l FF | FF | FF | FF | FF | FF | FF | FF | FF | FF | FF | FF | FF | FF | FF | FF
ooso| FF | FF | FF | FF | FF | FF | FF | FF | FF | FF | FF | FF | FF | FF | FF | FF

ooso|l FF | FF | FF | FF | FF | FF | FF | FF | FF | FF | FF | FF | FF | FF | FF | FF

wa0| FF | FF | FF | FF | FF | FF | FF | FF | FF | FF | FF | FF | FF | FF | FF | FF

ooeo| FF | FF | FF | FF | FF | FF | FF | FF | FF | FF | FF | FF | FF | FF | FF | FF

oocol FF | FF | FF | FF | FF | FF | FF | FF  FF | FF | FF | FF | FF | FF | FF | FF

oooco| FF | FF | FF | FF | FF | FF | FF | FF | FF | FF | FF | FF | FF | FF | FF | FF

ooEo| FF | FF | FF | FF | FF | FF | FF | FF | FF | FF | FF | FF | FF | FF | FF | FF

ooFo| FF | FF | FF | FF | FF | FF | FF | FF | FF | FF | FF | FF | FF | FF | FF | FF

o100 oo oa Lalu] [alu] [al] [ale) [ale) [al) [al) [als) oa Lalu] [alu] [al] [ale) L L

o110f oo oo Lala] oo oo oo oo oo oo oo oo Lala] oo oo oo OO e

oizof oo oo Lalu] ao ao ao a0 [al) [al) [als) oa Lalu] [alu] [uls] [al] [ A

o130 oo oa Lalu] [alu] [al] [ale) [ale) [al) [al) [als) oa Lalu] [alu] [al] [ale) L L

o140) 00 oo Lala] oo oo oo oo oo oo oo oo Lala] oo oo oo OO e

0150) 00 oo Lalu] [ulu] on on oo on on o0 oa [alu] an [uli] o0 O0 | e
010§ 00 oo Lalu] ao ao ao a0 [al) [al) [als) oa Lalu] [alu] [uls] [al] [ A

o170 oo oa Lalu] [alu] [al] [ale) [ale) [al) [al) [als) oa Lalu] [alu] [al] [ale) L L

010§ 00 oo Lalu] [ula] on on oo [uls) [uls) o0 oa Lalu] an [uli] [ali) O0 | vovvviin i, =
STATUS: Idle
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Code Watch Window

mikrolCD Code Watch Window is available from the drop-down menu, View >
Debug Windows > View Code.

The Code Watch window shows code (hex code) written into PIC. There is action
button concerning Code Watch window - Read Code. Read Code reads code from
PIC and loads it up in View Code Window.

Also, you can set an address scope in which hex code will be read.

CODE Watch =
Address Scope
000000 003FFF

oo | 01 | 0z | 03 | 04 | 05 | 06 | 07 | ASCII -
1EOD FF E03 1683 1703 E3 EE3 204 E4 . =ETH> <503 § <5
1EDS 204 ES 1554 1604 1653 1703 50E 1683 <lF > <B3= & . 5 <hat
1E10 1703 E7 1683 1703 B0F 1683 1703 E6 <ET» <ETBm g . F <2
1E18 1683 1703 1706 1388 1253 1703 1756 oo F <SfN> <ETH= <ETB
1EZ0 1FO5 ZEZ0 160G ZEzZ 1386 1683 1703 1786 <Ak US> <SPCs
1EZE 1683 1703 3018 ED 1253 1705 1FO5 ZEZE F <ZfN> <ETH= <ETB
1E30 1606 ZE30 1003 1BES 1403 1683 1703 DEA <Ak <ESCx 0. <E1
1E33 DEE DEC BED: ZE2C 301E Bh E&C 390F & <CR=1 <CR> i <¥Ts
1E40 3E44 1803 A58 g2 2E54 2EER 2ES4 2E8C D> <ETH> <CAN= 5 «
1E48 ZEAT 2ED3 ZEFS ZF1EB 2F51 2FER 2E28 ZEz8 5.0.8. <E5C=[ Q)
1ES0 2E28 2E28 2E28 2E28 1683 1703 1386 1683 o000 Famie <
1ES8 1703 867 EE 866 EC 3010 ED 301E <ET¥» <ETE> g <B3=
1EED 2] 3064 E3 2Faz 12583 1703 1356 1683 &.d0e&..)FDC2=
1EES 1703 1786 ZE28 1683 1703 1386 1683 1703 <ETi» <ETB> 1 <ETE
1E7D 3001 EA 30E3 EE a7F EC 3018 ED “530H=08. 808, <
1E7S 301E E9 3070 ES ZFE2 1283 1703 1386 <RS=0&.}0&.,[F
1E&D 1683 1703 1786 ZEZE 1353 1a6e 1783 66 £ <5¥M= <ETH= <ETB
1EBE 54 B64 50 ZEZE 1353 186 1783 1683 wi] <BIEE (L F<DC
1E50 1703 1386 154 1683 1703 500 EC 3005 <ETh= <ETE> T <DC3

1E9S ED 301E E9 309E E3 2FEZ Fadt ZE93 i <RS>0&.308&..) _
4w »

STATUS: Idle
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View RAM Memory

Debugger View RAM Window is available from the drop-down menu, View > Debug

Windows > View RAM.

The View RAM Window displays the map of PIC’'s RAM, with recently changed
items colored red.

RAnA
oo | 01 | 0z | 03 | 04 | s | i3] o7 | 05 | 09 | i} | 0B | oc | ao | 0E | oF | ASCIT
ooooy 0o oc 95 o oo oo 3F oo oo oo oo oo oo oo ] 22 e
E oo oo oo COF oo i a0 oo oo oo oo o a0 oo oo oF .
E oo oo 04 oo oo EO a0 oo o a4 81 oo 01 U] 20 oo
E i1 ] 25 0o 49 03 ao 40 04 ] 44 10 [in] in ao ag e
E an a4 20 Laln) 1z a0 oo 22 an 10 oo a1 a0 04 oo 48 o
E an [alx) oo 04 an [alx) 20 a0 o1 [alx) oo Laln) oz [alx) o1 oo e
E 4iZ 05 20 Laln) g 0z oo g g 14 o1 19 an 10 oo a0
E an 05 15 [=10) [l [alx) o1 g 10 o1 21 =123 26 50 oo oo e
E [uin] FF L] 0 [uin] 3F 7F FF FF o7 [al] Laln] [uin] Jal] [al] oo e
E oo oo FF oo oo oo oo oo 0z oo oo oo o7 oo oo oo e
E 50 o1 a4 oo 40 20 03 oo oo 04 oo 15 oo 41 20 oo e
E 05 oo o1 10 0z oo oo oo oo oo 04 40 0z 25 24 G2 e
E oo 22 o1 11 0] 70 11 55 54 oo 0z 10 oo &0 25 800
E oo oo o1 oo i oo 10 10 41 04 oo oo oo o1 40 84
E oo oo 04 20 50 20 oo a0 oo 40 40 54 21 14 a0 28
E [in] 03 15 60 0& ] o1 0g i 01 21 L] 26 =] ao ag e

Common Errors

B Trying to program PIC while mikrolCD is active.
Trying to debug Release build Type version of program.

B Trying to debug changed program code which hasn't been compiled and pro
grammed into PIC.
B Trying to select line that is empty for Run to cursor [F4] and Toggle Breakpoints
[F5] functions.

Trying to debug PIC with mikrolCD while Watch Dog Timer is enabled.
Trying to debug PIC with mikrolCD while Power Up Timer is enabled.

Trying to debug PIC with mikrolCD with pull-up resistors set to ON on RB6 and RB7.

[
|
W |t is not possible to force Code Protect while trying to debug PIC with mikrolCD.
[
[

For correct mikrolCD debugging do not use pull-ups.
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MIKROICD ADVANCED BREAKPOINTS

mikrolCD provides the possibility to use the Advanced Breakpoints. Advanced
Breakpoints can be used with PIC18 and PIC18FJ MCUs. To enable Advanced
Breakpoints set the Advanced Breakpoints checkbox inside Watch window:

Advanced Breakpoints
To configure Advanced Breakpoints, start mikrolCD [F9] and select View > Debug

Windows > Advanced Breakpoints option from the drop-down menu or use
[Ctri+Shift+A] shortcut.

[d advanced Breakpoints @
EBreakpoint #1 EBreakpoint #2 Breakpoint #3
Program Memory Break |:| Program Memory Break |:| Program Memary Break
Address 0z00 0oaa 0aoa
[CFile Register Break, File Register Break [ File Reqister Break.
3 Read Access Address @ Read Access 2) Read Access
non Wite Access ure 1 Write Access oon ‘Write Access
File Reqister Equal File Register Equal File R.eqgister Equal
0o Valug 9 an
Passcount 1 Passcount 2 1
Ernulator Features
Event Breakpoints Enable Stopwatch
Ereak on Stack CwverfUnderflow Halt on Start Condition (Ereakpoint 2)
EBreak on Watchdog Timer Halt on Stop Condition {Breakpoint 33
EBreak on SLEEP Reset Stopwatch on Run
o
[ [s]4 l [ Cancel l [ Apphy l

Note: When Advanced Breakpoints are enabled mikrolCD operates in Real-Time
mode, so it will support only the following set of commands: start Debugger [F9],
Run/Pause Debugger [F6] and stop Debugger [Ctrl+F2]. Once the Advanced
Breakpoint is reached, the Advanced Breakpoints feature can be disabled and
mikrolCD debugging can be continued with full set of commands. If needed,
Advanced Breakepoints can be re-enabled without restarting mikrolCD.

Note: Number of Advanced Breakpoints is equal to number of Hardware break-
points and it depends on used MCU.
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Program Memory Break

Program Memory Break is used to set the Advanced Breakpoint to the specific
address in program memory. Because of PIC pipelining mechanism program exe-
cution may stop one or two instructions after the address entered in the address
field. Value entered in the Address field must be in hex format.

Note: Program Memory Break can use the Passcount option. The program execu-
tion will stop when the specified program address is reached for the N-th time,
where N is the number entered in the passcount field. When some Advanced
Breakpoint stops the program execution, passcount counters for all Advanced
Breakpoints will be cleared.

Program Memory Break

Program Memory Break is used to set the Advanced Breakpoint to the specific
address in program memory. Because of PIC pipelining mechanism program exe-
cution may stop one or two instructions after the address entered in the Address
field. Value entered in the Address field must be in hex format.

Note: Program Memory Break can use the Passcount option. The program execu-
tion will stop when the specified program address is reached for the N-th time,
where N is the number entered in the passcount field. When some Advanced
Breakpoint stops the program execution, passcount counters for all Advanced
Breakpoints will be cleared.

File Register Break

File Register Break can be used to stop the code execution when read/write access
to the specific data memory location occurs. If read 2Access is selected, the File
Register Equal option can be used to set the matching value. The program execu-
tion will be stopped when the value read from the specified data memory location is
equal to the number written in the vaiue field. Values entered in the address and
value fields must be in hex format.

Note: File Register Break can also use the Passcount option in the same way as
Program Memory Break.
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Emulator Features
Event Breakpoints

B Break on Stack Overflow/Underflow: not implemented.

B Break on Watchdog Timer: not implemented.

B Break on SLEEP: break on SLEEP instruction. SLEEP instruction will not be
executed. If you choose to continue the mikrolCD debugging [F6] then the pro-
gram execution will start from the first instruction following the SLEEP instruction.

Stopwatch

Stopwatch uses Breakpoint#2 and Breakpoint#3 as a Start and Stop condi-
tions. To use the Stopwatch define these two Breakpoints and check the Enable
Stopwatch checkbox.

Stopwatch options:
Halt on Start Condition

B Halt on Start Condition (Breakpoint#2): when checked, the program execution
will stop on Breakpoint#2. Otherwise, Breakpoint#2 will be used only to
start the Stopwatch.

B Halt on Stop Condition (Breakpoint#3): when checked, the program execution
will stop on Breakpoint#3. Otherwise, Breakpoint#3 will be used only to
stop the Stopwatch.

B Reset Stopwatch on Run: when checked, the Stopwatch will be cleared before
continuing program execution and the next counting will start from zero. Other-
wise, the next counting will start from the previous Stopwatch value

116

MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD



CHAPTER Iy

mikroC PRO for PIC
Specifics

The following topics cover the specifics of mikroC PRO for PIC compiler:

- ANSI Standard Issues

- Predefined Globals and Constants
- Accessing Individual Bits

- Interrupts

- PIC Pointers

- Linker Directives

- Built-in Routines

- Code Optimization

- Memory Type Specifiers
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ANSI Standard Issues

Divergence from the ANSI C Standard
- Tentative declarations are not supported.
C Language Exstensions

mikroC PRO for PIC has additional set of keywords that do not belong to the ANSI
standard C language keywords:

- code
- data
- rx

- at

- shit
- bit

- sfr

Related topics: Keywords, PIC Specific
Predefined Globals and Constants

To facilitate programming of PIC compliant MCUs, the mikroC PRO for PIC imple-
ments a number of predefined globals and constants.

All PIC SFR registers and their bits are implicitly declared as global variables.
These identifiers have an external linkage, and are visible in the entire project.
When creating a project, the mikroC PRO for PIC will include an appropriate () file
from defs folder, containing declarations of available SFR registers and constants.

For a complete set of predefined globals and constants, look for “Defs” in the mikroC
PRO for PIC installation folder, or probe the Code Assistant for specific letters
(Ctri+Space in the Code Editor).
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Predefined project level defines

There are four predefined project level defines for any project you make. These
defines are based on values that you have entered/edited in the current project:

- First one is equal to the name of selected device for the project i.e. if 16F887 is
selected device, then 16F887 token will be defined as 1, so it can be used for
conditional compilation:

#ifdef P16F887
#endif

- The second one is _ FOSC__ value of frequency (in Khz) for which the project

is built.

- Third one is for identifying mikroC PRO for PIC compiler:
#ifdef _ MIKROC PRO FOR PIC

#endif
- Fourth one is for identifying the build version. For instance, if a desired build ver
sion is 142, user should put this in his code:
#if  MIKROC PRO FOR PIC BUILD == 142
#endif
User can define custom project level defines.

Accessing Individual Bits

The mikroC PRO for PIC allows you to access individual bits of 8-bit variables. It
also supports sbit and bit data types

Accessing Individual Bits Of Variables

If you are familiar with a particular MCU, you can access bits by name:

// Clear Global Interrupt Bit (GIE)
GIE bit = 0;

Also, you can simply use the direct member selector (.) with a variable, followed by
one of identifiers ko, B1, .. , B7, orro, r1, .. F7,with 77 being the most sig-
nificant bit:

// Clear bit 0 in INTCON register
INTCON.BO = 0;

// Set bit 5 in ADCONO register
ADCONO.F5 = 1;
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There is no need of any special declarations. This kind of selective access is an
intrinsic feature of mikroC PRO for PIC and can be used anywhere in the code. Iden-
tifiers B0-B7 are not case sensitive and have a specific namespace. You may over-
ride them with your own members 20-87 within any given structure.

See Predefined Globals and Constants for more information on register/bit names.

Note: If aiming at portability, avoid this style of accessing individual bits, use the bit
fields instead.

sbit type

The mikroC PRO for PIC compiler has sbit data type which provides access to bit-
addressable SFRs. You can access them in the following manner:

sbit LEDA at PORTA.BO;
sbit bit name at sfr-name.B<bit-position>;

sbit LEDB at PORTB.FO;
sbit bit name at sfr-name.F<bit-position>;

// If you are familiar with a particular MCU and its ports and direc-
tion registers (TRIS), you can access bits by their names:

sbit LEDC at RCO bit;

sbit bit name at R<port-letter><bit-position> bit;

sbit TRISCO at TRISCO bit;
sbit bit name at TRIS<port-letter><bit-position> bit;

bit type

The mikroC PRO for PIC compiler provides a bit data type that may be used for vari-
able declarations. It can not be used for argument lists, and function-return values.

bit bf; // bit variable
There are no pointers to bit variables:
bit—ptrr // invalid

An array of type bit is not valid:

bit—are L - // invalid
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Note:

- Bit variables can not be initialized.

- Bit variables can not be members of structures and unions.

- Bit variables do not have addresses, therefore unary operator & (address of) is not
applicable to these variables.

Related topics: Bit fields, Predefined globals and constants
Interrupts

Interrupts can be easily handled by means of reserved word interrupt. mikroC
PRO for PIC implictly declares function interrupt which cannot be redeclared. Its
prototype is:

void interrupt (void) ;

For P18 low priorty interrupts reserved word is interrupt low:
void interrupt low(void);

You are expected to write your own definition (function body) to handle interrupts in
your application.

mikroC PRO for PIC saves the following SFR on stack when entering interrupt and
pops them back upon return:

- PIC12 family: w, sTaTUsS, FSR, PCLATH
- PIC16 family: w, sTaTUs, FSR, PCLATH
- PIC18 family: rsr (fast context is used to save WREG, STATUS, BSR)

Use the #pragma disablecontexsaving to instruct the compiler not to automatical-
ly perform context-switching. This means that no regiser will be saved/restored by
the compiler on entrance/exit from interrupt service routine. This enables the user to
manually write code for saving registers upon entrance and to restore them before
exit from interrupt.
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P18 priority interrupts
Note: For the P18 family both low and high interrupts are supported.

1. function with name interrupt will be linked as ISR (interrupt service routine)
for high level interrupt

2. function with name interrupt low will be linked as ISR for low level inter
rupt_low

If interrupt priority feature is to be used then the user should set the appropriate SFR
bits to enable it. For more information refer to datasheet for specific device.

Function Calls from Interrupt

Calling functions from within the interrupt() routine is now possible. The compiler
takes care about the registers being used, both in "interrupt" and in "main" thread,
and performs "smart" context-switching between the two, saving only the registers
that have been used in both threads.Check functions reentrancy.

Interrupt Examples

Here is a simple example of handling the interrupts from TvrO (if no other interrupts
are allowed):

void interrupt() {
counter++;
T™RO = 96;
INTCON = $20;

}

In case of multiple interrupts enabled, you need to test which of the interrupts
occurred and then proceed with the appropriate code (interrupt handling):

void interrupt() {

if (INTCON.TMROIF) {
counter++;
TMRO = 96;
INTCON.TMROF = 0;

}

else if (INTCON.RBIF) {
counter++;
TMRO = 96;
INTCON.RBIF = O0;
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Linker Directives

The mikroC PRO uses an internal algorithm to distribute objects within memory. If
you need to have a variable or routine at specific predefined address, use the link-
er directives absolute and org.

Directive absolute

Directive absolute specifies the starting address in RAM for a variable. If the vari-
able is multi-byte, higher bytes will be stored at the consecutive locations.

Directive absolute is appended to declaration of a variable:

short x absolute 0x22;
// Variable x will occupy 1 byte at address 0x22

int y absolute 0x23;
// Variable y will occupy 2 bytes at addresses 0x23 and 0x24

Be careful when using the absolute directive, as you may overlap two variables by
accident. For example:

char i absolute 0x33;
// Variable i will occupy 1 byte at address 0x33

long jjjj absolute 0x30;

// Variable will occupy 4 bytes at 0x30, 0x31, 0x32, 0x33; thus,
// changing 1 changes jjjj highest byte at the same time, and vice versa

Directive org
Directive org specifies a starting address of a routine in ROM.

Directive org is appended to the function definition. Directives applied to non-defin-
ing declarations will be ignored, with an appropriate warning issued by the linker.

Here is a simple example:

void func (int par) org 0x200 {
// Function will start at address 0x200
asm nop;

}

It is possible to use org directive with functions that are defined externally (such as
library functions). Simply add org directive to function declaration:
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void UART Writel (char data) org 0x200;
Note: Directive org can be applied to any routine except for interrupt.
Directive orgall

If the user wants to place his routines, constants, etc, above a specified address in
ROM, #pragma orgall directive should be used:

#pragma orgall 0x200
Directive funcorg

You can use the #pragma funcorg directive to specify the starting address of a rou-
tine in ROM using routine name only:

#pragma funcorg <func name> <starting address>
Related topics: Indirect Function Calls
Indirect Function Calls
If the linker encounters an indirect function call (by a pointer to function), it assumes
that any of the functions addresses of which were taken anywhere in the program,
can be called at that point. Use the #pragma funcall directive to instruct the link-
er which functions can be called indirectly from the current function:
#pragma funcall <func name> <called func>[, <called func>,...]
A corresponding pragma must be placed in the source module where the function
func name is implemented. This module must also include declarations of all func-

tions listed in the called func list.

These functions will be linked if the function func name is called in the code no mat-
ter whether any of them was called or not.

Note: The #pragma funcall directive can help the linker to optimize function frame
allocation in the compiled stack.

Related topics: Linker Directives
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Built-in Routines

mikroC PRO for PIC compiler provides a set of useful built-in utility functions. Built-in functions do

not require any header files to be included; you can use them in any part of your project.

Built-in routines are implemented as “inline”; i.e. code is generated in the place of the call, so the
call doesn’t count against the nested call limit. The only exceptions are vdelay ms, Delay Cyc
and Get Fosc

Note: Lo, Hi, Higher and Highest functions are not implemented in compiler any more. If you

xHz which are actual C routines.

want to use these functions you must include built in.h into your project.

- Lo

- Hi

- Higher

- Highest

- Delay_us
- Delay_ms

- Vdelay_ms
- Delay_Cyc
- Clock_Khz
- Clock_Mhz
- Get_Fosc_kHz

Lo

Prototype [unsigned short Lo (long number);

Returns Returns the lowest 8 bits (byte) of number, bits 0..7.
Function returns the lowest byte of number. Function does not interpret bit pat-
terns of number — it merely returns 8 bits as found in register.

Description
This is an “inline” routine; code is generated in the place of the call, so the call
doesn’t count against the nested call limit.

Requires Arguments must be variable of scalar type (i.e. Arithmetic Types and Pointers).

E I d = 0x1AC30F4;

xample tmp = Lo(d); // Equals O0xF4
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Hi

Prototype unsigned short Hi (long number);

Returns Returns next to the lowest byte of number, bits 8..15.
Function returns next to the highest byte of number. Function does not interpret
bit patterns of number — it merely returns 8 bits as found in register.

Description
This is an “inline” routine; code is generated in the place of the call, so the call
doesn’t count against the nested call limit.

Requires Arguments must be variable of scalar type (i.e. Arithmetic Types and Pointers).

E I d = 0x1AC30F4;

Xxample tmp = Hi(d); // Equals 0x30

Higher

Prototype unsigned short Higher (long number) ;

Returns Returns next to the highest byte of number, bits 16..23.
Function returns the highest byte of number. Function does not interpret bit pat-
terns of number — it merely returns 8 bits as found in register.

Description
This is an “inline” routine; code is generated in the place of the call, so the call
doesn’t count against the nested call limit.

Requires Arguments must be variable of scalar type (i.e. Arithmetic Types and Pointers).

E I d = 0x1AC30F4;

Xxample tmp = Higher (d); // Equals 0xAC
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Highest

Prototype unsigned short Highest (long number) ;

Returns Returns the highest byte of number, bits 24..31.
Function returns next to the highest byte of number. Function does not interpret
bit patterns of number — it merely returns 8 bits as found in register.

Description
This is an “inline” routine; code is generated in the place of the call, so the call
doesn’t count against the nested call limit.

Requires Arguments must be variable of scalar type (i.e. Arithmetic Types and Pointers).

E I d = 0x1AC30F4;

xample tmp = Highest(d); // Equals 0x01

Delay_us

Prototype |void Delay us(const time in us);

Returns Nothing.
Creates a software delay in duration of time in us microseconds (a constant).
Range of applicable constants depends on the oscillator frequency.

Description |This is an “inline” routine; code is generated in the place of the call, so the call
doesn’t count against the nested call limit. This routine generates nested loops
using registers r13, RrR12, R11 and rR10. The number of used registers varies
from O to 4, depending on requested time in us.

Requires Nothing.

Example Delay us(10); /* Ten microseconds pause */
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Delay_ms

Prototype void Delay ms(const time in ms);

Returns Nothing.

Creates a software delay in duration of time in ms milliseconds (a constant).
Range of applicable constants depends on the oscillator frequency.

Description |This is an “inline” routine; code is generated in the place of the call, so the call
doesn’t count against the nested call limit. This routine generates nested loops
using registers k13, RrR12, RrR11 and r10. The number of used registers varies

from O to 4, depending on requested time in ms.

Requires Nothing.

Example Delay ms(1000); /* One second pause */

Vdelay_ms

Prototype void Vdelay ms (unsigned time in ms);

Returns Nothing.

Creates a software delay in duration of time in ms milliseconds (a variable).
Generated delay is not as precise as the delay created by Delay ms.
Description
Note that vdelay ms is library function rather than a built-in routine; it is pre-
sented in this topic for the sake of convenience.

Requires Nothing.

pause 1000;
Example //
Vdelay ms (pause); // ~ one second pause
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Delay_Cyc

Prototype void Delay Cyc(char Cycles div by 10);

Returns Nothing.

Creates a delay based on MCU clock. Delay lasts for 10 times the input param-
eter in MCU cycles.

Description Note that pe1ay cyc is library function rather than a built-in routine; it is pre-
sented in this topic for the sake of convenience. There are limitations for
Cycles_div_by 10 value. Value Cycles_div_by 10 must be between 3 and 255.

Requires Nothing.

Example Delay Cyc(10); /* Hundred MCU cycles pause */

Clock_Khz
Prototype [unsigned Clock Khz (void);

Returns Device clock in KHz, rounded to the nearest integer.

Function returns device clock in KHz, rounded to the nearest integer.

Description This is an “inline” routine; code is generated in the place of the call, so the call

doesn’t count against the nested call limit.

Requires Nothing.

Example clk = Clock Khz();
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Clock_Mhz

Prototype unsigned short Clock Mhz (void);

Returns Device clock in MHz, rounded to the nearest integer.

Function returns device clock in MHz, rounded to the nearest integer.

Description This is an “inline” routine; code is generated in the place of the call, so the call

doesn’t count against the nested call limit.

Requires Nothing.

Example clk = Clock Mhz();

Get_Fosc_kHz

Prototype unsigned long Get Fosc kHz (void) ;

Returns Device clock in KHz, rounded to the nearest integer.

Function returns device clock in KHz, rounded to the nearest integer.

Description Note that cet rosc kuz is library function rather than a built-in routine; it is pre-

sented in this topic for the sake of convenience.

Requires Nothing.

Example clk = Clock Khz();

Code Optimization

Optimizer has been added to extend the compiler usability, cut down the amount of code gener-
ated and speed-up its execution. The main features are:

Constant folding

All expressions that can be evaluated in the compile time (i.e. are constant) are being replaced
by their results. (3 + 5 -> 8);

Constant propagation
When a constant value is being assigned to a certain variable, the compiler recognizes this and

replaces the use of the variable by constant in the code that follows, as long as the value of a vari-
able remains unchanged.
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Copy propagation

The compiler recognizes that two variables have the same value and eliminates one
of them further in the code.

Value numbering

The compiler "recognizes" if two expressions yield the same result and can there-
fore eliminate the entire computation for one of them.

"Dead code" elimination

The code snippets that are not being used elsewhere in the programme do not affect
the final result of the application. They are automatically removed.

Stack allocation

Temporary registers ("Stacks") are being used more rationally, allowing VERY com-
plex expressions to be evaluated with a minimum stack consumption.

Local vars optimization

No local variables are being used if their result does not affect some of the global or
volatile variables.

Better code generation and local optimization

Code generation is more consistent and more attention is payed to implement spe-
cific solutions for the code "building bricks" that further reduce output code size.

Related topics: PIC specifics, mikroC PRO for PIC specifics, Memory type specifiers
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In order to get the most from your mikroC PRO for PIC compiler, you should be
familiar with certain aspects of PIC MCU. This knowledge is not essential, but it can
provide you a better understanding of PICs’ capabilities and limitations, and their
impact on the code writing.
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Types Efficiency

First of all, you should know that PIC’s ALU, which performs arithmetic operations,
is optimized for working with bytes. Although mikroC PRO for PIC is capable of han-
dling very complex data types, PIC may choke on them, especially if you are work-
ing on some of the older models. This can dramatically increase the time needed for
performing even simple operations. Universal advice is to use the smallest possible
type in every situation. It applies to all programming in general, and doubly so with
microcontrollers.

Get to know your tool. When it comes down to calculus, not all PIC MCUs are of
equal performance. For example, PIC16 family lacks hardware resources to multi-
ply two bytes, so it is compensated by a software algorithm. On the other hand,
PIC18 family has HW multiplier, and as a result, multiplication works considerably
faster.

Nested Calls Limitations

Nested call represents a function call within function body, either to itself (recursive
calls) or to another function. Recursive function calls are supported by mikroC PRO
for PIC but with limitations. Recursive function calls can't contain any function
parameters and local variables due to the PIC’s stack and memory limitations.

mikroC PRO for PIC limits the number of non-recursive nested calls to:

- 8 calls for PIC12 family,
- 8 calls for PIC16 family,
- 31 calls for PIC18 family.

Note that some of the built-in routines do not count against this limit, due to their
“inline” implementation.

Number of the allowed nested calls decreases by one if you use any of the follow-
ing operators in the code: = / <. It further decreases if you use interrupts in the
program. Number of decreases is specified by number of functions called from inter-
rupt. Check functions reentrancy.

If the allowed number of nested calls is exceeded, the compiler will report a stack
overflow error.
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PIC18FxxJxx Specifics
Shared Address SFRs

mikroC PRO for PIC does not provide auto setting of bit for acessing alternate reg-
ister. This is new feature added to pic18fxxjxx family and will be supported in future.
In several locations in the SFR bank, a single address is used to access two differ-
ent hardware registers. In these cases, a “legacy” register of the standard PIC18
SFR set (such as OSCCON, T1CON, etc.) shares its address with an alternate reg-
ister. These alternate registers are associated with enhanced configuration options
for peripherals, or with new device features not included in the standard PIC18 SFR
map. A complete list of shared register addresses and the registers associated with
them is provided in datasheet.

PIC16 Specifics
Breaking Through Pages

In applications targeted at PIC16, no single routine should exceed one page (2,000
instructions). If routine does not fit within one page, linker will report an error. When
confront with this problem, maybe you should rethink the design of your application
— try breaking the particular routine into several chunks, etc.

Limits of Indirect Approach Through FSR

Pointers with PIC16 are “near”: they carry only the lower 8 bits of the address. Com-
piler will automatically clear the 9th bit upon startup, so that pointers will refer to
banks 0 and 1. To access the objects in banks 2 or 3 via pointer, user should man-
ually set the IRP, and restore it to zero after the operation. The stated rules apply to
any indirect approach: arrays, structures and unions assignments, etc.

Note: It is very important to take care of the IRP properly, if you plan to follow this
approach. If you find this method to be inappropriate with too many variables, you
might consider upgrading to PIC18.

Note: If you have many variables in the code, try rearranging them with the linker
directive absolute. Variables that are approached only directly should be moved to
banks 3 and 4 for increased efficiency.

Related topics: mikroC PRO for PIC specifics
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MEMORY TYPE SPECIFIERS

The mikroC PRO for PIC supports usage of all memory areas. Each variable may be explicitly
assigned to a specific memory space by including a memory type specifier in the declaration, or
implicitly assigned.

The following memory type specifiers can be used:
- code
- data
- X

- sfr

Memory type specifiers can be included in variable declaration.

For example:

char data data buffer; // puts data buffer in data ram

const char code txt[] = "ENTER PARAMETER:"; // puts text in program memory
code

Description |The code memory type may be used for allocating constants in program memory.

// puts txt in program memory

Exan“ﬂe const char code txt[] = "ENTER PARAMETER:";

data

Description |This memory specifier is used when storing variable to the internal data SRAM.

Exambl // puts PORTG in data ram

xample sfr data unsigned short PORTG absolute 0x65;

rx

This memory specifier allows variable to be stored in the Rx space (Register file).
I Note: In most of the cases, there will be enough space left for the user variables in

Description ) . . .
the Rx space. However, since compiler uses Rx space for storing temporary vari-
ables, it might happen that user variables will be stored in the internal data SRAM,
when writing complex programs.
// puts y in Rx space

Example sfr char rx y;
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sfr

This memory specifier in combination with (rx, datz) allows user to access spe-
Description |cial function registers. It also instructs compiler to maintain same identifier in C and
assembly.

Example sfr rx char y;

Note: If none of the memory specifiers are used when declaring a variable, datz specifier will be
set as default by the compiler.

Related topics: Accessing individual bits, SFRs, Constants, Functions
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CHAPTER

mikroC PRO for PIC
Language Reference

The mikroC PRO for PIC Language Reference describes the syntax, semantics and
implementation of the mikroC PRO for PIC language.

The aim of this reference guide is to provide a more understandable description of
the mikroC PRO for PIC language to the user.
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LEXICAL ELEMENTS OVERVIEW

The following topics provide a formal definition of the mikroC PRO for PIC lexical
elements. They describe different categories of word-like units (tokens) recognized
by the mikroC PRO for PIC.

In the tokenizing phase of compilation, the source code file is parsed (that is, bro-
ken down) into tokens and whitespace. The tokens in the mikroC PRO for PIC are
derived from a series of operations performed on your programs by the compiler and
its built-in preprocessor.

WHITESPACE

Whitespace is a collective name given to spaces (blanks), horizontal and vertical
tabs, newline characters and comments. Whitespace can serve to indicate where
tokens start and end, but beyond this function, any surplus whitespace is discarded.
For example, two sequences

int i; float f;
and
int
i;
float £;

are lexically equivalent and parse identically to give six tokens:
int

i

float

f
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Whitespace in Strings

The ASCII characters representing whitespace can occur within string literals. In that
case they are protected from the normal parsing process (they remain as a part of
the string). For example,

char name[] = "mikro foo";

parses into seven tokens, including a single string literal token:

char
name
[
]

"mikro foo" /* just one token here! */

Line Splicing with Backslash (\)

A special case occurs if a line ends with a backslash (\). Both backslash and new
line character are discarded, allowing two physical lines of a text to be treated as
one unit. So, the following code

"mikroC PRO \

for PIC Compiler"

parses into "mikroC PRO for PIC Compiler". Referto String Constants for more
information.
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COMMENTS

Comments are pieces of a text used to annotate a program and technically are
another form of whitespace. Comments are for the programmer’s use only; they are
stripped from the source text before parsing. There are two ways to delineate com-
ments: the C method and the C++ method. Both are supported by mikroC PRO for
PIC.

You should also follow the guidelines on the use of whitespace and delimiters in
comments, discussed later in this topic to avoid other portability problems.

C comments

C comment is any sequence of characters placed after the symbol pair /*. The com-
ment terminates at the first occurance of the pair */ following the initial /*. The entire
sequence, including four comment-delimiter symbols, is replaced by one space after
macro expansion.

In the mikroC PRO for PIC,

int /* type */ i /* identifier */;

parses as:

int i;

Note that the mikroC PRO for PIC does not support a nonportable token pasting

strategy using /**/. For more information on token pasting, refer to the Preprocessor
Operators.

C++ comments

The mikroC PRO for PIC allows single-line comments using two adjacent slashes
(//). The comment can start in any position and extends until the next new line.

The following code

int i; // this is a comment

parses as:

int i;

int j;
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Nested comments

ANSI C doesn't allow nested comments. The attempt to nest a comment like this
/* int /* declaration */ i; */

fails, because the scope of the first /« ends at the first = /. This gives us

i; */

which would generate a syntax error.
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TOKENS

Token is the smallest element of a C program that compiler can recognize. The pars-
er separates tokens from the input stream by creating the longest token possible
using the input characters in a left—to-right scan.

The mikroC PRO for PIC recognizes the following kinds of tokens:

- keywords
- identifiers
- constants
- operators
- punctuators (also known as separators)

Token Extraction Example

Here is an example of token extraction. Take a look at the following example code
sequence:

inter = a+++b;

First, note that inter would be parsed as a single identifier, rather than as the key-
word int followed by the identifier er.

The programmer who has written the code might have intended to write inter =
a + (++b), but it wouldn’t work that way. The compiler would parse it into the
seven following tokens:

inter // variable identifier

= // assignment operator

a // variable identifier

++ // postincrement operator
+ // addition operator

b // variable identifier

; // statement terminator
Note that +++ parses as ++ (the longest token possible) followed by .

According to the operator precedence rules, our code sequence is actually:

inter (a++)+b;
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CONSTANTS
Constants or literals are tokens representing fixed numeric or character values.
The mikroC PRO for PIC supports:

- integer constants

- floating point constants

- character constants

- string constants (strings literals)
- enumeration constants

The data type of a constant is deduced by the compiler using such clues as a
numeric value and format used in the source code.

Integer Constants

Integer constants can be decimal (base 10), hexadecimal (base 16), binary (base
2), or octal (base 8). In the absence of any overriding suffixes, the data type of an
integer constant is derived from its value.

Long and Unsigned Suffixes

The suffix 1. (or |) attached to any constant forces that constant to be represented
as a long. Similarly, the suffix U (or u) forces a constant to be unsigned. Both 1. and
U suffixes can be used with the same constant in any order or case: u1, 1Tu, UL,
etc.

In the absence of any suffix (U, u, 1, or 1), a constant is assigned the “smallest” of
the following types that can accommodate its value: short, unsigned short,
int, unsigned int, long int, unsigned long int

Otherwise:

B If a constant has the U suffix, its data type will be the first of the following that
can accommodate its value: unsigned short, unsigned int, unsigned
long int.

B If a constant has the 1 suffix, its data type will be the first of the following that can
accommodate its value: 1ong int, unsigned long int.

B [f a constant has both 1. and U suffixes, (LU or UL), its data type will be unsigned
long int.
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Decimals

Decimal constants from -2147483648 to 4294967295 are allowed. Constants
exceeding these bounds will produce an “Out of range” error. Decimal constants
must not use an initial zero. An integer constant that has an initial zero is interpret-

ed as an octal constant. Thus,

int i = 10; /* decimal 10 */
int i = 010; /* decimal 8 */
int i = 0; /* decimal 0 =

octal 0 */

In the absence of any overriding suffixes, the data type of a decimal constant is
derived from its value, as shown below:

Value Assigned to Constant

Assumed Type

< -2147483648

Error: Out of range!

-2147483648 — -32769 long

-32768 —-129 int

-128 — 127 short

128 — 255 unsigned short
256 — 32767 int

32768 — 65535

unsigned int

65536 — 2147483647

long

2147483648 — 4294967295

unsigned long

> 4294967295

Error: Out of range!

Hexadecimal Constants

All constants starting with 0x (or 0x) are taken to be hexadecimal. In the absence
of any overriding suffixes, the data type of an hexadecimal constant is derived from
its value, according to the rules presented above. For example, 0xc367 will be treat-

ed as unsigned int.
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Binary Constants

All constants starting with 0b (or 0B) are taken to be binary. In the absence of any over-
riding suffixes, the data type of an binary constant is derived from its value, according
to the rules presented above. For example, ob11101 will be treated as short.

Octal Constants

All constants with an initial zero are taken to be octal. If an octal constant contains
the illegal digits 8 or 9, an error is reported. In the absence of any overriding suffix-
es, the data type of an octal constant is derived from its value, according to the rules
presented above. For example, 0777 will be treated as int.

Floating Point Constants
A floating-point constant consists of:

- Decimal integer

- Decimal point

- Decimal fraction

- e or E and a signed integer exponent (optional)
- Type suffix: £ or ¥ or 1 or 1. (optional)

Either decimal integer or decimal fraction (but not both) can be omitted. Either dec-
imal point or letter e (or £) with a signed integer exponent (but not both) can be omit-
ted. These rules allow conventional and scientific (exponent) notations.

Negative floating constants are taken as positive constants with an unary operator
minus (-) prefixed.

The mikroC PRO for PIC limits floating-point constants to the range
+1.17549435082 * 10-38 .. +6.80564774407 * 1038.

Here are some examples:

0. // = 0.0

-1.23 // = -1.23
23.45e6 // = 23.45 * 1076
2e-5 // = 2.0 * 10"-5
3E+10 // = 3.0 * 10710
.09E34 // = 0.09 * 10734

The mikroC PRO for PIC floating-point constants are of the type double. Note that
the mikroC PRO for PIC’s implementation of ANSI Standard considers f1ocat and
double (together with the 1ong double variant) to be the same type.
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Character Constants

A character constant is one or more characters enclosed in single quotes, such as
'A', '+', or '"\n'.Inthe mikroC PRO for PIC, single-character constants are
of the unsigned int type. Multi-character constants are referred to as string con-
stants or string literals. For more information refer to String Constants.

Escape Sequences

A backslash character (\) is used to introduce an escape sequence, which allows a
visual representation of certain nongraphic characters. One of the most common
escape constants is the newline character (\ n).

A backslash is used with octal or hexadecimal numbers to represent an ASCIl symbol
or control code corresponding to that value; for example, '\ x3r' for the question
mark. Any value within legal range for data type char (0 to 0xFF for the mikroC PRO
for PIC) can be used. Larger numbers will generate the compiler error “Out of range”.
For example, the octal number \ 777 is larger than the maximum value allowed (\ 377)
and will generate an error. The first nonoctal or nonhexadecimal character encountered
in an octal or hexadecimal escape sequence marks the end of the sequence.

Note: You must use the sequence \\ to represent an ASCII backslash, as used in
operating system paths.

The following table shows the available escape sequences:

Sequence Value Char Description
a 0x07 BEL Audible bell
b 0x08 BS Backspace
f 0x0C FF Formfeed
n 0x0A LF Newline (Linefeed)
r 0x0D CR Carriage Return
t 0x09 HT Tab (horizontal)
v 0x0B VT Vertical Tab
\ 0x5C Backslash
' 0x27 ‘ Single quote (Apostrophe)
" 0x22 " Double quote
2 O0x3F ? Question mark
o) any O = string of up to 3 octal digits
xH any H = string of hex digits
XH any H = string of hex digits
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Disambiguation

Some ambiguous situations might arise when using escape sequences.

Here is an example:

Led Out Cp("\x091.0 Intro");

This is intended to be interpreted as \x09 and "1.0 Tntro". However, the mikroC
PRO for PIC compiles it as the hexadecimal number \ x091 and literal string ".0
Intro". To avoid such problems, we could rewrite the code in the following way:
Led Out Cp("\x09™ "1.0 Intro");

For more information on the previous line, refer to String Constants.

Ambiguities might also arise if an octal escape sequence is followed by a nonoctal
digit. For example, the following constant:

H\ 118"

would be interpreted as a two-character constant made up of the characters \ 11 and
8, because 8 is not a legal octal digit.

String Constants

String constants, also known as string literals, are a special type of constants which
store fixed sequences of characters. A string literal is a sequence of any number of
characters surrounded by double quotes:

"This is a string."

The null string, or empty string, is written like "". Aliteral string is stored internally
as a given sequence of characters plus a final null character. A null string is stored

as a single null character.

The characters inside the double quotes can include escape sequences. This code,
for example:

"\ £\ "Name\ "\\\ tAddress\n\n"
prints like this:

"Name"\ Address
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The "Name" is preceded by two tabs; The Address is preceded by one tab. The line
is followed by two new lines. The \ " provides interior double quotes. The escape
character sequence \\ is translated into \ by the compiler.

Adjacent string literals separated only by whitespace are concatenated during the
parsing phase. For example:

"This is " "just"

" an example."

is equivalent to
"This is just an example."
Line Continuation with Backslash

You can also use the backslash (\) as a continuation character to extend a string
constant across line boundaries:

"This is really \
a one-line string."

Enumeration Constants

Enumeration constants are identifiers defined in enum type declarations. The identi-
fiers are usually chosen as mnemonics to contribute to legibility. Enumeration con-
stants are of int type. They can be used in any expression where integer constants
are valid.

For example:
enum weekdays { SUN = 0, MON, TUE, WED, THU, FRI, SAT };
The identifiers (enumerators) used must be unique within the scope of the enum dec-

laration. Negative initializers are allowed. See Enumerations for details about enum
declarations.
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Pointer Constants

A pointer or pointed-at object can be declared with the const modifier. Anything
declared as const cannot change its value. It is also illegal to create a pointer that
might violate a non-assignability of the constant object.

Consider the following examples:

int i; // 1 1is an 1int

int * pi; // pi is a pointer to int (uninitialized)
int * const cp = &i; // cp 1s a constant pointer to int

const int ci = 7; // ci 1s a constant int

const int * pci; // pci is a pointer to constant int
const int * const cpc = &ci; // cpc 1s a constant pointer to a

// constant int

The following assignments are legal:

i = ci; // Assign const-int to int
*cp = ci; // Assign const-int to
// object-pointed-at-by-a-const-pointer
++pci; // Increment a pointer-to-const
pci = cpc; // Assign a const-pointer—-to-a-const to a

// pointer-to-const

The following assignments are illegal:

ci = 0; // NO--cannot assign to a const-int
ci--; // NO--cannot change a const-int
*pci = 3; // NO--cannot assign to an object
// pointed at by pointer-to-const.
cp = &ci; // NO--cannot assign to a const-pointer,
// even 1f value would be unchanged.
cpct++; // NO--cannot change const-pointer
pi = pci; // NO--if this assignment were allowed,

// you would be able to assign to *pci
// (a const value) by assigning to *pi.

Similar rules are applayed to the volatile modifier. Note that both const and
volatile can appear as modifiers to the same identifier.
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Constant Expressions

A constant expressions can be evaluated during translation rather that runtime and
accordingly may be used in any place that a constant may be.

Constant expressions can consist only of the following:

- literals,

- enumeration constants,

- simple constants (no constant arrays or structures),
- sizeof operators.

Constant expressions cannot contain any of the following operators, unless the
operators are contained within the operand of a sizeof operator: assignment,
comma, decrement, function call, increment.

Each constant expression can evaluate to a constant that is in the range of repre-
sentable values for its type.

Constant expression can be used anywhere a constant is legal.
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KEYWORDS

Keywords are words reserved for special purposes and must not be used as normal
identifier names.

Beside standard C keywords, all relevant SFR are defined as global variables and
represent reserved words that cannot be redefined (for example: TvMr0, pcCL, etc).
Probe the Code Assistant for specific letters (Ctrl+Space in Editor) or refer to Pre-
defined Globals and Constants.

Here is an alphabetical listing of keywords in C:

- asm
- auto

- break

- case

- char

- const

- continue
- default
- do

- double

- else

- enum

- extern

- float

- for

- goto

- if

- int

- long

- register
- return

- short

- signed

- sizeof

- static

- struct

- switch

- typedef
- union

- unsigned
- void

- volatile
- while

Also, the mikroC PRO for PIC includes a number of predefined identifiers used in
libraries. You could replace them by your own definitions, if you want to develop your
own libraries. For more information, see mikroC PRO for PIC Libraries.
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IDENTIFIERS

Identifiers are arbitrary names of any length given to functions, variables, symbolic
constants, user-defined data types, and labels. All these program elements will be
referred to as objects throughout the help (don't get confused with the meaning of
object in object-oriented programming).

Identifiers can contain the letters a to z and A to Z, underscore character “_”, and
digits 0 to 9. The only restriction is that the first character must be a letter or an
underscore.

Case Sensitivity

The mikroC PRO for PIC identifiers aren't case sensitive by default, so that sum, sum,
and suM represent an equivalent identifier. Case sensitivity can be activated or sus-
pended in Output Settings window. Even if case sensitivity is turned off Keywords
remain case sensitive and they must be written in lower case.

Uniqueness and Scope

Although identifier names are arbitrary (according to the stated rules), if the same
name is used for more than one identifier within the same scope and sharing the
same name space then error arises. Duplicate names are legal for different name
spaces regardless of scope rules. For more information on scope, refer to Scope
and Visibility.

Identifier Examples

Here are some valid identifiers:

temperature V1
Pressure

no hit
dat2string
SUM3

_vtext

... and here are some invalid identifiers:

/temp // NO -- cannot begin with a numeral

higher // NO -- cannot contain special characters

int // NO -- cannot match reserved word

323.07.04 // NO -- cannot contain special characters (dot)
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PUNCTUATORS

The mikroC PRO for PIC punctuators (also known as separators) are:

- [ ] - Brackets

- () — Parentheses
-{} - Braces
-,—Comma

- ; — Semicolon
-:—Colon

- * — Asterisk

- = — Equal sign

- # — Pound sign

Most of these punctuators also function as operators.

Brackets

Brackets | ] indicate single and multidimensional array subscripts:

char ch, str[] = "mikro";

int mat[ 3][ 4] ; /* 3 x 4 matrix */

ch = str 3]; /* 4th element */

Parentheses

Parentheses ( ) are used to group expressions, isolate conditional expressions,

and indicate function calls and function parameters:

d=c¢c* (a + b); /* override normal precedence */

if (d == z) ++x; /* essential with conditional statement */
func () ; /* function call, no args */

void func2 (int n); /* function declaration with parameters */

Parentheses are recommended in macro definitions to avoid potential precedence
problems during an expansion:

#define CUBE (x) ((x) * (x) * (x))

For more information, refer to Operators Precedence And Associativity and Expres-
sions.
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Braces
Braces { } indicate the start and end of a compound statement:
if (d == z) {
++x;
func () ;

}

Closing brace serves as a terminator for the compound statement, so a semicolon
is not required after } , except in structure declarations. Sometimes, the semicolon
can be illegal, as in

if (statement)
R /* illegal semicolon! */
else

{ ... 17
For more information, refer to the Compound Statements.
Comma
Comma (, ) separates the elements of a function argument list:
void func(int n, float f, char ch);

Comma is also used as an operator in comma expressions. Mixing two uses of
comma is legal, but you must use parentheses to distinguish them. Note that (exp1,
exp2) evalutates both but is equal to the second:

func (i, 7J): /* call func with two args */
func ( (expl, exp2), (exp3, exp4, expb)); /* also calls func with two

args! */
Semicolon

Semicolon (;) is a statement terminator. Any legal C expression (including the empty
expression) followed by a semicolon is interpreted as a statement, known as an
expression statement. The expression is evaluated and its value is discarded. If the
expression statement has no side effects, the mikroC PRO for PIC might ignore it.

a + b; /* Evaluate a + b, but discard value */
++a; /* Side effect on a, but discard value of ++a */

; /* Empty expression, or a null statement */
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Semicolons are sometimes used to create an empty statement:
for (1 = 0; 1 < n; 1i++);

For more information, see the Statements.

Colon

Use colon (:) to indicate the labeled statement:

start: x = 0;

goéé.start;

Labels are discussed in the Labeled Statements.

Asterisk (Pointer Declaration)

Asterisk (*) in a variable declaration denotes the creation of a pointer to a type:
char *char ptr; /* a pointer to char is declared */

Pointers with multiple levels of indirection can be declared by indicating a pertinent
number of asterisks:

int **int ptr; /* a pointer to an array of integers */

double ***double ptr; /* a pointer to a matrix of doubles */

You can also use asterisk as an operator to either dereference a pointer or as mul-
tiplication operator:

*int ptr;
a=>Db * 3.14;

For more information, see the Pointers.

Equal Sign
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Equal sign (=) separates variable declarations from initialization lists:

int test[5] ={ 1, 2, 3, 4, 5 1};

int x = 5;
Equal sign is also used as an assignment operator in expressions:

int a, b, c¢;
a=>b + c;

For more information, see Assignment Operators.

Pound Sign (Preprocessor Directive)

Pound sign (#) indicates a preprocessor directive when it occurs as the first non-
whitespace character on a line. It signifies a compiler action, not necessarily asso-
ciated with a code generation. See the Preprocessor Directives for more informa-

tion.

# and #+ are also used as operators to perform token replacement and merging dur-
ing the preprocessor scanning phase. See the Preprocessor Operators.
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CONCEPTS

This section covers some basic concepts of language, essential for understanding
of how C programs work. First, we need to establish the following terms that will be
used throughout the help:

- Objects and Ivalues
- Scope and Visibility
- Name Spaces

- Duration

Objects

An object is a specific region of memory that can hold a fixed or variable value (or
set of values). This use of a term object is different from the same term, used in
object-oriented languages, which is more general. Our definiton of the word would
encompass functions, variables, symbolic constants, user-defined data types, and
labels.

Each value has an associated name and type (also known as a data type). The
name is used to access the object and can be a simple identifier or complex expres-
sion that uniquely refers the object.

Objects and Declarations

Declarations establish a necessary mapping between identifiers and objects. Each
declaration associates an identifier with a data type.

Associating identifiers with objects requires each identifier to have at least two attrib-
utes: storage class and type (sometimes referred to as data type). The mikroC PRO
for PIC compiler deduces these attributes from implicit or explicit declarations in the
source code. Usually, only the type is explicitly specified and the storage class spec-
ifier assumes the automatic value auto.

Generally speaking, an identifier cannot be legally used in a program before its dec-
laration point in the source code. Legal exceptions to this rule (known as forward ref-
erences) are labels, calls to undeclared functions, and struct or union tags.

The range of objects that can be declared includes:

- Variables

- Functions

- Types

- Arrays of other types

- Structure, union, and enumeration tags
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- Structure members

- Union members

- Enumeration constants
- Statement labels

- Preprocessor macros

The recursive nature of the declarator syntax allows complex declarators. You'll
probably want to use typedefs to improve legibility if constructing complex objects.

Lvalues

Lvalue is an object locator: an expression that designates an object. An example of
Ivalue expression is * p, where p is any expression evaluating to a non-null pointer.
A modifiable Ivalue is an identifier or expression that relates to an object that can be
accessed and legally changed in memory. A const pointer to a constant, for exam-
ple, is not a modifiable Ivalue. A pointer to a constant can be changed (but its deref-
erenced value cannot).

Historically, | stood for “left’, meaning that Ivalue could legally stand on the left (the
receiving end) of an assignment statement. Now only modifiable Ivalues can legal-
ly stand to the left of an assignment operator. For example, if a and b are noncon-
stant integer identifiers with properly allocated memory storage, they are both mod-
ifiable Ivalues, and assignments suchas 2 = 1andb = a2 + b are legal.

Rvalues
The expression 2 + bisnotlvalue: 2 + b = a isillegal because the expression

on the left is not related to an object. Such expressions are sometimes called rval-
ues (short for right values).
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Scope and Visibility
Scope

The scope of an identifier is a part of the program in which the identifier can be used
to access its object. There are different categories of scope: block (or local), func-
tion, function prototype, and file. These categories depend on how and where iden-
tifiers are declared.

B Block: The scope of an identifier with block (or local) scope starts at the declara
tion point and ends at the end of the block containing the declaration (such block
is known as the enclosing block). Parameter declarations with a function defini
tion also have block scope, limited to the scope of the function body.

B File: File scope identifiers, also known as globals, are declared outside of all
blocks; their scope is from the point of declaration to the end of the source file.

B Function: The only identifiers having function scope are statement labels. Label
names can be used with goto statements anywhere in the function in which the
label is declared. Labels are declared implicitly by writing 1zabel name: fol
lowed by a statement. Label names must be unique within a function.

B Function prototype: Identifiers declared within the list of parameter declarations
in a function prototype (not as a part of a function definition) have a function pro
totype scope. This scope ends at the end of the function prototype.

Visibility

The visibility of an identifier is a region of the program source code from which an
identifier’s associated object can be legally accessed.

Scope and visibility usually coincide, though there are circumstances under which
an object becomes temporarily hidden by the appearance of a duplicate identifier:
the object still exists but the original identifier cannot be used to access it until the
scope of the duplicate identifier ends.

Technically, visibility cannot exceed a scope, but a scope can exceed visibility. See
the following example:

void f (int 1) {
int j; // auto by default
J o= 3; // int 1 and j are in scope and visible

{ // nested block

double j; // j 1is local name in the nested block
J = 0.1; // 1 and double j are visible;
// int j = 3 in scope but hidden

}
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// double j out of scope
J o+= 1; // int j visible and = 4
}

// 1 and j are both out of scope
Name Spaces

Name space is a scope within which an identifier must be unique. The mikroC PRO
for PIC uses four distinct categories of identifiers:

1. goto label names - must be unique within the function in which they are
declared.

2. Structure, union, and enumeration tags - must be unique within the block in
which they are defined. Tags declared outside of any function must be unique.

3. Structure and union member names - must be unique within the structure or
union in which they are defined. There is no restriction on the type or offset of
members with the same member name in different structures.

4. Variables, typedefs, functions, and enumeration members - must be unique with
in the scope in which they are defined. Externally declared identifiers must be
unique among externally declared variables.

Duplicate names are legal for different name spaces regardless of the scope rules.

For example:
int blue = 73;

{ // open a block

enum colors { black, red, green, blue, violet, white } c;
/* enumerator blue = 3 now hides outer declaration of int blue */
struct colors { int i, J; }; // ILLEGAL: colors duplicate tag
double red = 2; // ILLEGAL: redefinition of red
}
blue = 37; // back in int blue scope
Duration

Duration, closely related to a storage class, defines a period during which the declared iden-
tifiers have real, physical objects allocated in memory. We also distinguish between com-
pile-time and run-time objects. Variables, for instance, unlike typedefs and types, have real
memory allocated during run time. There are two kinds of duration: static and local.
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Static Duration

Memory is allocated to objects with static duration as soon as execution is under-
way; this storage allocation lasts until the program terminates. Static duration
objects usually reside in fixed data segments allocated according to the memory
specifier in force. All globals have static duration. All functions, wherever defined,
are objects with static duration. Other variables can be given static duration by using
the explicit static or extern storage class specifiers.

In the mikroC PRO for PIC, static duration objects are not initialized to zero (or null)
in the absence of any explicit initializer.

Don’t mix static duration with file or global scope. An object can have static duration
and local scope — see the example below.

Local Duration

Local duration objects are also known as automatic objects. They are created on the
stack (or in a register) when an enclosing block or a function is entered. They are
deallocated when the program exits that block or function. Local duration objects
must be explicitly initialized; otherwise, their contents are unpredictable.

The storage class specifier auto can be used when declaring local duration variables, but
it is usually redundant, because auto is default for variables declared within a block.

An object with local duration also has local scope because it does not exist outside
of its enclosing block. On the other hand, a local scope object can have static dura-
tion. For example:

void f() {
/* local duration variable; init a upon every call to f */
int a = 1;
/* static duration variable; init b only upon first call to f */

static int b = 1;
/* checkpoint! */
at+;
b++;

t

void main () {
/* At checkpoint, we will have: */

£0); // a=1, b=1, after first call,

£0); // a=1, b=2, after second call,

£0); // a=1, b=3, after third call,
// etc

}
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TYPES

The mikroC PRO for PIC is a strictly typed language, which means that every object,
function, and expression must have a strictly defined type, known in the time of com-
pilation. Note that the mikroC PRO for PIC works exclusively with numeric types.

The type serves:

B to determine the correct memory allocation required initially.
W t{o interpret the bit patterns found in the object during subsequent access.
Hmin many type-checking situations, to ensure that illegal assignments are trapped.

The mikroC PRO for PIC supports many standard (predefined) and user-defined
data types, including signed and unsigned integers in various sizes, floating-point
numbers with various precisions, arrays, structures, and unions. In addition, point-
ers to most of these objects can be established and manipulated in memory.

The type determines how much memory is allocated to an object and how the pro-
gram will interpret the bit patterns found in the object’s storage allocation. A given
data type can be viewed as a set of values (often implementation-dependent) that
identifiers of that type can assume, together with a set of operations allowed with
these values. The compile-time operator sizeof allows you to determine the size
in bytes of any standard or user-defined type.

The mikroC PRO for PIC standard libraries and your own program and header files must
provide unambiguous identifiers (or expressions derived from them) and types so that the
mikroC PRO for PIC can consistently access, interpret, and (possibly) change the bit pat-
terns in memory corresponding to each active object in your program.

Type Categories
A common way to categorize types is to divide them into:

- fundamental
- derived

The fudamental types represent types that cannot be split up into smaller parts. They are
sometimes referred to as unstructured types. The fundamental types are void, char,
int, float, and double, together with short, long, signed, and unsigned vari-
ants of some of them. For more information on fundamental types, refer to the topic Fun-
damental Types.

The derived types are also known as structured types and they include pointers to
other types, arrays of other types, function types, structures, and unions. For more
information on derived types, refer to the topic Derived Types.
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Fundamental Types

The fudamental types represent types that cannot be divided into more basic ele-
ments, and are the model for representing elementary data on machine level. The
fudamental types are sometimes referred to as unstructured types, and are used as
elements in creating more complex derived or user-defined types.

The fundamental types include:

- Arithmetic Types
- Enumerations
- Void Type

Arithmetic Types

The arithmetic type specifiers are built up from the following keywords: void, char,
int, float and double, together with the prefixes short, long, signed and
unsigned. From these keywords you can build both integral and floating-point types.

Integral Types

The types char and int, together with their variants, are considered to be integral
data types. Variants are created by using one of the prefix modifiers short, 1ong,
signed and unsigned.

In the table below is an overview of the integral types — keywords in parentheses
can be (and often are) omitted.

The modifiers signed and unsigned can be applied to both char and int. In the
absence of the unsigned prefix, signed is automatically assumed for integral types.
The only exception is char, which is unsigned by default. The keywords signed
and unsigned, when used on their own, mean signed int and unsigned int,
respectively.

The modifiers short and 1ong can only be applied to int. The keywords short
and 1ong, used on their own, mean short int and long int, respectively.
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Type Size in Bytes Range
(unsigned) char 1 0..255
signed char 1 -128 .. 127
(signed) short (int) 1 -128 .. 127
unsigned short (int) 1 0..255
(signed) int 2 -32768 .. 32767
unsigned (int) 2 0 .. 65535
(signed) long (int) 4 -2147483648 .. 2147483647
unsigned long (int) 4 0 .. 4294967295

Floating-point Types

The types f10at and double, together with the 1ong double variant, are consid-
ered to be floating-point types. The mikroC PRO for PIC’s implementation of an
ANSI Standard considers all three to be the same type.

Floating point in the mikroC PRO for PIC is implemented using the Microchip AN575
32-bit format (IEEE 754 compliant).

An overview of the floating-point types is shown in the table below:

Type Size in Bytes Range

float 4 -1.5*1045 .. +3.4 * 1038

double 4 -1.5*1045 .. +3.4 * 1038
long double 4 -1.5*1045 .. +3.4 * 1038
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Enumerations

An enumeration data type is used for representing an abstract, discreet set of val-
ues with appropriate symbolic names.

Enumeration Declaration
Enumeration is declared like this:
enum tag {enumeration-list};

Here, tag is an optional name of the enumeration; enumeration-1ist is a comma-
delimited list of discreet values, enumerators (or enumeration constants). Each enu-
merator is assigned a fixed integral value. In the absence of explicit initializers, the
first enumerator is set to zero, and the value of each succeeding enumerator is set
to a value of its predecessor increased by one.

Variables of the enum type are declared the same as variables of any other type. For
example, the following declaration:

enum colors { black, red, green, blue, violet, white } c;

establishes a unique integral type, enum colors, variable c of this type, and set of
enumerators with constant integer values (black =0, red = 1, ...). In the mikroC PRO
for PIC, a variable of an enumerated type can be assigned any value of the type int
— no type checking beyond that is enforced. That is:

c = red; // OK
c = 1; // Also OK, means the same

With explicit integral initializers, you can set one or more enumerators to specific
values. The initializer can be any expression yielding a positive or negative integer
value (after possible integer promotions). Any subsequent names without initializers
will be increased by one. These values are usually unique, but duplicates are legal.

The order of constants can be explicitly re-arranged. For example:

enum colors { black, // value 0
red, // value 1
green, // value 2
blue=6, // value 6
violet, // value 7
white=4 }; // value 4
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Initializer expression can include previously declared enumerators. For example, in
the following declaration:

enum memory sizes { bit = 1, nibble = 4 * bit, byte = 2 * nibble,
kilobyte = 1024 * byte };

nibble would acquire the value 4, byte the value 8, and kilobyte the value 8192.
Anomous Enum Type

In our previous declaration, the identifier colors is an optional enumeration tag that
can be used in subsequent declarations of enumeration variables of the enum co1-
ors type:

enum colors bg, border; /* declare variables bg and border */

Like with struct and union declarations, you can omit the tag if no further variables
of this enum type are required:

/* Anonymous enum type: */
enum { black, red, green, blue, violet, white } color;

Enumeration Scope

Enumeration tags share the same name space as structure and union tags. Enu-
merators share the same name space as ordinary variable identifiers:

int blue = 73;

{ // open a block

enum colors { black, red, green, blue, violet, white } c;
/* enumerator blue = 3 now hides outer declaration of int blue */
struct colors { int i, j; }; // ILLEGAL: colors duplicate tag
double red = 2; // ILLEGAL: redefinition of red

t

blue = 37; // back in int blue scope
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Void Type

void is a special type indicating the absence of any value. There are no objects of
void; instead, void is used for deriving more complex types.

Void Functions

Use the void keyword as a function return type if the function does not return a
value.

void print temp (char temp) ({
Lcd Out Cp ("Temperature:");
Lcd Out Cp (temp) ;
Led_Chr _Cp(223); // degree character
Led Chr Cp('Ch);
}

Use void as a function heading if the function does not take any parameters. Alter-
natively, you can just write empty parentheses:

main (void) { // same as main ()
}

Generic Pointers

Pointers can be declared as void, which means that they can point to any type.
These pointers are sometimes called generic.
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Derived Types

The derived types are also known as structured types. They are used as elements
in creating more complex user-defined types.

The derived types include:

- arrays
- pointers

- structures
- unions

Arrays

Array is the simplest and most commonly used structured type. A variable of array
type is actually an array of objects of the same type. These objects represent ele-
ments of an array and are identified by their position in array. An array consists of a
contiguous region of storage exactly large enough to hold all of its elements.

Array Declaration

Array declaration is similar to variable declaration, with the brackets added after
identifer:

type array name[ constant-expression]

This declares an array named as array name and composed of elements of type. The
type can be any scalar type (except void), user-defined type, pointer, enumeration, or
another array. Result of constant-expression within the brackets determines a number
of elements in array. If an expression is given in an array declarator, it must evaluate to a
positive constant integer. The value is a number of elements in an array.

Each of the elements of an array is indexed from 0 to the number of elements minus
one. If a number of elements is n, elements of array can be approached as variables
array name[ 0] .. array name[ n-1] of type.

Here are a few examples of array declaration:

#define MAX = 50

int vector one[ 10] ; /* declares an array of 10 integers */
float vector two[ MAX] ; /* declares an array of 50 floats */
float vector three[ MAX - 20]; /* declares an array of 30 floats */
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Array Initialization

An array can be initialized in declaration by assigning it a comma-delimited
sequence of values within braces. When initializing an array in declaration, you can
omit the number of elements — it will be automatically determined according to the
number of elements assigned. For example:

/* Declare an array which holds number of days in each month: */
int days[ 12] = {31,28,31,30,31,30,31,31,30,31,30,31};

/* This declaration is identical to the previous one */
int days[] = {31,28,31,30,31,30,31,31,30,31,30,31};

If you specify both the length and starting values, the number of starting values must
not exceed the specified length. The opposite is possible, in this case the trailing
“excess” elements will be assigned to some encountered runtime values from mem-

ory.
In case of array of char, you can use a shorter string literal notation. For example:
/* The two declarations are identical: */

const char msgl[] = {'T', 'e', 's', 't', "\0'};

const char msg2[] = "Test";

For more information on string literals, refer to String Constants.

Arrays n Expressions

When the name of an array comes up in expression evaluation (except with opera-
tors ¢« and sizeof), it is implicitly converted to the pointer pointing to array’s first
element. See Arrays and Pointers for more information.

Multi-dimensional Arrays

An array is one-dimensional if it is of scalar type. One-dimensional arrays are some-
times referred to as vectors.

Multidimensional arrays are constructed by declaring arrays of array type. These
arrays are stored in memory in such way that the right most subscript changes
fastest, i.e. arrays are stored “in rows”. Here is a sample of 2-dimensional array:

float m[ 50][ 20] ; /* 2-dimensional array of size 50x20 */

A variable m is an array of 50 elements, which in turn are arrays of 20 floats each.
Thus, we have a matrix of 50x20 elements: the first elementis = 0][ 0], the last one
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ism 49][ 19]. The first element of the 5th row would be n[ 41[ 0] .

If you don't initialize the array in the declaration, you can omit the first dimension of
multi-dimensional array. In that case, array is located elsewhere, e.g. in another file.
This is a commonly used technique when passing arrays as function parameters:

int al 3][ 2] 4] ; /* 3-dimensional array of size 3x2x4 */
void func(int n[][2][4]) { /* we can omit first dimension */
n[ 21[ 1]1[ 3] ++; /* increment the last element*/

}
void main () {

func(a);

}

You can initialize a multi-dimensional array with an appropriate set of values within
braces. For example:

int a[ 3][ 2] = {{1,2}, (2,6}, {3,7}+}>
Pointers

Pointers are special objects for holding (or “pointing to”) memory addresses. In the
mikroC PRO for PIC, address of an object in memory can be obtained by means of
an unary operator «. To reach the pointed object, we use an indirection operator (~)
on a pointer.

A pointer of type “pointer to object of type” holds the address of (that is, points to)
an object of type. Since pointers are objects, you can have a pointer pointing to a
pointer (and so on). Other objects commonly pointed to include arrays, structures,
and unions.

A pointer to a function is best thought of as an address, usually in a code segment,
where that function’s executable code is stored; that is, the address to which control
is transferred when that function is called.

Although pointers contain numbers with most of the characteristics of unsigned inte-
gers, they have their own rules and restrictions for declarations, assignments, con-
versions, and arithmetic. The examples in the next few sections illustrate these rules
and restrictions.
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Pointer Declarations

Pointers are declared the same as any other variable, but with ~ ahead of identifier.
A type at the beginning of declaration specifies the type of a pointed object. A point-
er must be declared as pointing to some particular type, even if that type is void,
which really means a pointer to anything. Pointers to void are often called generic
pointers, and are treated as pointers to char in the mikroC PRO for PIC.

If type is any predefined or user-defined type, including void, the declaration
type *p; /* Uninitialized pointer */

declares p to be of type “pointer to type”. All scoping, duration, and visibility rules
are applied to the p object just declared. You can view the declaration in this way: if
*p is an object of type, then p has to be a pointer to such object (object of type).

Note: You must initialize pointers before using them! Our previously declared point-
er “p is not initialized (i.e. assigned a value), so it cannot be used yet.

Note: In case of multiple pointer declarations, each identifier requires an indirect
operator. For example:

int *pa, *pb, *pc;
/* 1is same as: */

int *pa;
int *pb;
int *pc;

Once declared, though, a pointer can usually be reassigned so that it points to an
object of another type. The mikroC PRO for PIC lets you reassign pointers without
typecasting, but the compiler will warn you unless the pointer was originally declared
to be pointing to void. You can assign the void* pointer to the non-void” pointer —
refer to void for details.
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Null Pointers

A null pointer value is an address that is guaranteed to be different from any valid
pointer in use in a program. Assigning the integer constant 0 to a pointer assigns a
null pointer value to it.

For example:
int *pn = 0; /* Here's one null pointer */

/* We can test the pointer like this: */
if ( pn == y { ...}

The pointer type “pointer to void” must not be confused with the null pointer. The
declaration

void *vp;

declares that vp is a generic pointer capable of being assigned to by any “pointer to
type” value, including null, without complaint.

Assignments without proper casting between a “pointer to type1” and a “pointer to
type2”, where typel and type2 are different types, can invoke a compiler warning
or error. If typel is a function and type2 isn’'t (or vice versa), pointer assignments
are illegal. If type1 is a pointer to void, no cast is needed. If type2 is a pointer to
void, no cast is needed.

Function Pointers

Function Pointers are pointers, i.e. variables, which point to the address of a func-
tion.

// Define a function pointer

int (*pt2Function) (float, char, char);

Note: Thus functions and function pointers with different calling convention (argu-
ment order, arguments type or return type is different) are incompatible with each
other.
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Assign an address to a Function Pointer

It's quite easy to assign the address of a function to a function pointer. Simply take
the name of a suitable and known function. Using the address operator & infront of
the function's name is optional.

//Assign an address to the function pointer

int Dolt (float a, char b, char c¢){ return atb+c; }
pt2Function = &DoIt; // assignment

Example:

int addC (char x,char vy)({
return x+y;

}
int subC (char x,char vy)({

return x-y;

}

int mulC (char x,char vy)({
return x*vy;

}

int divC (char x,char vy)({

return x/y;

}
int modC (char x,char vy)({

return x%y;

}

//array of pointer to functions that receive two chars and returns

int

int (*arrpf[]) (char,char) = { addC ,subC,mulC,divC,modC} ;
int res;

char i;

void main () {

for (i=0;i<5;i++){
res = arrpf[ i] (10,20);
}
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Pointer Arithmetic

Pointer arithmetic in the mikroC PRO for PIC is limited to:

- assigning one pointer to another,

- comparing two pointers,

- comparing pointer to zero,

- adding/subtracting pointer and an integer value,

- subtracting two pointers.

The internal arithmetic performed on pointers depends on the memory specifier in

force and the presence of any overriding pointer modifiers. When performing arith-
metic with pointers, it is assumed that the pointer points to an array of objects.

Arrays and pointers

Arrays and pointers are not completely independent types in the mikroC PRO for
PIC. When the name of an array comes up in expression evaluation (except with
operators ¢ and sizeof), it is implicitly converted to the pointer pointing to array’s
first element. Due to this fact, arrays are not modifiable Ivalues.

Brackets | ] indicate array subscripts. The expression

idl exp]

is defined as

*((id) + (exp))

where either:

- id is a pointer and exp is an integer, or

- id is an integer and exp is a pointer.

The following statements are true:

&al i] = a + i
al 1] = *(a + 1)

According to these guidelines, it can be written:

pa = &a[ 4] ; // pa points to al 4]
x = *(pa + 3); // x = al 7]

/* .. but: */

y = *pa + 3; // y = a4 + 3
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Also the care should be taken when using operator precedence:

*pat+; // Equal to * (pa++), increments the pointer
(*pa) ++; // Increments the pointed object!
p IS J

The following examples are also valid, but better avoid this syntax as it can make
the code really illegible:

(a + 1)[ 1] = 3;
*((a + 1) + 1)

// same as: =3, i.e. a[1 + 1] = 3
(1 + 2)[a]l] = 0O;
// same as: *((i + 2) + a) =0, 1.e. a[i1 + 2] =0

Assignment and Comparison

The simple assignment operator (=) can be used to assign value of one pointer to
another if they are of the same type. If they are of different types, you must use a
typecast operator. Explicit type conversion is not necessary if one of the pointers is
generic (of the void type).

Assigning the integer constant 0 to a pointer assigns a null pointer value to it.

Two pointers pointing to the same array may be compared by using relational oper-
ators ==, '=, <, <=, >, and >=. Results of these operations are the same as if
they were used on subscript values of array elements in question:

int *pa = &al 4], *pb = &a[ 2] ;

if (pa == pb) {... /* won't be executed as 4 is not equal to 2 */ )

if (pa > pb) {... /* will be executed as 4 is greater than 2 */ }

You can also compare pointers to zero value — testing in that way if the pointer actu-
ally points to anything. All pointers can be successfuly tested for equality or inequal-

ity to null:
if (pa == 0) { .}
if (pb != 0) { ...}

Note: Comparing pointers pointing to different objects/arrays can be performed at
programmer’s own responsibility — a precise overview of data’s physical storage is
required.
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Pointer Addition

You can use operators +, ++, and += to add an integral value to a pointer. The
result of addition is defined only if the pointer points to an element of an array and
if the result is a pointer pointing to the same array (or one element beyond it).

If a pointer is declared to point to type, adding an integral value n to the pointer
increments the pointer value by n * sizeof (type) as long as the pointer remains
within the legal range (first element to one beyond the last element). If - ype has a
size of 10 bytes, then adding 5 to a pointer to +ype advances the pointer 50 bytes
in memory. In case of the type type, the size of a step is one byte.

For example:

int af 10] ; /* array a containing 10 elements of type int */
int *pa = &a[ 0] ; /* pa is pointer to int, pointing to a[ 0] */
*(pa + 3) = 6; /* pa+3 1s a pointer pointing to a[ 3], so al 3]
now equals 6 */

pat+; /* pa now points to the next element of array a:

a[ 1] */

There is no such element as “one past the last element”, of course, but the pointer
is allowed to assume such value. C “guarantees” that the result of addition is defined
even when pointing to one element past array. If P points to the last array element,
P + 1lislegal, butr + 2 is undefined.

This allows you to write loops which access the array elements in a sequence by
means of incrementing pointer — in the last iteration you will have the pointer point-
ing to one element past the array, which is legal. However, applying an indirection
operator (*) to a “pointer to one past the last element” leads to undefined behavior.

For example:

void f (some type al], int n) {
/* function f handles elements of array a; */
/* array a has n elements of type some type */
int 1i;
some type *p=é&a[ 0] ;

for (1 = 0; 1 < n; i++ ) {
/* .. here we do something with *p .. */
pt+; /* . and with the last iteration p exceeds

the last element of array a */

/* at this point, *p is undefined! */

MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD

181



CHAPTER 6
Language Reference mikroC PRO for PIC

Pointer Subtraction

Similar to addition, you can use operators -, -- , and -= to subtract an integral
value from a pointer.

Also, you may subtract two pointers. The difference will be equal to the distance
between two pointed addresses, in bytes.

For example:

int af 10] ;

int *pil = &a[ 0] ;

int *pi2 = &al 4] ;

i = pi2 - pil; /* 1 equals 8 */

pi2 -= (i >> 1); /* pi2 pi2 - 4: pi2 now points to [ 0] */
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Structures

A structure is a derived type usually representing a user-defined collection of named
members (or components). These members can be of any type, either fundamental
or derived (with some restrictions to be discussed later), in any sequence. In addi-
tion, a structure member can be a bit field.

Unlike arrays, structures are considered to be single objects. The mikroC PRO for
PIC structure type lets you handle complex data structures almost as easily as sin-
gle variables.

Note: the mikroC PRO for PIC does not support anonymous structures (ANSI diver-
gence).

Structure Declaration and Initialization
Structures are declared using the keyword st ruct::
struct tag {member-declarator-1ist};

Here, tag is the name of a structure; member-declarator-1ist is a list of structure
members, actually a list of variable declarations. Variables of structured type are
declared the same as variables of any other type.

The member type cannot be the same as the struct type being currently declared.
However, a member can be a pointer to the structure being declared, as in the fol-
lowing example:

struct mystruct {mystruct s;}; /* illegal! */
struct mystruct {mystruct *ps;}; /* OK */

Also, a structure can contain previously defined structure types when declaring an
instance of declared structure. Here is an example:

/* Structure defining a dot: */
struct Dot { float x, vy;};

/* Structure defining a circle: */
struct Circle {
float r;
struct Dot center;
} ol, o02;
/* declare variables ol and o2 of Circle */
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Note that the structure tag can be omitted, but then additional objects of this type cannot be
declared elsewhere. For more information, see the Untagged Structures below.

Structure is initialized by assigning it a comma-delimited sequence of values within
braces, similar to array. For example:

/* Referring to declarations from the example above: */

/* Declare and initialize dots p and q: */
struct Dot p ={1., 1.}, g = {3.7, -0.5};

/* Declare and initialize circle ol: */
struct Circle ol = {1., {0., 0.}}; // radius is 1, center is at (0, 0)

Incomplete Declarations

Incomplete declarations are also known as forward declarations. A pointer to a
structure type 2 can legally appear in the declaration of another structure = before
2 has been declared:

struct A; // incomplete
struct B { struct A *pa;};
struct A { struct B *pb;};

The first appearance of 2 is called incomplete because there is no definition for it at
that point. An incomplete declaration is allowed here, because the definition of B
doesn’t need the size of x.

Untagged Structures and Typedefs

If the structure tag is omitted, an untagged structure is created. The untagged
structures can be used to declare the identifiers in the comma-delimited member-
declarator-list to be of the given structure type (or derived from it), but addition-
al objects of this type cannot be declared elsewhere.

It is possible to create a typedef while declaring a structure, with or without tag:

/* With tag: */
typedef struct mystruct { ... } Mystruct;
Mystruct s, *ps, arrs[ 10] ; /* same as struct mystruct s, etc. */

/* Without tag: */
typedef struct { ... } Mystruct;

Mystruct s, *ps, arrs[ 10] ;

Usually, there is no need to use both tzg and typedet: either can be used in struc-
ture type declarations.
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Untagged structure and union members are ignored during initialization.
Note: See also Working with structures.

WORKING WITH STRUCTURES

Structures represent user-defined types. A set of rules regarding the application of
structures is strictly defined.

Assignment

Variables of the same structured type may be assigned one to another by means of
simple assignment operator (=). This will copy the entire contents of the variable to
destination, regardless of the inner complexity of a given structure.

Note that two variables are of the same structured type only if they are both defined
by the same instruction or using the same type identifier. For example:

/* a and b are of the same type: */
struct {int ml, m2;} a, b;

/* But ¢ and d are not of the same type although
_ _ yp g
their structure descriptions are identical: */

struct {int ml, m2;} c;
struct {int ml, m2;} d;

Size of Structure
The size of the structure in memory can be retrieved by means of the operator

sizeof. It is not necessary that the size of the structure is equal to the sum of its
members’ sizes. It is often greater due to certain limitations of memory storage.

Structures and Functions

A function can return a structure type or a pointer to a structure type:

mystruct funcl (void) ; /* funcl () returns a structure */

mystruct *func2 (void) ; /* func2() returns pointer to structure */

A structure can be passed as an argument to a function in the following ways:

void funcl (mystruct s;); /* directly */
void func2 (mystruct *sptr;); /* via a pointer */
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Structure Member Access

Structure and union members are accessed using the following two selection oper-
ators:

- . (period)
- —> (right arrow)

The operator . is called the direct member selector and it is used to directly access
one of the structure’s members. Suppose that the object s is of the struct type s and
m is @ member identifier of the type M declared in s, then the expression

s.m // direct access to member m
is of the type 1, and represents the member object m in s.

The operator -> is called the indirect (or pointer) member selector. Suppose that the
object s is of the struct type s and ps is a pointer to s. Then if m is a member iden-
tifier of the type ~ declared in s, the expression

ps->m // indirect access to member m;

// identical to (*ps).m

is of the type 1, and represents the member object m in s. The expression ps->m is
a convenient shorthand for (ps) .m

For example:

struct mystruct {
int 1i;
char str[ 21] ;
double d;

} s, *sptr = &s;

s.i = 3; // assign to the 1 member of mystruct s
sptr => d = 1.23; // assign to the d member of mystruct s

The expression s.m is Ivalue, providing that s is Ivalue and m is not an array type.
The expression sptr->m is an lvalue unless m is an array type.
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Accessing Nested Structures

If the structure & contains a field whose type is the structure 2, the members of 2 can
be accessed by two applications of the member selectors:

struct A {
int j; double x;
b

struct B {
int i; struct A aa; double d;
} s, *sptr;
s.i = 3; // assign 3 to the 1 member of B
s.aa.j = 2 // assign 2 to the j member of A

sptr->d = 1.23; // assign 1.23 to the d member of B
sptr->aa.x = 3.14; // assign 3.14 to x member of A

Structure Uniqueness

Each structure declaration introduces a unique structure type, so that in

struct A {
int i,j; double d;
} aa, aaa;

struct B {
int i,j; double d;
} bb;

the objects =2 and za2a are both of the type struct 2, but the objects 22 and vt are
of different structure types. Structures can be assigned only if the source and desti-
nation have the same type:

aa = aaa; /* OK: same type, member by member assignment */
aa = bb; /* ILLEGAL: different types */

/* but you can assign member by member: */
aa.i = bb.i;
aa.j = bb.j;
aa.d = bb.d;
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Unions

Union types are derived types sharing many of syntactic and functional features of
structure types. The key difference is that a union members share the same mem-
ory space.

Note: The mikroC PRO for PIC does not support anonymous unions (ANSI diver-
gence).

Unions Declaration

Unions have the same declaration as structures, with the keyword union used
instead of struct

union tag { member-declarator-list };

Unlike structures’ members, the value of only one of union’s members can be stored
at any time. Here is a simple example:

union myunion { // union tag is 'myunion'
int 1i;
double d;
char ch;

} mu, *pm;

The identifier mu, of the type myunion, can be used to hold a 2-byte int, 4-byte dou-
ble or single-byte char, but only one of them at a certain moment. The identifier pm
is a pointer to union myunion.

Size of Union

The size of a union is the size of its largest member. In our previous example, both
sizeof (union myunion) and sizeof (mu) return 4, but 2 bytes are unused
(padded) when mu holds the int object, and 3 bytes are unused when mu holds
char.

Union Member Access

Union members can be accessed with the structure member selectors (. and ->), be
careful when doing this:

/* Referring to declarations from the example above: */
pm = &mu;

mu.d = 4.016;

tmp = mu.d; // OK: mu.d = 4.016
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tmp = mu.i; // peculiar result

pm->1 = 3;
tmp = mu.i; // OK: mu.i = 3

The third line is legal, since mu.. i is an integral type. However, the bit pattern in mu . 1
corresponds to parts of the previously assigned double. As such, it probably won’t
provide an useful integer interpretation.

When properly converted, a pointer to a union points to each of its members, and
vice versa.

Bit Fields

Bit fields are specified numbers of bits that may or may not have an associated iden-
tifier. Bit fields offer a way of subdividing structures into named parts of user-defined
sizes.

Structures and unions can contain bit fields that can be up to 16 bits.
You cannot take the address of a bit field.

Note: If you need to handle specific bits of 8-bit variables (char and unsigned
short) or registers, you don’t need to declare bit fields. Much more elegant solution
is to use the mikroC PRO for PIC’s intrinsic ability for individual bit access — see
Accessing Individual Bits for more information.

Bit Fields Declaration

Bit fields can be declared only in structures and unions. Declare a structure normal-
ly and assign individual fields like this (fields need to be unsigned):

struct tag {
unsigned bitfield-declarator-list;

}

Here, tag is an optional name of the structure; bitfield-declarator-list is a
list of bit fields. Each component identifer requires a colon and its width in bits to be
explicitly specified. Total width of all components cannot exceed two bytes (16 bits).

As an object, bit fields structure takes two bytes. Individual fields are packed within
two bytes from right to left. In bitfield-declarator-1ist, you can omit identifi-
er(s) to create an artificial “padding”, thus skipping irrelevant bits.
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For example, if there is a need to manipulate only bits 2—4 of a register as one block,
create a structure like this:

struct {
unsigned : 2, // Skip bits 0 and 1, no identifier here
mybits : 3; // Relevant bits 2, 3 and 4
// Bits 5, 6 and 7 are implicitly left out

} myreg;
Here is an example:

typedef struct {
lo nibble 4;
hi nibble : 4;
high byte 8;} myunsigned;
which declares the structured type myunsigned containing three components:
1o nibble (bits 3..0), hi nibble (bits 7..4) and high byte (bits 15..8).

Bit Fields Access

Bit fields can be accessed in the same way as the structure members. Use direct
and indirect member selector (. and —>). For example, we could work with our pre-
viously declared myunsigned like this:

// This example writes low byte of bit field of myunsigned type to
PORTO :
myunsigned Value For PORTO;

void main () {

Value For PORTO.lo nibble = 7;
Value For PORTO0.hi nibble = 0x0C;
PO = * (char *) (void *)&Value For PORTO;
// typecasting
// 1. address of structure to pointer to void
// 2. pointer to void to pointer to char
// 3. dereferencing to obtain the value
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Type Conversions

The mikroC PRO for PIC is a strictly typed language, with each operator, statement
and function demanding appropriately typed operands/arguments. However, we
often have to use objects of “mismatching” types in expressions. In that case, type
conversion is needed.

Conversion of object of one type means that object's type is changed into another
type. The mikroC PRO for PIC defines a set of standard conversions for built-in
types, provided by compiler when necessary. For more information, refer to the
Standard Conversions.

Conversion is required in the following situations:

- if a statement requires an expression of particular type (according to language def-
inition), and we use an expression of different type,

- if an operator requires an operand of particular type, and we use an operand of dif-
ferent type,

- if a function requires a formal parameter of particular type, and we pass it an object
of different type,

- if an expression following the keyword return does not match the declared func-
tion return type,

- if intializing an object (in declaration) with an object of different type.

In these situations, compiler will provide an automatic implicit conversion of types, without
any programmer's interference. Also, the programmer can demand conversion explicitly by
means of the fypecast operator. For more information, refer to the Explicit Typecasting.

Standard Conversions

When using arithmetic expression, such as = + b, where 2 and b are of different
arithmetic types, the mikroC PRO for PIC performs implicit type conversions before
the expression is evaluated. These standard conversions include promotions of
“lower” types to “higher” types in the interests of accuracy and consistency.

Assigning a signed character object (such as a variable) to an integral object results
in automatic sign extension. Objects of type signed char always use sign extension;
objects of type unsigned char always has its high byte set to zero when converted
to int.

Converting a longer integral type to a shorter type truncates the higher order bits
and leaves low-order bits unchanged. Converting a shorter integral type to a longer
type either sign-extends or zero-fills the extra bits of the new value, depending on
whether the shorter type is signed or unsigned, respectively.
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Note: Conversion of floating point data into integral value (in assignments or via
explicit typecast) produces correct results only if the 10zt value does not exceed
the scope of destination integral type.

Details:

Here are the steps the mikroC PRO for PIC uses to convert the operands in an arith-
metic expression:
First, any small integral types are converted according to the following rules:

. char converts to int

. signed char converts to int, with the same value

. short converts to int, with the same value, sign-extended

. unsigned short converts to int, with the same value, zero-filled
. enum converts to int, with the same value

AP ON -

After this, any two values associated with an operator are either int (including the
long and unsigned modifiers) or f1oat (equivalent with double and 1ong double
in the mikroC PRO for PIC).

1. If either operand is f10at, the other operand is converted to f1oat.

2. Otherwise, if either operand is unsigned 1ong, the other operand is converted to
unsigned long.

3. Otherwise, if either operand is 10ng, then the other operand is converted to 1ong.
4. Otherwise, if either operand is unsigned, then the other operand is converted to
unsigned

5. Otherwise, both operands are int.

The result of the expression is the same type as that of the two operands.
Here are several examples of implicit conversion:

2 + 3.1 /* 2 2. + 3.1 2 5.1 */
5/ 4 * 3. /* 2 (5/4)*3. 2 1*3. 2?2 1.*3. 2 3. */
3. * 5 / 4 /* 2 (3.%5)/4 2?2 (3.*5.)/4 ? 15./4 ? 15./4. 2 3.75 */

Pointer Conversion

Pointer types can be converted to other pointer types using the typecasting mecha-
nism:

char *str;
int *ip;

str = (char *)ip;

More generally, the cast type* will convert a pointer to type “pointer to type”.
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Explicit Type Concersions (Typecasting)

In most situations, compiler will provide an automatic implicit conversion of types
where needed, without any user's interference. Also, the user can explicitly convert
an operand to another type using the prefix unary typecast operator:

(type) object
This will convert object to a specified type. Parentheses are mandatory.

For example:

/* Let's have two variables of char type: */
char a, Db;

/* Following line will coerce a to unsigned int: */
(unsigned int) a;

/* Following line will coerce a to double,
then coerce b to double automatically,
resulting in double type value: */
(double) a + b; // equivalent to ((double) a) + b;

Declarations

A declaration introduces one or several names to a program — it informs the compil-
er what the name represents, what its type is, what operations are allowed with it,
etc. This section reviews concepts related to declarations: declarations, definitions,
declaration specifiers, and initialization.

The range of objects that can be declared includes:

- Variables

- Constants

- Functions

- Types

- Structure, union and enumeration tags
- Structure members

- Union members

- Arrays of other types

- Statement labels

- Preprocessor macros

MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD 193



CHAPTER 6
Language Reference mikroC PRO for PIC

Declarations and Definitions

Defining declarations, also known as definitions, beside introducing the name of an
object, also establish the creation (where and when) of an object; that is, the alloca-
tion of physical memory and its possible initialization. Referencing declarations, or
just declarations, simply make their identifiers and types known to the compiler.

Here is an overview. Declaration is also a definition, except if:

- it declares a function without specifying its body

- it has the extern specifier, and has no initializator or body (in case of func.)

- itis the typedef declaration

There can be many referencing declarations for the same identifier, especially in a
multifile program, but only one defining declaration for that identifier is allowed.

For example:

/* Here 1is a nondefining declaration of function max; */
/* it merely informs compiler that max is a function */
int max () ;

/* Here 1s a definition of function max: */
int max (int x, int y) {
return (x >= y) ? x : y;

}

/* Definition of variable 1i: */

int i;

/* Following line is an error, 1 1s already defined! */
int i;

Declarations and Declarators

The declaration contains specifier(s) followed by one or more identifiers (declara-
tors). The declaration begins with optional storage class specifiers, type specifiers,
and other modifiers. The identifiers are separated by commas and the list is termi-
nated by a semicolon.

Declarations of variable identifiers have the following pattern:
storage-class [ type-qualifier] type varl [ =initl], var2 [ =init2], ... ;
where var1, var2,... are any sequence of distinct identifiers with optional initializers.

Each of the variables is declared to be of type; if omitted, type defaults to int. The
specifier storage-class can take the values extern, static, register, or the
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default auto. Optional type-qualifier can take values const or volatile. For
more details, refer to Storage Classes and Type Qualifiers.

For example:

/* Create 3 integer variables called x, y, and z
and initialize x and y to the values 1 and 2, respectively: */
int x =1, yv = 2, z; // z remains uninitialized

/* Create a floating-point variable g with static modifier,
and initialize it to 0.25: */
static float g = .25;

These are all defining declarations; storage is allocated and any optional initializers
are applied.

Linkage

An executable program is usually created by compiling several independent trans-
lation units, then linking the resulting object files with preexisting libraries. A term
translation unit refers to a source code file together with any included files, but with-
out the source lines omitted by conditional preprocessor directives. A problem aris-
es when the same identifier is declared in different scopes (for example, in different
files), or declared more than once in the same scope.

The linkage is a process that allows each instance of an identifier to be associated
correctly with one particular object or function. All identifiers have one of two linkage
attributes, closely related to their scope: external linkage or internal linkage. These
attributes are determined by the placement and format of your declarations, togeth-
er with an explicit (or implicit by default) use of the storage class specifier static or

extern.

Each instance of a particular identifier with external linkage represents the same
object or function throughout the entire set of files and libraries making up the pro-
gram. Each instance of a particular identifier with internal linkage represents the
same object or function within one file only.

Linkage Rules

Local names have internal linkage; the same identifier can be used in different files
to signify different objects. Global names have external linkage; identifier signifies
the same object throughout all program files.

If the same identifier appears with both internal and external linkage within the same
file, the identifier will have internal linkage.
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Internal Linkage Rules

1. names having file scope, explicitly declared as static, have internal linkage

2. names having file scope, explicitly declared as const and not explicitly declared
as extern, have internal linkage

3. typedef names have internal linkage

4. enumeration constants have internal linkage

External Linkage Rules

1. names having file scope, that do not comply to any of previously stated internal
linkage rules, have external linkage

The storage class specifiers auto and register cannot appear in an external dec-
laration. No more than one external definition can be given for each identifier in a
translation unit declared with internal linkage. An external definition is an external
declaration that defines an object or a function and also allocates a storage. If an
identifier declared with external linkage is used in an expression (other than as part
of the operand of sizeof), then exactly one external definition of that identifier must
be somewhere in the entire program.

Storage Classes

Associating identifiers with objects requires each identifier to have at least two attrib-
utes: storage class and type (sometimes referred to as data type). The mikroC PRO
for PIC compiler deduces these attributes from implicit or explicit declarations in the
source code.

A storage class dictates the location (data segment, register, heap, or stack) of
object and its duration or lifetime (the entire running time of the program, or during
execution of some blocks of code). A storage class can be established by the syn-
tax of a declaration, by its placement in the source code, or by both of these factors:

storage-class type identifier

The storage class specifiers in the mikroC PRO for PIC are:
auto

register

static
extern
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Auto

The auto modifer is used to define that a local variable has a local duration. This is
the default for local variables and is rarely used. auto can not be used with globals.
See also Functions.

Register
At the moment the modifier register technically has no special meaning. The
mikroC PRO for PIC compiler simply ignores requests for register allocation.

Static
A global name declared with the static specifier has internal linkage, meaning that
it is local for a given file. See Linkage for more information.

Alocal name declared with the stat i c specifier has static duration. Use static with
a local variable to preserve the last value between successive calls to that function.
See Duration for more information.

Extern

A name declared with the extern specifier has external linkage, unless it has been
previously declared as having internal linkage. A declaration is not a definition if it
has the extern specifier and is not initialized. The keyword extern is optional for
a function prototype.

Use the extern modifier to indicate that the actual storage and initial value of the
variable, or body of the function, is defined in a separate source code module. Func-
tions declared with extern are visible throughout all source files in the program,
unless the function is redefined as static.

See Linkage for more information.

Type Qualifiers

The type qualifiers const and volatile are optional in declarations and do not
actually affect the type of declared object.

Qualifiers Const

The qualifier const implies that a declared object will not change its value during
runtime. In declarations with the const qualifier all objects need to be initialized.

The mikroC PRO for PIC treats objects declared with the const qualifier the same
as literals or preprocessor constants. If the user tries to change an object declared
with the const qualifier compiler will report an error.
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For example:

const double PI = 3.14159;
Qualifier Volatile

The qualifier volzatile implies that a variable may change its value during runtime
independently from the program. Use the volatile modifier to indicate that a variable
can be changed by a background routine, an interrupt routine, or 1/0 port. Declaring
an object to be volatile warns the compiler not to make assumptions concerning the
value of an object while evaluating expressions in which it occurs because the value
could be changed at any moment.

Typedef Specifier

The specifier typede £ introduces a synonym for a specified type. The typedef dec-
larations are used to construct shorter or more convenient names for types already
defined by the language or declared by the user.

The specifier typedef stands first in the declaration:

typedef <type definition> synonym;

The typedef keyword assigns synonym to <type definition>. The synonym
needs to be a valid identifier.

A declaration starting with the typedef specifier does not introduce an object or a
function of a given type, but rather a new name for a given type. In other words, the
typedef declaration is identical to a “normal” declaration, but instead of objects, it
declares types. It is a common practice to name custom type identifiers with start-
ing capital letter — this is not required by the mikroC PRO for PIC. For example:

/* Let's declare a synonym for "unsigned long int" */
typedef unsigned long int Distance;

/* Now, synonym "Distance'" can be used as type identifier: */
Distance 1i; // declare variable i of unsigned long int

In the typedef declaration, as in any other declaration, several types can be
declared at once. For example:

typedef int *Pti, Arrayl 10];

Here, pti is a synonym for type “pointer to int”, and array is @ synonym for type
“array of 10 int elements”.
asm Declarations
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The mikroC PRO for PIC allows embedding assembly in the source code by means
of the asm declaration. The declarations asm and asm are also allowed in the
mikroC PRO for PIC and have the same meaning. Note that numerals cannnot be
used as absolute addresses for SFR or GPR variables in assembly instructions.
Symbolic names may be used instead (listing will display these names as well as
addresses).

Assembly instructions can be grouped by the asm keyword (or , or asm):

asm {
block of assembly instructions

}

There are two ways to embeding single assembly instruction to C code:
asm assembly instruction;

and

asm assembly instruction

Note: semicolon and LF are terminating asm scope for single assembly instructions.
This is the reason why the following syntax is not asm block:

asm

{

block of assembly instructions

}

This code will be interpreted as single empty asm line followed by C compound
statement.

The mikroC PRO for PIC comments (both single-line and multi-line) are allowed in
embedded assembly code.

if you have a global variable "g_var", that is of type long (i.e. 4 bytes), you are to
access it like this:

MOVFE g vart0, O ;puts least-significant byte of g var in W register
MOVFE g vartl, 0O ;second byte of g var; corresponds to Hi(g var)
MOVEF g var+2, 0 ;Higher(g var)
MOVEF g var+3, 0 ;Highest (g_var)

. etc.

If you want to know details about asm syntax supported by mikroC PRO for PIC it
is recomended to study =sm and Ist files generated by compiler. It is also recomend-
ed to check "Include source lines in output files" checkbox in Output settings
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Note: Compiler doesn't expect memory banks to be changed inside the assembly
code. If the user wants to do this, then he must restore the previous bank selection.

Related topics: mikroC PRO for PIC specifcs
Initialization

The initial value of a declared object can be set at the time of declaration (initializa-
tion). A part of the declaration which specifies the initialization is called initializer.

Initializers for globals and static objects must be constants or constant expres-
sions. The initializer for an automatic object can be any legal expression that eval-
uates to an assignment-compatible value for the type of the variable involved.

Scalar types are initialized with a single expression, which can optionally be enclosed
in braces. The initial value of an object is that of the expression; the same constraints
for type and conversions as for simple assignments are applied to initializations too.

For example:

int i = 1;
char *s = "hello";
struct complex ¢ = {0.1, -0.2};

// where 'complex' is a structure (float, float)

For structures or unions with automatic storage duration, the initializer must be one
of the following:

- An initializer list.

- A single expression with compatible union or structure type. In this case, the initial
value of the object is that of the expression.

For example:

struct dot {int x; int y; } m = {30, 40} ;

For more information, refer to Structures and Unions.

Also, you can initialize arrays of character type with a literal string, optionally
enclosed in braces. Each character in the string, including the null terminator, initial-
izes successive elements in the array. For more information, refer to Arrays.

Automatic Initialization

The mikroC PRO for PIC does not provide automatic initialization for objects. Unini-
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tialized globals and objects with static duration will take random values from mem-
ory.

FUNCTIONS

Functions are central to C programming. Functions are usually defined as subpro-
grams which return a value based on a number of input parameters. Return value
of the function can be used in expressions — technically, function call is considered
to be an expression like any other.

C allows a function to create results other than its return value, referred to as side
effects. Often, the function return value is not used at all, depending on the side
effects. These functions are equivalent to procedures of other programming lan-
guages, such as Pascal. C does not distinguish between procedure and function —
functions play both roles.

Each program must have a single external function named mzin marking the entry
point of the program. Functions are usually declared as prototypes in standard or
user-supplied header files, or within program files. Functions have external linkage
by default and are normally accessible from any file in the program. This can be
restricted by using the static storage class specifier in function declaration (see
Storage Classes and Linkage).

Note: Check the PIC Specifics for more information on functions’ limitations on the
PIC compliant MCUs.

Function Declaration

Functions are declared in user's source files or made available by linking precom-
piled libraries. The declaration syntax of the function is:

type function name (parameter-declarator-1ist);

The function name must be a valid identifier. This name is used to call the func-
tion; see Function Calls for more information.

type represents the type of function result, and can be of any standard or user-
defined type. For functions that do not return value the void type should be used.
The type can be omitted in global function declarations, and function will assume the
int type by default.

Function type can also be a pointer. For example, f1oat* means that a function
result is a pointer to float. The generic pointer void* is also allowed.
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The function cannot return an array or another function.

Within parentheses, parameter-declarator-1list is a list of formal arguments
that function takes. These declarators specify the type of each function parameter.
The compiler uses this information to check validity of function calls. If the list is
empty, a function does not take any arguments. Also, if the list is void, a function
also does not take any arguments; note that this is the only case when void can
be used as an argument’s type.

Unlike variable declaration, each argument in the list needs its own type specifier
and possible qualifier const or volatile.

Function Prototype

A function can be defined only once in the program, but can be declared several
times, assuming that the declarations are compatible. When declaring a function,
the formal argument's identifier does not have to be specified, but its type does.

This kind of declaration, commonly known as the function prototype, allows better
control over argument number, type checking and type conversions. The name of a
parameter in function prototype has its scope limited to the prototype. This allows
one parameter identifier to have different name in different declarations of the same

function:

/* Here are two prototypes of the same function: */

int test (const char*) /* declares function test *

int test (const char*p) /* declares the same function test */

Function prototypes are very useful in documenting code. For example, the function
cf Init takes two parameters: Control Port and Data Port. The question is, which
is which? The function prototype:

void Cfiinit(char *ctrlport, char *dataport);

makes it clear. If a header file contains function prototypes, the user can read that
file to get the information needed for writing programs that call these functions. If a
prototype parameter includes an identifier, then the indentifier is only used for error
checking.
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Function Definition

Function definition consists of its declaration and function body. The function body
is technically a block — a sequence of local definitions and statements enclosed
within braces { } . All variables declared within function body are local to the function,
i.e. they have function scope.

The function itself can be defined only within the file scope, which means that func-
tion declarations cannot be nested.

To return the function result, use the return statement. The statement return in
functions of the void type cannot have a parameter — in fact, the return statement
can be omitted altogether if it is the last statement in the function body.

Here is a sample function definition:
/* function max returns greater one of its 2 arguments: */

int max (int x, int y) {
return (x>=y) ? x : y;

}
Here is a sample function which depends on side effects rather than return value:

/* function converts Descartes coordinates (x,y) to polar (r,fi): */
#include <math.h>

void polar (double x, double y, double *r, double *fi) ({
*r = sqgrt(x * x + y * y);
*fi = (x == 0 && y == 0) 2 0 : atan2(y, x);
return; /* this line can be omitted */

}
Function Reentrancy
Functions reentrancy is allowed if the function has no parameters and local vari-

ables, or if the local variables are placed in the Rx space. Remember that the PIC
has stack and memory limitations which can varies greatly between MCUs.

MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD 203



CHAPTER 6
Language Reference mikroC PRO for PIC

Function Calls and Argument Conversion
Function Calls

A function is called with actual arguments placed in the same sequence as their
matching formal parameters. Use the function-call operator ():

function name (expression 1, ... , expression n)

Each expression in the function call is an actual argument. Number and types of
actual arguments should match those of formal function parameters. If types do not
match, implicit type conversions rules will be applied. Actual arguments can be of
any complexity, but order of their evaluation is not specified.

Upon function call, all formal parameters are created as local objects initialized by
the values of actual arguments. Upon return from a function, a temporary object is
created in the place of the call, and it is initialized by the expression of the return
statement. This means that the function call as an operand in complex expression
is treated as a function result.

If the function has no result (type void) or the result is not needed, then the func-
tion call can be written as a self-contained expression.

In C, scalar arguments are always passed to the function by value. The function can
modify the values of its formal parameters, but this has no effect on the actual argu-
ments in the calling routine. A scalar object can be passed by the address if a for-
mal parameter is declared as a pointer. The pointed object can be accessed by
using the indirection operator * .

// For example, Soft Uart Read takes the pointer to error variable,
// so it can change the value of an actual argument:
Soft Uart Read(&error);

// The following code would be wrong; you would pass the value
// of error variable to the function:
Soft Uart Read(error);

Argument Conversions

If a function prototype has not been previously declared, the mikroC PRO for PIC
converts integral arguments to a function call according to the integral widening
(expansion) rules described in Standard Conversions. If a function prototype is in
scope, the mikroC PRO for PIC converts the passed argument to the type of the
declared parameter according to the same conversion rules as in assignment state-
ments.
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If a prototype is present, the number of arguments must match. The types need to
be compatible only to the extent that an assignment can legally convert them. The
user can always use an explicit cast to convert an argument to a type that is accept-
able to a function prototype.

Note: If the function prototype does not match the actual function definition, the mikroC
PRO for PIC will detect this if and only if that definition is in the same compilation unit
as the prototype. If you create a library of routines with the corresponding header file of
prototypes, consider including that header file when you compile the library, so that any
discrepancies between the prototypes and actual definitions will be detected.

The compiler is also able to force arguments to change their type to a proper one.
Consider the following code:

int limit = 32;
char ch = 'A';

long res;

// prototype

extern long func(long parl, long par2);
main () {
res = func(limit, ch); // function call

}

Since the program has the function prototype for func, it converts 1imit and ch to
long, using the standard rules of assignment, before it places them on the stack for
the call to func.

Without the function prototype, 1imit and ch would be placed on the stack as an
integer and a character, respectively; in that case, the stack passed to func will not
match size or content that func expects, which can cause problems.

Ellipsis ('...") Operator

The ellipsis ('...") consists of three successive periods with no whitespace intervening.
An ellipsis can be used in the formal argument lists of function prototypes to indicate a
variable number of arguments, or arguments with varying types. For example:

void func (int n, char ch, ...);

This declaration indicates that func will be defined in such a way that calls must have

at least two arguments, int and char, but can also have any number of addition-
al arguments.
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Example:

#include <stdarg.h>

int addvararg(char al,...){
va list ap;

char temp;

va_start (ap,al);

while( temp = va arg(ap,char))
al += temp;

return al;

}

int res;
void main () {

res = addvararg(l,2,3,4,5,0);

res = addvararg(l,2,3,4,5,6,7,8,9,10,0);
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OPERATORS

Operators are tokens that trigger some computation when applied to variables and
other objects in an expression.

Arithmetic Operators
Assignment Operators
Bitwise Operators

Logical Operators
Reference/Indirect Operators
Relational Operators
Structure Member Selectors

Comma Operator ,
Conditional Operator >

Array subscript operator | |
B Function call operator ()

B sizeof Operator

B Preprocessor Operators # and ##
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mikroC PRO for PIC

Operators Presidence and Associativity

There are 15 precedence categories, some of them contain only one operator.
Operators in the same category have equal precedence.

If duplicates of operators appear in the table, the first occurrence is unary and the
second binary. Each category has an associativity rule: left-to-right ( —), or right-to-
left ( «). In the absence of parentheses, these rules resolve a grouping of expres-
sions with operators of equal precedence.

Precedence |Operands Operators Associativity
15 2 () [] . -> —
14 i ltype)  sizeof -
13 2 * / -
12 2 + - -
11 2 << >> -
10 2 <<= > >= -
9 2 == I= -
8 2 & —
7 2 g -
6 2 \ —
5 2 &6 -
4 2 K -
3 3 2 -
2 2 - . \::<:z _i> . A <
1 2 , -

Arithmetic Operators

Arithmetic operators are used to perform mathematical computations. They have
numerical operands and return numerical results. The type char technically repre-
sents small integers, so the char variables can be used as operands in arithmetic

operations.

All arithmetic operators associate from left to right.
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Operator Operation | Precedence

Binary Operators

+ addition 12
- subtraction 12
* multiplication 13
/ division 13

modulus operator returns the remainder of integer

% . . . . 13
division (cannot be used with floating points)
Unary Operators
+ unary plus does not affect the operand 14
- unary minus changes the sign of the operand 14
increment adds one to the value of the operand.
Postincrement adds one to the value of the operand
++ . ; ) 14
after it evaluates; while preincrement adds one
before it evaluates
decrement subtracts one from the value of the
_ operand. Postdecrement subtracts one from the 14

value of the operand after it evaluates; while pre-
decrement subtracts one before it evaluates

Note: Operator * is context sensitive and can also represent the pointer reference
operator.
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Binary Arithmetic Operators

Division of two integers returns an integer, while remainder is simply truncated:
/* for example: */

7/ 4; /* equals 1 */

7% 3/ 4; /* equals 5 */

/* but: */
7. % 3./ 4.; /* equals 5.25 because we are working with floats */

Remainder operand < works only with integers; the sign of result is equal to the sign
of the first operand:

/* for example: */

9 % 3; /* equals 0 */
7% 3; /* equals 1 */
-7 % 3; /* equals -1 */

Arithmetic operators can be used for manipulating characters:

"A' + 32; /* equals 'a' (ASCII only) */
'G' - 'A'" + 'a'; /* equals 'g' (both ASCII and EBCDIC) */

Unary Arithmetic Operators

Unary operators ++ and -- are the only operators in C which can be either prefix
(e.g. ++k, —-k) or postfix (e.g. k++, k--).

When used as prefix, operators ++ and -- (preincrement and predecrement) add or
subtract one from the value of the operand before the evaluation. When used as suf-
fix, operators ++ and -- (postincrement and postdecrement) add or subtract one
from the value of the operand after the evaluation.

For example:

int j = 5;
3= ++k; /* k =k + 1, 5 = k, which gives us § = 6, k = 6 */

but:

int j = 5;
J o= kt+; /* 3 =k, k = k + 1, which gives us j =5, k = 6 */
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Relational Operators

Use relational operators to test equality or inequality of expressions. If an expres-
sion evaluates to be true, it returns 1; otherwise it returns 0.

All relational operators associate from left to right.

Relational Operators Overview

Operator Operation Precedence
== equal 9
1= not equal 9
> greater than 10
< less than 10
>= greater than or equal (10
<= less than or equal 10

Relational Operators in Expressions

Precedence of arithmetic and relational operators is designated in such a way to
allow complex expressions without parentheses to have expected meaning:

a+ 5> c¢c - 1.0/ e /* 2?2 (a + 5) >= (c - (1.0 / e)) */

Do not forget that relational operators return either 0 or 1. Consider the following

examples:
/* ok: */
5> 17 /* returns 0 */
10 <= 20 /* returns 1 */

/* this can be tricky: */

8 == 13 > 5 /* returns 0, as: 8 == (13 > 5) ? 8§ == 1
? 0 */

14 > 5 < 3 /* returns 1, as: (14 > 5) < 3 2 1 <3 2
1 */

a< b < b /* returns 1, as: (a < b) < 5 ? (0 or 1)

<5 2 1x/
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Bitwise Operators
Use the bitwise operators to modify individual bits of numerical operands.

Bitwise operators associate from left to right. The only exception is the bitwise com-
plement operator ~ which associates from right to left.

Bitwise Operators Overview

Operator Operation Precedence

bitwise AND; compares pairs of bits and returns 1 if 8

& both bits are 1, otherwise returns 0

| bitwise (inclusive) OR; compares pairs of bits and retums 1 if 6
either or both bits are 1, otherwise retumns 0

bitwise exclusive OR (XOR); compares pairs of bits
A and returns 1 if the bits are complementary, other- 7
wise returns 0

~ bitwise complement (unary); inverts each bit 14

bitwise shift left; moves the bits to the left, discards 1
the far left bit and assigns 0 to the far right bit.

bitwise shift right; moves the bits to the right, dis-
>> cards the far right bit and if unsigned assigns 0 to 11
the far left bit, otherwise sign extends

<<

Logical Operations on Bit Level

& 0 1 | 0|1 A 0 1 ~1ol1
0 0 0 0] 0|1 0| O 1 11 o
1 0 1 1 (1 1 1 1 0

Bitwise operators ¢, | and ~ perform logical operations on the appropriate pairs of bits
of their operands. Operator ~ complements each bit of its operand. For example:
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0x1234 & 0x5678 /* equals 0x1230 */
/* because ..

0x1234 : 0001 0010 0011 0100
0x5678 : 0101 0110 0111 1000

& : 0001 0010 0011 0000
. that is, 0x1230 */

/* Similarly: */

0x1234 | 0x5678; /* equals 0x567C */
0x1234 ~ 0x5678; /* equals 0x444C */
~ 0x1234; /* equals OxEDCB */

Note: Operator « can also be a pointer reference operator. Refer to Pointers for
more information.

Bitwise Shift Operators

Binary operators << and >> move the bits of the left operand by a number of posi-
tions specified by the right operand, to the left or right, respectively. Right operand
has to be positive.

With shift left (<<), far left bits are discarded and “new” bits on the right are assigned
zeroes. Thus, shifting unsigned operand to the left by n positions is equivalent to
multiplying it by 2n if all discarded bits are zero. This is also true for signed operands
if all discarded bits are equal to a sign bit.

000001 << 5; /* equals 000040 */
0x3801 << 4; /* equals 0x8010, overflow! */

With shift right (>>), far right bits are discarded and the “freed” bits on the left are
assigned zeroes (in case of unsigned operand) or the value of a sign bit (in case of
signed operand). Shifting operand to the right by n positions is equivalent to divid-

ing it by 2n.
0xFF56 >> 4; /* equals OxFFF5 */
0xFF56u >> 4; /* equals 0xO0FF5 */
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Bitwise versus Logical

Do not forget of the principle difference between how bitwise and logical operators
work. For example:

0222222 & 0555555; /* equals 000000 */
0222222 && 0555555; /* equals 1 */
~ 0x1234; /* equals OxEDCB */
! 0x1234; /* equals 0 */

Logical Operators

Operands of logical operations are considered true or false, that is non-zero or zero.
Logical operators always return 1 or 0. Operands in a logical expression must be of
scalar type.

Logical operators s« and | | associate from left to right. Logical negation operator !
associates from right to left.

Logical Operators Overview

Operator Operation Precedence
&& logical AND 5
Il logical OR 4
! logical negation 14

Logical Operators

&& | O X Il 0 X ! 0| x
0 0 0 0 0 1 1 0
X 0 1 X 1 1

Precedence of logical, relational, and arithmetic operators was designated in such
a way to allow complex expressions without parentheses to have an expected

meaning:
c>= '"0" && c <= '9'; /* reads as: (c >= '0') && (c <= '9") */
a+1=Db || ! £(x); /* reads as: ((a + 1) == Db) || (! (£(x))) */

Logical AND s« returns 1 only if both expressions evaluate to be nonzero, otherwise
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returns 0. If the first expression evaluates to false, the second expression will not be
evaluated. For example:

a>Db && c < d; /* reads as (a > b) && (c < d) */
/* 1f (a > b) 1is false (0), (c < d) will not be evaluated */

Logical OR || returns 1 if either of expression evaluates to be nonzero, otherwise
returns 0. If the first expression evaluates to true, the second expression is not eval-
uated. For example:

a && b || c && d; /* reads as: (a && b) || (c && d) */
/* if (a && b) 1is true (1), (c && d) will not be evaluated */

Logical Expressions and Side Effects

General rule regarding complex logical expressions is that the evaluation of consec-
utive logical operands stops at the very moment the final result is known. For exam-
ple, if we have an expression 2 «s b «& c where a is false (0), then operands b
and c will not be evaluated. This is very important if o and ¢ are expressions, as their
possible side effects will not take place!

Logical versus Bitwise

Be aware of the principle difference between how bitwise and logical operators
work. For example:

0222222 & 0555555 /* equals 000000 */
0222222 && 0555555 /* equals 1 */
~ 0x1234 /* equals OxEDCB */
! 0x1234 /* equals 0 */
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Conditional Operator ?:

The conditional operator > : is the only ternary operator in C. Syntax of the condi-
tional operator is:

expressionl ? expression2 : expression3

The expressionl is evaluated first. If its value is true, then expression2 evaluates
and expression3 is ignored. If expression1 evaluates to false, then expression3
evaluates and expression2 isignored. The result will be a value of either expres-
sion2 Or expression3 depending upon which of them evaluates.

Note: The fact that only one of these two expressions evaluates is very important if
they are expected to produce side effects!

Conditional operator associates from right to left.
Here are a couple of practical examples:

/* Find max(a, b): */
max = (a > b ) ? a : b;

/* Convert small letter to capital: */
/* (no parentheses are actually necessary) */
c = (c>= 'a'" && c <= "'z" ) ? (c - 32) : ¢c;

Conditional Operator Rules

expressionl must be a scalar expression; expression2 and expression3 must
obey one of the following rules:

1. Both expressions have to be of arithmetic type. expression2 and expression3
are subject to usual arithmetic conversions, which determines the resulting type.

2. Both expressions have to be of compatible struct or union types. The resulting
type is a structure or union type of expression2 and expression3.

3. Both expressions have to be of void type. The resulting type is void.

4. Both expressions have to be of type pointer to qualified or unqualified versions
of compatible types. The resulting type is a pointer to a type qualified with all type
qualifiers of the types pointed to by both expressions.

5. One expression is a pointer, and the other is a null pointer constant. The result-
ing type is a pointer to a type qualified with all type qualifiers of the types point-
ed to by both expressions.

6. One expression is a pointer to an object or incomplete type, and the other is a
pointer to a qualified or unqualified version of void. The resulting type is that of
the non-pointer-to-void expression.
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Assignment Operators

Unlike many other programming languages, C treats value assignment as operation
(represented by an operator) rather than instruction.

Simple Assignment Operator

For a common value assignment, a simple assignment operator (=) is used:
expressionl=expression?2

The expressionl is an object (memory location) to which the value of expression?
is assigned. Operand expressionl has to be Ivalue and expression2 can be any
expression. The assignment expression itself is not lvalue.

If expressionl and expression? are of different types, the result of the expres-
sion2 will be converted to the type of expressioni, if necessary. Refer to Type
Conversions for more information.

Compound Assignment Operator

C allows more comlex assignments by means of compound assignment operators.
The syntax of compound assignment operators is:

expressionl op = expression?

where op can be one of binary operators +, -, *, /, %, &, |, ~, <<, OF >>,
Thus, we have 10 different compound assignment operators: +=, -=, *=, /=, %=,
&=, |=, "=, <<= and >>=.All of them associate from right to left. Spaces sepa-

rating compound operators (e.g. +=) will generate an error.

Compound assignment has the same effect as

expressionl = expressionl op expression?2

except the Ivalue expressionl is evaluated only once. For example, expres-

sionl+= expression? is the same as expressionl = expressionl + expres-
sion?2.
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Assignment Rules

For both simple and compound assignment, the operands ecxpressionl and
expression2 must obey one of the following rules:

1. expressionl is of qualified or unqualified arithmetic type and expression2 is of
arithmetic type.

2. expressionl has a qualified or unqualified version of structure or union type
compatible with the type of expression2.

3. expressionl and expression2 are pointers to qualified or unqualified versions
of compatible types and the type pointed to by left has all qualifiers of the type
pointed to by right.

4. Either expressionl Or expression2 is a pointer to an object or incomplete type
and the other is a pointer to a qualified or unqualified version of void. The type
pointed to by left has all qualifiers of the type pointed to by right.

5. expressionl is a pointer and expression2 is a null pointer constant.

Sizeof Operator

The prefix unary operator sizeof returns an integer constant that represents the
size of memory space (in bytes) used by its operand (determined by its type, with
some exceptions).

The operator sizeof can take either a type identifier or an unary expression as an
operand. You cannot use sizeof with expressions of function type, incomplete types,
parenthesized names of such types, or with Ivalue that designates a bit field object.

Sizeof Applied to Expression

If applied to expression, the size of an operand is determined without evaluating the
expression (and therefore without side effects). The result of the operation will be
the size of the type of the expression’s result.

Sizeof Applied to Type

If applied to a type identifier, sizeof returns the size of the specified type. The unit

for type size is sizeof (char) which is equivalent to one byte. The operation size-
of (char) gives the result 1, whether char is signed or unsigned.

Thus:

sizeof (char) /* returns 1 */
sizeof (int) /* returns 2 */
sizeof (unsigned long) /* returns 4 */
sizeof (float) /* returns 4 */
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When the operand is a non-parameter of array type, the result is the total number of
bytes in the array (in other words, an array name is not converted to a pointer type):

int i, 7j, al 10];
7 = sizeof (a[ 1]); /* j = sizeof(int) = 2 */
i = sizeof (a); /* i = 10*sizeof (int) = 20 */

/* To get the number of elements in an array: */
int num elem = i/j;

If the operand is a parameter declared as array type or function type, sizeof gives
the size of the pointer. When applied to structures and unions, sizeof gives the
total number of bytes, including any padding. The operator sizeof cannot be
applied to a function.

EXPRESSION

Expression is a sequence of operators, operands, and punctuators that specifies a
computation. Formally, expressions are defined recursively: subexpressions can be
nested without formal limit. However, the compiler will report an out-of-memory error
if it can’t compile an expression that is too complex.

In ANSI C, the primary expressions are: constant (also referred to as literal), identi-
fier, and (expression), defined recursively.

Expressions are evaluated according to a certain conversion, grouping, associativi-
ty and precedence rules, which depends on the operators used, presence of paren-
theses and data types of the operands. The precedence and associativity of the
operators are summarized in Operator Precedence and Associativity. The way
operands and subexpressions are grouped does not necessarily specify the actual
order in which they are evaluated by the mikroC PRO for PIC.

Expressions can produce Ivalue, rvalue, or no value. Expressions might cause side
effects whether they produce a value or not.

Comma Expressions

One of the specifics of C is that it allows using of comma as a sequence operator to
form so-called comma expressions or sequences. Comma expression is a comma-
delimited list of expressions — it is formally treated as a single expression so it can
be used in places where an expression is expected. The following sequence:

expression 1, expression 2;
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results in the left-to-right evaluation of each expression, with the value and type of
expression 2 giving the result of the whole expression. Result of expression 1
is discarded.

Binary operator comma (,) has the lowest precedence and associates from left to
right, sothat 2, b, c isthesameas (a, b), c. This allows writing sequences
with any number of expressions:

expression 1, expression 2, ... expression n;

which results in the left-to-right evaluation of each expression, with the value and
type of expression n giving the result of the whole expression. Results of other
expressions are discarded, but their (possible) side-effect do occur.

For example:

result = (a =5, b /=2, ct++ );
/* returns preincremented value of variable c,
but also intializes a, divides b by 2 and increments c */

result = ( x =10, v = x + 3, x-——, z —= x * 3 - --y );

/* returns computed value of variable z,
and also computes x and y */

Note

Do not confuse comma operator (sequence operator) with comma punctuator which
separates elements in a function argument list and initializator lists. To avoid ambi-
guity with commas in function argument and initializer lists, use parentheses. For
example,

func(i, (3 =1, 7 + 4), k);

calls the function func with three arguments (i, 5, k), not four.
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STATEMENTS

Statements specify a flow of control as the program executes. In the absence of
specific jump and selection statements, statements are executed sequentially in the
order of appearance in the source code.

Statements can be roughly divided into:

- Labeled Statements

- Expression Statements

- Selection Statements

- lteration Statements (Loops)

- Jump Statements

- Compound Statements (Blocks)

Labeled Statements

Each statement in a program can be labeled. A label is an identifier added before
the statement like this:

label identifier: statement;

There is no special declaration of a label — it just “tags” the statement. 1abel iden-
tifier has a function scope and the same label cannot be redefined within the
same function.

Labels have their own namespace: label identifier can match any other identifier in
the program.

A statement can be labeled for two reasons:

1. The label identifier serves as a target for the unconditional goto statement,

2. The label identifier serves as a target for the switch statement. For this purpose,
only case and default labeled statements are used:

case constant-expression : statement

default : statement
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Expression Statements
Any expression followed by a semicolon forms an expression statement:
expression;

The mikroC PRO for PIC executes an expression statement by evaluating the
expression. All side effects from this evaluation are completed before the next
statement starts executing. Most of expression statements are assignment state-
ments or function calls.

Anull statement is a special case, consisting of a single semicolon (;). The null
statement does nothing, and therefore is useful in situations where the mikroC PRO
for PIC syntax expects a statement but the program does not need one. For exam-
ple, a null statement is commonly used in “empty” loops:

for (; *gt++ = *p++ ;); /* body of this loop is a null statement */
Selection Statements

Selection or flow-control statements select one of alternative courses of action by
testing certain values. There are two types of selection statements:

m if
B switch

If Statement

The it statement is used to implement a conditional statement. The syntax of the
if statementis:

if (expression) statementl [ else statement?2]

If expression evaluates to true, statementl executes. If statement is false,
statement2 executes. The expression must evaluate to an integral value; other-
wise, the condition is ill-formed. Parentheses around the expression are mandato-

ry.

The <1se keyword is optional, but no statements can come between it and c1se.
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Nested If Statement

Nested i r statements require additional attention. A general rule is that the nested
conditionals are parsed starting from the innermost conditional, with each eise
bound to the nearest available i r on its left:

if (expressionl) statementl
else if (expression?2)
if (expression3) statement2

else statement3 /* this belongs to: if (expression3) */
else statementd /* this belongs to: if (expression2) */
Note

#if and #else preprocessor statements (directives) look similarto if and else
statements, but have very different effects. They control which source file lines are
compiled and which are ignored.

Switch Statements

The switch statement is used to pass control to a specific program branch, based
on a certain condition. The syntax of the switch statement is:

switch (expression) {

case constant-expression 1 : statement 1;
case constantfexpressionin : statement n;
[ default : statement;]

}

First, the expression (condition) is evaluated. The switch statement then com-
pares it to all available constant-expressions following the keyword czse. If a match
is found, switch passes control to that matching case causing the statement fol-
lowing the match evaluates. Note that constant-expressions must evaluate to
integer. It is not possible to have two same constant expressions evaluating to
the same value.

Parentheses around expression are mandatory.

Upon finding a match, program flow continues normally: the following instructions
will be executed in natural order regardless of the possible case label. If no case
satisfies the condition, the default case evaluates (if the label default is speci-
fied).

For example, if a variable i has value between 1 and 3, the following switch would
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always return it as 4:

switch (i) {
case 1: i++;
case 2: i++;
case 3: i++;

}

To avoid evaluating any other cases and relinquish control from switch, each case
should be terminated with break.

Here is a simple example with switch. Suppose we have a variable phase with only
3 different states (0, 1, or 2) and a corresponding function (event) for each of these
states. This is how we could switch the code to the appopriate routine:

switch (phase) {
case 0: Lo(); break;
case 1: Mid(); break;
case 2: Hi(); break;

case: Message ("Invalid state!");

}

Nested Switch

Conditional switch statements can be nested — labels case and default are then
assigned to the innermost enclosing switch statement.

Iteration Statements (Loops)

Iteration statements allows to loop a set of statements. There are three forms of iter-
ation statements in the mikroC PRO for PIC:

B while
H do
m for

While Statement

The while keyword is used to conditionally iterate a statement. The syntax of the
while statementis:

while (expression) statement

The statement executes repeatedly until the value of expression is false. The test
takes place before statement is executed. Thus, if expression evaluates to false
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on the first pass, the loop does not execute. Note that parentheses around expres-
sion are mandatory.

Here is an example of calculating scalar product of two vectors, using the while
statement:

int s = 0, 1 = 0;
while (i < n) {
s += al 1] * bl i];
1++;
}
Note that body of the loop can be a null statement. For example:
while (*gt+ = *p++);

Do Statement

The do statement executes until the condition becomes false. The syntax of the do
statement is:

do statement while (expression);

The statement is executed repeatedly as long as the value of expression remains
non-zero. The expression is evaluated after each iteration, so the loop will execute
statement at least once.

Parentheses around expression are mandatory.

Note that do is the only control structure in C which explicitly ends with semicolon
(;). Other control structures end with statement, which means that they implicitly

include a semicolon or closing brace.

Here is an example of calculating scalar product of two vectors, using the do state-

ment:

s =0; 1 = 0;

do {
s += al 1] * D[ i];
1++;

} while ( i < n );
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For Statement

The for statement implements an iterative loop. The syntax of the for statement

IS:
for ([ init-expression]; [ condition-expression]; [ increment-expres-
sion] ) statement

Before the first iteration of the loop, init-expression sets the starting variables for
the loop. You cannot pass declarations in init-expression.

condition-expression is checked before the first entry into the block; statement
is executed repeatedly until the value of condition-expression is false. After
each iteration of the loop, increment-expression increments a loop counter. Conse-
quently, i++ is functionally the same as ++1.

All expressions are optional. If condition-expression is left out, it is assumed to
be always true. Thus, “empty” for statement is commonly used to create an end-
less loop in C:

for ( ; ; ) statement
The only way to break out of this loop is by means of the brezk statement.

Here is an example of calculating scalar product of two vectors, using the ror state-
ment:

for ( s =0, 1 = 0; 1 < n; i++ ) s += a[ 1] * p[ 1] ;
There is another way to do this:

for ( s =0, 1 =0; 1< n; s += ali] * bl 1i], i++ ); /* wvalid, but

ugly */

but it is considered a bad programming style. Although legal, calculating the sum
should not be a part of the incrementing expression, because it is not in the service
of loop routine. Note that null statement (;) is used for the loop body.
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Jump Statements

The jump statement, when executed, transfers control unconditionally. There are
four such statements in the mikroC PRO for PIC:

break
continue
goto
return

BREAK AND CONTINUE STATEMENTS

Break Statement

Sometimes it is necessary to stop the loop within its body. Use the break statement
within loops to pass control to the first statement following the innermost switch,

for, while, or do block.

break is commonly used in the switch statements to stop its execution upon the
first positive match. For example:

switch (state) {
case 0: Lo(); break;
case 1: Mid(); break;
case 2: Hi(); break;

default: Message("Invalid state!");
}

Continue Statement

The continue statement within loops is used to “skip the cycle”. It passes control
to the end of the innermost enclosing end brace belonging to a looping construct. At
that point the loop continuation condition is re-evaluated. This means that contin-
ue demands the next iteration if the loop continuation condition is true.

Specifically, the continue statement within the loop will jump to the marked posi-
tion as it is shown below:

while (..) { do { for (..;..;:..) {

if (val>0) continue; if (val>0) continue; if (val>0) continue;
// continue jumps // continue jumps // continue  jumps
here here here

} while (..); }
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Goto Statement

The goto statement is used for unconditional jump to a local label — for more infor-
mation on labels, refer to Labeled Statements. The syntax of the goto statement is:

goto label identifier;

This will transfer control to the location of a local label specified by 1abel identi-
fier. The label identifier has to be a name of the label within the same func-
tion in which the goto statement is. The goto line can come before or after the label.

goto is used to break out from any level of nested control structures but it cannot be
used to jump into block while skipping that block’s initializations — for example, jump-
ing into loop’s body, etc.

The use of goto statement is generally discouraged as practically every algorithm can
be realized without it, resulting in legible structured programs. One possible application
of the goto statement is breaking out from deeply nested control structures:

for (...) {
for (...) {

if (disaster) goto Error;

Error: /* error handling code */
Return Statement

The return statement is used to exit from the current function back to the calling
routine, optionally returning a value. The syntax is:

return [ expression] ;

This will evaluate expression and return the result. Returned value will be auto-
matically converted to the expected function type, if needed. The expression is
optional; if omitted, the function will return a random value from memory.

Note: The statement return in functions of the void type cannot have expres-
sion —infact, the return statement can be omitted altogether if it is the last state-
ment in the function body.
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Compound Statements (Blocks)

The compound statement, or block, is a list (possibly empty) of statements enclosed
in matching braces { }. Syntactically, the block can be considered to be a single
statement, but it also plays a role in the scoping of identifiers. An identifier declared
within the block has a scope starting at the point of declaration and ending at the
closing brace. Blocks can be nested to any depth up to the limits of memory.

For example, the for loop expects one statement in its body, so we can pass it a
compound statement:

for (i = 0; 1 < n; 1i++ ) {
int temp = a[ i] ;
a[ i] = bl i];
bl 1] = temp;

}

Note that, unlike other statements, compound statements do not end with semicolon
(;), i.e. there is never a semicolon following the closing brace.

PREPROCESSOR

Preprocessor is an integrated text processor which prepares the source code for
compiling. Preprocessor allows:

- inserting text from a specifed file to a certain point in the code (see File Inclusion),
- replacing specific lexical symbols with other symbols (see Macros),

- conditional compiling which conditionally includes or omits parts of the code (see
Conditional Compilation).

Note that preprocessor analyzes text at token level, not at individual character level.
Preprocessor is controled by means of preprocessor directives and preprocessor
operators.

Preprocessor Directives

Any line in the source code with a leading # is taken as a preprocessing directive (or
control line), unless # is within a string literal, in a character constant, or embedded
in a comment. The initial # can be preceded or followed by a whitespace (excluding
new lines).

A null directive consists of a line containing the single character #. This line is always
ignored.

Preprocessor directives are usually placed at the beginning of the source code, but
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they can legally appear at any point in a program. The mikroC PRO for PIC pre-
processor detects preprocessor directives and parses the tokens embedded in
them. A directive is in effect from its declaration to the end of the program file.
Here is one commonly used directive:

#include <math.h>

For more information on including files with the #inc1ude directive, refer to File
Inclusion.

The mikroC PRO for PIC supports standard preprocessor directives:

# (null directive) #if
#define #ifdef
#elif #ifndef
felse #include
#endif #line
ferror #undef

Note: For the time being only funcall pragma is supported.
Line Continuation with Backslash (\)

To break directive into multiple lines end the line with a backslash (\ ):

#define MACRO This directive continues to \
the following line.
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Macros

Macros provide a mechanism for a token replacement, prior to compilation, with or
without a set of formal, function-like parameters.

Defining Macros and Macro Expansions
The #define directive defines a macro:
#define macro identifier <token sequence>

Each occurrence of macro identifier in the source code following this control line will
be replaced in the original position with the possibly empty token sequence (there are
some exceptions, which are discussed later). Such replacements are known as macro
expansions.token sequence is sometimes called the body of a macro. An empty token
sequence results in the removal of each affected macro identifier from the source code.

No semicolon (;) is needed to terminate a preprocessor directive. Any character
found in the token sequence, including semicolons, will appear in a macro expan-
sion.token sequence terminates at the first non-backslashed new line encoun-
tered. Any sequence of whitespace, including comments in the token sequence, is
replaced with a single-space character.

After each individual macro expansion, a further scan is made of the newly expanded
text. This allows the possibility of using nested macros: the expanded text can contain
macro identifiers that are subject to replacement. However, if the macro expands into
something that looks like a preprocessing directive, such directive will not be recog-
nized by the preprocessor. Any occurrences of the macro identifier found within literal
strings, character constants, or comments in the source code will not be expanded.

A macro won't be expanded during its own expansion (SO #define MACRO MACRO
won’t expand indefinitely).
Here is an example:

/* Here are some simple macros: */
#define ERR _MSG "Out of range!"
#define EVERLOOP for( ; ; )
/* which we could use like this: */
main () {

EVERLOOP ({

if (error) { Lcd Out Cp(ERR MSG); break; }

MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD 231



CHAPTER 6
Language Reference mikroC PRO for PIC

Attempting to redefine an already defined macro identifier will result in a warning
unless a new definition is exactly the same token-by-token definition as the existing
one. The preferred strategy when definitions might exist in other header files is as
follows:

#ifndef BLOCK_SIZE
#define BLOCK SIZE 512
#endif

The middle line is bypassed if srLocx size is currently defined; if BLock s1zE is
not currently defined, the middle line is invoked to define it.

Macros with Parameters
The following syntax is used to define a macro with parameters:
#define macro identifier (<arg list>) <token sequence>

Note that there can be no whitespace between macro identifier and ™ (7. The
optional arg 1ist is a sequence of identifiers separated by commas, like the argu-
ment list of a C function. Each comma-delimited identifier has the role of a formal
argument or placeholder.

Such macros are called by writing
macro_identifier (<actual arg list>)

in the subsequent source code. The syntax is identical to that of a function call;
indeed, many standard library C “functions” are implemented as macros. However,
there are some important semantic differences.

The optional actual arg 1ist must contain the same number of comma-delimit-
ed token sequences, known as actual arguments, as found in the formal arg_list of
the #define line —there must be an actual argument for each formal argument. An
error will be reported if the number of arguments in two lists is not the same.

A macro call results in two sets of replacements. First, the macro identifier and the
parenthesis-enclosed arguments are replaced by the token sequence. Next, any for-
mal arguments occurring in the token sequence are replaced by the corresponding
real arguments appearing in actual arg list. Like with simple macro definitions,
rescanning occurs to detect any embedded macro identifiers eligible for expansion.

Here is a simple example:

/* A simple macro which returns greater of its 2 arguments: */
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#define MAX(A, B) ((A) > (B)) ? (A) : (B)
/* Let's call it: */
x = MAX(a + b, ¢ + d);

/* Preprocessor will transform the previous line into:
x = ((a +b) > (¢c+d))? (a+Db) : (c+d */

It is highly recommended to put parentheses around each argument in the macro
body in order to avoid possible problems with operator precedence.

Undefining Macros
The #undef directive is used to undefine a macro.
#undef macroiidentifier

The directive #under detaches any previous token sequence from macro identi-
fier; the macro definition has been forgotten, and macro identifier is undefined.
No macro expansion occurs within the #undef lines.

The state of being defined or undefined is an important property of an identifier,
regardless of the actual definition. The #ifdef and #i fndef conditional directives,
used to test whether any identifier is currently defined or not, offer a flexible mech-
anism for controlling many aspects of a compilation.

After a macro identifier has been undefined, it can be redefined with #define, using
the same or different token sequence.

File Inclusion
The preprocessor directive #include pulls in header files (extension .h) into the
source code. Do not rely on preprocessor to include source files (extension ) — see

Add/Remove Files from Project for more information.

The syntax of the #include directive has two formats:

#include <header name>

#include "header name"

The preprocessor removes the #include line and replaces it with the entire text of
a header file at that point in the source code. The placement of #inc1ude can there-
fore influence the scope and duration of any identifiers in the included file.

The difference between these two formats lies in searching algorithm employed in
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trying to locate the include file.

If the #include directive is used with the <header name> version, the search is
made successively in each of the following locations, in this particular order:

1. the mikroC PRO for PIC installation folder » “include” folder
2. user's custom search paths

The "header name" version specifies a user-supplied include file; the mikroC PRO
for PIC will look for the header file in the following locations, in this particular order:

1. the project folder (folder which contains the project file .mcppi)
2. the mikroC PRO for PIC installation folder » “include” folder
3. user's custom search paths

Explicit Path

By placing an explicit path in header name, only that directory will be searched. For
example:

#include "C:\my files\test.h"
Note

There is also a third version of the #include directive, rarely used, which assumes
that neither < nor “ appear as the first non-whitespace character following
#include:

#include macro identifier
It assumes that macro definition that will expand macro identifier into a valid

delimited header name with either <header name> Or "header name" formats
exists.
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Preprocessor Operators

The # (pound sign) is a preprocessor directive when it occurs as the first non-white-
space character on a line. Also, # and ## perform operator replacement and merg-
ing during the preprocessor scanning phase.

Operator #

In C preprocessor, a character sequence enclosed by quotes is considered a token
and its content is not analyzed. This means that macro names within quotes are not
expanded.

If you need an actual argument (the exact sequence of characters within quotes) as
a result of preprocessing, use the # operator in macro body. It can be placed in front
of a formal macro argument in definition in order to convert the actual argument to
a string after replacement.

For example, let's have macro 1.co prInT for printing variable name and value on
Lcd:

#define LCD PRINT (val) Lcd Custom Out Cp(#val ": "); \
Lcd Custom Out Cp (IntToStr(val));

Now, the following code,
LCD_PRINT (temp)

will be preprocessed to this:

Lcd Custom Out Cp ("temp" ": "); Lcd Custom Out Cp (IntToStr (temp));

Operator ##

Operator ## is used for token pasting. Two tokens can be pasted(merged) together
by placing ## in between them (plus optional whitespace on either side). The pre-
processor removes whitespace and # #, combining the separate tokens into one new
token. This is commonly used for constructing identifiers.

For example, see the definition of macro srr.1cE for pasting two tokens into one
identifier:

#define SPLICE(x,y) x ## _ ## y

Now, the call spL1CE (cnt, 2) will expand to the identifier cnt 2.
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Note

The mikroC PRO for PIC does not support the older nonportable method of token
pasting using (1/** /7).

Conditional Compilation

Conditional compilation directives are typically used to make source programs easy
to change and easy to compile in different execution environments. The mikroC
PRO for PIC supports conditional compilation by replacing the appropriate source-
code lines with a blank line.

All conditional compilation directives must be completed in the source or include file
in which they have begun.

Directives #if, #elif, #else and #endif

The conditional directives #if, #elif, #else, and #endif work very similar to
the common C conditional statements. If the expression you write after #if has a
nonzero value, the line group immediately following the #it directive is retained in
the translation unit.

The syntax is:

#1f constant expression 1
<section 1>

[ #elif constant expression 2
<section_ 2>]

[ #elif constant expression n
<section n>]

[ #else
<final section>]

#endif

Each #if directive in a source file must be matched by a closing #endif directive.
Any number of #c11 £ directives can appear between #i f and #endi f directives, but
at most one #c1se directive is allowed. The #c1se directive, if present, must be the
last directive before #endi .

sections can be any program text that has meaning to compiler or preprocessor.
The preprocessor selects a single section by evaluating constant expression fol-
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lowing each #if or #elif directive until it finds a true (nonzero) constant expres-
sion. The constant expressions are subject to macro expansion.

If all occurrences of constant-expression are false, or if no #<1ir directives appear,
the preprocessor selects the text block after the #e1se clause. If the #c1se clause
is omitted and all instances of constant expression in the #if block are false, no
section is selected for further processing.

Any processed section can contain further conditional clauses, nested to any depth.
Each nested #clse, #elif, or tendif directive belongs to the closest preceding
the #i £ directive.

The net result of the preceding scenario is that only one code section (possibly
empty) will be compiled.

Directives #ifdef and #ifndef

The #ifdef and #ifndef directives can be used anywhere #if can be used and
they can test whether an identifier is currently defined or not. The line

#ifdef identifier

has exactly the same effect as #if 1 if identifier is currently defined, and the
same effect as #if 0 if identifier is currently undefined. The other directive,
#1ifndef, tests true for the “not-defined” condition, producing the opposite results.

The syntax thereafter follows that of #if, #e1if, #else,and #endif.

An identifier defined as nULL is considered to be defined.
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Libraries

mikroC PRO for PIC provides a set of libraries which simplify the initialization and
use of PIC compliant MCUs and their modules:

Use Library manager to include mikroC PRO for PIC Libraries in you project.

239



CHAPTER 7
Libraries mikroC PRO for PIC

Hardware PIC-specific Libraries

- ADC Library

- CAN Library

- CANSPI Library

- Compact Flash Library

- EEPROM Library

- Ethernet PIC18FxxJ60 Library
- Flash Memory Library

- Graphic LCD Library

- I’C Library

- Keypad Library

- LCD Library

- Manchester Code Library
- Muliti Media Card Libray
- OneWire Library

- Port Expander Library

- PrintOut Library

- PS/2 Library

- PWM Library

- RS-485 Library

- Software I°C Library

- Software SPI Library

- Software UART Library

- Sound Library

- SPI Library

- SPI Ethernet Library

- SPI Graphic LCD Library
- SPI LCD Library

- SPI LCD8 Library

- SPI T6963C Graphic LCD Library
- T6963C Graphic LCD Library
- UART Library

- USB HID Library

Standard ANSI C Libraries

- ANSI C Ctype Library
- ANSI C Math Library

- ANSI C Stdlib Library
- ANSI C String Library

Miscellaneous Libraries

- Button Library

- Conversions Library
- Sprint Library

- Setjmp Library

- Time Library

- Trigonometry Library

See also Built-in Routines.
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LIBRARY DEPENDENCIES

[cANsPI J—[spI ] Certain libraries use (depend on)
function and/or variables, con-
olempe ] stants defined in other libraries.
CF_FAT16 N

Image below shows clear repre-

“+[Compact Flash | ;
Compact Flash sentation about these dependen-

LCunversiuns J—-LC_String J Cies'
[Gled |—»[Glcd_Fonts | For example, SPI _Glcd uses
Glecd_Fonts and Port_Expander
[Led J——[Lcd Constants | library which uses SPI library.
This means that if you check
[mmc ]—[sPI ] . . .
SPI_Glcd library in Library manag-
PEICE T er, all libraries on which it depends
[Mmc_FaTie | will be checked too.
eme )
[ Port_Expander ] '[ SPI ]
[Rs-485 J——+[uART ]
_~[sP1
[sPiethemet |
T String
/,vi Port_Expander |—=[sP1
SPI_Glcd N
T Glcd_Fonts
/,xi_Porl_Expander J —*LSPI J
SPI_Lcd -
\‘ Lcd_Constants
/LPoﬂ_Expander J—"[SPI J
SPI_Lcd8 -
T Lcd_Constants
T | Port_Expander ]—-[ SPI J
SPI_T6963C \
" Trigonometry |
[ Sprintf ]—-{ C_Type ]
[ Sprintl ]—»{ C_Type ]
[ Sprinti |—+[ c_Type J . .
Related topics: Library manager,
[ Te6963C |—+[ Trigonometry | PIC Libraries
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HARDWARE LIBRARIES

- ADC Library

- CAN Library

- CANSPI Library

- Compact Flash Library

- EEPROM Library

- Ethernet PIC18FxxJ60 Library
- Flash Memory Library

- Graphic Lcd Library

- 1 C Library

- Keypad Library

- Lcd Library

- Manchester Code Library
- Multi Media Card Library
- OneWire Library

- Port Expander Library

- PrintOut Library

- PS/2 Library

- PWM Library

- RS-485 Library

- Software | C Library

- Software SPI Library

- Software UART Library

- Sound Library

- SPI Library

- SPI Ethernet Library

- SPI Graphic Lcd Library
- SPI Lcd Library

- SPI Lcd8 Library

- SPI T6963C Graphic Lcd Library
- T6963C Graphic Lcd Library
- UART Library

- USB HID Library
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ADC LIBRARY

ADC (Analog to Digital Converter) module is available with a number of PIC MCU models. Library
function Abc read is included to provide you comfortable work with the module.

ADC_Read

Prototype unsigned ADC Read (unsigned short channel);

Returns 10-bit unsigned value read from the specified channel.

Initializes PIC’s internal ADC module to work with RC clock. Clock determines
the time period necessary for performing AD conversion (min 12TAD).
Description Parameter channel represents the channel from which the analog value is to be
acquired. Refer to the appropriate datasheet for channel-to-pin mapping.

Requires Nothing.

unsigned tmp;
Example S
tmp = ADC Read(2); // Read analog value from channel 2

Library Example

This example code reads analog value from channel 2 and displays it on PORTB and PORTC.
unsigned int temp res;

void main () {

ANSEL = 0x04; // Configure AN2 pin as analog
TRISA = OxFF; // PORTA is input
ANSELH = 0; // Configure other AN pins as digital I/O
TRISC = 0x3F; // Pins RC7, RC6 are outputs
TRISB = 0; // PORTB is output
do {
temp res = ADC Read(2); // Get 10-bit results of AD conversion
PORTB = temp res; // Send lower 8 bits to PORTB
PORTC = temp res >> 2; // Send 2 most significant bits to RC7, RC6
} while (1) ;

MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD 243



CHAPTER 7
Libraries mikroC PRO for PIC

HW Connection
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ADC HW connection

CAN LIBRARY

mikroC PRO for PIC provides a library (driver) for working with the CAN module.
CAN is a very robust protocol that has error detection and signalling, self-checking
and fault confinement. Faulty CAN data and remote frames are re-transmitted auto-
matically, similar to the Ethernet.

Data transfer rates vary from up to 1 Mbit/s at network lengths below 40m to 250
Kbit/s at 250m cables, and can go even lower at greater network distances, down
to 200Kbit/s, which is the minimum bitrate defined by the standard. Cables used are
shielded twisted pairs, and maximum cable length is 1000m.

CAN supports two message formats:

B Standard format, with 11 identifier bits, and
B Extended format, with 29 identifier bits

Note: CAN Library is supported only by MCUs with the CAN module.

Note: Consult the CAN standard about CAN bus termination resistance.
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Library Routines

CANSetOperationMode
CANGetOperationMode
CANInitialize
CANSetBaudRate
CANSetMask
CANSetFilter

CANRead

CANWrite

Following routines are for the internal use by compiler only:

B RegsToCANID
B CANIDToRegs

Be sure to check CAN constants necessary for using some of the functions.

CANSetOperationMode

void CANSetOperationMode (unsigned short mode, unsigned short
Prototype TR

wait flag);
Returns Nothing.

Sets CAN to requested mode, i.e. copies mode to CANSTAT. Parameter mode
needs to be one of can or MoDE constants (see CAN constants).

Parameter wait flag needs to be either O or OxFF:

Description B If set to OxFF, this is a blocking call — the function won'’t “return” until the
requested mode is set.

B If O, this is a non-blocking call. It does not verify if CAN module is switched to
requested mode or not. Caller must use cANGetOperationMode to verify cor-
rect operation mode before performing mode specific operation.

CAN routines are currently supported only by P18XXX8 PIC MCUs. Microcon-
Requires troller must be connected to CAN transceiver (MCP2551 or similar) which is
connected to CAN bus.

Example CANSetOperationMode ( CAN MODE CONFIG, OxFF);
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CANGetOperationMode
Prototype unsigned short CANGetOperationMode () ;

Returns Current opmode.

Description |Function returns current operational mode of CAN module.

CAN routines are currently supported only by P18XXX8 PIC MCUs. Microcon-
Requires troller must be connected to CAN transceiver (MCP2551 or similar) which is
connected to CAN bus.

Example if (CANGetOperationMode() == CAN MODE NORMAL) { ... };
CANiInitialize

void CANInitialize (char SJW, char BRP, char PHSEG1l, char PHSEGZ2,
Prototype

char PROPSEG, char CAN CONFIG FLAGS);

Returns Nothing.

Initializes CAN. All pending transmissions are aborted. Sets all mask registers to 0 to
allow all messages. The Config mode is internaly set by this function. Upon a execu-
tion of this function Normal mode is set. Filter registers are set according to flag value:

if (CAN CONFIG FLAGS & CAN CONFIG VALID XTD MSG != 0)
// Set all filters to XTD MSG
else if (config & CAN CONFIG VALID STD MSG != 0)

// Set all filters to STD MSG

Description |S15€ .
// Set half the filters to STD, and the rest to XTD MSG

Parameters:

saw as defined in 18XXX8 datasheet (1-4)

BrP as defined in 18XXX8 datasheet (1-64)

pHSEGT as defined in 18XXX8 datasheet (1-8)

pHSEG2 as defined in 18XXX8 datasheet (1-8)

prROPSEG as defined in 18XXX8 datasheet (1-8)

CAN CONFIG FLAGS is formed from predefined constants (see CAN constants)

CAN routines are currently supported only by P18XXX8 PIC MCUs. Microcon-
Requires troller must be connected to CAN transceiver (MCP2551 or similar) which is con-
nected to CAN bus.

init = CAN CONFIG SAMPLE THRICE &
CAN CONFIG PHSEG2 PRG ON &
CAN CONFIG STD MSG &
CAN CONFIG DBL BUFFER ON &
CAN CONFIG VALID XTD MSG &
CAN CONFIG LINE FILTER OFF;

Example

CANInitialize(1, 1, 3, 3, 1, init); // initialize CAN
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CANSetBoudRate
Prokﬂype void CANSetBaudRate (char SJW, char BRP, char PHSEGl, char PHSEGZ2,

char PROPSEG, char CAN CONFIG FLAGS);

Returns Nothing.

Sets CAN baud rate. Due to complexity of CAN protocol, you cannot simply force
a bps value. Instead, use this function when CAN is in Config mode. Refer to
datasheet for details.

Parameters:

Description | g ./ 45 defined in 18XXX8 datasheet (1-4)
B erp as defined in 18XXX8 datasheet (1-64)
B rusecl as defined in 18XXX8 datasheet (1-8)
B pusec2 as defined in 18XXX8 datasheet (1-8)
B proprseG as defined in 18XXX8 datasheet (1-8)

B can conrIG FLAGS is formed from predefined constants (see CAN constants)

CAN must be in Config mode; otherwise the function will be ignored.
CAN routines are currently supported only by P18XXX8 PIC MCUs. Microcon-

Requires troller must be connected to CAN transceiver (MCP2551 or similar) which is con-
nected to CAN bus.
init = CAN CONFIG_SAMPLE THRICE &
_CAN CONFIG PHSEG2 PRG ON &
_CAN_CONFIG_STD MSG &
CAN CONFIG DBL BUFFER ON &
Example - - - = -

~CAN CONFIG VALID XTD MSG &
_CAN CONFIG LINE FILTER OFF;

CANSetBRaudRate (1, 1, 3, 3, 1, init);
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CANSetMask
Proknype void CANSetFilter (char CAN FILTER, long value, char

CAN CONFIG FLAGS) ;

Returns Nothing.

Function sets mask for advanced filtering of messages. Given va1lue is bit adjust-
ed to appropriate buffer mask registers.

Parameters:
Description
B can Mask is one of predefined constant values (see CAN constants)
B va=lue is the mask register value

B CAN CONFIG FLAGS selects type of message to filter, either
_CAN _CONFIG_XTD MSG or _CAN CONFIG STD MSG

CAN must be in Config mode; otherwise the function will be ignored.
Requires CAN routines are currently supported only by P18XXX8 PIC MCUs. Microcontroller must
be connected to CAN transceiver (MCP2551 or similar) which is connected to CAN bus.

// Set all mask bits to 1, i.e. all filtered bits are relevant:
CANSetMask ( CAN MASK B1, -1, CAN CONFIG XTD MSG) ;

Example // Note that -1 is just a cheaper way to write OxFFFFFFFF.
Complement will do the trick and fill it up with ones.
CANSetFilter
Prototype void CANSetFilter (char CAN FILTER, long value, char
yp CAN CONFIG FLAGS) ;

Returns Nothing.
Function sets message filter. Given value is bit adjusted to appropriate buffer
mask registers.
Parameters:

Description

B can FILTER iS one of predefined constant values (see CAN constants)
B value is the filter register value

B can CcONFIG FLAGS selects type of message to filter, either
_CAN CONFIG XTD MSG or CAN CONFIG STD MSG

CAN must be in Config mode; otherwise the function will be ignored.
Requires CAN routines are currently supported only by P18XXX8 PIC MCUs. Microcontroller must be
connected to CAN transceiver (MCP2551 or similar) which is connected to CAN bus.

// Set id of filter Bl F1 to 3:

Example CANSetFilter ( CAN FILTER B1 F1, 3, CAN CONFIG XTD MSG);
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CANRead
Protot char CANRead(long *id, char *data, char *datalen, char
rototype 1. CAN RX MSG FLAGS) ;

Returns Message from receive buffer or zero if no message found.
Function reads message from receive buffer. If at least one full receive buffer is found, it is
extracted and retumed. If none found, function retums zero. Parameters:

Description id is message identifier

data is an array of bytes up to 8 bytes in length
datalen is data length, from 1-8.

]
]
u
B CAN RX MSG FLAGS is value formed from constants (see CAN constants)

CAN must be in mode in which receiving is possible.
Requires CAN routines are currently supported only by P18XXX8 PIC MCUs. Microcontroller must be
connected to CAN transceiver (MCP2551 or similar) which is connected to CAN bus.

char rcv, rx, len, datdl 8] ;

long id;
Example e
rx = 0;
VA
rcv = CANRead(id, data, len, rx);
CANWrite
Protot unsigned short CANWrite (long id, char *data, char datalen, char
rototype CAN TX MSG FLAGS) ;
Returns Returns zero if message cannot be queued (buffer full).
If at least one empty transmit buffer is found, function sends message on queue
for transmission. If buffer is full, function returns 0.
Parameters:
Description id is CAN message identifier. Only 11 or 29 bits may be used depending on

message type (standard or extended)
B data is array of bytes up to 8 bytes in length
B datalen is data length from 1-8
B CAN TX MSG FLAGS is value formed from constants (see CAN constants)

CAN must be in Normal mode.
Requires CAN routines are currently supported only by P18XXX8 PIC MCUs. Microcontroller must be
connected to CAN transceiver (MCP2551 or similar) which is connected to CAN bus.

char tx, data;

long id;
/..
Example tx = CAN TX PRIORITY 0 &

_CAN TX XTD FRAME;
/] ...
CANWrite (id, data, 2, tx);
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CAN Constants

There is a number of constants predefined in CAN library. To be able to use the
library effectively, you need to be familiar with these. You might want to check the
example at the end of the chapter.

CAN_OP_MODE

can op MODE  constants define CAN  operation mode. Function
CANSetOperationMode expects one of these as its argument:

const char

_CAN MODE BITS = 0xEO, // Use this to access opmode Dbits
_CAN_MODE_NORMAL = 0x00,
_CAN MODE_SLEEP = 0x20,
_CAN _MODE_LOOP = 0x40,

_CAN _MODE_LISTEN = 0x60,
_CAN _MODE_CONFIG = 0x80;

CAN_CONFIG_FLAGS

caN coNFIG FLAGS constants define flags related to CAN module configuration.
Functions canTnitialize and CaANSetBaudRate expect one of these (or a bitwise
combination) as their argument:

const char

_CAN_CONFIG DEFAULT 0xFF, // 11111111
_CAN CONFIG PHSEG2 PRG BIT 0x01,

_CAN CONFIG PHSEG2 PRG ON 0xFF, // XXXXXXX1
_CAN _CONFIG PHSEG2 PRG OFF 0xFE, // XXXXXXXO0

_CAN CONFIG LINE FILTER BIT = 0x02,

_CAN _CONFIG LINE FILTER ON 0xFF, // XXXXXX1X
_CAN _CONFIG LINE FILTER OFF = OxFD, // XXXXXX0X
_CAN CONFIG SAMPLE BIT 0x04,

_CAN CONFIG_SAMPLE ONCE OxFF, // XXXXX1IXX
_CAN CONFIG SAMPLE THRICE 0xFB, [/ XXXXXOXX
_CAN CONFIG MSG_TYPE BIT 0x08,

_CAN _CONFIG STD MSG OxFF, // XXXXIXXX
_CAN CONFIG_XTD MSG 0xF7, // XXXX0XXX
_CAN CONFIG DBL BUFFER BIT 0x10,

_CAN CONFIG DBL BUFFER ON OxFF, // XXXLXXXX
_CAN _CONFIG DBL BUFFER OFF = OxEF, // XXXOXXXX
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_CAN_CONFIG MSG BITS = 0x60,
_CAN CONFIG ALL MSG = OxFF, // X11XXXXX
_CAN_CONFIG VALID XTD MSG = 0xDF, // X1OXXXXX
_CAN_CONFIG VALID STD MSG = O0xBF, // XO1XXXXX
_CAN _CONFIG ALL VALID MSG = 0x9F; // XOOXXXXX

You may use bitwise AND (&) to form config byte out of these values. For example:

init = CAN CONFIG_SAMPLE THRICE &
_CAN CONFIG PHSEG2 PRG ON &
_CAN_CONFIG STD_MSG &
_CAN _CONFIG DBL BUFFER ON &
_CAN CONFIG VALID XTD MSG &
_CAN CONFIG LINE FILTER OFF;

CANInitialize(1, 1, 3, 3, 1, init); // initialize CAN

CAN_TX_MSG_FLAGS

caN Tx MSG FLAGS are flags related to transmission of a CAN message:

const char
_CAN TX PRIORITY BITS = 0x03,

_CAN_TX PRIORITY O = OxFC, // XXXXXX00
_CAN TX PRIORITY 1 = O0xFD, // XXXXXX01
_CAN _TX PRIORITY 2 = OxFE, [/ XXXXXX10
_CAN_TX PRIORITY 3 = OxFF, // XXXXXX11
_CAN TX FRAME BIT = 0x08,

_CAN TX STD FRAME = OxFF, // XXXXX1XX
_CAN_TX XTD FRAME = 0xF7, // XXXXX0XX
_CAN TX RTR BIT = 0x40,

_CAN_TX NO RTR_FRAME OxFF, // XLXXXXXX
_CAN_TX RTR_FRAME = OxBF; // XOXXXXXX

You may use bitwise AND (s) to adjust the appropriate flags. For example:

// form value to be used with CANSendMessage:
send_config = CAN TX PRIORITY 0 &

_CAN TX XTD FRAME &

_CAN TX NO_RTR_FRAME;

CANSendMessage (id, data, 1, send config);
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CAN_RX_MSG_FLAGS

CAN Rx MsG FLAGS are flags related to reception of CAN message. If a particular bit is set; cor-
responding meaning is TRUE or else it will be FALSE.

const char

_CAN RX FILTER BITS = 0x07, // Use this to access filter bits
_CAN RX FILTER 1 = 0x00,

_CAN RX FILTER 2 = 0x01,

_CAN RX FILTER 3 = 0x02,

_CAN RX FILTER 4 = 0x03,

_CAN RX FILTER 5 = 0x04,

_CAN RX FILTER 6 = 0x05,

_CAN RX OVERFLOW = 0x08, // Set if Overflowed else cleared
_CAN RX_INVALID MSG = 0x10, // Set if invalid else cleared
_CAN RX XTD FRAME = 0x20, // Set if XTD message else cleared
_CAN RX RTR FRAME = 0x40, // Set if RIR message else cleared

_CAN RX DBL BUFFERED = 0x80; // Set if this message was hard
ware double-buffered

You may use bitwise AND () to adjust the appropriate flags. For example:
if (MsgFlag & CAN RX OVERFLOW != 0) {

// Receiver overflow has occurred.
// We have lost our previous message.

CAN_MASK

can Mask constants define mask codes. Function CANSetMask expects one of
these as its argument:

#const char
_CAN MASK_B1

_CAN MASK B2 = 1;

Il
o
<

CAN_FILTER

caN FILTER constants define filter codes. Function cansetrilter expects one of these as its
argument:

const char
_CAN FILTER Bl F1
_CAN FILTER Bl F2
_CAN FILTER B2 F1
_CAN FILTER B2 F2

Il
~

~

~

I
w N = O

~
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_CAN FILTER B2 F3
_CAN FILTER B2 F4 =
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Library Example

This is a simple demonstration of CAN Library routines usage. First node initiates
the communication with the second node by sending some data to its address. The
second node responds by sending back the data incremented by 1. First node then
does the same and sends incremented data back to second node, etc.

Code for the first CAN node:

unsigned char Can Init Flags, Can Send Flags, Can Rcv Flags; // can flags

unsigned char Rx Data Len;

char RxTx Datal 8] ;

char Msg Rcvd;

const long ID 1st = 12111, ID 2nd = 3;
long Rx ID;

void main () {

PORTC
TRISC

0;
0;

Can Init Flags = 0
Can Send Flags = 0;
Can Rcv Flags = 0

Can Send Flags = CAN TX PRIORITY 0 &
_CAN TX XTD FRAME &

// received data length in bytes
// can rx/tx data buffer

// reception flag

// node IDs

// clear PORTC
// set PORTC as output

//
// clear flags
//

// form value to be used
// with CANWrite

_CAN_TX NO RTR FRAME;

Can Init Flags = CAN CONFIG SAMPLE THRICE & // form value to be used
_CAN CONFIG PHSEG2 PRG ON & // with CANInit
_CAN CONFIG XTD MSG &
_CAN CONFIG DBL BUFFER ON &
_CAN CONFIG VALID XTD MSG;

CANInitialize(1,3,3,3,1,Can_Init Flags); // Initialize CAN module
CANSetOperationMode ( CAN MODE CONFIG,O0xFF); // set CONFIGURATION mode
CANSetMask (_ CAN MASK B1,-1, CAN CONFIG XTD MSG); // set all maskl bits to

ones

CANSetMask (_CAN MASK B2,-1, CAN CONFIG XTD MSG); // set all mask2 bits to

ones

CANSetFilter ( CAN FILTER B2 F4,ID 2nd, CAN CONFIG XTD MSG);// set id of

filter B2 F4 to 2nd node ID

CANSetOperationMode ( CAN MODE NORMAL, OxFF) ; // set NORMAL mode

RxTx Datal 0] = 9;

// set initial data to be sent
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CANWrite (ID 1st, RxTx Data, 1, Can Send Flags); // send initial message

while (1) { // endless loop
Msg Rcvd = CANRead (&Rx ID , RxTx Data , &Rx Data Len, &Can Rcv Flags); //
receive message

if ((Rx ID == ID 2nd) && Msg Rcvd) { // if message received check id
PORTC RxTx Datal 0] ; // id correct, output data at PORTC
RxTx Datal 0] ++; // increment received data
Delay ms(10);

CANWrite (ID 1st, RxTx Data, 1, Can Send Flags); // send incremented data back
}
}

Code for the second CAN node:

unsigned char Can Init Flags, Can Send Flags, Can Rcv Flags; // can

flags

unsigned char Rx Data Len; // received data length in bytes
char RxTx Datal 8] ; // can rx/tx data buffer

char Msg Rcvd; // reception flag

const long ID 1st = 12111, ID 2nd = 3; // node IDs
long Rx ID;

void main () {

PORTC
TRISC

0; // clear PORTC
0; // set PORTC as output

Can Init Flags = 0; !/
Can_Send Flags = 0; // clear flags
Can Rcv _Flags = 0; //

Can_Send Flags = CAN TX PRIORITY 0 & // form value to be used
_CAN_TX_XTD_FRAME & // with CANWrite
_CAN TX NO RTR_FRAME;

Can Init Flags = CAN CONFIG SAMPLE THRICE & // form value to be used
_CAN CONFIG PHSEG2 PRG ON & // with CANInit
_CAN CONFIG XTD MSG &
_CAN CONFIG DBL BUFFER ON &
_CAN CONFIG VALID XTD MSG &
_CAN _CONFIG LINE FILTER OFF;

CANInitialize(1,3,3,3,1,Can Init Flags); // initialize external CAN module

CANSetOperationMode ( CAN MODE CONFIG,OxFF); // set CONFIGURATION mode

CANSetMask (_CAN MASK Bl,-1, CAN CONFIG XTID MSG); // set all maskl
bits to ones
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CANSetMask ( CAN MASK B2,-1, CAN CONFIG XTD MSG); // set all mask2

bits to ones
CANSetFilter( CAN FILTER B2 F3,ID lst, CAN CONFIG XTD MSG);// set

id of filter B2 F3 to 1st node ID

CANSetOperationMode (_CAN MODE NORMAL, OxFF); // set NORMAL mode

while (1) { // endless loop
Msg Rcvd = CANRead(&Rx ID , RxTx Data , &Rx Data Len,
&Can_Rcv_Flags); // receive message
if ((Rx ID == ID 1st) && Msg Rcvd) { // if message received check id
PORTC = RxTx Datal 0] ; // id correct, output data at PORTC
RxTx Data[ 0] ++; // increment received data

CANWrite (ID 2nd, RxTx Data, 1, Can Send Flags); // send incre-
mented data back
}

HW Connection
= CAN RX of MCU
——» CAN TX of MCU
10R D
1 LS B
] tx-can rs [—
I”—zf GHND CANH ]?7
vee  [lvee eane [o—
fRap wer [
MCP2551
Shielded L{
twisted pair |

Example of interfacing CAN transceiver with MCU and bus
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CANSPI LIBRARY

The SPI module is available with a number of the PIC compliant MCUs. The mikroC
PRO for PIC provides a library (driver) for working with mikroElektronika's CANSPI
Add-on boards (with MCP2515 or MCP2510) via SPI interface.

The CAN is a very robust protocol that has error detection and signalization,
self-checking and fault confinement. Faulty CAN data and remote frames are re-
transmitted automatically, similar to the Ethernet.

Data transfer rates depend on distance. For example, 1 Mbit/s can be achieved at net-
work lengths below 40m while 250 Kbit/s can be achieved at network lengths below
250m. The greater distance the lower maximum bitrate that can be achieved. The lowest
bitrate defined by the standard is 200Kbit/s. Cables used are shielded twisted pairs.

CAN supports two message formats:

B Standard format, with 11 identifier bits; and
B Extended format, with 29 identifier bits.

Note:

B Consult the CAN standard about CAN bus termination resistance.

B An effective CANSPI communication speed depends on SPI and certainly is
slower than “real” CAN.

B The library uses the SPI module for communication. User must initialize SPI
module before using the SPI Graphic Lcd Library.
For MCUs with two SPI modules it is possible to initialize both of them and then
switch by using the sp1 set Active () routine.

B CANSPI module refers to mikroElektronika's CANSPI Add-on board connected
to SPI module of MCU.

External dependecies of CANSPI Library

The following variables

must be defined in all

projects using CANSPI
Library:

Description: Example:

extern sfr sbit
CanSpi CS;

sbit CanSpi CS at
RCO _bit;

sbit CanSpi Rst at

Chip Select line.

extern sfr sbit .
Reset line.

CanSpi Rst; RC2 bit;
extern sfr sbit Direction of the Chip sbit CanSpi CS Direction
CanSpi CS Direction; Select pin. at TRISCO bit;

extern sfr sbit
CanSpi Rst Direction;

sbit CanSpi Rst Direction

Direction of the Reset pin. at TRISC2 bits
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Library Routines

- CANSPISetOperationMode
- CANSPIGetOperationMode
- CANSPIInitialize

- CANSPISetBaudRate

- CANSPISetMask

- CANSPISetFilter

- CANSPIread

- CANSPIWrite

The following routines are for an internal use by the library only:

- RegsToCANSPIID
- CANSPIIDToRegs

Be sure to check CANSPI constants necessary for using some of the functions.
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CANSPISetOperationMode

Prokﬂype void CANSPISetOperationMode (char mode, char WAIT);

Returns Nothing.

Sets the CANSPI module to requested mode.
Parameters:

- mode: CANSPI module operation mode. Valid values: canspI op MODE con-
Description |stants (see CANSPI constants).

- warT: CANSPI mode switching verification request. If watT == 0, the call is non-
blocking. The function does not verify if the CANSPI module is switched to
requested mode or not. Caller must use caNsPIGetOperationMode to verify cor-
rect operation mode before performing mode specific operation. If watT = 0, the
call is blocking — the function won’t “return” until the requested mode is set.

The CANSPI routines are supported only by MCUs with the SPI module.
Requires MCU has to be properly connected to mikroElektronika's CANSPI Extra Board or
similar hardware. See connection example at the bottom of this page.

// set the CANSPI module into configuration mode (wait inside
Example CANSPISetOperationMode until this mode is set)
CANSPiSetOperationMode(7CANSPL7MODE7CONBLG, O0xXFF) ;

CANSPIGetOperationMode

Prototype char CANSPIGetOperationMode () ;

Returns Current operation mode.

The function returns current operation mode of the CANSPI module. Check can-
Description |sr1 or MoDE constants (see CANSPI constants) or device datasheet for opera-
tion mode codes.

The CANSPI routines are supported only by MCUs with the SPI module.
Requires MCU has to be properly connected to mikroElektronika's CANSPI Extra Board or
similar hardware. See connection example at the bottom of this page.

// check whether the CANSPI module is in Normal mode and if it
is do something.
Example if (CANSPIGetOperationMode () == CANSPI MODE NORMAL) {

}
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CANSPIinitialize

void CANSPIInitialize( char SJW, char BRP, char PHSEGl, char

PrOtOtype PHSEG2, char PROPSEG, char CANSPI CONFIG FLAGS);

Returns Nothing.

Initializes the CANSPI module.
Stand-Alone CAN controller in the CANSPI module is set to:

- Disable CAN capture

- Continue CAN operation in Idle mode

- Do not abort pending transmissions

- Fcan clock: 4*Tey (Fosc)

- Baud rate is set according to given parameters

- CAN mode: Normal

- Filter and mask registers IDs are set to zero

- Filter and mask message frame type is set according to can conric FLAGS value
Description
SAM, SEG2PHTS, WAKFIL and DBEN bits are setaccording to CANSPT CONFIG FIAGS value.

Parameters:

- sgw as defined in CAN controller's datasheet

- BrP as defined in CAN controller's datasheet

- pHSEG1 as defined in CAN controller's datasheet

- pHSEG2 as defined in CAN controller's datasheet

- proPsEG as defined in CAN controller's datasheet

- caN coNFIG FLAGS is formed from predefined constants (see CANSPI con-
stants)

Global variables:

- Canspi cs: Chip Select line

- Ccanspi rst: Resetline

- Canspi CS Direction: Direction of the Chip Select pin
- Canspi Rst Direction: Direction of the Reset pin
Requires must be defined before using this function.

The CANSPI routines are supported only by MCUs with the SPI module.

The SPI module needs to be initialized. See the SPI1_Init and
SPI1_Init_Advanced routines.

MCU has to be properly connected to mikroElektronika's CANSPI Extra Board or sim-
ilar hardware. See connection example at the bottom of this page.
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// CANSPI module connections

sbit CanSpi CSs at RCO bit;

sbit CanSpi CS Direction at TRISCO bit;
sbit CanSpi Rst at RC2 bit;

sbit CanSpi Rst Direction at TRISC2 bit;
// End CANSPI module connections

// initialize the CANSPI module with the appropriate baud rate
and message acceptance flags along with the sampling rules
char CanSPi Init Flags;
Example CanSPi Init Flags = CANSPI CONFIG SAMPLE THRICE & // form
value to be used

_CANSPI CONFIG PHSEG2 PRG ON & // with

CANSPIInitialize
_CANSPI CONFIG XTD MSG &
_CANSPI CONFIG DBL BUFFER ON &
_CANSPI CONFIG VALID XTD MSG;
SPI1 Init(); // initialize SPI module
CANSPIInitialize(1,3,3,3,1,CanSpi Init Flags); // initialize

external CANSPI module
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CANSPISetBaudRate

void CANSPISetBaudRate( char SJW, char BRP, char PHSEG1l, char
PHSEG2, char PROPSEG, char CANSP17CONFIGiFLAGS);

Prototype

Returns Nothing.

Sets the CANSPI module baud rate. Due to complexity of the CAN protocol,
you can not simply force a bps value. Instead, use this function when the
CANSPI module is in Config mode.

saM, SEG2pPHTS and wakrIL bits are set according to CANSPT CONFIG FLAGS
value. Refer to datasheet for details.

Description |[Parameters:

- sgw as defined in CAN controller's datasheet

- Brp as defined in CAN controller's datasheet

- pHSEG1 as defined in CAN controller's datasheet

- pHSEG2 as defined in CAN controller's datasheet

- proPSEG as defined in CAN controller's datasheet

- CAN CONFIG FLAGS is formed from predefined constants (see CANSPI constants)

The CANSPI module must be in Config mode, otherwise the function will be
ignored. See CANSPISetOperationMode.

Requires The CANSPI routines are supported only by MCUs with the SPI module.

MCU has to be properly connected to mikroElektronika's CANSPI Extra Board or
similar hardware. See connection example at the bottom of this page.

// set required baud rate and sampling rules
char canspi config flags;

CANSPISetOperationMode (CANSPI_MODE CONFIG,O0xFF); // set CONFIGU-
RATION mode (CANSPI module mast be in config mode for baud rate

settings)
Example canspi config flags = CANSPI CONFIG_SAMPLE THRICE &
_CANSPI CONFIG_PHSEG2 PRG ON &
_CANSPI CONFIG_STD MSG &

_CANSPI CONFIG DBL BUFFER ON &

_CANSPI CONFIG VALID XTD MSG &

_CANSPI CONFIG LINE FILTER OFF;
CANSPISetBaudRate(l, 1, 3, 3, 1, canspi config flags);
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CANSPISetMask

void CANSPISetMask (char CANSPI MASK, long val, char CANSPI CON-

Prototype FIG_FLAGS) ;

Returns Nothing.

Configures mask for advanced filtering of messages. The parameter value is
bit-adjusted to the appropriate mask registers.

Parameters:

- can_mask: CANSPI module mask number. Valid values: cansp1 Mask costants
(see CANSPI constants)

Description |- va1: mask register value

- CAN CONFIG FLAGS: selects type of message to filter. Valid values:

CANSPI CONFIG _ALL VALID MSG,
CANSPI_CONFIG MATCH MSG TYPE and CANSPI CONFIG STD MSG,

CANSPI CONFIG _MATCH MSG_TYPE and CANSPI CONFIG_XTD MSG.

(see CANSPI constants)

The CANSPI module must be in Config mode, otherwise the function will be
ignored. See CANSPISetOperationMode.

Requires The CANSPI routines are supported only by MCUs with the SPI module.

MCU has to be properly connected to mikroElektronika's CANSPI Extra Board or
similar hardware. See connection example at the bottom of this page.

// set the appropriate filter mask and message type value
CANSPISetOperationMode ( CANSPI MODE CONFIG, OxFF) ;

// set CONFIGURATION mode (CANSPI module must be in config mode
for mask settings)

Exan“ﬂe // Set all Bl mask bits to 1 (all filtered bits are relevant):
// Note that -1 is just a cheaper way to write OxFFFFFFFF.

// Complement will do the trick and fill it up with ones.
CANSPISetMask( CANSPI MASK Bl, -1, CANSPI CONFIG MATCH MSG TYPE
& CANSPI CONFIG XTD MSG);
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CANSPISetFilter

void CANSPISetFilter (char CANSPI FILTER, long val, char

Prototype CANSPI_CONFIG FLAGS) ;

Returns Nothing.

Configures message filter. The parameter va1ue is bit-adjusted to the appropri-
ate filter registers.

Parameters:

- can rILTER: CANSPI module filter number. Valid values: canspr FILTER
constants (see CANSPI constants)

Description |- . 1: filter register value

- CAN CONFIG FLAGS: selects type of message to filter. Valid values:

CANSPI CONFIG ALL VALID MSG,
CANSPI CONFIG MATCH MSG TYPE and CANSPI CONFIG STD MSG,

CANSPI CONFIG MATCH MSG_TYPE and CANSPI CONFIG XTD MSG.

(see CANSPI constants)

The CANSPI module must be in Config mode, otherwise the function will be
ignored. See CANSPISetOperationMode.

Requires The CANSPI routines are supported only by MCUs with the SPI module.

MCU has to be properly connected to mikroElektronika's CANSPI Extra Board or
similar hardware. See connection example at the bottom of this page.

// set the appropriate filter value and message type
CANSPISetOperationMode ( CANSPI MODE CONFIG, OxFF) ;

// set CONFIGURATION mode (CANSPI module must be in config mode
for filter settings

Example 9s)
/* Set id of filter Bl F1 to 3: */
CANSPISetFilter ( CANSPI FILTER Bl F1, 3, CANSPI_CONFIG XTD MSG);
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CANSPIRead
Prototype char CANSPIRead(long *id, char *rd data, char *data len, char

*CANSPI RX MSG_FLAGS) ;

- 0 if nothing is received

Returns - oxrr if one of the Receive Buffers is full (message received)

If at least one full Receive Buffer is found, it will be processed in the following
way:

- Message ID is retrieved and stored to location provided by the id parameter
- Message data is retrieved and stored to a buffer provided by the rd data parameter
- Message length is retrieved and stored to location provided by the
data len parameter
Description |- Message flags are retrieved and stored to location provided by the
CAN RX MSG FLAGS parameter

Parameters:

- id: message identifier storage address

- rd data: data buffer (an array of bytes up to 8 bytes in length)
- data len: data length storage address.

- CAN RX MSG FLAGS: message flags storage address

The CANSPI module must be in a mode in which receiving is possible. See
CANSPISetOperationMode.

Requires The CANSPI routines are supported only by MCUs with the SPI module.

MCU has to be properly connected to mikroElektronika's CANSPI Extra Board or
similar hardware. See connection example at the bottom of this page.

// check the CANSPI module for received messages. If any was
received do something.

char msg rcvd, rx flags, data len;

char datal 8] ;

long msg id;

CANSPISetOperationMode (CA NSPI MODE NORMAL, 0XFF) ;
Example // set NORMAL mode (CANSPI module must be in mode in which
receive is possible)

rx flags = 0;
// clear message flags

if (msg rcvd = CANSPIRead(msg id, data, data len, rx flags)) {

}
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CANSPIWrite
Protot char CANSPIWrite(long id, char *wr data, char data len, char CAN-
rototype SPI TX MSG FLAGS);
Returns - 0 if all Transmit Buffers are busy
- 0xrF if at least one Transmit Buffer is available

If at least one empty Transmit Buffer is found, the function sends message in

the queue for transmission.

Parameters:
Description

- id: CAN message identifier. Valid values: 11 or 29 bit values, depending on
message type (standard or extended)

-wr data: data to be sent (an array of bytes up to 8 bytes in length)

- data len: data length. Valid values: 1 to 8

- CAN RX MSG FLAGS: message flags

The CANSPI module must be in mode in which transmission is possible. See
CANSPISetOperationMode.

Requires The CANSPI routines are supported only by MCUs with the SPI module.

MCU has to be properly connected to mikroElektronika's CANSPI Extra Board or
similar hardware. See connection example at the bottom of this page.

// send message extended CAN message with the appropriate ID and
data

char tx flags;

char datal 8] ;

long msg id;

CANSPISetOperationMode ( CANSPI MODE NORMAL, OxFF) ;
// set NORMAL mode (CANSPI must be in mode in which transmission
is possible)

Example

tx flags = CANSPI TX PRIORITY O & CANSPI TX XTD FRAME;
// set message flags
CANSPIWrite (msg id, data, 2, tx flags);
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CANSPI Constants

There is a number of constants predefined in the CANSPI library. You need to be
familiar with them in order to be able to use the library effectively. Check the exam-
ple at the end of the chapter.

CANSPI_OP_MODE

The cansp1 orp moDE constants define CANSPI operation mode. Function
CANSPISetOperationMode expects one of these as it's argument:

const char

_CANSPI MODE BITS = 0xEOQ, // Use this to access opmode bits
_CANSPI_MODE NORMAL = 0x00,
_CANSPI MODE SLEEP = 0x20,
_CANSPI MODE _LOOP = 0x40,

_CANSPI_MODE_LISTEN = 0x60,
_CANSPI_MODE_CONFIG = 0x80;

CANSPI_CONFIG_FLAGS

The canspI conrIG FLAGS constants define flags related to the CANSPI module
configuration. The functions  CANSPIInitialize, CANSPISetBaudRate,
CANSPISetMask and CANSPISetFilter expect one of these (or a bitwise combina-
tion) as their argument:

const char

_CANSPI CONFIG DEFAULT = OxFF, // 11111111
_CANSPI CONFIG PHSEG2 PRG BIT = 0x01,

_CANSPI _CONFIG PHSEG2 PRG ON = OxFF, // XXXXXXX1
_CANSPI CONFIG PHSEG2 PRG OFF = O0xFE, // XXXXXXXO0

_CANSPI_CONFIG LINE FILTER BIT = 0x02,

_CANSPI CONFIG LINE FILTER ON = OxFF, [/ XXXXXX1X
_CANSPI CONFIG LINE FILTER OFF = OxFD, // XXXXXX0X
_CANSPI CONFIG SAMPLE BIT = 0x04,

_CANSPI CONFIG SAMPLE ONCE = OxFF, // XXXXX1XX
_CANSPI CONFIG SAMPLE THRICE = OxFB, // XXXXXO0XX
_CANSPI CONFIG MSG_TYPE BIT = 0x08,

_CANSPI CONFIG_STD MSG = OxFF, // XXXXLXXX
_CANSPI CONFIG XTD MSG = 0xF7, // XXXX0XXX
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_CANSPI_CONFIG DBL BUFFER BIT = 0x10,

_CANSPI_CONFIG DBL BUFFER ON = OxFF, // XXXLIXXXX
_CANSPI_CONFIG DBL BUFFER OFF = OxEF, // XXXOXXXX
_CANSPI_CONFIG MSG BITS = 0x60,

_CANSPI CONFIG ALL MSG = OxFF, // X1IXXXXX
_CANSPI_CONFIG VALID XTD MSG = O0xDF, // XLOXXXXX
_CANSPI CONFIG VALID STD MSG = OxBF, // XO1XXXXX
_CANSPI CONFIG ALL VALID MSG = 0x9F; // X0O0XXXXX

You may use bitwise AND (&) to form config byte out of these values. For example:

init = CANSPI_CONFIG SAMPLE THRICE &
_CANSPI CONFIG PHSEG2 PRG ON &
_CANSPI_CONFIG STD MSG &
_CANSPI_CONFIG DBL BUFFER ON &
_CANSPI_CONFIG VALID XTD MSG &
_CANSPI_CONFIG LINE FILTER OFF;

CANSPIInitialize(1l, 1, 3, 3, 1, init); // initialize CANSPI

CANSPI_TX_MSG_FLAGS

canspI Tx MsG FLAGS are flags related to transmission of a CAN message:

const char
_CANSPI TX PRIORITY BITS = 0x03,

_CANSPI TX PRIORITY 0 = 0xFC, // XXXXXX00
_CANSPI TX PRIORITY 1 = O0xFD, // XXXXXX01
_CANSPI TX PRIORITY 2 = OxFE, // XXXXXX10
_CANSPI TX PRIORITY 3 = OxFF, // XXXXXX11
_CANSPI TX FRAME BIT = 0x08,

_CANSPI TX STD FRAME = OxFF, [/ XXXXX1XX
_CANSPI TX XTD FRAME = 0xF7, // XXXXXO0XX
_CANSPI TX RTR BIT = 0x40,

_CANSPI TX NO RTR FRAME = OxFF, // XIXXXXXX
_CANSPI TX RTR_FRAME = OxBF; // XOXXXXXX

You may use bitwise AND (s) to adjust the appropriate flags. For example:

/* form value to be used as sending message flag : */
send config = CANSPI_TX PRIORITY 0 &
_CANSPI_TX XTD FRAME &
_CANSPI_TX NO_RTR_FRAME;

CANSPIWrite(id, data, 1, send config);

MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD 267



CHAPTER 7
Libraries mikroC PRO for PIC

CANSPI_RX_MSG_FLAGS

CANSPI RxX MSG FLAGS are flags related to reception of CAN message. If a particu-
lar bit is set then corresponding meaning is TRUE or else it will be FALSE.

const char
_CANSPI RX FILTER BITS = 0x07, // Use this to access filter bits

_CANSPI RX FILTER 1 = 0x00,

_CANSPI RX FILTER 2 = 0x01,

" CANSPI RX FILTER 3 = 0x02,

_CANSPI RX FILTER 4 = 0x03,

_CANSPI RX FILTER 5 = 0x04,

“CANSPI RX FILTER 6 = 0x05,

_CANSPI RX OVERFLOW = 0x08, // Set if Overflowed else cleared

_CANSPI RX INVALID MSG = 0x10, // Set if invalid else cleared

_CANSPI RX XTD FRAME = 0x20, // Set if XTD message else
cleared

_CANSPI RX RTR_FRAME = 0x40, // Set if RTR message else
cleared

_CANSPI_RX DBL BUFFERED = 0x80; // Set if this message was hard
ware double-buffered

You may use bitwise AND (&) to adjust the appropriate flags. For example:
if (MsgFlag & CANSPI RX OVERFLOW != 0) {

// Receiver overflow has occurred.
// We have lost our previous message.

}
CANSPI_MASK

The cansp1 Mask constants define mask codes. Function CANSPISetMask expects
one of these as it's argument:

const char
_CANSPI MASK Bl
_CANSPI MASK B2

0,
1;

CANSPI_FILTER

The cansp1 rILTER constants define filter codes. Functions CANSPISetFilter
expects one of these as it's argument:

const char
_CANSPI FILTER Bl F1 = 0
_CANSPI FILTER Bl F2 = 1
_CANSPI FILTER B2 Fl = 2,
_CANSPI FILTER B2 F2 = 3

~

~
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_CANSPI_FILTER B2 F3
_CANSPI_FILTER B2 F4

[
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Library Example

This is a simple demonstration of CANSPI Library routines usage. First node initi-
ates the communication with the second node by sending some data to its address.
The second node responds by sending back the data incremented by 1. First node
then does the same and sends incremented data back to second node, etc.

Code for the first CANSPI node:

unsigned char Can Init Flags,
flags

unsigned char Rx Data Len;
char RxTx Datal 8] ;
char Msg Rcvd;
const long ID 1st
long Rx ID;

// CANSPI module connections

sbit CanSpi Cs at
sbit CanSpi CS Direction at
sbit CanSpi Rst at

sbit CanSpi Rst Direction at

Can_Send Flags, Can Rcv_Flags; // can

// received data length in bytes
// can rx/tx data buffer
// reception flag

12111, ID 2nd = 3; // node IDs

RCO bit;
TRISCO bit;
RC2 bit;
TRISC2 bit;

// End CANSPI module connections

void main () {

ANSEL = 0; // Configure AN pins as digital I/O

ANSELH = O0;

PORTB = 0; // clear PORTB

TRISB = 0; // set PORTB as output

Can_Init Flags 0; //

Can_Send Flags = 0; // clear flags

Can_Rcv_Flags = 0; //

Can_Send Flags = CANSPI TX PRIORITY 0 & // form value to be used

_CANSPI_TX XTD FRAME & // with CANSPIWrite
_CANSPI TX NO RTR FRAME;

Can Init Flags = CANSPI CONFIG SAMPLE THRICE & // Form value to be used
_CANSPI_CONFIG PHSEG2 PRG ON & // with CANSPIInit
_CANSPI_CONFIG_XTD MSG &
_CANSPI_CONFIG DBL BUFFER ON &
_CANSPI CONFIG VALID XTD MSG;
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SPI1 Init(); // initialize SPI1 module

CANSPIInitialize(1,3,3,3,1,Can Init Flags); // Initialize external CANSPI

module
CANSPISetOperationMode ( CANSPI MODE CONFIG, OxFF); // set CONFIGURATION mode
CANSPISetMask ( CANSPI MASK B1,-1, CANSPI CONFIG XTD MSG); // set

all maskl bits to ones
CANSPISetMask ( CANSPI MASK B2,-1, CANSPI CONFIG XTD MSG); // set
all mask2 bits to ones

CANSPISetFilter ( CANSPI FILTER B2 F4,ID 2nd, CANSPI CONFIG XTD MSG);
// set id of filter B2 F4 to 2nd node ID

CANSPISetOperationMode ( CANSPI MODE NORMAL, OxFF); // set NORMAL mode
RxTx Datal 0] = 9; // set initial data to be sent

CANSPIWrite (ID 1st, RxTx Data, 1, Can Send Flags); // send initial

message
while (1) { // endless loop
Msg Rcvd = CANSPIRead(&Rx ID , RxTx Data , &Rx Data Len,
&Can_Rcv_Flags);// receive message
if ((Rx_ID == ID 2nd) && Msg Rcvd) {

// if message received check id
PORTB = RxTx Data[ 0] ;
// id correct, output data at PORTC
RxTx Datal 0] ++;
// increment received data
Delay ms (10);
CANSPIWrite (ID 1st, RxTx Data, 1, Can_Send Flags);
// send incremented data back

}
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Code for the second CANSPI node:

unsigned char Can Init Flags,
flags

unsigned char Rx Data Len;
char RxTx Datal 8] ;
char Msg Rcvd;
const long ID 1lst
long Rx ID;

// CANSPI module connections

sbit CanSpi Cs at
sbit CanSpi CS Direction at
sbit CanSpi Rst at

sbit CanSpi Rst Direction at

Can_Send Flags, Can Rcv Flags; // can

// received data length in bytes
// can rx/tx data buffer
// reception flag

12111, ID 2nd = 3; // node IDs

RCO bit;
TRISCO bit;
RC2 bit;
TRISC2 bit;

// End CANSPI module connections

void main () {

ANSEL = O0;
ANSELH = 0;

// Configure AN pins as digital I/0

PORTB = 0; // clear PORTB

TRISB = 0; // set PORTB as output

Can_Init Flags 0; //

Can_Send Flags = 0; // clear flags

Can Rcv _Flags = 0; //

Can_Send Flags = CANSPI TX PRIORITY 0 & // form value to be used

_CANSPI TX XTD FRAME & // with CANSPIWrite
_CANSPI TX NO RTR FRAME;

Can Init Flags = CANSPI CONFIG SAMPLE THRICE & // Form value to be used
_CANSPI CONFIG _PHSEG2 PRG ON & // with CANSPIInit
_CANSPI CONFIG XTD MSG &
_CANSPI CONFIG DBL BUFFER ON &
_CANSPI CONFIG VALID XTD MSG &
_CANSPI CONFIG LINE FILTER OFF;

SPI1 Init(); // initialize SPI1 module

CANSPIInitialize(1,3,3,3,1,Can Init Flags); // initialize external

CANSPI module

CANSPISetOperationMode ( CANSPI MODE CONFIG, OxFF); // set CONFIGU-

RATION mode

CANSPISetMask ( CANSPI MASK Bl,-1, CANSPI CONFIG XTD MSG);// set

all maskl bits to ones

CANSPISetMask ( CANSPI MASK B2,-1, CANSPI CONFIG XTD MSG); // set
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all mask2 bits to ones

CANSPISetFilter ( CANSPI FILTER B2 F3,ID 1lst, CANSPI CONFIG XTD MSG);
// set id of filter B2 F3 to 1lst node ID

CANSPISetOperationMode ( CANSPI MODE NORMAL, OxFF);// set NORMAL mode

while (1) { // endless loop
Msg Rcvd = CANSPIRead(&Rx ID , RxTx Data , &Rx Data Len,
&Can_Rcv_Flags); // receive message
if ((Rx ID == ID 1st) && Msg Rcvd) { // if message received check id
PORTB = RxTx Datal 0] ; // id correct, output data at PORTC
RxTx Data[ 0] ++; // increment received data

CANSPIWrite (ID 2nd, RxTx Data, 1, Can Send Flags); // send
incremented data back

}

HW Connection
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Example of interfacing CAN transceiver MCP2510 with MCU via SPI interface
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COMPACT FLASH LIBRARY

The Compact Flash Library provides routines for accessing data on Compact Flash
card (abbr. CF further in text). CF cards are widely used memory elements, com-
monly used with digital cameras. Great capacity and excellent access time of only
a few microseconds make them very attractive for microcontroller applications.

In CF card, data is divided into sectors. One sector usually comprises 512 bytes.
Routines for file handling, the c£ rat routines, are not performed directly but suc-
cessively through 512B buffer.

Note: Routines for file handling can be used only with FAT16 file system.
Note: Library functions create and read files from the root directory only.

Note: Library functions populate both FAT1 and FAT2 tables when writing to files,
but the file data is being read from the FAT1 table only; i.e. there is no recovery if
the FAT1 table gets corrupted.

Note: If MMC/SD card has Master Boot Record (MBR), the library will work with the
first available primary (logical) partition that has non-zero size. If MMC/SD card has
Volume Boot Record (i.e. there is only one logical partition and no MBRs), the library
works with entire card as a single partition. For more information on MBR, physical
and logical drives, primary/secondary partitions and partition tables, please consult
other resources, e.g. Wikipedia and similar.

Note: Before writing operation, make sure not to overwrite boot or FAT sector as it
could make your card on PC or digital camera unreadable. Drive mapping tools,
such as Winhex, can be of great assistance.
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The following variables
must be defined in all
projects using Compact
Flash Library:

Description:

Example:

extern sfr char
CF Data Port;

Compact Flash Data Port.

char CF Data Port
at PORTD;

extern sfr sbit
CF_RDY;

Ready signal line.

sbit CF RDY at
RB7 bit;

extern sfr sbit
CF_WE;

Write Enable signal line.

sbit CF WE at
RB6 bit;

extern sfr sbit
CF OE;

Output Enable signal line.

sbit CF OE at
RB5 bit;

extern sfr sbit
CF CD1;

Chip Detect signal line.

sbit CF CDl at
RB4 bit;

extern sfr sbit
CF _CE1;

Chip Enable signal line.

sbit CF CE1 at
RB3 bit;

extern sfr sbit
CF A2;

Address pin 2.

sbit CF A2 at
RB2 bit;

extern sfr sbit
CFiAl;

Address pin 1.

sbit CF Al at
RB1 bit;

extern sfr sbit
CF_AO0;

Address pin 0.

sbit CF A0 at
RBO bit;

extern sfr sbit
CF_RDY direction;

Direction of the Ready pin.

sbit CF RDY direc-
tion at TRISB7 bit;

extern sfr sbit
CF WE direction;

Direction of the Write Enable
pin.

sbit CF WE direction
at TRISB6 bit;

extern sfr sbit
CF OE direction;

Direction of the Output
Enable pin.

sbit CF OE direction
at TRISB5 bit;

extern sfr sbit
CF _CD1 direction;

Direction of the Chip Detect
pin.

sbit CF CDl direc-
tion at TRISB4 bit;

extern sfr sbit
CF _CEl direction;

Direction of the Chip Enable
pin.

sbit CF CEl direc-
tion at TRISB3 bit;

extern sfr sbit
CF A2 direction;

Direction of the Address 2
pin.

sbit CF A2 direction
at TRISB2 bit;

extern sfr sbit
CF Al direction;

Direction of the Address 1
pin.

sbit CF Al direction
at TRISB1 bit;

extern sfr sbit
CF A0 direction;

Direction of the Address 0
pin.

sbit CF AO0 direction
at TRISBO bit;
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Library Routines

- Cf_Init

- Cf_Detect

- Cf_Enable

- Cf_Disable

- Cf_Read_lInit

- Cf_Read_Byte

- Cf_Write_Init

- Cf_Write_Byte

- Cf_Read_Sector
- Cf_Write_Sector

Routines for file handling:

- Cf_Fat_Init

- Cf_Fat_QuickFormat

- Cf_Fat_Assign

- Cf_Fat_Reset

- Cf_Fat_Read

- Cf_Fat_Rewrite

- Cf_Fat_Append

- Cf_Fat_Delete

- Cf_Fat_Write

- Cf_Fat_Set_File_Date
- Cf_Fat_Get_File_Date
- Cf_Fat_Get_File_Size
- Cf_Fat_Get_Swap_File

The following routine is for the internal use by compiler only:

- Cf_Issue_ID_Command
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Cf_Init

Prototype [void Cf Init();

Returns Nothing.

Description |Initializes ports appropriately for communication with CF card.

Global variables:

- CF Data port : Compact Flash data port

- cr rDY : Ready signal line

- cr we : Write enable signal line

- cr OE : Output enable signal line

- cr_cp1 : Chip detect signal line

- cr crel : Enable signal line

- cr A2 :Address pin 2

- Cr Al :Address pin 1

Requires - Cr A0 :Address pin 0

- CF RDY direction : Direction of the Ready pin

- CF WE direction : Direction of the Write enable pin
- CF OE direction : Direction of the Output enable pin
- CF CDl direction : Direction of the Chip detect pin
- CF CEl direction : Direction of the Chip enable pin
- CF A2 direction : Direction of the Address 2 pin

- CF Al direction : Direction of the Address 1 pin

- CF A0 direction : Direction of the Address 0 pin

must be defined before using this function.

// set compact flash pinout
char Cf Data Port at PORTD;

sbit CF_RDY at RB7 bit;
sbit CF WE at RB6 bit;
sbit CF OE at RB5 bit;
sbit CF CD1 at RB4 bit;
sbit CF CEl at RB3 bit;
sbit CF A2 at RB2 bit;
sbit CF Al at RB1 bit;
sbit CF A0 at RBO bit;
Example
sbit CF RDY direction at TRISB7 bit;
sbit CF WE direction at TRISB6 bit;
sbit CF OE direction at TRISBS bit;
sbit CF CD1 direction at TRISB4 bit;
sbit CF CEl direction at TRISB3 bit;
sbit CF A2 direction at TRISB2 bit;
sbit CF Al direction at TRISB1 bit;
sbit CF A0 direction at TRISBO bit;
// end of compact flash pinout

Cf Init(); // initialize CF
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Cf_Detect

Prototype unsigned short Cf Detect (void);

- 1 - if CF card was detected

Returns .
- 0 - otherwise

Description |Checks for presence of CF card by reading the chip detect pin.

Requires The corresponding MCU ports must be appropriately initialized for CF card. See

Cf_Init.
// Wait until CF card is inserted:
do
Example
asm nop;
while (!Cf Detect());
Cf_Enable

Prototype void Cf Enable (void);

Returns Nothing.

Enables the device. Routine needs to be called only if you have disabled the
Description |[device by means of the Cf _Disable routine. These two routines in conjunction
allow you to free/occupy data line when working with multiple devices.

The corresponding MCU ports must be appropriately initialized for CF card. See

Requires

Cf_Init.
Examble // enable compact flash
P Cf Enable();
Cf _Disable

Prototype |void Cf Disable (void);

Returns Nothing.

Routine disables the device and frees the data lines for other devices. To enable
Description [the device again, call Cf_Enable. These two routines in conjunction allow you to
free/occupy data line when working with multiple devices.

The corresponding MCU ports must be appropriately initialized for CF card. See
Cf_Init.

// disable compact flash
Cf Disable();

Requires

Example
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Cf_Read_lInit
Proknype void CfiReadi%nit(unsigned long address, unsigned short
sector count) ;
Returns Nothing.
Initializes CF card for reading.
e Parameters:
Description
- address: the first sector to be prepared for reading operation.
- sector count: humber of sectors to be prepared for reading operation.
. The corresponding MCU ports must be appropriately initialized for CF card. See
Requires :
Cf_Init.
// initialize compact flash for reading from sector 590
Example Cf Read Init (590, 1);

Cf_Read_Byte

Prototype unsigned short Cf Read Byte (void);
Returns a byte read from Compact Flash sector buffer.
Returns
Note: Higher byte of the unsigned return value is cleared.
i Reads one byte from Compact Flash sector buffer location currently pointed to
Description . : . . . .
by internal read pointers. These pointers will be autoicremented upon reading.
The corresponding MCU ports must be appropriately initialized for CF card. See
. Cf_Init.
Requires -
CF card must be initialized for reading operation. See Cf_Read_|Init.
// Read a byte from compact flash:
char data;
Example
data = Cf Read Byte();
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Cf_Write_Init

Prototype void Cf Write Init (unsigned long address, unsigned short sectcnt);

Returns Nothing.

Initializes CF card for writing.

o Parameters:
Description

- address: the first sector to be prepared for writing operation.
- sectent: number of sectors to be prepared for writing operation.

The corresponding MCU ports must be appropriately initialized for CF card. See
Cf_Init.

// initialize compact flash for writing to sector 590
Cf Write Init (590, 1);

Requires

Example

Cf_Write_Byte

Prototype void Cf Write Byte (unsigned short data );

Returns Nothing.

Writes a byte to Compact Flash sector buffer location currently pointed to by
writing pointers. These pointers will be autoicremented upon reading. When
sector buffer is full, its contents will be transfered to appropriate flash memory
. sector.

Description

Parameters:

- data : byte to be written.

The corresponding MCU ports must be appropriately initialized for CF card. See

Requires Cf_Init.
CF card must be initialized for writing operation. See Cf_Write_Init.
char data = O0xAA;

Example

Cf7WriteiByte(data);
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Cf_Read_Sector

void Cf Read Sector (unsigned long sector number, unsigned short

Prototype *buffer):

Returns Nothing.

Reads one sector (512 bytes). Read data is stored into burfer provided by the
buffer parameter.

Description |Parameters:

sector number: sector to be read.
buffer: data buffer of at least 512 bytes in length.

The corresponding MCU ports must be appropriately initialized for CF card. See

Requires .
9 Cf_Init.
// read sector 22
unsigned short datal 512] ;
Example g [ ]

Cf Read Sector (22, data):;

Cf_Write_Sector

void Cf Write Sector (unsigned long sector number, unsigned short

Prototype |, puffer) :

Returns Nothing.

Writes 512 bytes of data provided by the bur fer parameter to one CF sector.

i Parameters:
Description
- sector number: sector to be written to.
- buffer: data buffer of 512 bytes in length.
Requires The corresponding MCU ports must be appropriately initialized for CF card. See

Cf_Init.

// write to sector 22

unsigned short datal 512] ;
Example g [ ]

Cf Write Sector (22, data);
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Cf_Fat_Init

Prototype unsigned short Cf Fat Init();

- 0 - if CF card was detected and successfuly initialized
Returns - 1 -if FAT16 boot sector was not found
- 255 - if card was not detected

Initializes CF card, reads CF FAT16 boot sector and extracts necessary data

Description needed by the library.

Requires Nothing.

// Init the FAT library

if (!Cf Fat Init // Init the FAT librar
Example ( B B ) | / y

}

Cf_Fat_QuickFormat

Prototype unsigned char Cf Fat QuickFormat (char *cf fat label);

- 0 - if CF card was detected, successfuly formated and initialized
Returns - 1 - if FAT16 format was unseccessful
- 255 - if card was not detected

Formats to FAT16 and initializes CF card.

Parameters:

- cf fat label:volume label (11 characters in length). If less than 11
characters are provided, the label will be padded with spaces. If null string is

Description passed, the volume will not be labeled.

Note: This routine can be used instead or in conjunction with Cf_Fat_Init routine.

Note: If CF card already contains a valid boot sector, it will remain unchanged

(except volume label field) and only FAT and ROOT tables will be erased. Also,
the new volume label will be set.

Requires Nothing.

//--- format and initialize the FAT library -

if ICf Fat QuickFormat (&cf fat label
Example (er et feef fat Pt

\

J
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Cf_Fat_Assign

Prototype unsigned short Cf Fat Assign(char *filename, char file cre attr);

- 0o if file does not exist and no new file is created.

Returns - 1 if file already exists or file does not exist but a new file is created.
Assigns file for file operations (read, write, delete...). All subsequent file opera-
tions will be applied over the assigned file.
Parameters:
- filename: name of the file that should be assigned for file operations. The file name
should be in DOS 8.3 (file_name.extension) format. The file name and extension will
be automatically padded with spaces by the library if they have less than length
required (i.e. "mikro.tx" -> "mikro .tx "), so the user does not have to take care of that.
The file name and extension are case insensitive. The library will convert them to prop-
er case automatically, so the user does not have to take care of that.
Also, in order to keep backward compatibility with the first version of this library,
file names can be entered as UPPERCASE string of 11 bytes in length with no
dot character between the file name and extension (i.e. "MIKROELETXT" ->
MIKROELE.TXT). In this case the last 3 characters of the string are considered
to be file extension.
- file cre attr: file creation and attributs flags. Each bit corresponds to the
Description appropriate file attribut::

Bit | Mask Description

0 0x01 Read Only

1 0x02 Hidden

2 0x04 System

3 0x08 Volume Label

4 0x10 Subdirectory

5 0x20 Archive

6 0x40 Device (internal use only, never found on disk)

File creation flag. If the file does not exist and this flag is
7 0x80 S o :
set, a new file with specified name will be created.

Note: Long File Names (LFN) are not supported.

Requires CF card and CF library must be initialized for file operations. See Cf_Fat_|Init.

// create file with archive attributes if it does not already exist

Example Cf Fat Assign ("MIKROO0O07.TXT", 0xAO0);
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Cf_Fat_Reset

Prototype void Cf Fat Reset (unsigned long *size);

Returns Nothing.

Opens currently assigned file for reading.

. Parameters:
Description

- size: buffer to store file size to. After file has been open for reading its size is
returned through this parameter.

CF card and CF library must be initialized for file operations. See Cf_Fat_Init.

Requires File must be previously assigned. See Cf_Fat_Assign.
unsigned long size;

Example ce
Cf Fat Reset(size);

Cf_Fat_Read

Prototype void Cf Fat Read(unsigned short *bdata);

Returns Nothing.

Reads a byte from currently assigned file opened for reading. Upon function exe-
cution file pointers will be set to the next character in the file.

Description [Parameters:

- bdata: buffer to store read byte to. Upon this function execution read byte is
returned through this parameter.

CF card and CF library must be initialized for file operations. See Cf_Fat_Init.
Requires File must be previously assigned. See Cf _Fat_Assign.
File must be open for reading. See Cf_Fat_Reset.

char character;
Example S
Cf Fat Read(&character);
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Cf_Fat_Rewrite

Prototype [void Cf Fat Rewrite();
Returns Nothing.
Description Opens currently assigned file for writing. If the file is not empty its content will be
erased.
Requires CF card and CF library must be initialized for file operations. See Cf_Fat_Init.
q The file must be previously assigned. See Cf_Fat_Assign.
Example // open file for writing

Cf Fat Rewrite();

Cf_Fat_Append

Prototype void Cf Fat Append();

Returns Nothing.
Opens currently assigned file for appending. Upon this function execution file

Description |pointers will be positioned after the last byte in the file, so any subsequent file writ-
ing operation will start from there.

Requires CF card and CF library must be initialized for file operations. See Cf_Fat_|Init.

q File must be previously assigned. See Cf Fat_Assign.
Example // open file for appending

Cf Fat Append();

Cf_Fat_Delete

Prototype |void Cf Fat Delete();

Returns Nothing.

Description |Deletes currently assigned file from CF card.

Requires C_F card and CF Ii_brary mus_t be initialized for file operations. See Cf_Fat_Init.
File must be previously assigned. See Cf_Fat_Assign.

Example // delete current file

Cf Fat Delete();
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Cf_Fat_Write

Prototype void Cf Fat Write (char *fdata, unsigned data len);

Returns Nothing.

Writes requested number of bytes to currently assigned file opened for writing.

. Parameters:
Description

- fdata: data to be written.
- data len: number of bytes to be written.

CF card and CF library must be initialized for file operations. See Cf_Fat_lInit.
Requires File must be previously assigned. See Cf_Fat_Assign.
File must be open for writing. See Cf_Fat_Rewrite or Cf_Fat_Append.

char fiTeicontehts[4?J;

Exan“ﬂe Cf Fat Write(file contents, 42); // write data to the assigned

file

Cf_Fat_Set_File Date

void Cf Fat Set File Date(unsigned int year, unsigned short
Prototype month, unsigned short day, unsigned short hours, unsigned short
mins, unsigned short seconds);

Returns Nothing.

Sets the date/time stamp. Any subsequent file writing operation will write this
stamp to currently assigned file's time/date attributs.

Parameters:

Description |- vear: year attribute. Valid values: 1980-2107
- month: month attribute. Valid values: 1-12

- day: day attribute. Valid values: 1-31

- hours: hours attribute. Valid values: 0-23

- mins: minutes attribute. Valid values: 0-59

- seconds: seconds attribute. Valid values: 0-59

CF card and CF library must be initialized for file operations. See Cf_Fat_Init.
Requires File must be previously assigned. See Cf _Fat_Assign.
File must be open for writing. See Cf_Fat_Rewrite or Cf_Fat_Append.

Example Cf Fat Set File Date(2005,9,30,17,41,0);

MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD 285



CHAPTER 7
Libraries mikroC PRO for PIC

Cf_Fat_Set_File_Date

void Cf Fat Get File Date(unsigned int *year, unsigned short
Prototype *month, unsigned short *day, unsigned short *hours, unsigned
short *mins);

Returns Nothing.

Reads time/date attributes of currently assigned file.

Parameters:

- vyear: buffer to store year attribute to. Upon function execution year attribute
is returned through this parameter.

- month: buffer to store month attribute to. Upon function execution month

Description attribute is returned through this parameter.

- day: buffer to store day attribute to. Upon function execution day attribute is
returned through this parameter.

- hours: buffer to store hours attribute to. Upon function execution hours
attribute is returned through this parameter.

- mins: buffer to store minutes attribute to. Upon function execution minutes
attribute is returned through this parameter.

CF card and CF library must be initialized for file operations. See Cf_Fat_|Init.

Requires . . . }
q File must be previously assigned. See Cf _Fat_Assign.
unsigned year;
char month, day, hours, mins;
Example

Cf Fat Get File Date(&year, &month, &day, &hours, &mins);

Cf_Fat_Set_File_Size

Prototype unsigned long Cf Fat Get File Size();

Returns Size of the currently assigned file in bytes.

Description |This function reads size of currently assigned file in bytes.

CF card and CF library must be initialized for file operations. See Cf_Fat_Init.

Requires File must be previously assigned. See Cf_Fat_Assign.

unsigned long my file size;
Example

my file size = Cf Fat Get File Size();
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Cf_Fat_Get_Swap_File

unsigned long Cf Fat Get Swap File (unsigned long sectors cnt,

Prototype char *filename, char file attr);
- Number of the start sector for the newly created swap file, if there was enough free space
Returns on CF card to create file of required size.

- 0 otherwise

This function is used to create a swap file of predefined name and size on the CF
media. If a file with specified name already exists on the media, search for con-
secutive sectors will ignore sectors occupied by this file. Therefore, it is recom-
mended to erase such file if it exists before calling this function. If it is not erased
and there is still enough space for a new swap file, this function will delete it after
allocating new memory space for a new swap file.

The purpose of the swap file is to make reading and writing to CF media as fast
as possible, by using the Cf Read_Sector() and Cf Write_Sector() functions
directly, without potentially damaging the FAT system. Swap file can be consid-
ered as a "window" on the media where the user can freely write/read data. It's
main purpose in the mikroC's library is to be used for fast data acquisition; when
the time-critical acquisition has finished, the data can be re-written into a "normal”
file, and formatted in the most suitable way.

Parameters:

- sectors_cnt: number of consecutive sectors that user wants the swap file to have.
- filename: name of the file that should be assigned for file operations. The file name
should be in DOS 8.3 (file_name.extension) format. The file name and extension will
be automatically padded with spaces by the library if they have less than length
required (i.e. "mikro.tx" -> "mikro .tx "), so the user does not have to take care of that.
The file name and extension are case insensitive. The library will convert them to
proper case automatically, so the user does not have to take care of that. Also, in order
Description |to keep backward compatibility with the first version of this library, file names can be
entered as UPPERCASE string of 11 bytes in length with no dot chsaracter between
the file name and extension (i.e. "MIKROELETXT" -> MIKROELE.TXT). In this case
the last 3 characters of the string are considered to be file extension.

- file attr: file creation and attributs flags. Each bit corresponds to the
appropriate file attribut:

Bit | Mask Description
0 0x01 Read Only
1 0x02 Hidden
2 0x04 System
3 0x08 Volume Label
4 0x10 Subdirectory
5 0x20 Archive
6 0x40 Device (internal use only, never found on disk)
7 0x80 Not used

Note: Long File Names (LFN) are not supported.
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Requires CF card and CF library must be initialized for file operations. See Cf_Fat_|Init.
/=== Try to create a swap file with archive

atribute, whose size will be at least 1000 sectors.
// If it succeeds, it sends the No. of start sector over UART
unsigned long size;

size = Cf Fat Get Swap File (1000, "mikroE.txt", 0x20);
if (size) {

Exan“ﬂe UART_Write(OxAA);

UART Write (Lo (size));
UART_Write(Hi(size));
UART_Write(Higher(size));
UART Write (Highest (size));
UART_Write(OxAA);

Library Example

The following example demonstrates various aspects of the Cf_Fat16 library: Creation of new file
and writing down to it; Opening existing file and re-writing it (writing from start-of-file); Opening
existing file and appending data to it (writing from end-of-file); Opening a file and reading data from
it (sending it to USART terminal); Creating and modifying several files at once;

// set compact flash pinout
char Cf Data Port at PORTD;

sbit CF RDY at RB7 bit;
sbit CF WE at RB6 bit;
sbit CF OE at RBS5 bit;
sbit CF CD1 at RB4 bit;
sbit CF CE1 at RB3 bit;
sbit CF A2 at RB2 bit;
sbit CF A1l at RB1 bit;
sbit CF A0 at RBO bit;

sbit CF RDY direction at TRISB7 bit;
sbit CF WE direction at TRISB6 bit;
sbit CF OE direction at TRISBS bit;
sbit CF CD1 direction at TRISB4 bit;
sbit CF CEl direction at TRISB3 bit;
sbit CF A2 direction at TRISB2 bit;
sbit CF Al direction at TRISB1 bit;
sbit CF AQ direction at TRISBO bit;

// end of cf pinout

const LINE LEN = 39;

char err txt[ 20] = "FAT16 not found";
char file contents[ LINE LEN] = "XX CF FAT16 library by Anton Rieckertn";
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char filename[ 14] = "MIKROOOx.TXT"; // File names
unsigned short loop, loop2;

unsigned long i, size;

char Buffer[ 512] ;

// UART1 write text and new line (carriage return + line feed)
void UART1 Write Line(char *uart text) ({

UART1 Write Text (uart text);

UART1 Write (13);

UART1 Write (10);

// Creates new file and writes some data to it
void M Create New File() {

filename[ 7] = 'A';
Cf Fat Assign(&filename, OxAQ0); // Find existing file or create a
new one
Cf Fat Rewrite(); // To clear file and start with new data
for (loop = 1; loop <= 99; loop+t+) {
UART1 Write('.'");
file contents[ 0] = loop / 10 + 48;
file contents[ 1] = loop % 10 + 48;

Cf Fat Write(file contents, LINE LEN-1); // write data to the
assigned file

}

// Creates many new files and writes data to them
void M Create Multiple Files () {

for (loop2 = 'B'; loop2 <= 'Z'; loop2++) {
UART1 Write (loop2); // signal the progress
filename[ 7] = loop2; // set filename

Cf_Fat_Assign(&filename, O0xAQ0); // find existing file or create
a new one
Cf Fat Rewrite(); // To clear file and start with new data
for (loop = 1; loop <= 44; loop++) {
file contents[ 0] loop / 10 + 48;
file contents[ 1] = loop % 10 + 48;
Cf Fat Write(file contents, LINE LEN-1); // write data to the
assigned file

}

// Opens an existing file and rewrites it
void M Open File Rewrite() {

filename[ 7] = 'C';

Cf Fat Assign(&filename, 0);

Cf Fat Rewrite();

for (loop = 1; loop <= 55; loop+t+) {
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file contents[ 0] = loop / 10 + 65;
file contents[ 1] = loop % 10 + 65;
Cf Fat Write(file contents, LINE LEN-1); // write data to the

assigned file

}

// Opens an existing file and appends data to it
// (and alters the date/time stamp)
void M Open File Append() {
filename[ 7] = 'B';
Cf Fat Assign(&filename, O0);
Cf Fat Set File Date(2005,6,21,10,35,0);
Cf Fat Append(); // Prepare file for append
Cf Fat Write(" for mikroElektronika 2005n", 27); // Write data to
assigned file

}

// Opens an existing file, reads data from it and puts it to UART
void M Open File Read() {
char character;

filename[ 7] = 'B';
Cf Fat Assign(&filename, 0);
Cf Fat Reset(&size);// To read file, procedure returns size of file

for (i = 1; i <= size; 1i++) {
Cf Fat Read(&character);
UART1 Write (character); // Write data to UART

// Deletes a file. If file doesn't exist, it will first be created
// and then deleted.
void M Delete File() {

filename[ 7] = 'F';

Cf Fat Assign(filename, O0);

Cf Fat Delete();

// Tests whether file exists, and if so sends its creation date
// and file size via UART
void M Test File Exist() {

unsigned long fsize;

unsigned int year;

unsigned short month, day, hour, minute;

unsigned char outstr 12];

filename[ 7] = 'B'; //uncomment this line to search for file that
DOES exists
// filename[ 7] = 'F'; //uncomment this line to search for file that

DOES NOT exist
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if (Cf Fat Assign(filename, 0)) {
//--- file has been found - get its date
Cf Fat Get File Date(&year, &month, &day, &hour, é&minute);
WordToStr (year, outstr);
UART1 Write Text (outstr);
ByteToStr (month, outstr);
UART1 Write Text (outstr)
WordToStr (day, outstr);
UART1 Write Text (outstr);
WordToStr (hour, outstr);
UART1 Write Text (outstr);
WordToStr (minute, outstr);
UART1 Write Text (outstr);
//--- get file size
fsize = Cf Fat Get File Size();
LongToStr ( (signed long) fsize, outstr);
UART1 Write Line (outstr);
}
else {
//--- file was not found - signal it
UART1 Write (0x55);
Delay ms(1000);
UART1 Write (0x55);

’

}

// Tries to create a swap file, whose size will be at least 100
// sectors (see Help for details)
void M Create Swap File() {

unsigned int i;

for (i=0; i<512; i++)
Buffer[ i] = 1i;

size = Cf Fat Get Swap File (5000, "mikroE.txt", 0x20); // see help
on this function for details

if (size) {
LongToStr ((signed long)size, err txt);
UART1 Write Line(err txt);

for (i=0; i<5000; i++) {
Cf Write Sector(size++, Buffer);
UART1 Write('.');

}
// Main. Uncomment the function(s) to test the desired operation (s)
void main () {

#define COMPLETE EXAMPLE // comment this line to make sim-
pler/smaller example
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ADCON1 |= 0xO0F; // Configure AN pins as digital
CMCON | 7; // Turn off comparators

// Initialize UART1 module
UART1 Init (19200);
Delay ms (10);

UART1 Write Line("PIC-Started"); // PIC present report

// use fatl6 quick format instead of init routine if a formatting
is needed

if (Cf_Fat Init() == 0) {
Delay ms (2000); // wait for a while until the card is stabilized
// period depends on used CF card

//--- Test start

UART1 Write Line("Test Start.");

//--- Test routines. Uncomment them one-by-one to test certain
features

M Create New File();
#ifdef COMPLETE EXAMPLE
M Create Multiple Files();
M Open File Rewrite();
M Open File Append();
M Open File Read();
M Delete File();
M Test File Exist();
M Create Swap File();
#endif
UART1 Write Line("Test End.");

}
else {
UART1 Write Line(err_txt); // Note: Cf_Fat Init tries to initial-
ize a card more than once.
// If card is not present, initializa-
tion may last longer (depending on clock speed)

}
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HW Connection
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EEPROM LIBRARY

EEPROM data memory is available with a number of PIC MCUs. mikroC PRO for PIC includes

library for comfortable work with EEPROM.

Library Routines

- Eeprom_Read
- Eeprom_Write

EEPROM_Read

Prototype unsigned short EEPROM Read(unsigned int address);

Returns Returns byte from specified address.

Describtion Reads data from specified address. Parameter address is of integer type,

P which means it supports MCUs with more than 256 bytes of EEPROM.
Requires EEPROM module.
Requires Ensure minimum 20ms delay between successive use of routines
9 EEPROM Write and eEprOM Read. Although PIC will write the correct value,
EEPROM Read might return an undefined result.
unsigned short take;

Example -
take = EEPROM Read (0x3F) ;

EEPROM_Write

Prototype void EEPROM Write (unsigned int address, unsigned short data);

Returns Nothing.

Writes data to specified address. Parameter address is of integer type, which
means it supports MCUs with more than 256 bytes of EEPROM.

Description |Be aware that all interrupts will be disabled during execution of EEPrOM Write
routine (GIE bit of INTCON register will be cleared). Routine will restore previ-
ous state of this bit on exit.

Requires EEPROM module.
Reauires Ensure minimum 20ms delay between successive use of routines
q EEPROM Write and EEPROM Read. Although PIC will write the correct value,
EEPROM Read might return an undefined result.

Example EEPROM Write (0x32, 19);
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Library Example

The example demonstrates use of EEPROM Library.

char ii;

void mai

n(){

// loop variable

ANSEL = O; // Configure AN pins as digital I/0

ANSELH = 0;

PORTB = 0O;

PORTC = 0;

PORTD = 0O;

TRISB = 0;

TRISC = O0;

TRISD = 0O;

for(ii = 0; 1ii < 32; 1ii++) // Fill data buffer
EEPROM Write (0x80+ii, 1ii); // Write data to address 0x80+ii

EEPROM Write (0x02, 0xAA); // Write some data at address 2

EEPROM Write (0x50,0x55); // Write some data at address 0150

Delay ms (1000); // Blink PORTB and PORTC diodes

PORTB = OxFF; // to indicate reading start

PORTC = OxFF;

Delay ms (1000) ;

PORTB = 0x00;

PORTC = 0x00;

Delay ms (1000);

PORTB = EEPROM Read (0x02); // Read data from address 2 and

display it on PORTB
PORTC = EEPROM Read (0x50); // Read data from address 0x50 and
display it on PORTC

Delay ms (1000) ;

for(ii = 0; 1i < 32; ii++) { // Read 32 bytes block from address 0x80
PORTD = EEPROM Read(0x80+ii); // and display data on PORTD

Delay ms (250);

}

MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD 295



CHAPTER 7
Libraries mikroC PRO for PIC

ETHERNET PIC18FXXJ60 LIBRARY

pIC18FxxJ60 family of microcontrollers feature an embedded Ethernet controller module. This is
a complete connectivity solution, including full implementations of both Media Access Control
(MAC) and Physical Layer transceiver (PHY) modules. Two pulse transformers and a few passive
components are all that are required to connect the microcontroller directly to an Ethernet net-
work.

The Ethernet module meets all of the IEEE 802.3 specifications for 10-BaseT connectivity to a
twisted-pair network. It incorporates a number of packet filtering schemes to limit incoming pack-
ets. It also provides an internal DMA module for fast data throughput and hardware assisted IP
checksum calculations. Provisions are also made for two LED outputs to indicate link and network
activity

This library provides the posibility to easily utilize ethernet feature of the above mentioned MCUs.
Ethernet PIC18FxxJ60 library supports:

- IPv4 protocol.

- ARP requests.

- ICMP echo requests.

- UDP requests.

- TCP requests (no stack, no packet reconstruction).
- ARP client with cache.

- DNS client.

- UDP client.

- DHCP client.

- packet fragmentation is NOT supported.

Note: Global library variable Ethernet userTimersec is used to keep track of time for all client
implementations (ARP, DNS, UDP and DHCP). It is user responsibility to increment this variable
each second in it's code if any of the clients is used.

Note: For advanced wusers there are header files ("eth j60LibDef.h" and
"eth j60Libprivate.h")in Uses\P18 folder of the compiler with description of all routines and
global variables, relevant to the user, implemented in the Ethernet PIC18FxxJ60 Library.
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Library Routines

- Ethernet_Init

- Ethernet_Enable

- Ethernet_Disable

- Ethernet_doPacket

- Ethernet_putByte

- Ethernet_putBytes

- Ethernet_putString

- Ethernet_putConstString

- Ethernet_putConstBytes

- Ethernet_getByte

- Ethernet_getBytes

- Ethernet_UserTCP

- Ethernet_UserUDP

- Ethernet_getlpAddress

- Ethernet_getGwIpAddress
- Ethernet_getDnsIpAddress
- Ethernet_getlpMask

- Ethernet_confNetwork

- Ethernet_arpResolve

- Ethernet_sendUDP

- Ethernet_dnsResolve

- Ethernet_initDHCP

- Ethernet_doDHCPLeaseTime
- Ethernet_renewDHCP
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Ethernet_Init

void Ethernet Init (unsigned char *mac, unsigned char *ip,
unsigned char fullDuplex);

Prototype

Returns Nothing.

This is MAC module routine. It initializes Ethernet controller. This function is
internaly splited into 2 parts to help linker when coming short of memory.

Ethernet controller settings (parameters not mentioned here are set to default):

- receive buffer start address : 0x0000.

- receive buffer end address : 0x192aD.

- transmit buffer start address: 0x192E.

- transmit buffer end address : 0x1FFF.

- RAM buffer read/write pointers in auto-increment mode.

- receive filters set to default: CRC + MAC Unicast + MAC Broadcast in OR

mode.

- flow control with TX and RX pause frames in full duplex mode.

- frames are padded to ¢0 bytes + CRC.

Description |- maximum packet size is set to 1518.

- Back-to-Back Inter-Packet Gap: 0x15 in full duplex mode; 0x12 in half duplex
mode.

- Non-Back-to-Back Inter-Packet Gap: 0x0012 in full duplex mode; 0x0c12 in
half duplex mode.

- half duplex loopback disabled.

- LED configuration: default (LEDA-link status, LEDB-link activity).

Parameters:

- mac: RAM buffer containing valid MAC address.

- ip: RAM buffer containing valid IP address.

- fullbuplex: ethernet duplex mode switch. Valid values: 0 (half duplex
mode) and 1 (full duplex mode).

Note: If a DHCP server is to be used, |P address should be setto 0.0.0.0.

Requires Nothing.

#define Ethernet HALFDUPLEX 0
#define Ethernet FULLDUPLEX 1
Example unsigned char myMacAddr[ 6] = { 0x00, 0Ox14, OxA5, 0x76, 0x19,
P 0x3f} ; // my MAC address
unsigned char myIpAddr = {192, 168, 1, 60 }; // my IP addr

Ethernet Init (myMacAddr, myIpAddr, Ethernet FULLDUPLEX) ;
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Ethernet_Enable

PrOtOtype void Ethernet Enable (unsigned char enFlt);

Returns Nothing.

This is MAC module routine. This routine enables appropriate network traffic on
the MCU's internal Ethernet module by the means of it's receive filters (unicast,
multicast, broadcast, crc). Specific type of network traffic will be enabled if a
corresponding bit of this routine's input parameter is set. Therefore, more than
one type of network traffic can be enabled at the same time. For this purpose,
predefined library constants (see the table below) can be ORed to form appro-
priate input value.

Parameters:
- enrlt: network traffic/receive filter flags. Each bit corresponds to the appro-
priate network traffic/receive filter:

Bi Mask Description Predefined library
t const
o | ox01 MAC Broadcast traffic/receive filter flag. When _Ethernet BROADCAST

set, MAC broadcast traffic will be enabled.
MAC Multicast traffic/receive filter flag. When

10x02 set, MAC multicast traffic will be enabled. _Bthernet MULTICAST
Description || 2 [ 0x04 not used none
0x08 not used none
4 1 0x10 not used none
5 | 0x20 CRC check flag. When set, packets with _Ethernet CRC

invalid CRC field will be discarded.
6 | 0x40 not used none

MAC Unicast trafficireceive filter flag. When
set, MAC unicast traffic will be enabled.

7 |1 0x80 _Ethernet UNICAST

Note: Advance filtering available in the MCU's internal Ethernet module such as
Pattern Match, Magic Packet and Hash Table can not be enabled by this
routine. Additionaly, all filters, except CRC, enabled with this routine will work in
OR mode, which means that packet will be received if any of the enabled filters
accepts it.

Note: This routine will change receive filter configuration on-the-fly. It will not, in
any way, mess with enabling/disabling receive/transmit logic or any other part of
the MCU's internal Ethernet module. The MCU's internal Ethernet module should
be properly cofigured by the means of Ethernet_|Init routine.
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Requires Ethernet module has to be initialized. See Ethernet_Init.
E I Ethernet Enable( Ethernet CRC | Ethernet UNICAST); // enable
xample CRC checking and Unicast traffic

Ethernet_Disable

Prototype void Ethernet Enable (unsigned char enFlt);

Returns Nothing.

This is MAC module routine. This routine disables appropriate network traffic on the
MCU's internal Ethernet module by the means of it's receive filters (unicast, multicast,
broadcast, crc). Specific type of network traffic will be disabled if a corresponding bit
of this routine's input parameter is set. Therefore, more than one type of network traf-
fic can be disabled at the same time. For this purpose, predefined library constants
(see the table below) can be ORed to form appropriate input value.

Parameters:
- disrlt: network traffic/receive filter flags. Each bit corresponds to the appro-
priate network traffic/receive filter:

Bit| Mask Description Predefined library
const
MAC Br t traffic/receive filter flag. When
0 | 0x01 se?, MZ?:dgfsadsas?/tgcfr?c wil be disablod. | EheTnet BROADCAST
1 | oxo2 MAC Multicast t_rafﬁc/receive ﬁlter ﬂgg. When thernet MULTICAST
set, MAC multicast traffic will be disabled. |~ -
Description 2 | 0x04 not used none
3 | 0x08 not used none
4 1 0x10 not used none
CRC check flag. When set, CRC check will
5 | 0x20 | be disabled and packets with invalid CRC _Ethernet CRC
field will be accepted.
6 | 0x40 not used none
MAC Uni raffic/receive filter flag. When
7080 sect:, %\J/IA(?sL"Jtr:i:as(t;/trea(;f?c wil be diebleq. | | _Etneznet_unICasT

Note: Advance filtering available in the MCU's intemal Ethernet module such as
pPattern Match, Magic Packet and Hash Table can not be disabled by this routine.
Note: This routine will change receive filter configuration on-the-fly. It will not, in
any way, mess with enabling/disabling receive/transmit logic or any other part of
the MCU's internal Ethernet module. The MCU's internal Ethernet module
should be properly cofigured by the means of Ethernet_|Init routine.
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Requires Ethernet module has to be initialized. See Ethernet_Init..
E I Ethernet Disable( Ethernet CRC | Ethernet UNICAST); // disable
xample CRC checking and Unicast traffic

Ethernet_doPacket

Prototype unsigned char Ethernet doPacket();

- 0 - upon successful packet processing (zero packets received or received
packet processed successfuly).

- 1 - upon reception error or receive buffer corruption. Ethernet controller

Returns needs to be restarted.

- 2 -received packet was not sent to us (not our IP, nor IP broadcast address).

- 3 -received IP packet was not IPv4.

- 4 -received packet was of type unknown to the library.

This is MAC module routine. It processes next received packet if such exists.
Packets are processed in the following manner:

- ARP & ICMP requests are replied automatically.
- upon TCP request the Ethernet_UserTCP function is called for further processing.
- upon UDP request the Ethernet_UserUDP function is called for further processing.

Description

Note: Ethernet dopacket must be called as often as possible in user's code.

Requires Ethernet module has to be initialized. See Ethernet_Init.

if (Ethernet doPacket () == 0) { // process received packets
Example

}
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Ethernet_putByte

Prototype void Ethernet putByte (unsigned char v);

Returns Nothing.

This is MAC module routine. It stores one byte to address pointed by the cur-
rent Ethernet controller's write pointer (EwrpT).

Description Parameters:
- v: value to store
Requires Ethernet module has to be initialized. See Ethernet_Init.

char data;

Exan“ﬂe Ethernet putByte(data); // put an byte into Ethernet controller's

buffer

Ethernet_putBytes

Prototype void Ethernet putBytes (unsigned char *ptr, unsigned char n);

Returns Nothing.

This is MAC module routine. It stores requested number of bytes into Ethernet
controller's RAM starting from current Ethernet controller's write pointer (EwreT)
location.

Description Parameters:

- ptr: RAM buffer containing bytes to be written into Ethernet controller's RAM.
- n: number of bytes to be written.

Requires Ethernet module has to be initialized. See Ethernet_Init.

char *buffer = "mikroElektronika";

Exan“ﬂe Ethernet putBytes (buffer, 16); // put an RAM array into Ethernet

controller's buffer
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Ethernet_putConstBytes

void Ethernet putConstBytes (const unsigned char *ptr, unsigned
char n);

Prototype

Returns Nothing.

This is MAC module routine. It stores requested number of const bytes into Eth-
ernet controller's RAM starting from current Ethernet controller's write pointer
(ewrpT) location.

Description
P Parameters:
- ptr: const buffer containing bytes to be written into Ethernet controller's RAM.
- n: number of bytes to be written.
Requires Ethernet module has to be initialized. See Ethernet_Init.
const char *buffer = "mikroElektronika";
Exan“ﬂe Ethernet putConstBytes (buffer, 16); // put a const array into

Ethernet controller's buffer

Ethernet_putString

Prototype unsigned int Ethernet putString(unsigned char *ptr);

Returns Number of bytes written into Ethernet controller's RAM.

This is MAC module routine. It stores whole string (excluding null termination) into
Ethernet controller's RAM starting from current Ethernet controller's write pointer
(ewrPT) location.

Description
Parameters:
- ptr: string to be written into Ethernet controller's RAM.
Requires Ethernet module has to be initialized. See Ethernet_Init.
char *buffer = "mikroElektronika";
Exa"“ﬂe ﬁéﬁernet putString (buffer); // put a RAM string into Ethernet

controller's buffer
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Ethernet_putConstString

Prototype unsigned int Ethernet putConstString(const unsigned char *ptr);
yp g _ g

Returns Number of bytes written into Ethernet controller's RAM.

This is MAC module routine. It stores whole const string (excluding null termina-
tion) into Ethernet controller's RAM starting from current Ethernet controller's
Description |write pointer (zwrpT) location.

Parameters:

- ptr: const string to be written into Ethernet controller's RAM.

Requires Ethernet module has to be initialized. See Ethernet_Init.

const char *buffer = "mikroElektronika";

Exa"“ﬂe Ethernet putConstString(buffer); // put a const string into

Ethernet controller's buffer

Ethernet_getByte

Prototype unsigned char Ethernet getByte();

Returns Byte read from Ethernet controller's RAM.

This is MAC module routine. It fetches a byte from address pointed to by current
Ethernet controller's read pointer (erDPT).

Requires Ethernet module has to be initialized. See Ethernet_Init.

char buffer;

Description

Example buffer = Ethernet getByte(); // read a byte from Ethernet con-

troller's buffer

Ethernet_getBytes

void Ethernet getBytes (unsigned char *ptr, unsigned int addr,
unsigned char n);

Prototype

Returns Nothing.

This is MAC module routine. It fetches equested number of bytes from Ethernet
controller's RAM starting from given address. If value of OxFFFF is passed as
the address parameter, the reading will start from current Ethernet controller's
read pointer (ERDPT) location.

Parameters:

- ptr: buffer for storing bytes read from Ethernet controller's RAM.

- addr: Ethernet controller's RAM start address. Valid values: 0..8192.

- n: number of bytes to be read.

Description

Requires Ethernet module has to be initialized. See Ethernet_Init.
char buffer| 16] ;

Exa"“ﬂe Ethernet getBytes (buffer, 0x100, 16); // read 16 bytes, starting

from address 0x100
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Ethernet_UserTCP

Protot unsigned int Ethernet UserTCP (unsigned char *remoteHost, unsigned
rototype int remotePort, unsigned int localPort, unsigned int reglength);
Returns - 0 - there should not be a reply to the request.
- Length of TCP/HTTP reply data field - otherwise.
This is TCP module routine. It is internally called by the library. The user access-
es to the TCP/HTTP request by using some of the Ethernet_get routines. The
user puts data in the transmit buffer by using some of the Ethernet_put routines.
The function must return the length in bytes of the TCP/HTTP reply, or O if there
is nothing to transmit. If there is no need to reply to the TCP/HTTP requests, just
define this function with return(0) as a single statement.
e Parameters:
Description
- remoteHost: client's IP address.
- remotePort: client's TCP port.
- localport: port to which the request is sent.
- reqgLength: TCP/HTTP request data field length.
Note: The function source code is provided with appropriate example projects.
The code should be adjusted by the user to achieve desired reply.
Requires Ethernet module has to be initialized. See Ethernet_Init.
This function is internally called by the library and should not be called by the
Example .
user's code.
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Ethernet_UserUDP

Protot unsigned int Ethernet UserUDP (unsigned char *remoteHost, unsigned
rototype int remotePort, unsigned int destPort, unsigned int reglength);

Returns - 0 - there should not be a reply to the request.
- Length of UDP reply data field - otherwise.
This is UDP module routine. It is internally called by the library. The user access-
es to the UDP request by using some of the Ethernet_get routines. The user puts
data in the transmit buffer by using some of the Ethernet_put routines. The func-
tion must return the length in bytes of the UDP reply, or 0 if nothing to transmit. If
you don't need to reply to the UDP requests, just define this function with a
return(0) as single statement.

e Parameters:

Description
- remoteHost: client's IP address.
- remotePort: client's port.
- destport: port to which the request is sent.
- reqgLength: UDP request data field length.
Note: The function source code is provided with appropriate example projects.
The code should be adjusted by the user to achieve desired reply.

Requires Ethernet module has to be initialized. See Ethernet_Init.

Example This function is intemally called by the library and should not be called by the user's code.

Ethernet_getlpAddress

Prototype unsigned char * Ethernet getIpAddress();

Returns Ponter to the global variable holding IP address.

This routine should be used when DHCP server is present on the network to fetch
assigned IP address.

Description Note: User should always copy the IP address from the RAM location returned by
this routine into it's own IP address buffer. These locations should not be altered
by the user in any case!

Requires Ethernet module has to be initialized. See Ethernet_Init.

unsigned char ipAddr| 4] ; // user IP address buffer
Example S
memcpy (ipAddr, Ethernet getIpAddress(), 4); // fetch IP address
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Ethernet_getGwlpAddress

Prototype unsigned char * Ethernet getGwIpAddress () ;

Returns Ponter to the global variable holding gateway IP address.

This routine should be used when DHCP server is present on the network to fetch
assigned gateway IP address.

Description Note: User should always copy the IP address from the RAM location returned by
this routine into it's own gateway IP address buffer. These locations should not be
altered by the user in any case!

Requires Ethernet module has to be initialized. See Ethernet_Init.

unsigned char gwIpAddr] 4]; // user gateway IP address buffer

Example memcpy (gwIpAddr, Ethernet getGwlIpAddress(), 4); // fetch gateway

IP address

Ethernet_getDnsipAddress();

Prototype unsigned char * Ethernet getDnsIpAddress

Returns Ponter to the global variable holding DNS IP address.

This routine should be used when DHCP server is present on the network to fetch
assigned DNS IP address.

Description Note: User should always copy the IP address from the RAM location returned by
this routine into it's own DNS IP address buffer. These locations should not be
altered by the user in any case!

Requires Ethernet module has to be initialized. See Ethernet_Init.

unsigned char dnsIpAddr[ 4] ; // user DNS IP address buffer

Example memcpy (dnsIpAddr, Ethernet getDnsIpAddress(), 4); // fetch DNS

server address
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Ethernet_getlpMask

Prototype unsigned char * Ethernet getIpMask()

Returns Ponter to the global variable holding IP subnet mask.

This routine should be used when DHCP server is present on the network to fetch
assigned IP subnet mask.

Description Note: User should always copy the IP address from the RAM location returned by
this routine into it's own IP subnet mask buffer. These locations should not be
altered by the user in any case!

Requires Ethernet module has to be initialized. See Ethernet_Init.
unsigned char IpMaskl 4] ; // user IP subnet mask buffer

Example S
memcpy (IpMask, Ethernet getIpMask(), 4); // fetch IP subnet mask

Ethernet_confNetwork
void Ethernet confNetwork(char *ipMask, char *gwIpAddr, char

PrOtOtype *dnsIpAddr) ;

Returns Nothing.

Configures network parameters (IP subnet mask, gateway IP address, DNS IP
address) when DHCP is not used.
Parameters:
Description |- ipmMask: IP subnet mask.
- gwipAddr gateway IP address.
- dnsIpAddr: DNS IP address.
Note: The above mentioned network parameters should be set by this routine
only if DHCP module is not used. Otherwise DHCP will override these settings.

Requires Ethernet module has to be initialized. See Ethernet_Init.
unsigned char ipMask| 4] = {255, 255, 255, 01} // network
mask (for example : 255.255.255.0)
unsigned char gwIpAddr| 4] = {192, 1le8, 1, 11%}; // gateway
(router) IP address

Example unsigned char dnsIpAddr] 4] = {192, 168, 1, 11}; // DNS serv-
er IP address
ﬁéﬂerneticoanetwork(ipMask, gwIpAddr, dnsIpAddr); // set network
configuration parameters
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Ethernet_arpResolve

Prototype

unsigned char *Ethernet arpResolve (unsigned char *ip, unsigned
char tmax);

Returns

- MAC address behind the IP address - the requested IP address was resolved.

0 - otherwise.

Description

This is ARP module routine. It sends an ARP request for given IP address and waits for
ARRP reply. If the requested IP address was resolved, an ARP cash entry is used for stor-
ing the configuration. ARP cash can store up to 3 entries. For ARP cash structure refer to
"eth j60LibDef.h" header file in the compiler's Uses/P18 folder.

Parameters:

ip: IP address to be resolved.
tmax: time in seconds to wait for an reply.

Note: The Ethernet services are not stopped while this routine waits for ARP
reply. The incoming packets will be processed normaly during this time.

Requires

Ethernet module has to be initialized. See Ethernet_Init.

Example

unsigned char IpAddr| 4] = {192, 168, 1, 11}; // IP address

Ethernet arpResolve(IpAddr, 5); // get MAC address behind the
above IP address, wait 5 secs for the response

Ethernet_sendUDP

unsigned char Ethernet sendUDP (unsigned char *destIP, unsigned

Prokﬂype int sourcePort, unsigned int destPort, unsigned char *pkt,
unsigned int pktlen);
- 1 - UDP packet was sent successfully.
Returns )
- 0 - otherwise.
This is UDP module routine. It sends an UDP packet on the network.
Parameters:
. - dest1P: remote host IP address.
Description )
- sourcepPort: local UDP source port number.
- destport: destination UDP port number.
- pkt: packet to transmit.
- pktLen: length in bytes of packet to transmit.
Requires Ethernet module has to be initialized. See Ethernet_Init.
unsigned char IpAddr 4] = {192, 168, 1, 11}; // remote IP address
Exarnple Ethernet sendUDP (IpAddr, 10001, 10001, "Hello", 5); // send Hello mes-

sage to the above IP address, from UDP port 10001 to UDP port 10001

MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD

309



CHAPTER 7
Libraries mikroC PRO for PIC

Ethernet_dnsResolve

unsigned char *Ethernet dnsResolve (unsigned char *host, unsigned
char tmax);

Prototype

- pointer to the location holding the IP address - the requested host name was
Returns resolved.
- 0 - otherwise.

This is DNS module routine. It sends an DNS request for given host name and
waits for DNS reply. If the requested host name was resolved, it's IP address is
stored in library global variable and a pointer containing this address is returned
by the routine. UDP port 53 is used as DNS port.

Parameters:

e - host: host name to be resolved.

Description TR .
- tmax: time in seconds to wait for an reply.

Note: The Ethernet services are not stopped while this routine waits for DNS

reply. The incoming packets will be processed normaly during this time.

Note: User should always copy the IP address from the RAM location returned by
this routine into it's own resolved host IP address buffer. These locations should
not be altered by the user in any case!

Requires Ethernet module has to be initialized. See Ethernet_Init.

unsigned char * remoteHostIpAddr 4] ; // user host IP address buffer

// SNTP server:

// Zurich, Switzerland: Integrated Systems Lab, Swiss Fed. Inst. of
Example Technology

// 129.132.2.21: swisstime.ethz.ch

// Service Area: Switzerland and Europe

memcpy (remoteHostIpAddr, Ethernet dnsResolve ("swisstime.ethz.ch", 5), 4);
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Ethernet_initDHCL

Prototype unsigned char Ethernet initDHCP (unsigned char tmax);

- 1 - network parameters were obtained successfuly.

Returns .
- 0 - otherwise.

This is DHCP module routine. It sends an DHCP request for network parameters
(IP, gateway, DNS addresses and IP subnet mask) and waits for DHCP reply. If
the requested parameters were obtained successfuly, their values are stored into
the library global variables.

These parameters can be fetched by using appropriate library IP get routines:
- Ethernet_getlpAddress - fetch IP address.

- Ethernet_getGwlpAddress - fetch gateway IP address.

- Ethernet_getDnslpAddress - fetch DNS IP address.

- Ethernet_getlpMask - fetch IP subnet mask.

Description |UDP port 68 is used as DHCP client port and UDP port 67 is used as DHCP serv-
er port.

Parameters:
- tmax: time in seconds to wait for an reply.

Note: The Ethernet services are not stopped while this routine waits for DNS
reply. The incoming packets will be processed normaly during this time.

Note: When DHCP module is wused, global Ilibrary variable
Ethernet userTimerSec is used to keep track of time. It is user responsibility to
increment this variable each second in it's code.

Requires Ethernet module has to be initialized. See Ethernet_Init.

Ethernet initDHCP(5); // get network configuration from DHCP server,

Example wait 5 sec for the response
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Ethernet_doDHCPLeaseTime

Prototype unsigned char Ethernet doDHCPLeaseTime () ;

- 0 - lease time has not expired yet.

Returns -~ 1 - lease time has expired, it's time to renew it.

This is DHCP module routine. It takes care of IP address lease time by decre-
Description |menting the global lease time library counter. When this time expires, it's time to
contact DHCP server and renew the lease.

Requires Ethernet module has to be initialized. See Ethernet_Init.
while (1) {
Example if (Ethernet doDHCPLeaseTime ())

. // it's time to renew the IP address lease

Ethernet_renewDHCP

Prototype unsigned char Ethernet renewDHCP (unsigned char tmax);

- 0 -upon success (lease time was renewed).

Returns - 1 - otherwise (renewal request timed out).
This is DHCP module routine. It sends IP address lease time renewal request to
DHCP server.

Description

Parameters:

- tmax: time in seconds to wait for an reply.

Requires Ethernet module has to be initialized. See Ethernet_Init.

while (1) {

if (Ethernet doDHCPLeaseTime ())
Ethernet renewDHCP (5); // it's time to renew the IP address lease,

Example with 5 secs for a reply

}
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Library Example
This code shows how to use the PIC18FxxJ60 Ethernet library:

- the board will reply to ARP & ICMP echo requests

- the board will reply to UDP requests on any port :
returns the request in upper char with a header made of remote host IP &
port number

- the board will reply to HTTP requests on port 80, GET method with pathnames :
/ will return the HTML main page
/s will return board status as text string
/0 ... /t7 will toggle RDO to RD7 bit and return HTML main page
all other requests return also HTML main page.

#define Ethernet HALFDUPLEX 0
#define Ethernet FULLDUPLEX 1

/*‘k*‘k*‘k*‘k*‘k*‘k*‘k*‘k*‘k*‘k*‘k*‘k*‘k*‘k*‘k*‘k*‘k*‘k************************

* ROM constant strings

*/
const unsigned char httpHeader[] = "HTTP/1.1 200 OKnContent-type: "
; // HITP header
const unsigned char httpMimeTypeHTMI[ ] = "text/htmlnn" ;
// HTML MIME type
const unsigned <char httpMimeTypeScript] ] = "text/plainnn" ;
// TEXT MIME type
unsigned char httpMethod ] = "GET /";

/*

* web page, splited into 2 parts

* when coming short of ROM, fragmented data is handled more effi-
ciently by linker

*

* this HTML page calls the boards to get its status, and builds
itself with javascript

*/
const char *indexPage = // Change the IP address of the page to
be refreshed

"<meta http-equiv="refresh" content="3;url=http://192.168.20.60">
<HTML><HEAD></HEAD><BODY>
<h1>PIC18FxxJ60 Mini Web Server</hl>
<a href=/>Reload</a>
<script src=/s></script>
<table><tr><td wvalign=top><table Dborder=1 style="font-size:20px
;font-family: terminal ;">
<tr><th colspan=2>ADC</th></tr>
<tr><td>AN2</td><td><script>document.write (AN2)</script></td></tr>
<tr><td>AN3</td><td><script>document.write (AN3)</script></td></tr>
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</table></td><td><table border=1 style="font-size:20px ;font-family:
terminal ;">

<tr><th colspan=2>PORTB</th></tr>

<script>

var str,i;

str="";

for (i=0;i<8;i++)

{ str+="<tr><td bgcolor=pink>BUTTON #"+i+"</td>";
if (PORTB& (1<<1i) ){ str+="<td bgcolor=red>ON";}
else { str+="<td bgcolor=#cccccc>OFF";}
str+="</td></tr>";}

document.write (str) ;

</script>

LU
’

const char *indexPage2 = "</table></td><td>
<table border=1 style="font-size:20px ;font-family: terminal ;">
<tr><th colspan=3>PORTD</th></tr>

<script>

var str,i;

str="";

for (i=0;i<3;i++)

{ str+="<tr><td bgcolor=yellow>LED #"+i+"</td>";

if (PORTD& (1<<1i) ){ str+="<td bgcolor=red>ON";}

else { str+="<td bgcolor=#cccccc>OFF";}
str+="</td><td><a href=/t"+i+">Toggle</a></td></tr>";}
document.write (str) ;

</script>
</table></td></tr></table>
This is HTTP request

#<script>document.write (REQ)</script></BODY></HTML>

LU
’

/*‘k*‘k*‘k*‘k*‘k*************************

* RAM variables

*/
unsigned char myMacAddr 6] = { 0x00, Ox14, OxA5, 0x76, 0x19, O0x3f};
// my MAC address
unsigned char myIpAddr| 4] = {192, 168, 20, 60 };
// my IP address
unsigned char gwIpAddr[ 4] = {192, 168, 20, 6 }; // gateway
(router) IP address
unsigned char ipMask[ 4] = {255, 255, 255, O01}; // network mask
(for example : 255.255.255.0)
unsigned char dnsIpAddr| 4] = {192, 168, 20, 1 3}

// DNS server IP address

unsigned char getRequest[ 15] ; // HTTP request buffer
unsigned char dynal 30] ; // buffer for dynamic response
unsigned long httpCounter = 0; // counter of HTTP requests
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/*‘k*‘k*‘k*‘k*‘k*‘k*‘k*‘k*‘k*************************

* functions

*/

/*
* put the constant string pointed to by s to the Ethernet con-
troller's transmit buffer.

*/
/*unsigned int putConstString (const char *s)
{
unsigned int ctr = 0;
while (*s)
{
Ethernet putByte (*s++);
ctr++;
}
return(ctr);
y*/
/*
* it will be much faster to use library Ethernet putConstString rou-
tine

* instead of putConstString routine above. However, the code will
be a little

* bit bigger. User should choose between size and speed and pick the
implementation that

* suites him best. If you choose to go with the putConstString def-
inition above

* the #define line below should be commented out.

*

*/

#define putConstString Ethernet putConstString

/*
* put the string pointed to by s to the Ethernet controller's trans-
mit buffer

*/
/*unsigned int putString (char *s)
{
unsigned int ctr = 0;
while (*s)
{
Ethernet putByte (*s++);
ctr++;
}
return(ctr);
y*/
/*
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* it will be much faster to use library Ethernet putString routine
* 1instead of putString routine above. However, the code will be a
little

* bit bigger. User should choose between size and speed and pick the
implementation that

* suites him best. If you choose to go with the putString defini-
tion above

* the #define line below should be commented out.

*

*/
#define putString Ethernet putString

/*

* this function is called by the library

* the wuser accesses to the HTTP request by successive calls to
Ethernet getByte ()

* the user puts data in the transmit buffer by successive calls to
Ethernet putByte ()

* the function must return the length in bytes of the HTTP reply,
or 0 if nothing to transmit

*

* 1f you don't need to reply to HTTP requests,

* just define this function with a return(0) as single statement
*

*/
unsigned int Ethernet UserTCP (unsigned char *remoteHost, unsigned
int remotePort, unsigned int localPort, unsigned int reqglength)

{

unsigned int len = 0; // my reply length
unsigned char i; // general purpose char
if (localPort != 80)//I listen only to web request on port 80
{
return (0) ;

}

// get 10 first bytes only of the request, the rest does not
matter here
for(i = 0; i < 10; i++)
{
getRequest|[ i] = Ethernet getByte();
}
getRequest[ 10] = 0;

if (memcmp (getRequest, httpMethod, 5))// only GET method is
supported here
{
return (0) ;

}
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httpCounter++; // one more request done

if (getRequest[ 5] == 's') // if request path name starts with
s, store dynamic data in transmit buffer
{
// the text string replied by this request can be
interpreted as javascript statements
// by browsers

len = putConstString (httpHeader) ; // HTTP header
len += putConstString (httpMimeTypeScript); // with
text MIME type

// add AN2 value to reply
IntToStr (ADC Read(2), dyna);

len += putConstString("var AN2=");
len += putString(dyna);

len += putConstString(";");

// add AN3 value to reply
IntToStr (ADC Read(3), dyna);

len += putConstString("var AN3=");
len += putString(dyna);

len += putConstString(";");

// add PORTB value (buttons) to reply
len += putConstString("var PORTB=");
IntToStr (PORTB, dyna);

len += putString(dyna);

len += putConstString(";");

// add PORTD value (LEDs) to reply
len += putConstString("var PORTD=");
IntToStr (PORTD, dyna);

len += putString(dyna);

len += putConstString(";");

// add HTTP requests counter to reply
IntToStr (httpCounter, dyna);
len += putConstString("var REQ=");
len += putString(dyna);
len += putConstString(";");
}
else if (getRequest[ 5] == 't') // if request path name starts
with t, toggle PORTD (LED) bit number that comes after
{
unsigned char bitMask = 0; // for bit mask
if (isdigit (getRequest[ 6])) // 1if 0 <= bit number <=
9, bits 8 & 9 does not exist but does not matter

{
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bitMask = getRequest[ 6] - '0'; // convert ASCII to integer
bitMask = 1 << bitMask; // create bit mask
PORTD "= bitMask; // toggle PORTD with xor operator
}

if(len == 0) // what do to by default
{
len = putConstString(httpHeader); // HTTP header
len += putConstString (httpMimeTypeHTML); // with HTML MIME type
len += putConstString (indexPage); // HIML page first part
len += putConstString(indexPage?2);// HIML page second part
}

return(len); // return to the library with the number of
bytes to transmit

}

/*

* this function is called by the library

* the wuser accesses to the UDP request by successive calls to
Ethernet getByte ()

* the user puts data in the transmit buffer by successive calls to
Ethernet putByte ()

* the function must return the length in bytes of the UDP reply, or
0 if nothing to transmit

*

* 1f you don't need to reply to UDP requests,

* just define this function with a return(0) as single statement

*

*/
unsigned int Ethernet UserUDP (unsigned char *remoteHost, unsigned

int remotePort, unsigned int destPort, unsigned int reqglLength)

{
unsigned int len; // my reply length

// reply is made of the remote host IP address in human read-

able format
ByteToStr (remoteHost[ 0] , dyna);// first IP address byte

dynal 3] = '.';

ByteToStr (remoteHost[ 1] , dyna + 4); // second
dynal 7] = "'.';

ByteToStr (remoteHost[ 2] , dyna + 8); // third
dynal[ 11] = ".";

ByteToStr (remoteHost[ 3] , dyna + 12); // fourth
dynal 15] = ':'; // add separator

// then remote host port number
WordToStr (remotePort, dyna + 16);
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dynal 21] = '[ ';
WordToStr (destPort, dyna + 22);
dynal 27] = ']";
dynal 28] = 0;

// the total length of the request is the length of the
dynamic string plus the text of the request
len = 28 + reqglLength;

// puts the dynamic string into the transmit buffer
Ethernet putBytes(dyna, 28);

// then puts the request string converted into upper char
into the transmit buffer
while (regLength--)
{
Ethernet putByte (toupper (Ethernet getByte()));
}

return (len); // back to the library with the length of the
UDP reply
}

/*
* main entry
*/
void main ()
{
ADCON1 = 0x0B; // ADC convertors will be used with AN2 and AN3

CMCON = 0x07; // turn off comparators
PORTA = 0;
TRISA = Oxfc; // set PORTA as input for ADC

// except RAO and RAl which will be used as
// ethernet's LEDA and LEDB

PORTB = 0;

TRISB = Oxff; // set PORTB as input for buttons
PORTD = 0;

TRISD = 0; // set PORTD as output

/*

* Initialize Ethernet controller

*/

Ethernet Init (myMacAddr, myIpAddr, Ethernet FULLDUPLEX) ;

//dhcp will not be used here, so use preconfigured addresses
Ethernet confNetwork (ipMask, gwIpAddr, dnsIpAddr);
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while (1) // do forever
{
/*
* 1f necessary, test the return value to get error code
*/
Ethernet doPacket(); // process incoming Ethernet packets
/*
* add your stuff here if needed
* Ethernet doPacket () must be called as often as possible
* otherwise packets could be lost
*/

}
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FLASH MEMORY LIBRARY

This library provides routines for accessing microcontroller Flash memory. Note that
prototypes differ for PIC16 and PIC18 families.

Note: Due to the P16/P18 family flash specifics, flash library is MCU dependent.
Since the P18 family differ significantlly in number of bytes that can be erased
and/or written to specific MCUs, the appropirate suffix is added to the names of
functions in order to make it easier to use them. Flash memory operations are MCU
dependent :

1. Read operation supported. For this group of MCU's only read function is imple
mented.

2. Read and Write operations supported (write is executed as erase-and-write). For
this group of MCU's read and write functions are implemented. Note that write
operation which is executed as erase-and-write, may write less bytes than it
erases.

3. Read, Write and Erase operations supported. For this group of MCU's read,
write and erase functions are implemented. Further more, flash memory block
has to be erased prior to writting (write operation is not executed as erase-and-
write).

Please refer to MCU datasheet before using flash library.
Library Routines

- FLASH_Read

- FLASH_Read N _Bytes
- FLASH_Write

- FLASH_Write_8

- FLASH_Write_16

- FLASH_Write_32

- FLASH_Write_64

- FLASH_Erase

- FLASH_Erase 64

- FLASH_Erase 1024

- FLASH_Erase_Write

- FLASH_Erase_ Write_64
- FLASH_Erase_Write_1024
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FLASH_Read

// for PIC1l6
unsigned FLASH Read (unsigned address);

Prototype

// for PIC18

unsigned short FLASH Read(long address);
Returns Returns data byte from Flash memory.

Description |Reads data from the specified address in Flash memory.

Requires Nothing.

// for PIC18

unsigned short tmp;
Example S
tmp = FLASH Read (0x0DO00) ;

FLASH_Read_N_Bytes

Prototype void FLASH Read N Bytes(long address, char* data , unsigned int N);

Returns Nothing.

Reads N data from the specified address in Flash memory to varibale pointed by

Description e

Requires Nothing.

Example FLASH Read N (0x0D00,data buffer,sizeof (data_buffer));
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FLASH_Write

// for PIC16

void FLASH Write (unsigned address, unsigned int* data);
// for PIC18

Prokﬂype void FLASH Write 8 (long address, char* data);

void FLASH Write 16(long address, char* data);

void FLASH Write 32 (long address, char* data);

void FLASH Write 64 (long address, char* data);

Returns Nothing.

Writes block of data to Flash memory. Block size is MCU dependent.

P16: This function may erase memory segment before writing block of data to it
(MCU dependent). Furthermore, memory segment which will be erased may be
greater than the size of the data block that will be written (MCU dependent).
Therefore it is recommended to write as many bytes as you erase. FLASH_Write
writes 4 flash memory locations in a row, so it needs to be called as many times
as it is necessary to meet the size of the data block that will be written.

Description

P18: This function does not perform erase prior to write.

Flash memory that will be written may have to be erased before this function is

Requires called (MCU dependent). Refer to MCU datasheet for details.
Write consecutive values in 64 consecutive locations, starting from 0x0DO0O:
unsigned short toWrite] 64] ;
// initialize array:
Example for (1 = 0; 1 < 64; i++)
toWritel i] = 1i;

// write contents of the array to the address 0x0D0O:
FLASH Write 64 (0x0D00, toWrite);
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FLASH_Erase

// for PICl6

void FLASH Erase (unsigned address);
Prototype // for PIC18

void FLASH Erase 64 (long address);
void FLASH Erase 1024 (long address);

Returns Nothing.

Erases memory block starting from a given address. For P16 familly is implement-
Description |ed only for those MCU's whose flash memory does not support erase-and-write
operations (refer to datasheet for details).

Requires Nothing.

Erase 64 byte memory memory block, starting from address 0x0DO0O:
Example

FLASH Erase 64 (0x0D00) ;

FLASH_Erase_Write

// for PIC18

Prokﬂype void FLASH Erase Write 64 (long address, char* data);

void FLASH Erase Write 1024 (long address, char* data);

Returns None.

Description |Erase then write memory block starting from a given address.

Requires Nothing.

char toWrite[ 64] ;
int i;

// initialize array:

Example for (i=0; 1i<64; i++) toWrite[ i]=i;

// erase block of memory at address 0x0D0O0 then write contents of
the array to the address 0x0D0O:
FLASH Erase Write 64 (0x0D00, toWrite);
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Library Example

The example demonstrates simple write to the flash memory for PIC16F887, then
reads the data and displays it on PORTB and PORTC.

char i = 0;
unsigned int addr, data , dataAR[ 4][ 4] = {{ Ox3FAA+O, Ox3FAA+1,
O0x3FAA+2, Ox3FAA+3},

{ Ox3FAA+4, Ox3FAA+5,
O0x3FAA+6, Ox3FAA+7},

{ Ox3FAA+8, Ox3FAA+9,
Ox3FAA+10, Ox3FAA+11},

{ Ox3FAA+12, Ox3FAA+13,
Ox3FAA+14, Ox3FAA+15}} ;

void main () {

ANSEL = O0; // Configure AN pins as digital I/0
ANSELH = 0;
PORTB = 0; // Initial PORTB value

0

TRISB = 0; // Set PORTB as output
PORTC = O0; // Initial PORTC value
TRISC = 0; // Set PORTC as output
Delay ms (500);

// All block writes

// to program memory are done as l6-word erase by

// eight-word write operations. The write operation is

// edge-aligned and cannot occur across boundaries.

// Therefore it is recommended to perform flash writes in 16-word
chunks.

// That is why lower 4 bits of start address [ 3:0] must be zero.

// Since FLASH Write routine performs writes in 4-word chunks,

// we need to call it 4 times in a row.

addr = 0x0430; // starting Flash address, valid for P16F887

for (i = 0; 1 < 4; i++){ // Write some data to Flash

Delay ms (100);
FLASH Write (addr+i*4, dataAR[ i]);
}
Delay ms (500) ;

addr = 0x0430;

for (i = 0; 1 < 16; i++){
data = FLASH Read(addr++); // Pl6's FLASH is 14-bit wide, so
Delay us (10); // two MSB's will always be '00'
PORTB = data ; // Display data on PORTB LS Byte
PORTC = data_ >> 8; // and PORTC MS Byte

Delay ms (500);

}

MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD 325



CHAPTER 7

Libraries

mikroC PRO for PIC

GRAPHIC LCD LIBRARY

The mikroC PRO for PIC provides a library for operating Graphic Lcd 128x64 (with
commonly used Samsung KS108/KS107 controller).

For creating a custom set of Glcd images use Glcd Bitmap Editor Tool.

External dependencies of Graphic LCD Library

The following variables must
be defined in all projects
using Graphic LCD Library:

Description:

Example:

extern sfr char
GLCD DataPort;

Glcd Data Port.

char GLCD DataPort at
PORTD;

extern sfr sbit

Chip Select 1 line.

sbit GLCD CSl at

GLCD CS1; RBO bit;

extern sfr sbit . . sbit GLCD CS2 at
GLCD CS2; Chip Select 2 line. RE1 bit;

extern sfr sbit Reaister select line sbit GLCD RS at

GLCD_RS; 9 ' RB2 bit;

extern sfr sbit T sbit GLCD RW at

GLCD RW; Read/Write line. RE3 bit;

extern sfr sbit Enable line sbit GLCD EN at

GLCD EN; : RB4 bit;

extern sfr sbit Reset line sbit GLCD RST at
GLCD RST; ' RB5 bit;

extern sfr sbit

Direction of the Chip

sbit GLCD CS1 Direction

GLCD CS1 Direction; Select 1 pin. at TRISBO bit;
extern sfr sbit Direction of the Chip sbit GLCD CS2 Direction
GLCD_CS2 Direction; Sebct2[ﬁn_ at TRISB1 bit;

extern sfr sbit
GLCD RS Direction;

Direction of the Regis-
ter select pin.

sbit GLCD RS Direction
at TRISB2 bit;

extern sfr sbit
GLCD RW Direction;

Direction of the
Read/Write pin.

sbit GLCD RW Direction
at TRISB3 bit;

extern sfr sbit
GLCD_EN_Direction;

Direction of the Enable
pin.

sbit GLCD EN Direction
at TRISB4 bit;

extern sfr sbit
GLCD RST Direction;

Direction of the Reset
pin.

sbit GLCD RST Direction
at TRISBS5 bit;
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Library Routines
Basic routines:

- Gled_Init

- Glcd_Set_Side

- Gled_Set X

- Glcd_Set_Page
- Glcd_Read_Data
- Glcd_Write_Data

Advanced routines:

- Glcd_Fill

- Gled_Dot

- Gled_Line

- Gled_V_Line

- Gled_H_Line

- Glcd_Rectangle
- Gled_Box

- Gled_Circle

- Glcd_Set_Font
- Glcd_Write_Char
- Glcd_Write_Text
- Gled_Image
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Gled_Init

Prototype |void Glcd Init();

Returns Nothing.

Initializes the Glcd module. Each of the control lines is both port and pin config-

Description urable, while data lines must be on a single port (pins <0:7>).

Global variables:

GLcp cs1: Chip select 1 signal pin

GLcp cs2: Chip select 2 signal pin

GLCcD Rrs: Register select signal pin

crco rw: Read/Write Signal pin

GLco EN: Enable signal pin

GLCcD RrST: Reset signal pin

Requires - GLCD DataPort: Data port

GLCD cs1 Direction: Direction of the Chip select 1 pin
GLCD cs2 Direction: Direction of the Chip select 2 pin
GLCD RS Direction: Direction of the Register select signal pin
GLCD rRW Direction: Direction of the Read/Write signal pin
GLCD EN Direction: Direction of the Enable signal pin
GLCD RST Direction: Direction of the Reset signal pin

must be defined before using this function.

// glcd pinout settings
char GLCD DataPort at PORTD;

sbit GLCD CS1 at RBO bit;
sbit GLCD CS2 at RB1 bit;
sbit GLCD RS at RB2 bit;
sbit GLCD RW at RB3 bit;
sbit GLCD EN at RB4 bit;
sbit GLCD RST at RB5 bit;
Exan“ﬂe sbit GLCD CS1 Direction at TRISBO bit;
sbit GLCD CS2 Direction at TRISB1 bit;
sbit GLCD RS Direction at TRISB2 bit;
sbit GLCD RW Direction at TRISB3 bit;
sbit GLCD EN Direction at TRISB4 bit;
sbit GLCD RST Direction at TRISBS bit;

ANSEL = 0

ANSELH = 0O;
GlcdiTnit();

328 MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD



CHAPTER 7

Libraries

mikroC PRO for PIC

Glcd_Set_Side

Prototype void Glcd Set Side (unsigned short x pos);

Returns Nothing.
Selects Glcd side. Refer to the Glcd datasheet for detailed explaination.
Parameters:
- = pos: position on x-axis. Valid values: 0..127

Description
The parameter x_pos specifies the Glcd side: values from 0 to 63 specify the
left side, values from 64 to 127 specify the right side.
Note: For side, x axis and page layout explanation see schematic at the bottom
of this page.

Requires Glcd needs to be initialized, see Glcd_Init routine.
The following two lines are equivalent, and both of them select the left side of
Gled:

Example
Glcd Select Side(0);
Glcd Select side(10);

Glcd_Set_X

Prototype void Glcd Set X (unsigned short x pos);

Returns Nothing.
Sets x-axis position to x pos dots from the left border of Glcd within the select-
ed side.
Parameters:

Description
- = pos: position on x-axis. Valid values: 0..63
Note: For side, x axis and page layout explanation see schematic at the bottom
of this page.

Requires Glcd needs to be initialized, see Glcd_Init routine.

Example Glcd Set X(25);
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Glcd_Set_Page

Prototype void Glcd Set Page (unsigned short page);
Returns Nothing.
Selects page of the Glcd.
Parameters:
Description | page: page number. Valid values: 0..7
Note: For side, x axis and page layout explanation see schematic at the bottom
of this page.
Requires GLCD needs to be initialized, see Glcd_Init routine.
Example Glcd Set Page(5);

Glcd_Read_Data

Prototype unsigned short Glcd Read Datal();
Returns One byte from GLCD memory.
e Reads data from from the current location of Glcd memory and moves to the
Description .
next location.
Glcd needs to be initialized, see Glcd_Init routine.
Requires Glcd side, x-axis position and page should be set first. See functions
Glcd_Set_Side, Glcd_Set_X, and Glcd_Set_Page.
unsigned short data;
Example

data = Glcd Read Data();
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Glcd_Write_Data

Prototype |void Glcd Write Data(unsigned short ddata);

Returns Nothing.

Writes one byte to the current location in Glcd memory and moves to the next
location.

Description Parameters:

- ddata: data to be written

Glcd needs to be initialized, see Glcd_Init routine.

Requires Glcd side, x-axis position and page should be set first. See functions
Glcd_Set_Side, Glcd_Set_X, and Glcd_Set Page.
unsigned short data;

Example -
Glcd Write Data(data);

Glcd_Fill

Prototype void Glcd Fill (unsigned short pattern);

Returns Nothing.

Fills Glcd memory with the byte pattern.
Parameters:

Description |- pattern: byte to fill Glcd memory with

To clear the Glcd screen, use Glcd Fill (0).

To fill the screen completely, use Glcd Fill (0xEF).

Requires Glcd needs to be initialized, see Glcd_Init routine.

// Clear screen

Example Gled Fill(0);
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Glcd Dot

void Glcd Dot (unsigned short x pos, unsigned short y pos,

Prototype

unsigned short color);

Returns Nothing.

Draws a dot on Glcd at coordinates (x_pos, y_pos).
Parameters:

- x_pos: X position. Valid values: 0..127
- v pos: Yy position. Valid values: 0..63
Description |- color: color parameter. Valid values: 0..2

The parameter color determines a dot state: 0 clears dot, 1 puts a dot, and 2
inverts dot state.

Note: For x and y axis layout explanation see schematic at the bottom of this
page.

Requires Glcd needs to be initialized, see Glcd_Init routine.

// Invert the dot in the upper left corner

Example Gled Dot (0, 0, 2);
Glcd_Line
Protot void Glcd Line(int x start, int y start, int x end, int y end,
ototype unsigned short color);
Returns Nothing.
Draws a line on Glcd.
Parameters:
- x_start: X coordinate of the line start. Valid values: 0..127
Description | v start:y coordinate of the line start. Valid values: 0..63
P - x_end: x coordinate of the line end. Valid values: 0..127
- v _end: y coordinate of the line end. Valid values: 0..63
- color: color parameter. Valid values: 0..2
The parameter color determines the line color: 0 white, 1 black, and 2 inverts
each dot.
Requires Glcd needs to be initialized, see Glcd_Init routine.
// Draw a line between dots (0,0) and (20, 30)
Example

Glcd Line (0, 0, 20, 30, 1);
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Glcd_V_Line
void Glcd V Line (unsigned short y start, unsigned short y end,
Prototype unsigned short x pos, unsigned short color);
Returns Nothing.
Draws a vertical line on Glcd.
Parameters:
-y start:y coordinate of the line start. Valid values: 0..63
Description |- vy end: y coordinate of the line end. Valid values: 0..63
- x_pos: X coordinate of vertical line. Valid values: 0..127
- color: color parameter. Valid values: 0..2
The parameter color determines the line color: 0 white, 1 black, and 2 inverts
each dot.
Requires Glcd needs to be initialized, see Glcd_Init routine.
Exambple // Draw a vertical line between dots (10,5) and (10,25)
P Gled V Line(5, 25, 10, 1);
Glcd_H_Line
Prototvpe void Glcd H Line (unsigned short x start, unsigned short x end,
yp unsigned short y pos, unsigned short color);
Returns Nothing.
Draws a horizontal line on Glcd.
Parameters:
- x_start: X coordinate of the line start. Valid values: 0..127
Description |-z end: x coordinate of the line end. Valid values: 0..127
- v _pos:y coordinate of horizontal line. Valid values: 0..63
- color: color parameter. Valid values: 0..2
The parameter color determines the line color: 0 white, 1 black, and 2 inverts
each dot.
Requires Glcd needs to be initialized, see Glcd_Init routine.
Example // Draw a horizontal line between dots (10,20) and (50,20)
P Gled H Line (10, 50, 20, 1);
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Glcd_Rectangle

void Glcd Rectangle (unsigned short x upper left, unsigned short
Prototype y upper left, unsigned short x bottom right, unsigned short
y bottom right, unsigned short color);

Returns Nothing.
Draws a rectangle on GLCD.

Parameters:

- x upper left: X coordinate of the upper left rectangle corner. Valid values: 0..127

-y upper left:y coordinate of the upper left rectangle corner. Valid values: 0..63

L. - x bottom right: X coordinate of the lower right rectangle corner. Valid

Description | | 5j,es: 0..127

- v bottom right:y coordinate of the lower right rectangle corner. Valid
values: 0..63

- color: color parameter. Valid values: 0..2

The parameter color determines the color of the rectangle border: 0 white, 1
black, and 2 inverts each dot.

Requires GLCD needs to be initialized, see Glcd_Init routine.

// Draw a rectangle between dots (5,5) and (40,40)

Example Glcd_Rectangle (5, 5, 40, 40, 1);

Glcd_Box

void Glcd Box (unsigned short x upper left, unsigned short
Prokﬂype y upper left, unsigned short x bottom right, unsigned short
y bottom right, unsigned short color);

Returns Nothing.
Draws a box on GLCD.

Parameters:

- x upper left: X coordinate of the upper left box corner. Valid values: 0..127
- v upper left:y coordinate of the upper left box corner. Valid values: 0..63
Description |- x bottom right: X coordinate of the lower right box corner. Valid values: 0..127

- v bottom right:y coordinate of the lower right box corner. Valid values: 0..63

- color: color parameter. Valid values: 0..2

The parameter color determines the color of the box fill: 0 white, 1 black, and 2
inverts each dot.

Requires GLCD needs to be initialized, see Glcd_Init routine.

// Draw a box between dots (5,15) and (20,40)

Example Gled_Box (5, 15, 20, 40, 1);
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Glcd_Circle
Prokﬂype void Glcd Circle(int x center, int y center, int radius, unsigned

short color);

Returns Nothing.

Draws a circle on GLCD.
Parameters:

- x_center: X coordinate of the circle center. Valid values: 0..127
Description |- v center:y coordinate of the circle center. Valid values: 0..63
- radius: radius size

- color: color parameter. Valid values: 0..2

The parameter color determines the color of the circle line: 0 white, 1 black,
and 2 inverts each dot.

Requires GLCD needs to be initialized, see Glcd_lInit routine.

// Draw a circle with center in (50,50) and radius=10

Example Gled Circle(50, 50, 10, 1);

Glcd_Set_Font

void Glcd Set Font (const char *activeFont, unsigned short

Proknype aFontWidth, unsigned short aFontHeight, unsigned int aFontOffs);

Returns Nothing.
Sets font that will be used with Glcd_Write_Char and Glcd_Write_Text routines.

Parameters:

- activeront: font to be set. Needs to be formatted as an array of byte

- aFontwidth: width of the font characters in dots.

- aFontHeight: height of the font characters in dots.

Description [~ 2FontOffs: number that represents difference between the mikroC PRO for
PIC character set and regular ASCII set (eg. if 'A"is 65 in ASCII character, and
'A' is 45 in the mikroC PRO for PIC character set, aFontOffs is 20). Demo
fonts supplied with the library have an offset of 32, which means that they start
with space.

The user can use fonts given in the file “__Lib_GLCDFonts” file located in the
Uses folder or create his own fonts.

Requires GLCD needs to be initialized, see Glcd_|Init routine.

// Use the custom 5x7 font "myfont" which starts with space (32):

Exan"ﬂe Glcd Set Font (&myfont, 5, 7, 32);
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Glcd_Write_Char

void Glcd Write Char (unsigned short chr, unsigned short x pos,
unsigned short page num, unsigned short color);

Prototype

Returns Nothing.
Prints character on the GLCD.

Parameters:

- chr: character to be written

- x_pos: character starting position on x-axis. Valid values: 0..(127-FontWidth)
- page num: the number of the page on which character will be written. Valid
Description | values: 0..7

- color: color parameter. Valid values: 0..2

The parameter color determines the color of the character: 0 white, 1 black,
and 2 inverts each dot.

Note: For x axis and page layout explanation see schematic at the bottom of
this page.

Glcd needs to be initialized, see Glcd_Init routine. Use Glcd_Set Font to speci-
Requires fy the font for display; if no font is specified, then default 5x8 font supplied with
the library will be used.

// Write character 'C' on the position 10 inside the page 2:

Example Gled Write Char('C', 10, 2, 1);
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Glcd_Write Text

void Glcd Write Text (char *text, unsigned short x pos, unsigned

PrOtOtype short page num, unsigned short color);
Returns Nothing.
Prints text on GLCD.
Parameters:
- text: text to be written
- x pos: text starting position on x-axis.
o - page num: the number of the page on which text will be written. Valid values: 0..7
Description . . )
- color: color parameter. Valid values: 0..2
The parameter color determines the color of the text: 0 white, 1 black, and 2
inverts each dot.
Note: For x axis and page layout explanation see schematic at the bottom of
this page.
Glcd needs to be initialized, see Glcd_Init routine. Use Glcd_Set_Font to specify
Requires the font for display; if no font is specified, then default 5x8 font supplied with the
library will be used.
E I // Write text "Hello world!"™ on the position 10 inside the page 2:
xample Glcd Write Text("Hello world!"™, 10, 2, 1);
Glcd_Image
Prototype void Glcd Image (code const unsigned short *image);
Returns Nothing.
Displays bitmap on GLCD.
Parameters:
Description | image: image to be displayed. Bitmap array must be located in code memory.
Use the mikroC PRO for PIC integrated Glcd Bitmap Editor to convert image to
a constant array suitable for displaying on Glcd.
Requires Glcd needs to be initialized, see Glcd_Init routine.
Example // Draw image my_ image on Glcd

Glcd Image (my image);

MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD

337



CHAPTER 7
Libraries mikroC PRO for PIC

Library Example

The following example demonstrates routines of the Glcd library: initialization,
clear(pattern fill), image displaying, drawing lines, circles, boxes and rectangles, text
displaying and handling.

declarations

// Glcd module connections
char GLCD DataPort at PORTD;

sbit GLCD CS1 at RBO bit;
sbit GLCD CS2 at RB1 bit;
sbit GLCD RS at RB2 bit;
sbit GLCD RW at RB3 bit;
sbit GLCD EN at RB4 bit;
sbit GLCD RST at RB5 bit;

sbit GLCD CS1 Direction at TRISBO bit;
sbit GLCD CS2 Direction at TRISB1 bit;
sbit GLCD RS Direction at TRISB2 bit;
sbit GLCD RW Direction at TRISB3 bit;
sbit GLCD EN Direction at TRISB4 bit;
sbit GLCD RST Direction at TRISBS bit;
// End Glcd module connections

void delay2S(){ // 2 seconds delay function
Delay ms (2000) ;
}

void main () {
unsigned short ii;
char *someText;

#define COMPLETE EXAMPLE // comment this 1line to make
simpler/smaller example

ANSEL = 0; // Configure AN pins as digital
ANSELH = 0;
ClON bit = 0; // Disable comparators

C20N bit = 0;

Glcd_Init(); // Initialize GLCD
Glcd Fill (0x00); // Clear GLCD
while (1) {
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#ifdef COMPLETEiEXAMPLE
Glcd Image (truck bmp) ; // Draw image
delay2S(); delay2S();
#endif
Glcd Fill (0x00); // Clear GLCD
Glcd Box(62,40,124,56,1); // Draw box
Glcd Rectangle(5,5,84,35,1); // Draw rectangle
Glcd Line(0, 0, 127, 63, 1); // Draw line
delay2S();

for(ii = 5; ii < 60; 1i+=5 ){ // Draw horizontal and vertical lines
Delay ms (250);
Glcd V Line(2, 54, ii, 1);
Glcd H Line(2, 120, ii, 1);

delay2S();

Glcd Fill (0x00); // Clear GLCD
#ifdef COMPLETEiEXAMPLE
Glcd Set Font (Character8x7, 8, 7, 32);// Choose font, see
~ Lib GLCDFonts.c in Uses folder
#endif
Glcd Write Text ("mikroE", 1, 7, 2); // Write string

for (ii = 1; ii <= 10; ii++) // Draw circles
Glcd Circle (63,32, 3*ii, 1);
delay2S();

Glcd Box (12,20, 70,57, 2); // Draw box
delay2S();

#ifdef COMPLETE EXAMPLE
Glcd_Fill (OxFF); // Fill GLCD

Glcd Set Font (Character8x7, 8, 7, 32);// Change font

someText = "8x7 Font";
Glcd Write Text (someText, 5, 0, 2); // Write string
delay2S();

Glcd _Set Font (System3x5, 3, 5, 32); // Change font
someText = "3X5 CAPITALS ONLY";
Glcd Write Text (someText, 60, 2, 2); // Write string
delay2S();

Glcd_Set Font (font5x7, 5, 7, 32); // Change font
someText = "5x7 Font";
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Glcd Write Text (someText, 5, 4, 2); // Write string
delay2S();

Glcd Set Font (FontSystem5x7 v2, 5, 7, 32); // Change font

someText = "5x7 Font (v2)";
Glcd Write Text (someText, 5, 6, 2); // Write string
delay2S();

#endif

}

HW Connection
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I’C LIBRARY

| C full master MSSP module is available with a number of PIC MCU models. mikroC PRO for PIC
provides library which supports the master | C mode.

Note: Some MCUs have multiple I C modules. In order to use the desired | C library routine, sim-
ply change the number 1 in the prototype with the appropriate module number, i.e.
I2C1 Init (100000);

Library Routines

- 12C1_Init
- 12C1_Start
- 12C1_Repeated_Start
- 12C1_Is_Idle
-12C1_Rd
- 12C1_Wr
- 12C1_Stop
12C1_Init
Prototype void I2C1 Init (unsigned long clock);
Returns Nothing.
Initializes 1 C with desired c1ock (refer to device data sheet for correct values in
respect with Fosc). Needs to be called before using other functions of | C Library.
Description
You don’t need to configure ports manually for using the module; library will take
care of the initialization.
Library requires MSSP module on PORTB or PORTC.
. Note: Calculation of the | C clock value is carried out by the compiler, as it would
Requires . . .
produce a relatively large code if performed on the libary level.
Therefore, compiler needs to know the value of the parameter in the compile time.
That is why this parameter needs to be a constant, and not a variable.
Example I2C1 Init(100000);
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12C1_Start
Prototype |unsigned short I2C1 Start (void);
Returns If there is no error, function returns 0.
Description [Determines if I12C bus is free and issues START signal.
Requires 12C must be configured before using this function. See 12C1_Init.
Example I2C1 Start();
12C1_Repeated_Start
Prototype void I2C1 Repeated Start (void);
Returns Nothing.
Description |Issues repeated START signal.
Requires 12C must be configured before using this function. See 12C1_lInit.
Example I2C1 Repeated Start();
12C1_Is_lIdle
Prototype |unsigned short I2C1 Is Idle(void);
Returns Returns 1 if 12C bus is free, otherwise returns 0.
Description |Tests if 12C bus is free.
Requires 12C must be configured before using this function. See 12C1_lInit.
Example if (I2C1 Is Idle()) { ...}
12C1_Rd
Prototype unsigned short I2Cl Rd(unsigned short ack);
Returns Returns one byte from the slave.
. Reads one byte from the slave, and sends not acknowledge signal if parameter
Description ) .
ack is 0, otherwise it sends acknowledge.
Requires 12C must be configured before using this function. See 12C1_Init.
Also, START signal needs to be issued in order to use this function. See 12C1_Start.
Read data and send not acknowledge signal:
Example unsigned short take;
fake = I2C1 Rd(0);
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12C1_Wr

Prototype unsigned short I2Cl1 Wr (unsigned short data );

Returns Returns 0 if there were no errors.

Description |Sends data byte (parameter data) via I2C bus.

Requires 12C must be configured before using this function. See 12C1_Init.
Also, START signal needs to be issued in order to use this function. See 12C1_Start.
Example I2C1 Write (0xA3);
12C1_Stop
Prototype |void 12C1 Stop(void);
Returns Nothing.
Description |Issues STOP signal.
Requires 12C must be configured before using this function. See 12C1_Init.
Example I2C1_Stop();

MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD 343



CHAPTER 7
Libraries mikroC PRO for PIC

Library Example

This code demonstrates use of | C library. PIC MCU is connected (SCL, SDA pins)
to 24c02 EEPROM. Program sends data to EEPROM (data is written at address 2).
Then, we read data via | C from EEPROM and send its value to PORTB, to check
if the cycle was successful (see the figure below how to interface 24c02 to PIC).

void main (){

ANSEL 0; // Configure AN pins as digital I/0
ANSELH = 0;

PORTB = 0;

TRISB = 0; // Configure PORTB as output

I2C1 Init(100000); // initialize I2C communication

I2Cl1 Start(); // issue I2C start signal

I2C1 Wr (0xA2); // send byte via I2C (device address + W)
I2C1 Wr(2); // send byte (address of EEPROM location)
I2C1 Wr (0xFO); // send data (data to be written)

I2C1 Stop(); // issue I2C stop signal

Delay 100ms () ;

I2Cl1 Start(); // issue I2C start signal

I2C1 Wr (0xA2); // send byte via I2C (device address + W)
I2C1 Wr(2); // send byte (data address)

I2C1_Repeated Start(); // 1issue I2C signal repeated start

I2C1 Wr (0xA3); // send byte (device address + R)

PORTB = I2C1l Rd(Ou); // Read the data (NO acknowledge)

I2C1 Stop(); // issue I2C stop signal
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KEYPAD LIBRARY

The mikroC PRO for PIC provides a library for working with 4x4 keypad. The library routines can
also be used with 4x1, 4x2, or 4x3 keypad. For connections explanation see schematic at the bot-
tom of this page.

External dependencies of Keypad Library

The following variable must
be defined in all projects Description:
using Keypad Library:

Example:

extern sfr
keypadPort;

char

Keypad Port.

char keypadPort at PORTD;

Library Routines

- Keypad_Init
- Keypad_Key_Press
- Keypad_Key_Click

Keypad_Init

Prototype void Keypad Init (void);

Returns Nothing.

Description |[Initializes port for working with keypad.
Global variable:

Requires - keypadport - Keypad port
must be defined before using this function.
// Keypad module connections
char keypadPort at PORTD;

Exan“ﬂe // End of keypad module connections
Keypad Init();
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Keypad_Key_Press

Prototype char Keypad Key Press (void);

The code of a pressed key (1..16).

Returns If no key is pressed, returns 0.

Description [Reads the key from keypad when key gets pressed.

Requires Port needs to be initialized for working with the Keypad library, see Keypad_Init.

char kp;

Example

kp = Keypad Key Press{();

Keypad_Key_Click

Prokﬂype char Keypad Key Click(void);

The code of a clicked key (1..16).
If no key is clicked, returns 0.

Returns

Call to keypad Key Click is a blocking call: the function waits until some key is
pressed and released. When released, the function returns 1 to 16, depending on
Description [the key. If more than one key is pressed simultaneously the function will wait until
all pressed keys are released. After that the function will return the code of the
first pressed key.

Requires Port needs to be initialized for working with the Keypad library, see Keypad_ Init.

char kp;
Example

kp = Keypad Key Click();
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Library Example

This is a simple example of using the Keypad Library. It supports keypads with 1..4
rows and 1..4 columns. The code being returned by Keypad_Key_Click() function is
in range from 1..16. In this example, the code returned is transformed into ASCII
codes [0..9,A..F] and displayed on LCD. In addition, a small single-byte counter dis-
plays in the second LCD row number of key presses.

unsigned short kp, cnt, oldstate = 0;
char txt[ 6] ;

// Keypad module connections
char keypadPort at PORTD;
// End Keypad module connections

// LCD module connections
sbit LCD RS at RB4 bit;
sbit LCD EN at RB5 bit;
sbit LCD D4 at RBO bit;
sbit LCD D5 at RB1 bit;
sbit LCD D6 at RB2 bit;
sbit LCD D7 at RB3 bit;

sbit LCD RS Direction at TRISB4 bit;
sbit LCD EN Direction at TRISBS5 bit;
sbit LCD D4 Direction at TRISBO bit;
sbit LCD D5 Direction at TRISB1 bit;
sbit LCD D6 Direction at TRISBZ bit;
sbit LCD D7 Direction at TRISB3 bit;
// End LCD module connections

void main () {

cnt = 0; // Reset counter
Keypad Init(); // Initialize Keypad
Led Init(); // Initialize Lcd
Led Cmd( LCD _CLEAR) ; // Clear display
Led Cmd ( LCD _CURSOR _OFF) ; // Cursor off
Led Out (1, 1, "1M);
Lecd Out(l, 1, "Key :"); // Write message text on Lcd
Led Out (2, 1, "Times:");
do {
kp = 0; // Reset key code variable

// Wait for key to be pressed and released

do

//kp = Keypad Key Press(); // Store key code in kp variable
kp = Keypad Key Click(); // Store key code in kp variable

while ('kp);
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// Prepare value for output, transform key to it's ASCII value
switch (kp) {
//case 10: kp = 42; break; // '*' // Uncomment this block for
keypaddx3
//case 11: kp = 48; break; // '0'
//case 12: kp = 35; break; // '#'
//default: kp += 48;

case 1: kp = 49; break; // 1 // Uncomment this block for keypaddx4

case 2: kp = 50; break; // 2
case 3: kp = 51; break; // 3
case 4: kp = 65; break; // A
case 5: kp = 52; break; // 4
case ©6: kp = 53; break; // 5
case 7: kp = 54; break; // 6
case 8: kp = 66; break; // B
case 9: kp = 55; break; // 7
case 10: kp = 56; break; // 8
case 11: kp = 57; break; // 9
case 12: kp = 67; break; // C
case 13: kp = 42; break; // *
case 14: kp = 48; break; // 0
case 15: kp = 35; break; // #
case 16: kp = 68; break; // D
}
if (kp != oldstate) { // Pressed key differs from previous
cnt = 1;
oldstate = kp;
}
else { // Pressed key 1s same as previous
cnt++;
}
Led Chr (1, 10, kp); // Print key ASCII value on Lcd
if (cnt == 255) { // If counter varialble overflow
cnt = 0;
Led Out (2, 10, " ")
}

WordToStr (cnt, txt); // Transform counter value to string
Led Out (2, 10, txt); // Display counter value on Lcd
} while (1);
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HW Connection
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LCD LIBRARY

The mikroC PRO for PIC provides a library for communication with Lcds (with
HD44780 compliant controllers) through the 4-bit interface. An example of Lcd con-
nections is given on the schematic at the bottom of this page.

For creating a set of custom Lcd characters use Lcd Custom Character Tool.

External dependencies of LCD Library

The following variables
must be defined in all
projects using Lcd
Library:

Description: Example:

extern sfr sbit sbit LCD RS at

Register Select line.

LCD_RS: RB4 bit;
extern sfr sbit Enable line sbit LCD EN at
LCD_EN: : RB5 bit;
extern sfr sbit Data 7 line sbit LCD D7 at
LCD D7; ) RB3 bit;
extern sfr sbit Data 6 line sbit LCD D6 at
LCD_D6; ) RB2 bit;
extern sfr sbit Data 5 line sbit LCD D5 at
LCD D5; ) RB1 bit;
extern sfr sbit Data 4 line sbit LCD D4 at
LCD D4; ’ RBO bit;

extern sfr sbit
LCD RS Direction;

sbit LCD RS Direction
at TRISB4 bit;
sbit LCD EN Direction
at TRISBS bit;
sbit LCD D7 Direction
at TRISB3 bit;

Register Select direction pin.

extern sfr sbit

LCD EN Direction; Enable direction pin.

extern sfr sbit

ICD D7 Direction; Data 7 direction pin.

extern sfr sbit

LCD D6 Direction;

Data 6 direction pin.

sbit LCD D6 Direction
at TRISB2 bit;

extern sfr sbit
LCD D5 Direction;

Data 5 direction pin.

sbit LCD D5 Direction
at TRISBL bit;

extern sfr sbit
LCD_D4_Direction;

Data 4 direction pin.

sbit LCD D4 Direction
at TRISBO bit;
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Library Routines

- Led_Init

- Led_Out
-Lcd _Out Cp
- Led_Chr
-Lcd_Chr_Cp
-Lcd_Cmd

Lcd_Init

Prototype |void Lcd Init();
Returns Nothing.
Description |[Initializes LCD module.

Global variables:

- rcp Dp7: Data bit 7

- Lcp D6: Data bit 6

- Lcp D5: Data bit 5

- Lcp D4: Data bit 4

- .cp Rrs: Register Select (data/instruction) signal pin

- .cp eN: Enable signal pin

Requires  |. . cp 7 pirection: Direction of the Data 7 pin

- LCD D6 Direction: Direction of the Data 6 pin

- LCD D5 Direction: Direction of the Data 5 pin

- LCD D4 Direction: Direction of the Data 4 pin

- LCD RS Direction: Direction of the Register Select pin
- LCD _EN Direction: Direction of the Enable signal pin

must be defined before using this function.

// Lcd pinout settings

sbit LCD RS at RB4 bit;

sbit LCD EN at RBS5 bit;

sbit LCD D7 at RB3 bit;

sbit LCD D6 at RB2 bit;

sbit LCD D5 at RB1 bit;

sbit LCD D4 at RBO bit;

// Pin direction

sbit LCD RS Direction at TRISB4 bit;
sbit LCD EN Direction at TRISB5 bit;
sbit LCD D7 Direction at TRISB3 bit;
sbit LCD D6 Direction at TRISBZ bit;
sbit LCD D5 Direction at TRISB1 bit;
sbit LCD D4 Direction at TRISBO bit;

Example

Lcdilnit();
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Lcd_Out

Prototype void Lcd Out (char row, char column, char *text);

Returns Nothing.

Prints text on Lcd starting from specified position. Both string variables and liter-
als can be passed as a text.

- Parameters:
Description
- row: starting position row number

- column: starting position column number
- text: text to be written

Requires The Lcd module needs to be initialized. See Lcd_Init routine.

// Write text "Hello!"™ on Lcd starting from row 1, column 3:

Example Led Out (1, 3, "Hello!™);

Lcd Out CP

Prototype void Lcd Out CP(char *text);

Returns Nothing.

Prints text on LCD at current cursor position. Both string variables and literals
can be passed as a text.

Description Parameters:

- text: text to be written

Requires The Lcd module needs to be initialized. See Lcd_Init routine.

// Write text "Here!" at current cursor position:

Example Lcd Out CP("Here!");
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Lcd_Chr

Prototype void Lcd Chr (char row, char column, char out char);

Returns Nothing.

Prints character on LCD at specified position. Both variables and literals can be
passed as a character.

i Parameters:
Description
- row: writing position row number
- column: writing position column number
- out char: character to be written
Requires The Lcd module needs to be initialized. See Lcd_Init routine.
// Write character "i" at row 2, column 3:
Example

Led Chr(2, 3, 'i');

Lcd Chr_Cp

Prototype void Lcd Chr CP(char out char);

Returns Nothing.

Prints character on LCD at current cursor position. Both variables and literals
can be passed as a character.

Description Parameters:

- out char: character to be written

Requires The Lcd module needs to be initialized. See Lcd_Init routine.

// Write character "e" at current cursor position:

Example Lcd Chr CP('e');
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Lcd_Cmd

Prototype void Lcd Cmd(char out char);

Returns Nothing.
Sends command to LCD.
Parameters:

Desc"ptlon -out char: command to be sent
Note: Predefined constants can be passed to the function, see Available LCD
Commands.

Requires The LCD module needs to be initialized. See Lcd_Init table.
// Clear Lcd display:

Example Led Cmd ( LCD _CLEAR) ;

Available LCD Commands

Lcd Command

Purpose

LCD_FIRST ROW

Move cursor to the 1st row

LCD_SECOND_ROW

Move cursor to the 2nd row

LCD THIRD ROW

Move cursor to the 3rd row

LCD FOURTH ROW

Move cursor to the 4th row

LCD_CLEAR

Clear display

LCD_RETURN HOME

Return cursor to home position, returns a shifted display to its original
position. Display data RAM is unaffected.

LCD_CURSOR OFF

Turn off cursor

LCD_UNDERLINE ON

Underline cursor on

LCD_BLINK CURSOR ON

Blink cursor on

LCD_MOVE CURSOR_LEFT

Move cursor left without changing display data RAM

LCD _MOVE CURSOR RIGHT

Move cursor right without changing display data RAM

LCD_TURN ON

Turn LCD display on

LCD_TURN OFF

Turn LCD display off

LCD_SHIFT LEFT

Shift display left without changing display data RAM

LCD_SHIFT RIGHT

Shift display right without changing display data RAM
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Library Example

The following code demonstrates usage of the Lcd Library routines:

// LCD module connections
sbit LCD RS at RB4 bit;
sbit LCD EN at RB5 bit;
sbit LCD D4 at RBO bit;
sbit LCD D5 at RB1 bit;
sbit LCD D6 at RB2 bit;
sbit LCD D7 at RB3 bit;

sbit LCD RS Direction at TRISB4 bit;
sbit LCD EN Direction at TRISBS5 bit;
sbit LCD D4 Direction at TRISBO bit;
sbit LCD D5 Direction at TRISB1 bit;
sbit LCD D6 Direction at TRISBZ bit;
sbit LCD D7 Direction at TRISB3 bit;
// End LCD module connections

char txtl[] = "mikroElektronika";
char txt2[] = "EasyPIC5";
char txt3[] = "Lcd4bit";
char txt4[] = "example";
char i; // Loop variable
void Move Delay () { // Function used for text moving
Delay ms (500); // You can change the moving speed here
}
void main (){
TRISB = O0;
PORTB = OXxFF;
TRISB = 0Oxff;
ANSEL = O0; // Configure AN pins as digital I/0
ANSELH = 0;
Led Init(); // Initialize LCD
Lcd Cmd (_LCD_CLEAR) ; // Clear display
Lcd Cmd (_LCD _CURSOR _OFF) ; // Cursor off
Led Out (1, 6,txt3); // Write text in first row
Led Out (2, 6,txtd); // Write text in second row
Delay ms (2000) ;
Lcd Cmd (_LCD_CLEAR) ; // Clear display
Led Out(1,1,txtl); // Write text in first row
Led Out(2,5,txt2); // Write text in second row
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Delay ms (2000) ;

// Moving text
for (i=0; i<4; i++) { // Move text to the right 4 times

Led Cmd( LCD SHIFT RIGHT) ;
Move Delay();
}

while (1) { // Endless loop
for (1i=0; i<8; i++) { // Move text to the left 7 times

Led Cmd( LCD_SHIFT LEFT);
Move Delay();
}

for (i=0; i<8; i++) { // Move text to the right 7 times
Led Cmd ( LCD _SHIFT RIGHT) ;
Move Delay();

}
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HW connection
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MANCHESTER CODE LIBRARY

The mikroC PRO for PIC provides a library for handling Manchester coded signals.
The Manchester code is a code in which data and clock signals are combined to
form a single self-synchronizing data stream; each encoded bit contains a transition
at the midpoint of a bit period, the direction of transition determines whether the bit
is 0 or 1; the second half is the true bit value and the first half is the complement of
the true bit value (as shown in the figure below).

Manchester RF_Send_Byte format

St1|St2|Cir |B7 | B6|B5|B4 | B3| B2|B1|BO

Bi-phase coding
Al
1 O

Z2ms Example of transmission

117000100011

Notes: The Manchester receive routines are blocking calls (Man Receive Init
and Man Synchro). This means that MCU will wait until the task has been per-
formed (e.g. byte is received, synchronization achieved, etc).

Note: Manchester code library implements time-based activities, so interrupts need
to be disabled when using it.

External dependencies of Manchester Code Library

The following variables
must be defined in all proj-

. Description: Example:
ects using Manchester P P
Code Library:

extern sfr sbit MAN- Receive line sbit MANRXPIN at
RXPIN; ' RCO bit;

extern sfr sbit MAN- Transmit line sbit MANTXPIN at
TXPIN; ' RC1 bit;

extern sfr sbit MAN- sbit MANRXPIN Direction

Direction of the Receive pin.

RXPIN Direction; at TRISCO bit;

extern sfr sbit MAN- Direction of the Transmit pin sbit MANTXPIN Direction
TXPIN Direction; pin. at TRISCI1 bit;
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Library Routines

- Man_Receive_|Init
- Man_Receive

- Man_Send_Init

- Man_Send

- Man_Synchro

- Man_Break

The following routines are for the internal use by compiler only:
- Manchester_0
- Manchester_1

- Manchester_Out

Man_Receive_lInit

Prototype unsigned int Man Receive Init();

- 0 - if initialization and synchronization were successful.
Returns - 1 - upon unsuccessful synchronization.
- 255 - upon user abort.

The function configures Receiver pin and performs synchronization procedure in
order to retrieve baud rate out of the incoming signal.

Description
Note: In case of multiple persistent errors on reception, the user should call this
routine once again or Man_Synchro routine to enable synchronization.

Global variables:

MANRXPIN: Receive line

Requires , ‘ o . .
MANRXPIN Direction: Direction of the receive pin
must be defined before using this function.

// Initialize Receiver
sbit MANRXPIN at RCO bit;
Example sbit MANRXPIN Direction at TRISCO bit;

Man Receive Init();
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Man_Receive

Prototype unsigned char Man Receive (unsigned char *error);

Returns A byte read from the incoming signal.

The function extracts one byte from incoming signal.

.. Parameters:
Description

- error: error flag. If signal format does not match the expected, the error flag
will be set to non-zero.

To use this function, the user must prepare the MCU for receiving. See

Requires . .
q Man_Receive_|Init.
unsigned char data = 0, error = O0;
Example data = Man Receive (&error);
if (error)
{ /* error handling */ }
Man_Send_lInit

Prototype |void Man Send Init();

Returns Nothing.

Description |The function configures Transmitter pin.

Global variables:

MANTXPIN: Transmitline

Requires . . .
q MANTXPIN Direction: Direction of the transmit pin
must be defined before using this function.
// Initialize Transmitter:
sbit MANTXPIN at RC1 bit;
Example sbit MANTXPIN Direction at TRISCl bit;

Man Send Init();
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Man_Send

Prototype void Man Send(unsigned char tr data);

Returns Nothing.

Sends one byte.
Parameters:

Description
- tr data: data to be sent

Note: Baud rate used is 500 bps.

To use this function, the user must prepare the MCU for sending. See

ReqUIreS Man_Send_lnit_

unsigned char msg;
Example

Man Send (msg) ;

Man_Synchro

Prototype unsigned char Man Synchro();

- 255 - if synchronization was not successful.
Returns - Half of the manchester bit length, given in multiples of 10us - upon suc-
cessful synchronization.

Description |Measures half of the manchester bit length with 10us resolution.

To use this function, you must first prepare the MCU for receiving. See

Requires Man_Receive_Init.

unsigned int man half bit len;

Example S
man half bit len = Man Synchro();
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Man_Break

Prototype

void Man Break();

Returns

Nothing.

Description

Man_Receive is blocking routine and it can block the program flow. Call this
routine from interrupt to unblock the program execution. This mechanism is sim-
ilar to WDT.

Note: Interrupts should be disabled before using Manchester routines again
(see note at the top of this page).

Requires

Nothing.

Example

char datal, error, counter = 0;
void interrupt {

if (INTCON.TOIF) {
if (counter >= 20) {
Man Break () ;
counter = 0; // reset counter

}
else
counter++; // increment counter

INTCON.TOIF = 0; // Clear Timer0O overflow interrupt flag

}
}

void main () {

OPTION REG = 0x04; // TMRO prescaler set to 1:32

Man Receive Init();

// try Man Receive with blocking prevention mechanism

INTCON.GIE = 1; // Global interrupt enable

INTCON.TOIE = 1; // Enable Timer0 overflow
interrupt

datal = ManiReceive(&error);

INTCON.GIE = 0; // Global interrupt disable
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Library Example

The following code is code for the Manchester receiver, it shows how to use the
Manchester Library for receiving data:

// LCD module connections
sbit LCD RS at RB4 bit;
sbit LCD EN at RB5 bit;
sbit LCD D4 at RBO bit;
sbit LCD D5 at RB1 bit;
sbit LCD D6 at RB2 bit;
sbit LCD D7 at RB3 bit;

sbit LCD RS Direction at TRISB4 bit;
sbit LCD EN Direction at TRISBS5 bit;
sbit LCD D4 Direction at TRISBO bit;
sbit LCD D5 Direction at TRISB1 bit;
sbit LCD D6 Direction at TRISB2Z bit;
sbit LCD D7 Direction at TRISB3 bit;
// End LCD module connections

// Manchester module connections

sbit MANRXPIN at RCOibit;

sbit MANRXPIN Direction at TRISCO bit;
sbit MANTXPIN at RClibit;

sbit MANTXPIN Direction at TRISCl bit;
// End Manchester module connections

char error, ErrorCount, temp;

void main () {

ErrorCount = 0;
ANSEL = O0; // Configure AN pins as digital I/0
ANSELH = 0;
TRISC.F5 = 0;
Led Init(); // Initialize LCD
Led Cmd (. LCD CLEAR) ; // Clear LCD display
Man Receive Init(); // Initialize Receiver
while (1) { // Endless loop
Lcd Cmd( LCD_FIRST ROW) ; // Move cursor to the lst row
while (1) { // Wait for the "start" byte
temp = Man Receive (&error); // Attempt byte receive
if (temp == 0x0B)// "Start" byte, see Transmitter example
break; // We got the starting sequence
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if (error) // Exit so we do not loop forever

break;

do

{
temp = Man Receive (&error); // Attempt byte receive
// If error occured

if (error) {
Led Chr CP('?21'"); // Write question mark on LCD
ErrorCount++; // Update error counter
{ // In case of multiple errors

if (ErrorCount > 20)
temp = Man Synchro(); // Try to synchronize again
//Man_Receive Init(); // Alternative, try to Initialize

Receiver again

ErrorCount = 0; // Reset error counter
}
}
else { // No error occured
if (temp != O0x0E) // If "End" byte was received(see

Transmitter example)
Lcd Chr CP(temp);//

}
Delay ms (25);

do not write received byte on LCD

}

while (temp != 0x0E);// If "End" byte was received exit do loop
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The following code is code for the Manchester transmitter, it shows how to use the
Manchester Library for transmitting data:

// Manchester module connections

sbit MANRXPIN at RCOibit;

sbit MANRXPIN Direction at TRISCO bit;
sbit MANTXPIN at RClibit;

sbit MANTXPIN Direction at TRISCl bit;
// End Manchester module connections

char index, character;

char sl[] = "mikroElektronika";
void main () {
Man Send Init(); // Initialize transmitter
while (1) { // Endless loop
Man_ Send (0x0B) ; // Send "start" byte
Delay ms(100); // Wait for a while
character = s1[ 0] ; // Take first char from string
index = 0; // Initialize index variable
while (character) { // String ends with zero
Man Send(character); // Send character
Delay ms (90); // Wait for a while
index++; // Increment index variable
character = sl index] ; // Take next char from string
}
Man_ Send (0x0E) ; // Send "end" byte

Delay ms (1000);
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Connection Example
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MULTI MEDIA CARD LIBRARY

The Multi Media Card (MMC) is a flash memory card standard. MMC cards are cur-
rently available in sizes up to and including 1 GB, and are used in cell phones, mp3
players, digital cameras, and PDA’s.

mikroC PRO for PIC provides a library for accessing data on Multi Media Card via
SPI communication.This library also supports SD(Secure Digital) memory cards.

Secure Digital Card

Secure Digital (SD) is a flash memory card standard, based on the older Multi Media
Card (MMC) format.

SD cards are currently available in sizes of up to and including 2 GB, and are used
in cell phones, mp3 players, digital cameras, and PDAs.

Notes:

- Library works with PIC18 family only;

- The library uses the SPI module for communication. User must initialize
SPI module before using the SPI Graphic Lcd Library.

- For MCUs with two SPI modules it is possible to initialize both of them and
then switch by using the sp1 set active () routine.

- Routines for file handling can be used only with FAT16 file system.

- Library functions create and read files from the root directory only;

- Library functions populate both FAT1 and FAT2 tables when writing to files,
but the file data is being read from the FAT1 table only; i.e. there is no
recovery if FAT1 table is corrupted.

Note: The SPI module has to be initialized through sp11 Tnit Advanced routine
with the following parameters:

- SPI Master

- 8bit mode

- primary prescaler 16

- Slave Select disabled

- data sampled in the middle of data output time

- clock idle low

- Serial output data changes on transition from idle clock state to active

clock state
SPI1 Init Advanced( SPI MASTER OSC DIV16,  SPI DATA SAMPLE MIDDLE,
_SPI CLK IDLE LOW,  SPI 1OW 2 HIGH); must be called before initializing
Mmc_Init.
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Note: Once the MMC/SD card is initialized, the user can reinitialize SPI at higher
speed. See the Mmc_Init and Mmc_Fat_Init routines.

External dependencies of MMC Library

The following variable must

be defined in all projects Description: Example:

using MMC library:
extern sfr sbit
Mmc Chip Select;

sbit Mmc Chip Select at
RC2 bit

sbit

Mmc Chip Select Direction
at TRISC2 bit;

Chip select pin.

extern sfr sbit Direction of the
Mmc Chip Select Direction;|chip select pin.

Library Routines

- Mmc_Init

- Mmc_Read_Sector
- Mmc_Write_Sector
- Mmc_Read_Cid

- Mmc_Read_Csd

Routines for file handling:

- Mmc_Fat_|Init

- Mmc_Fat_QuickFormat
- Mmc_Fat_Assign

- Mmc_Fat_Reset

- Mmc_Fat_Read

- Mmc_Fat_Rewrite

- Mmc_Fat_Append

- Mmc_Fat_Delete

- Mmc_Fat_Write

- Mmc_Fat_Set File_Date
- Mmc_Fat_Get _File_Date
- Mmc_Fat_Get_File_Size
- Mmc_Fat_Get Swap_File
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Mmc_lInit

Prototype unsigned char Mmc Init();

- 0 -if MMC/SD card was detected and successfuly initialized
- 1 - otherwise

Returns

Initializes hardware SPI communication; The function returns 1 if MMC card is
Description |present and successfuly initialized, otherwise returns 0.
Mmc_Init needs to be called before using other functions of this library.

Global variables:

-Mmc Chip select: Chip Select line

Requires -Mmc Chip select Direction: Direction of the Chip Select pin

must be defined before using this function.

// MMC module connections

sfr sbit Mmc Chip Select at RC2 bit;

sfr sbit Mmc Chip Select Direction at TRISC2 bit;
Example // MMC module connections

SPI1 Init();
error = Mmc_Init(); // Init with CS line at RC2 bit

Mmc_Read_Sector

Prototype unsigned char Mmc Read Sector (unsigned long sector, char* dbuff);

Returns Returns 0 if read was successful, or 1 if an error occurred.

Function reads one sector (512 bytes) from MMC card at sector address scctor.
Description |Read data is stored in the array d=ta. Function returns 0 if read was successful,
or 1 if an error occurred.

Requires Library needs to be initialized, see Mmc_Init.

Example error = Mmc_Read Sector (sector, data);
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Mmc_Write_Sector

Prototype unsigned char Mmc Write Sector (unsigned long sector, char *dbuff);
Returns 0 if write was successful; returns 1 if there was an error in sending
Returns . ) . . s
write command; returns 2 if there was an error in writing.
Function writes 512 bytes of data to MMC card at sector address sector.
Description |Function returns 0 if write was successful, or 1 if there was an error in sending
write command, or 2 if there was an error in writing.
Requires Library needs to be initialized, see Mmc_Init.
Example error := Mmc Write Sector (sector, data);

Mmc_Read_Cid

Prototype unsigned char Mmc Read Cid(char * data for registers);
Returns Returns 0 if read was successful, or 1 if an error occurred.
I Function reads CID register and returns 16 bytes of content into
Description ,
data for registers.
Requires Library needs to be initialized, see Mmc_Init.
Example error = Mmc Read Cid(data);

Mmc_Read_Csd

Prototype unsigned char Mmc Read Csd(char * data for registers);
Returns Returns 0 if read was successful, or 1 if an error occurred.
e Function reads CSD register and returns 16 bytes of content into
Description ,
data for registers.
Requires Library needs to be initialized, see Mmc_Init.
Example error = Mmc Read Csd(data);
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Mmc_Fat_Init

Prototype [unsigned short Mmc Fat Init();

- 0 -if MMC/SD card was detected and successfuly initialized
Returns - 1 -if FAT16 boot sector was not found
- 255 - if MMC/SD card was not detected

Initializes MMC/SD card, reads MMC/SD FAT16 boot sector and extracts neces-
Description |sary data needed by the library.
Note: MMC/SD card has to be formatted to FAT16 file system.

Global variables:

-Mmc Chip select: Chip Select line

-Mmc Chip Select Direction: Direction of the Chip Select pin
Requires
must be defined before using this function.

The appropriate hardware SPI module must be previously initialized. See the
SPI1_Init, SPI1_Init_Advanced routines.

// MMC module connections

sfr sbit Mmc Chip Select at RC2 bit;

sfr sbit Mmc Chip Select Direction at TRISC2Z bit;
// MMC module connections

// Initialize SPI1 module and set pointer(s) to SPI1 functions
SPI1 Init Advanced (MASTER OSC DIV64, DATA SAMPLE MIDDLE,
CLK_IDLE IOW, LOW 2 HIGH);

Example
// use fatl6 quick format instead of init routine if a formatting
is needed

if (!Mmc Fat Init()) {

// reinitialize SPI1 at higher speed

SPI1 Init Advanced (MASTER OSC DIV4, DATA SAMPLE MIDDLE,

CLK_IDLE IOW, LOW 2 HIGH);

}
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Mmc_Fat_QuickFormat

Prototype unsigned char Mmc Fat QuickFormat (char * mmc_fat label);

- 0 -if MMC/SD card was detected and successfuly initialized
Returns - 1 -if FAT16 format was unseccessful
- 255 - if MMC/SD card was not detected

Formats to FAT16 and initializes MMC/SD card.
Parameters:

-mmc fat label: volume label (11 characters in length). If less than 11 charac-
ters are provided, the label will be padded with spaces. If null string is passed
i volume will not be labeled

Description
Note: This routine can be used instead or in conjunction with Mmc_Fat_Init rou-
tine.

Note: If MMC/SD card already contains a valid boot sector, it will remain
unchanged (except volume label field) and only FAT and ROOT tables will be
erased. Also, the new volume label will be set.

Requires The appropriate hardware SPI module must be previously initialized.

// Initialize SPI1 module and set pointer(s) to SPI1 functions
SPT1 Tnit Advanced (MASTER OSC DIV64, DATA SAMPLE MIDDLE,
CLK IDLE IOW, LOW 2 HIGH);

// Format and initialize MMC/SD card and MMC FAT16 library glob-
als

if (!Mmc Fat QuickFormat (&émmc fat label)) {
Example - = - -
// Reinitialize the SPI module at higher speed (change primary
prescaler) .
SPI1 Init Advanced (MASTER OSC DIV4, DATA SAMPLE MIDDLE,
CLK_IDLE LOW, LOW 2 HIGH);

}
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Mmc_Fat_Assign

Prototype unsigned short Mmc Fat Assign(char * filename, char file cre attr);

- 1 - if file already exists or file does not exist but new file is created.
- 0 -if file does not exist and no new file is created.

Assigns file for file operations (read, write, delete...). All subsequent file opera-
tions will be applied over the assigned file.

Returns

Parameters:

- filename: name of the file that should be assigned for file operations. File name
should be in DOS 8.3 (file_name.extension) format. The file name and extension will
be automatically padded with spaces by the library if they have less than length
required (i.e. "mikro.tx" -> "mikro .tx "), so the user does no have to take care of that.
The file name and extension are case insensitive. The library will convert them to
proper case automatically, so the user does not have to take care of that. Also, in
order to keep backward compatibility with first version of this library, file names can
be entered as UPPERCASE string of 11 bytes in length with no dot character
between file name and extension (i.e. "MIKROELETXT" -> MIKROELE.TXT). In this
case last 3 characters of the string are considered to be file extension.

- file cre attr: file creation and attributs flags. Each bit corresponds to

Description | 505 opriate file attribut:

Bit Mask Description

0x01 Read Only

0x02 Hidden

0x04 System

0x08 Volume Label

0x10 Subdirectory

0x20 Archive

0x40 Device (internal use only, never found on disk)

File creation flag. If file does not exist and this flag is set,
new file with specified name will be created.

N | Ol R WIN] | O

0x80

Note: Long File Names (LFN) are not supported.

MMC/SD card and MMC library must be initialized for file operations. See

Requires Mmc_Fat_Init.

//Create file with archive attribut if it does not already exists

Example Mmc Fat Assign ('MIKROELE.TXT', 0xAO0);
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Mmc_Fat_Reset

Prototype void Mmc Fat Reset (unsigned long * size);
Returns Nothing.
Procedure resets the file pointer (moves it to the start of the file) of the assigned
Description [file, so that the file can be read.
Parameter size stores the size of the assigned file, in bytes.
Requires The file must be assigned, see Mmc_Fat_Assign.
Example Mmc_Fat Reset (size);

Mmc_Fat_Rewrite

Prototype void Mmc Fat Rewrite();
Returns Nothing.
. Procedure resets the file pointer and clears the assigned file, so that new data
Description . . .
can be written into the file.
Requires The file must be assigned, see Mmc_Fat_Assign.
Example Mmc Fat Rewrite;

Mmc_Fat_Append

Prototype void Mmc Fat Append();
Returns Nothing.
.- The procedure moves the file pointer to the end of the assigned file, so that
Description !
data can be appended to the file.
Requires The file must be assigned, see Mmc_Fat_Assign.
Example Mmc_ Fat Append;
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Mmc_Fat_Read

Prototype void Mmc Fat Read (unsigned short *bdata);

Returns Nothing.

Procedure reads the byte at which the file pointer points to and stores data into
Description |parameter data. The file pointer automatically increments with each call of
Mmc Fat Read.

The file must be assigned, see Mmc_Fat_Assign. Also, file pointer must be ini-

Requires tialized; see Mmc_Fat_Reset.

Example Mmc_Fat Read (mydata) ;

Mmc_Fat_Delete

Prototype void Mmc Fat Delete();

Returns Nothing.

Description |Deletes currently assigned file from MMC/SD card.

MMC/SD card and MMC library must be initialized for file operations. See
Requires Mmc_Fat_Init.
The file must be previously assigned. See Mmc_Fat_Assign.

// delete current file

Example Mmc Fat Delete () ;

Mmc_Fat_Write

Prototype void Mmc Fat Write (char * fdata, unsigned data len);

Returns Nothing.

Procedure writes a chunk of bytes (fdztz) to the currently assigned file, at the

Description position of the file pointer.

The file must be assigned, see Mmc_Fat_Assign. Also, file pointer must be ini-

Requires tialized; see Mmc_Fat_Append or Mmc_Fat_Reuwrite.

Mmc Fat Write (txt,255);

Example Mmc Fat Write('Hello world',255);
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Mmc_Fat_Set File_Date

void Mmc Fat Set File Date (unsigned int year, unsigned short

Prokﬂype month, unsigned short day, unsigned short hours, unsigned short
mins, unsigned short seconds);
Returns Nothing.
i Writes system timestamp to a file. Use this routine before each writing to file;
Description : i : .
otherwise, the file will be appended an unknown timestamp.
. The file must be assigned, see Mmc_Fat_Assign. Also, file pointer must be ini-
Requires L
tialized; see Mmc_Fat_Reset.
Example // April 1lst 2005, 18:07:00

Mmc Fat Set File Date (2005, 4, 1, 18, 7, 0);

Mmc_Fat_Get_File_Date

void Mmc Fat Get File Date (unsigned int *year, unsigned short *month,

PrOtOtype unsigned short *day, unsigned short *hours, unsigned short *mins);
Returns Nothing.
e Retrieves date and time for the currently selected file. Seconds are not being
Description . . . . .
retrieved since they are written in 2-sec increments.
Requires The file must be assigned, see Mmc_Fat_Assign.
// get Date/time of file
unsigned yr;
char mnth, dat, hrs, mins;
Example

"MYFILEABTXT";
Mmc Fat Assign(file Name);
Mmc Fat Get File Date(yr,

file Name =

mnth, dat, hrs, mins);

Mmc_Fat_Get_File_Size

Prototype |unsigned long Mmc Fat Get File Size();
Returns This function returns size of active file (in bytes).
Description |Retrieves size for currently selected file.
Requires The file must be assigned, see Mmc_Fat_Assign.

// get Date/time of file

unsigned yr;

char mnth, dat, hrs, mins;
Example -

file name = "MYFILEXXTXT";

Mmc Fat Assign(file name);

mmc_size = Mmc Fat Get File Size;
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Mmc_Fat_Get Swap_File

unsigned long Mmc Fat Get Swap File (unsigned long sectors cnt, char*
filename, char file attr);

Prototype

- Number of the start sector for the newly created swap file, if there was enough
Returns free space on the MMC/SD card to create file of required size.
- 0 - otherwise.

This function is used to create a swap file of predefined name and size on the
MMC/SD media. If a file with specified name already exists on the media, search
for consecutive sectors will ignore sectors occupied by this file. Therefore, it is
recomended to erase such file if it exists before calling this function. If it is not
erased and there is still enough space for new swap file, this function will delete
it after allocating new memory space for new swap file.

The purpose of the swap file is to make reading and writing to MMC/SD media as
fast as possible, by using the Mmc_Read_Sector() and Mmc_Write_Sector()
functions directly, without potentially damaging the FAT system. Swap file can be
considered as a "window" on the media where user can freely write/read the data.
It's main purpose in mikroC's library is to be used for fast data acquisition; when
the time-critical acquisition has finished, the data can be re-written into a "normal”
file, and formatted in the most suitable way.

e Parameters:
Description
- sectors cnt: number of consecutive sectors that user wants the swap file to
have.

- filename: name of the file that should be assigned for file operations. File name
should be in DOS 8.3 (file_name.extension) format. The file name and extension
will be automatically padded with spaces by the library if they have less than
length required (i.e. "mikro.tx" -> "mikro .tx "), so the user does no have to take
care of that. The file name and extension are case insensitive. The library will con-
vert them to proper case automatically, so the user does not have to take care of
that.

Also, in order to keep backward compatibility with first version of this library, file
names can be entered as UPPERCASE string of 11 bytes in length with no dot
character between file name and extension (i.e. "MIKROELETXT" ->
MIKROELE.TXT). In this case last 3 characters of the string are considered to be
file extension.
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Description

- file attr: file creation and attributs flags. Each bit corresponds to appropri-

ate file attribut:

Bit Mask Description

0 0x01 Read Only

1 0x02 Hidden

2 0x04 System

3 0x08 Volume Label

4 0x10 Subdirectory

5 0x20 Archive

6 0x40 Device (internal use only, never found on disk)
7 0x80 Not used

Note: Long File Names (LFN) are not supported.

MMC/SD card and MMC library must be initialized for file operations. See

Requires Mmc_Fat_Init.
[/ == ——————— Tries to create a swap file, whose size will be at
least 100 sectors.
//If it succeeds, it sends the No. of start sector over UART
void M Create Swap File (){
size = Mmc Fat Get Swap File(100);
if (size <> 0) {
E | UARTJNri‘Ee (OxAR) ;
Xample UART Write(Lo(size));
UART Write (Hi(size));

UART Write (Highest (size));

(L
(H
UART Write (Higher(size));
(
UARTJNri‘Ee (OxAR) ;
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Library Example

The following example demonstrates MMC library test. Upon flashing, insert a
MMC/SD card into the module, when you should receive the "Init-OK" message.
Then, you can experiment with MMC read and write functions, and observe the
results through the Usart Terminal.

// MMC module connections

sbit Mmc Chip Select at RC2 bit;
sbit Mmc Chip Select Direction at TRISCZ bit;
// eof MMC module connections

// Variables for MMC routines
unsigned char SectorDatal 512] ; // Buffer for MMC sector reading/writing
unsigned char data for registers[ 16] ;// buffer for CID and CSD registers

// UART1 write text and new line (carriage return + line feed)
void UART1 Write Line(char *uart text) ({

UART1 Write Text (uart text);

UART1 Write(13);

UART1 Write (10);
}

// Display byte in hex
void PrintHex (unsigned char i) {
unsigned char hi, lo;

hi = i & OxFO; // High nibble
hi = hi >> 4;

hi = hl + '0';

if (h 'Y hi=hi+7;

lo = (1 & OxO0F) + '0'; // Low nibble
if (1lo>'9') lo=lo+7;

UART1 Write (hi);
UART1 Write(lo);

void main () {

const char FILL CHAR = 'm';

unsigned int i, SectorNo;

char mmc_error;

bit data ok;

ADCON1 |= 0xO0F; // Configure AN pins as digital
CMCON = 7; // Turn off comparators

// Initialize UART1 module

380 MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD



CHAPTER 7
mikroC PRO for PIC Libraries

UART1 Init(19200);
Delay ms (10);

UART1 Write Line("PIC-Started"); // PIC present report
// Initialize SPI1 module
SPI1 Init Advanced( SPI_MASTER OSC DIV64, SPI_DATA SAMPLE MIDDLE,

_SPI_CLK_IDLE LOW, SPI LOW 2 HIGH);

// initialise a MMC card

mmc_error = Mmc_ Init();
if (mmc_error == 0)

UART1 Write Line("MMC Init-OK"); // If MMC present report
else

UART1 Write Line("MMC Init-error"); // If error report

// Fill MMC buffer with same characters
for (i=0; i<=511; i++)
SectorDatal i] = FILL CHAR;

// Write sector
mmc_error = Mmc Write Sector (SectorNo, SectorData);
if (mmc_error == 0)
UART1 Write Line ("Write-OK");
else // if there are errors.....
UART1 Write Line ("Write-Error");

// Reading of CID register
mmc_error = Mmc Read Cid(data for registers);
if (mmc_error == 0) {

UART1 Write Text ("CID : ");

for (1i=0; 1i<=15; 1i++)

PrintHex (data for registers[ i]);

UART1 Write Line("");
}
else

UART1 Write Line ("CID-error");

// Reading of CSD register
mmc_error = Mmc Read Csd(data for registers);
if (mmc_error == 0) {

UART1 Write Text ("CSD : ");

for (i=0; 1i<=15; 1i++)

PrintHex (data for registers[ i]);

UART1 Write Line("");
}
else

UART1 Write Line ("CSD-error");

// Read sector
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mmc_error = Mmc Read Sector (SectorNo, SectorData);
if (mmc _error == 0) {
UART1 Write Line ("Read-OK");
// Chech data match
data ok = 1;
for (1=0; 1i<=511; i++) {
UART1 Write (SectorDatal i]);
if (SectorDatal i] != FILL CHAR) {
data ok = 0;
break;
}
}
UART1 Write Line("");
if (data ok)
UART1 Write Line ("Content-OK");
else
UART1 Write Line ("Content-Error");
}
else // if there are errors.....
UART1 Write Line ("Read-Error");

// Signal test end
UART1 Write Line("Test End.");
}
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HW Connection

i -~ ]
1 1
E | :
1 i ez
] B p T
(] 1
E 2 %—O ’ SPIMNS0
., = o %—u v cas
_CECWLATOR i VCC SFI-MO0SI
Mﬂ GND E i seiscK
S—— CLKIN m ] R13 ms[:| RAT
|: N :l ZK2 pivd 2Kz
1 I
i o i
RC2 RCS
RC3 R4 [} I
i i LJ:*.::U?.:‘:U:‘.:&
] I 1T
|

MMC interface

/ 1111111

1234567

MMC

Back view

MMC back view

MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD 383



CHAPTER 7
Libraries mikroC PRO for PIC

ONEWIRE LIBRARY

The OneWire library provides routines for communication via the Dallas OneWire
protocol, for example with DS18x20 digital thermometer. OneWire is a Master/Slave
protocol, and all communication cabling required is a single wire. OneWire enabled
devices should have open collector drivers (with single pull-up resistor) on the
shared data line.

Slave devices on the OneWire bus can even get their power supply from data line.
For detailed schematic see device datasheet.

Some basic characteristics of this protocol are:

- single master system,

- low cost,

- low transfer rates (up to 16 kbps),

- fairly long distances (up to 300 meters),
- small data transfer packages.

Each OneWire device also has a unique 64-bit registration number (8-bit device
type, 48-bit serial number and 8-bit CRC), so multiple slaves can co-exist on the
same bus.

Note that oscillator frequency Fosc needs to be at least 4MHz in order to use the
routines with Dallas digital thermometers.

Note: This library implements time-based activities, so interrupts need to be dis-
abled when using OneWire library.

Library Routines
- Ow_Reset

- Ow_Read
- Ow_Write
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Ow_Reset
Prototype unsigned short Ow Reset (unsigned short *port, unsigned short pin);
Returns 0 if DS1820 is present, and 1 if not present.
.- Issues OneWire reset signal for DS1820. Parameters PORT and pin specify the
Description :
location of DS1820.
Requires Works with Dallas DS1820 temperature sensor only.
To reset the DS1820 that is connected to the RA5 pin:
Example
Ow_Reset (&PORTA, 5);
Ow_Read
Prototype unsigned short Ow Read(unsigned short *port, unsigned short pin);
Returns Data read from an external device over the OneWire bus.
Description |Reads one byte of data via the OneWire bus.
Requires Nothing.
unsigned short tmp;
Example S
tmp = Ow_Read (&PORTA, 5);
Ow_Write
Prototype void Ow Wr%te (unsigned short *port, unsigned short pin, unsigned
short par);
Returns Nothing.
Description |Writes one byte of data (argument pzr) via OneWire bus.
Requires Nothing.
Example Ow _Write (&§PORTA, 5, 0xCC);
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Library Example

This example reads the temperature using DS18x20 connected to pin PORTA.B5.
After reset, MCU obtains temperature from the sensor and prints it on the Lcd. Make
sure to pull-up PORTA.B5 line and to turn off the PORTA LEDs.

// LCD module connections
sbit LCD RS at RB4 bit;
sbit LCD EN at RB5 bit;
sbit LCD D4 at RBO bit;
sbit LCD D5 at RB1 bit;
sbit LCD D6 at RB2 bit;
sbit LCD D7 at RB3 bit;

sbit LCD RS Direction at TRISB4 bit;
sbit LCD EN Direction at TRISBS5 bit;
sbit LCD D4 Direction at TRISBO bit;
sbit LCD D5 Direction at TRISB1 bit;
sbit LCD D6 Direction at TRISBZ bit;
sbit LCD D7 Direction at TRISB3 bit;
// End LCD module connections

// Set TEMP RESOLUTION to the corresponding resolution of used
DS18x20 sensor:

// 18S20: 9 (default setting; can be 9,10,11,o0r 12)

// 18B20: 12

const unsigned short TEMP RESOLUTION = 9;

char *text = "000.0000";

unsigned temp;

void Display Temperature (unsigned int temp2write) {
const unsigned short RES SHIFT = TEMP RESOLUTION - 8;
char temp whole;
unsigned int temp fraction;

// check if temperature is negative
if (temp2write & 0x8000) {
text[ 0] = '-';
temp2write = ~temp2write + 1;
}
// extract temp whole
temp whole = tempZwrite >> RES SHIFT;

// convert temp whole to characters
if (temp whole/100)

text[ 0] = temp whole/100 + 48;
else
text[ 0] = '0"';
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text[ 1] = (temp whole/10)%10 + 48; // Extract tens digit
text[ 2] = temp whole%10 + 48; // Extract ones digit

// extract temp fraction and convert it to unsigned int
temp fraction = temp2write << (4-RES_ SHIFT);

temp fraction &= 0x000F;

temp fraction *= 625;

// convert temp fraction to characters

text[ 4] = temp fraction/1000 + 48; // Extract thousands digit
text[ 5] = (temp fraction/100)%10 + 48; // Extract hundreds digit
text[ 6] = (temp fraction/10)%10 + 48; // Extract tens digit
text[ 7] = temp fraction%10 + 48; // Extract ones digit

// print temperature on LCD
Lcd Out (2, 5, text);
}

void main () {

ANSEL = O0; // Configure AN pins as digital I/0
ANSELH = O0;

Led Init(); // Initialize LCD

Lcd Cmd ( LCD _CLEAR) ; // Clear LCD

Lcd Cmd (. LCD _CURSOR_OFF) ; // Turn cursor off

Lcd Out(l, 1, " Temperature: ")

// Print degree character, 'C' for Centigrades

Lcd Chr(2,13,223); // different LCD displays have different char

code for degree
// if you see greek alpha letter try typing 178 instead of 223

Led Chr(2,14,'Cl);

//--- main loop
do {
//--- perform temperature reading
Ow_Reset (&PORTA, 5); // Onewire reset signal
Ow _Write (&§PORTA, 5, O0xCC); // Issue command SKIP ROM
Ow Write (&PORTA, 5, 0x44); // Issue command CONVERT T
(

Delay us(120);

Ow_Reset (&PORTA, 5);

Ow Write (&PORTA, 5, 0xCC); // Issue command SKIP ROM
Ow Write (&§PORTA, 5, OxBE); // Issue command READ SCRATCHPAD
temp = Ow_Read(&PORTA, 5);

temp = (Ow_Read(&PORTE, 5) << 8) + temp;

//--- Format and display result on Lcd

Display Temperature (temp) ;

Delay ms (500);
} while (1);
}

MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD 387




CHAPTER 7
Libraries mikroC PRO for PIC

HW Connection
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PORT EXPANDER LIBRARY

The mikroC PRO for PIC provides a library for communication with the Microchip’s
Port Expander MCP23S17 via SPI interface. Connections of the PIC compliant MCU
and MCP23S17 is given on the schematic at the bottom of this page.

Note: Library does not use Port Expander interrupts.
Note: The appropriate hardware SPI module must be initialized before using any of
the Port Expander library routines. Refer to SPI Library.

External dependencies of Port Expander Library

The following variables
must be defined in all

projects using Port Description: Example:
Expander Library:
extern sfr sbit Reset line. SPExpanderCS : sbit
SPExpanderRST; at P1.B1;
SIS [one sectine Lo
sbit

extern sfr sbit

i i i SPE RST Directi
SPExpanderRST Direction; Direction of the Reset pin. |[SPExpanderRST Direction

at TRISCO bit;

sbit

SPExpanderCS Direction
at TRISCI bit

extern sfr sbit Direction of the Chip
SPExpanderCs_Direction; |Select pin.

Library Routines

- Expander_Init

- Expander_Read_Byte

- Expander_Write_Byte

- Expander_Read_PortA

- Expander_Read_PortB

- Expander_Read_PortAB

- Expander_Write_PortA

- Expander_Write_PortB

- Expander_Write_PortAB

- Expander_Set_DirectionPortA
- Expander_Set_DirectionPortB
- Expander_Set DirectionPortAB
- Expander_Set PullUpsPortA
- Expander_Set_PullUpsPortB
- Expander_Set PullUpsPortAB
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Expander_lInit

Prototype void Expander Init (char ModuleAddress);

Returns Nothing.

Initializes Port Expander using SPI communication.

Port Expander module settings:

- hardware addressing enabled

- automatic address pointer incrementing disabled (byte mode)
Description |- BANK 0 register adressing

- slew rate enabled

Parameters:

- ModuleAddress: Port Expander hardware address, see schematic at the
bottom of this page

Global variables:

- SPExpandercs: Chip Select line

- sPExpanderRST: Resetline

. - SPExpanderCS Direction: Direction of the Chip Select pin

Requires - , o X
- SpPExpanderRST Direction: Direction of the Reset pin

must be defined before using this function.

SPI module needs to be initialized. See SPI1_Init and SPI1_Init Advanced routines.

// Port Expander module connections

sbit SPExpanderRST at RCO bit;

sbit SPExpanderCS at RC1l bit;

sbit SPExpanderRST Direction at TRISCO bit;
sbit SPExpanderCS Direction at TRISC1l bit;
// End Port Expander module connections

Example

ANSEL =
ANSELH

// Configure AN pins as digital I/O

0;
0;

// If Port Expander Library uses SPI module

SPI1 Init(); // Initialize SPI module used with
PortExpander
Expander Init (0); // Initialize Port Expander
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Expander_Read_Byte

Prokﬂype char Expander Read Byte (char ModuleAddress, char RegAddress);

Returns Byte read.

The function reads byte from Port Expander.

Parameters:

Description

- Moduleaddress: Port Expander hardware address, see schematic at the
bottom of this page

- Reghddress: Port Expander's internal register address

Requires Port Expander must be initialized. See Expander_lnit.

// Read a byte from Port Expander's register

char read data;
Example -

read data = Expander Read Byte(0,1);

Expander_Write_Byte

void Expander Write Byte (char ModuleAddress, char RegAddress,

Prototype |, .. Data) ;

Returns Nothing.
Routine writes a byte to Port Expander.
Parameters:

Description

- ModuleAddress: Port Expander hardware address, see schematic at the
bottom of this page

- RegAddress: Port Expander's internal register address

- Data : data to be written

Requires Port Expander must be initialized. See Expander_Init.

// Write a byte to the Port Expander's register

Exan“ﬂe Expander Write Byte (0,1, SFF);
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Expander_Read_ PortA

Prototype char Expander Read PortA(char ModuleAddress);

Returns Byte read.

The function reads byte from Port Expander's PortA.

. Parameters:
Description

- ModuleAddress: Port Expander hardware address, see schematic at the
bottom of this page

Port Expander must be initialized. See Expander_Init.

Requires ' .
q Port Expander's PortA should be configured as an input. See
Expander_Set_DirectionPortA and Expander_Set_DirectionPortAB routines.
// Read a byte from Port Expander's PORTA
char read data;
Example Expander Set DirectionPortA(0,0xFF); // set expander's porta to

be input

read data = Expander Read PortA(0);

Expander_Read_PortB

Prototype char Expander Read PortB(char ModuleAddress);

Returns Byte read.

The function reads byte from Port Expander's PortB.

e Parameters:
Description
- Moduleaddress: Port Expander hardware address, see schematic at the

bottom of this page

Port Expander must be initialized. See Expander_Init.

Requires . ) . .
q Port Expander's PortB should be configured as input. See Expander_Set_Direc-
tionPortB and Expander_Set_DirectionPortAB routines.
// Read a byte from Port Expander's PORTB
char read data;
Example Expander Set DirectionPortB(0,0xFF); // set expander's

portb to be input

read data = Expander Read PortB(0);
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Expander_Read_ PortAB

Prototype unsigned int Expander Read PortAB(char ModuleAddress) ;

Returns Word read.

The function reads word from Port Expander's ports. PortA readings are in the
higher byte of the result. PortB readings are in the lower byte of the result.

Description |Parameters:

- ModuleAddress: Port Expander hardware address, see schematic at the
bottom of this page

Port Expander must be initialized. See Expander_Init.

Requires Port Expander's PortA and PortB should be configured as inputs. See
Expander_Set_DirectionPortA, Expander_Set_DirectionPortB and
Expander_Set_DirectionPortAB routines.

// Read a byte from Port Expander's PORTA and PORTB
unsigned int read data;

Exan“ﬂe Expander Set DirectionPortAB (0, OxFFFF); // set expander's porta
and portb to be input

read data =

Expander Read PortAB(0);

Expander_Write_PortA

Prokﬂype void Expander Write PortA(char ModuleAddress, char Data );

Returns Nothing.

The function writes byte to Port Expander's PortA.

Parameters:

Description .
- Moduleaddress: Port Expander hardware address, see schematic at the

bottom of this page
- Data : data to be written

Port Expander must be initialized. See Expander_Init.

Requires Port Expander's PortA should be configured as output. See
Expander_Set_DirectionPortA and Expander_Set_DirectionPortAB routines.
// Write a byte to Port Expander's PORTA

Example ﬁgéanderisetiDirectionPortA(0,0XOO); // set expander's

porta to be output

Expander Write PortA (0, OxAA);
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Expander_Write_PortB

Prototype void Expander Write PortB(char ModuleAddress, char Data );

Returns Nothing.

The function writes byte to Port Expander's PortB.

Parameters:

Description :
- Moduleaddress: Port Expander hardware address, see schematic at the

bottom of this page
- Data: data to be written

Port Expander must be initialized. See Expander_|nit.

Requires Port Expander's PortB should be configured as output. See
Expander_Set_DirectionPortB and Expander_Set_DirectionPortAB routines.
// Write a byte to Port Expander's PORTB

Example Expander Set DirectionPortB(0,0x00); // set expander's
portb to be output

Expander Write PortB (0, 0x55);

Expander_Write_PortAB

Prototype void Expander Write PortAB(char ModuleAddress, unsigned int Data );

Returns Nothing.

The function writes word to Port Expander's ports.

Parameters:

Description |, 1 nq4rcss: Port Expander hardware address, see schematic at the
bottom of this page

- Data: data to be written. Data to be written to PortA are passed in pata's
higher byte. Data to be written to PortB are passed in pata's lower byte

Port Expander must be initialized. See Expander_Init.

Requires Port Expander's PortA and PortB should be configured as outputs. See
Expander_Set_DirectionPortA, Expander_Set DirectionPortB and
Expander_Set_DirectionPortAB routines.

// Write a byte to Port Expander's PORTA and PORTB

Expander Set DirectionPortAB(0,0x0000) ; // set expander's

Exan“ﬂe porta and portb to be output

Expander Write PortAB (0, OxAAS55);
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Expander_Set_DirectionPortA

Prototype void Expander Set DirectionPortA(char ModuleAddress, char Data );

Returns Nothing.

The function sets Port Expander's PortA direction.
Parameters:

Description |- Moduleaddress: Port Expander hardware address, see schematic at the
bottom of this page

- Data: data to be written to the PortA direction register. Each bit corresponds
to the appropriate pin of the PortA register. Set bit configures the correspon-

ding pin as an input. Cleared bit configures the corresponding pin as an output.

Requires Port Expander must be initialized. See Expander_|nit.

// Set Port Expander's PORTA to be output

Exan“ﬂe Expander Set DirectionPortA(0,0x00);

Expander_Set_DirectionPortB

Prototype void Expander Set DirectionPortB(char ModuleAddress, char Data );

Returns Nothing.

The function sets Port Expander's PortB direction.
Parameters:

Description |- Moduleaddress: Port Expander hardware address, see schematic at the
bottom of this page

- Data: data to be written to the PortB direction register. Each bit corresponds
to the appropriate pin of the PortB register. Set bit configures the correspon-

ding pin as an input. Cleared bit configures the corresponding pin as an output.

Requires Port Expander must be initialized. See Expander_Init.

// Set Port Expander's PORTB to be input

Exan“ﬂe Expander Set DirectionPortB(0,0xFF);
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Expander_Set DirectionPortAB

void Expander Set DirectionPortAB (char ModuleAddress, unsigned

Prototype int Direction);
Returns Nothing.
The function sets Port Expander's PortA and PortB direction.
Parameters:
- Moduleaddress: Port Expander hardware address, see schematic at the
i bottom of this page
Description

- Direction: data to be written to direction registers. Data to be written to the
PortA direction register are passed in Direction's higher byte. Data to be
written to the PortB direction register are passed in pirection's lower byte.
Each bit corresponds to the appropriate pin of the PortA/PortB register. Set bit
configures the corresponding pin as an input. Cleared bit configures the corre-

sponding pin as an output.

Requires Port Expander must be initialized. See Expander_|nit.

// Set Port Expander's PORTA to be output and PORTB to be input

Example Expander Set DirectionPortAB (0, 0x00FF);

Expander_Set PullUpsPortA

Prototype void Expander Set PullUpsPortA(char ModuleAddress, char Data );

Returns Nothing.

The function sets Port Expander's PortA pull up/down resistors.
Parameters:

Description |- Moduleaddress: Port Expander hardware address, see schematic at the
bottom of this page

- Data: data for choosing pull up/down resistors configuration. Each bit
corresponds to the appropriate pin of the PortA register. Set bit enables pull-up
for corresponding pin.

Requires Port Expander must be initialized. See Expander_Init.

// Set Port Expander's PORTA pull-up resistors

Example Expander Set PullUpsPortA (0, OxFF);
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Expander_Set PullUpsPortB

Prototype void Expander Set PullUpsPortB(char ModuleAddress, char Data );

Returns Nothing.

The function sets Port Expander's PortB pull up/down resistors.
Parameters:

Description |- Moduleaddress: Port Expander hardware address, see schematic at the
bottom of this page

- Data: data for choosing pull up/down resistors configuration. Each bit
corresponds to the appropriate pin of the PortB register. Set bit enables
pull-up for corresponding pin.

Requires Port Expander must be initialized. See Expander_Init.

// Set Port Expander's PORTB pull-up resistors

Example Expander Set PullUpsPortB(0, OxFF);

Expander_Set PullUpsPortAB

void Expander Set PullUpsPortAB (char ModuleAddress, unsigned int

Prototype PullUps) ;

Returns Nothing.

The function sets Port Expander's PortA and PortB pull up/down resistors.

Parameters:

- ModuleAddress: Port Expander hardware address, see schematic at the

Description | bottom of this page

- PullUps: data for choosing pull up/down resistors configuration. PortA pull
up/down resistors configuration is passed in Pul1Ups's higher byte. PortB pull
up/down resistors configuration is passed in Pul1Ups's lower byte. Each bit
corresponds to the appropriate pin of the PortA/PortB register. Set bit enables
pull-up for corresponding pin.

Requires Port Expander must be initialized. See Expander_Init.

// Set Port Expander's PORTA and PORTB pull-up resistors

Example Expander Set PullUpsPortaAB (0, OxFFFF);
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Library Example

The example demonstrates how to communicate with Port Expander MCP23S17.
Note that Port Expander pins A2 A1 A0 are connected to GND so Port Expander
Hardware Address is 0.

// Port Expander module connections

sbit SPExpanderRST at RCO _bit;

sbit SPExpanderCS at RC1l bit;

sbit SPExpanderRST Direction at TRISCO bit;
sbit SPExpanderCS Direction at TRISC1 bit;
// End Port Expander module connections

unsigned char i = 0;

void main () {

ANSEL = O0; // Configure AN pins as digital I/O
ANSELH = 0;

TRISB = 0; // Set PORTB as output

PORTB = 0OxFF;

// 1If Port Expander Library uses SPI1 module
SPI1 Init(); // Initialize SPI module used with PortExpander

// If Port Expander Library uses SPI2 module

// SPI2 Init(); // Initialize SPI module used with PortExpander
Expander Init (0); // Initialize Port Expander
Expander Set DirectionPortA(0, 0x00); // Set Expander's PORTA to

be output

Expander Set DirectionPortB(0,0xFF); // Set Expander's PORTB to be
input

Expander Set PullUpsPortB(0, 0xFF); // Set pull-ups to all of the
Expander's PORTB pins

while (1) { // Endless loop
Expander Write PortA (0, i++); // Write i to expander's PORTA
PORTB = Expander Read PortB(0); // Read expander's PORTB and

write it to LEDs
Delay ms (100);
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HW Connection
MCP23517
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PS/2 LIBRARY

The mikroC PRO for PIC provides a library for communication with the common
PS/2 keyboard.

Note: The library does not utilize interrupts for data retrieval, and requires the oscil-
lator clock to be at least 6MHz.

Note: The pins to which a PS/2 keyboard is attached should be connected to the
pull-up resistors.

Note: Although PS/2 is a two-way communication bus, this library does not provide
MCU-to-keyboard communication; e.g. pressing the Caps Lock key will not turn on
the Caps Lock LED.

External dependencies of PS/2 Library

The following vari-
ables must be defined

. . . Description: Example:
in all projects using
PS/2 Library:

extern sfr sbit . sbit PS2 Data at
PS2 Data; PS/2 Data line. RCO bit
extern sfr sbit . sbit PS2 Clock at
PS2 Clock; PS/2 Clock line. RC1 bit;
extern sfr sbit sbit PS2 Data Direction

Direction of the PS/2 Data pin.

PS2 Data Direction; at TRISCO bit;

extern sfr sbit . . . |sbit PS2 Clock Direction
PS2 Clock Direction; Direction of the PS/2 Clock pin. at TRISCI bit;

Library Routines

- Ps2_Config
- Ps2_Key_Read

400
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mikroC PRO for PIC
Ps2_Config
Prototype [void Ps2 Config();
Returns Nothing.
Description |[Initializes the MCU for work with the PS/2 keyboard.
Global variables:
- ps2 Data: Data signal line
. - Ps2 clock: Clock signal line in
Requires - ‘ , L .
- PS2 Data Direction: Direction of the Data pin
- PS2 Clock Direction: Direction of the Clock pin
must be defined before using this function.
sbit PS2 Data at RCO bit;
sbit PS2 Clock at RC1 bit;
Example sbit PS2 Data Direction at TRISCO bit;
P sbit PS2 Clock Direction at TRISCI bit;
Ps2 Config(); // Init PS/2 Keyboard
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Ps2_Key_Read

unsigned short Ps2 Key Read(unsigned short *value, unsigned short
*special, unsigned short *pressed);

Prototype

- 1 if reading of a key from the keyboard was successful

Returns - 0 if no key was pressed

The function retrieves information on key pressed.
Parameters:

- value: holds the value of the key pressed. For characters, numerals,

Description | punctuation marks, and space vz1ue will store the appropriate ASCII code.
Routine “recognizes” the function of Shift and Caps Lock, and behaves
appropriately. For special function keys see Special Function Keys Table.

- special: is a flag for special function keys (F1, Enter, Esc, etc). If key pressed
is one of these, special will be set to 1, otherwise 0.

- pressed: is set to 1 if the key is pressed, and 0 if it is released.

Requires PS/2 keyboard needs to be initialized. See Ps2_Config routine.

unsigned short keydata = 0, special = 0, down = O0;

// Press Enter to continue:
do {
if (Ps2 Key Read(&keydata, é&special, &down)) {
if (down && (keydata == 16)) break;
}
} while (1);

Example
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Special Function Keys

Key Value returned Num Lock 29
F1 1 Left Arrow 30
F2 2 Right Arrow 31
F3 3 Up Arrow 32
F4 4 Down Arrow 33
F5 5 Escape 34
F6 6 Tab 35
F7 7
F8 8
F9 9
F10 10
F11 1
F12 12
Enter 13
Page Up 14
Page Down 15
Backspace 16
Insert 17
Delete 18
Windows 19
Ctrl 20
Shift 21
Alt 22
Print Screen 23
Pause 24
Caps Lock 25
End 26
Home 27
Scroll Lock 28
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Library Example

This simple example reads values of the pressed keys on the PS/2 keyboard and
sends them via UART.

unsigned short keydata = 0, special = 0, down = O0;
sbit PS2 Data at RCO bit;
sbit PS2 Clock at RC1l bit;

sbit PS2 Data Direction at TRISCO bit;
sbit PS2 Clock Direction at TRISCI bit;

void main () {

ANSEL = 0; // Configure AN pins as digital I/0
ANSELH = 0;

UART1 Init(19200); // Initialize UART module at 19200 bps
Ps2 Config(); // Init PS/2 Keyboard
Delay ms (100); // Wait for keyboard to finish

UART1 Write Text ("Ready");

do {
if (Ps2 Key Read(&keydata, &special, &down)) {
if (down && (keydata == 16)) {// Backspace
UART1 Write (0x08);

}

else if (down && (keydata == 13)) {// Enter
UART1 Write('r'); // send carriage return to usart terminal
//Usart Write('n'); // uncomment this line if wusart

terminal also expects line feed
// for new line transition
}
else if (down && !special && keydata) {
UART1 Write (keydata);

}
Delay ms (1) ; // debounce

} while (1);
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HW Connection
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PWM LIBRARY

CCP module is available with a number of PIC MCUs. mikroC PRO for PIC provides library which
simplifies using PWM HW Module.

Note: Some MCUs have multiple CCP modules. In order to use the desired CCP library routine,
simply change the number 1 in the prototype with the appropriate module number, i.e.
PWM2 Start();

Library Routines
- PWM1_Init
- PWM1_Set Duty

- PWM1_Start
- PWM1_Stop

PWM1_Init

Prototype void PWM1 Init(long freq);

Returns Nothing.

Initializes the PWM module with duty ratio 0. Parameter freq is a desired PWM
frequency in Hz (refer to device data sheet for correct values in respect with
Description |Fosc).

This routine needs to be called before using other functions from PWM Library.

MCU must have CCP module.

Note: Calculation of the PWM frequency value is carried out by the compiler, as

Requires it would produce a relatively large code if performed on the libary level.
Therefore, compiler needs to know the value of the parameter in the compile time.
That is why this parameter needs to be a constant, and not a variable.
Initialize PWM module at 5KHz:

Example

PWM1_ Init (5000) ;
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PWM1_Set_Duty

Prototype void PWM1 Set Duty(unsigned short duty ratio);

Returns Nothing.

Sets PWM duty ratio. Parameter duty takes values from 0 to 255, where 0 is
Description |0%, 127 is 50%, and 255 is 100% duty ratio. Other specific values for duty ratio
can be calculated as (percent*255) /100.

Requires MCU must have CCP module. PWM1_Init must be called before using this routine.

Set duty ratio to 75%:
Example
PWM1 Set Duty(192);

PWM1_Start

Prototype |void PWMI Start (void);

Returns Nothing.
Description |Starts PWM.

Requires MCU must have CCP module. PWM1_Init must be called before using this routine.
Example PWM1 Start();

PWM1_Stop

Prototype |void PWMI Stop (void);

Returns Nothing.
Description |Starts PWM.

MCU must have CCP module. PWM1_Init must be called before using this rou-
Requires tine. PWM1_Start should be called before using this routine, otherwise it will have
no effect as the PWM module is not running.

Example PWM1_Stop () ;
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Library Example

The example changes PWM duty ratio on RC1 and RC2 pins continually. If LED is
connected to these pins, you can observe the gradual change of emitted light.

unsigned short current duty, old duty, current dutyl, old dutyl;

void InitMain () {
ANSEL = 0; // Configure AN pins as digital I/0
ANSELH = 0;
PORTA = 255;

TRISA = 255; // configure PORTA pins as input
PORTB = 0; // set PORTB to 0

TRISB = 0; // designate PORTB pins as output
PORTC = 0; // set PORTC to O

TRISC = 0; // designate PORTC pins as output
PWM1 Init (5000); // Initialize PWMl module at 5KHz
PWM2 Init (5000); // Initialize PWM2 module at 5KHz

void main () {

InitMain () ;
current duty = 16; // initial value for current duty
current dutyl = 16; // initial value for current dutyl
PWM1 Start(); // start PWM1
PWM2 Start(); // start PWM2
PWM1 Set Duty(current duty); // Set current duty for PWMI
PWM2 Set Duty(current dutyl); // Set current duty for PWM2
while (1) { // endless loop
if (RAO bit) { // button on RAO pressed
Delay ms (40);
current duty++; // increment current duty

PWM1 Set Duty(current duty);
}

if (RAl bit) { // button on RAl pressed
Delay ms (40);
current duty--; // decrement current duty

PWM1 Set Duty(current duty);
}

if (RA2 bit) { // button on RA2 pressed
Delay ms (40) ;
current dutyl++; // increment current dutyl

PWM2 Set Duty(current dutyl);
}

408
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if (RA3 bit) {
Delay ms (40) ;
current dutyl--;

}

Delay ms (5);
}
}

HW Connection

// button on RA3 pressed

// decrement current dutyl
PWM2 Set Duty(current dutyl);

// slow down change pace a little
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RS-485 LIBRARY

RS-485 is a multipoint communication which allows multiple devices to be connect-
ed to a single bus. The mikroC PRO for PIC provides a set of library routines for
comfortable work with RS485 system using Master/Slave architecture. Master and
Slave devices interchange packets of information. Each of these packets contains
synchronization bytes, CRC byte, address byte and the data. Each Slave has
unique address and receives only packets addressed to it. The Slave can never ini-
tiate communication. It is the user’s responsibility to ensure that only one device
transmits via 485 bus at a time. The RS-485 routines require the UART module. Pins
of UART need to be attached to RS-485 interface transceiver, such as LTC485 or
similar (see schematic at the bottom of this page).

Note: The library uses the UART module for communication. The user must initial-
ize the appropriate UART module before using the RS-485 Library. For MCUs with
two UART modules it is possible to initialize both of them and then switch by using
the UART set active function. See the UART Library functions.

Library constants:

- START byte value = 150

- STOP byte value = 169

- Address 50 is the broadcast address for all Slaves (packets containing address 50
will be received by all Slaves except the Slaves with addresses 150 and 169).

Note: Since some PIC18 MCUs have multiple UART modules, appropiate UART
module must be initialized. Switching between UART modules in the UART library
is done by the UART_Set_Active function (UART module has to be previously ini-
tialized).

External dependencies of RS-485 Library

The following variable

must be defined in all proj- Description: Example:
ects using RS-485 Library:

) Control RS485 ) ‘
extern sfr sbit Transmit/Receive operation sbit RS485 rxtx pin at
RS485 rxtx pin; pe RC2 bit;

- - mode -
extern sfr sbit Direction of the RS-485  [5°*©

RS485 rxtx pin direc- RS485 rxtx pin direc-

Transmit/Receive pin tion at TRISCZ bit;

tion;
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Library Routines

- RS485master_Init

- RS485master_Receive
- RS485master_Send

- RS485slave_Init

- RS485slave_Receive

- RS485slave_Send

RS485Master_Init

Prototype void RS485Master Init();

Returns Nothing.

Description |[Initializes MCU as a Master for RS-485 communication.

Global variables:

RS485 rxtx pin - this pin is connected to RE/DE input of RS-485 transceiv-
er(see schematic at the bottom of this page). RE/DE signal controls RS-485
transceiver operation mode.

Requires
RS485 rxtx pin direction - direction of the RS-485 Transmit/Receive pin
must be defined before using this function.
UART HW module needs to be initialized. See UART1_Init.
// RS485 module pinout
sbit RS485 rxtx pin direction at RC2 bit; // transmit/receive
control set to PORTC.B2
// Pin direction
sbit RS485 rxtx pin direction at TRISC2 bit; // RxTx pin direc-
Example - - -

tion set as output

UART1 Init(9600); // initialize UART module

RS485Master Init(); // intialize MCU as a Master for RS-485
communication
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RS485Master_Receive

Prototype void RS485Master Receive (char *data buffer);

Returns Nothing.

Receives messages from Slaves. Messages are multi-byte, so this routine must
be called for each byte received.

Parameters:
- data buffer: 7 byte buffer for storing received data, in the following manner:
..2] : message content

: number of message bytes received, 1-3

. is set to 255 when message is received

. is set to 255 if error has occurred

: address of the Slave which sent the message

Description |- data

The function automatically adjusts datal 41 and data[ 5] upon every received
message. These flags need to be cleared by software.

MCU must be initialized as a Master for RS-485 communication. See
RS485master_Init.

char msqf 8] ;

Requires

Example S
RS485Master Receive (msg);

RS485Master_Send

void RS485Master Send(char *data buffer, char datalen, char
Slave address);

Prototype

Returns Nothing.

Sends message to Slave(s). Message format can be found at the bottom of this
page.

. Parameters:
Description

- data buffer: data to be sent
- datalen: number of bytes for transmition. Valid values: 0...3.
- slave address: Slave(s) address

MCU must be initialized as a Master for RS-485 communication. See
RS485Master_Init.

Requires . ; e .
q It is the user’s responsibility to ensure (by protocol) that only one device sends
data via 485 bus at a time.
char msqf 8] ;
Example // send 3 bytes of data to Slave with address 0x12

RS485Master Send(msg, 3, 0x12);
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RS485slave_Init

Prototype void RS485Slave Init (char Slave address);

Returns Nothing.

Initializes MCU as a Slave for RS-485 communication.
Description |Parameters:

- slave address: Slave address

Global variables:

RS485 rxtx pin - this pin is connected to RE/DE input of RS-485 transceiv-
er(see schematic at the bottom of this page). RE/DE signal controls RS-485
transceiver operation mode. Valid values: 1 (for transmitting) and o (for receiv-

Requires ing)
RS485 rxtx pin direction - direction of the RS-485 Transmit/Receive pin

must be defined before using this function.

UART HW module needs to be initialized. See UART1 _Init.

// RS485 module pinout
sbit RS485 rxtx pin at RC2 bit; // transmit/receive control
set to PORTC.B2

// Pin direction
sbit RS485 rxtx pin direction at TRISC2 bit; // RxTx pin direc-

Example tion set as output

UART1 Init (9600); // initialize UART module
RS485Slave Init (160); // intialize MCU as a Slave
for RS-485 communication with address 160
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RS485slave Receive

Prototype void RS485Slave Receive (char *data buffer);

Returns Nothing.

Receives messages from Master. If Slave address and Message address field
don't match then the message will be discarded. Messages are multi-byte, so this
routine must be called for each byte received.

Parameters:

o . -data buffer: 6 byte buffer for storing received data, in the following manner:
Description -

-datal 0..2] : message content

- datal 3] : number of message bytes received, 1-3
- datal 4] : is set to 255 when message is received
- datal 5] : is set to 255 if error has occurred

The function automatically adjusts datal 41 and datal 5] upon every received
message. These flags need to be cleared by software.

MCU must be initialized as a Slave for RS-485 communication. See

Requires RS485slave_|nit.

char msql 8] ;

Example S
RS485Slave Read (msqg) ;
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RS485slave _Send

Prototype

void RS485Slave Send(char *data buffer, char datalen);

Returns

Nothing.

Description

Sends message to Master. Message format can be found at the bottom of this
page.

Parameters:

- data buffer: data to be sent
- datalen: number of bytes for transmition. Valid values: 0...3.

Requires

MCU must be initialized as a Slave for RS-485 communication. See
RS485slave_Init. It is the user’s responsibility to ensure (by protocol) that only
one device sends data via 485 bus at a time.

Example

char msql 8] ;

// send 2 bytes of data to the Master
RS485Slave Send(msg, 2);

Library Example

This is a simple demonstration of RS485 Library routines usage.

Master sends message to Slave with address 160 and waits for a response. The Slave accepts
data, increments it and sends it back to the Master. Master then does the same and sends incre-

mented data back to Slave, etc.

Master displays received data on PORTB, while error on receive (0xAA) and number of consec-
utive unsuccessful retries are displayed on PORTD. Slave displays received data on PORTB,
while error on receive (0xAA) is displayed on PORTD. Hardware configurations in this example

are made for the EasyPIC5 board and 16F887.
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RS485 Master code:

char dat[ 10] ; // buffer for receving/sending messages
char i, 7j;

sbit 1rs485 rxtx pin at RC2 bit; // set transcieve pin
sbit 1rs485 rxtx pin direction at TRISC2 bit; // set transcieve pin
direction

// Interrupt routine

void interrupt () {
RS485Master Receive (dat);

}

void main (){
long cnt = 0;

ANSEL =
ANSELH =

(@]

// Configure AN pins as digital I/O

(@]
~.

PORTB =
PORTD =
TRISB =
TRISD =

O O O O

UART1 Init(9600); // initialize UART1 module
Delay ms (100);

RS485Master Init(); // initialize MCU as Master

dat[ 0] = OxAA;

dat[ 1] = 0xFO;

dat[ 2] = 0xOF;

dat[ 4] = 0; // ensure that message received flag is 0
dat[ 5] = 0; // ensure that error flag is 0

dat[ 6] = 0;

RS485Master Send(dat,1,160);

PIE1.RCIE = 1; // enable interrupt on UART1 receive
PIE2.TXIE = O0; // disable interrupt on UART1 transmit
INTCON.PEIE = 1; // enable peripheral interrupts
INTCON.GIE = 1; // enable all interrupts
while (1){
// upon completed valid message receiving
// datal 4] is set to 255
cnt++;
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if (dat[ 5]) { // if an error detected, signal it
PORTD = OxAA; // by setting portd to 0xAA
}
if (dat[ 4] ) { // if message received successfully
cnt = 0;
dat[ 4] = 0; // clear message received flag
j = dat[ 3] ;
for (i = 1; 1 <= dat[ 3]; i++) { // show data on PORTB
PORTB = dat[ i-1] ;
} // increment received dat[ 0]
dat[ 0] = dat[ 0] +1; // send back to master

Delay ms (1) ;
RS485Master Send(dat,1,160);

if (cnt > 100000) {

PORTD ++;
cnt = 0;
RS485Master Send(dat,1,160);
if (PORTD > 10) // if sending failed 10 times
RS485Master Send(dat,1,50); // send message on broadcast
address

}

// function to be properly linked.

RS485 Slave code:

char dat[ 9] ; // buffer for receving/sending messages
char i,7;

sbit 1rs485 rxtx pin at RC2 bit; // set transcieve pin
sbit 1rs485 rxtx pin direction at TRISC2 bit; // set transcieve pin
direction

// Interrupt routine
void interrupt () {

RS485Slave Receive (dat);
}

void main () {
ANSEL = O0; // Configure AN pins as digital I/0
ANSELH = 0;

PORTB = 0
PORTD = O;
TRISB = 0
TRISD = 0
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UART1 Init(9600); // initialize UART1 module
Delay ms (100);

RS485Slave Init (160); // Intialize MCU as slave, address 160
dat[ 4] = 0; // ensure that message received flag is O
dat[ 5] = 0; // ensure that message received flag is O
dat[ 6] = 0; // ensure that error flag is O
PIE1.RCIE = 1; // enable interrupt on UART1 receive
PIE2.TXIE = 0; // disable interrupt on UART1 transmit
INTCON.PEIE = 1; // enable peripheral interrupts
INTCON.GIE = 1; // enable all interrupts
while (1) {
if (dat[ 5]) { // if an error detected, signal it by
PORTD = O0xAA; // setting portd to OxAA
dat[ 5] = 0;
}
if (datf[ 4]) { // upon completed valid message receive
dat[ 4] = 0; // datal 4] is set to OxFF
J = dat[ 3] ;

for (i = 1; 1 <= dat[ 3] ;1i++){
PORTB = dat[ i-1] ;
}

dat[ 0] = dat[ 0] +1; // increment received dat[ 0]
Delay ms (1) ;
RS485Slave Send(dat,1); // and send it back to master
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HW Connection
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Example of interfacing PC to 8051 MCU via RS485 bus with LTC485 as
RS-485 transceiver
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Message format and CRC calculations

Q: How is CRC checksum calculated on RS485 Master side?

START BYTE = 0x96; // 10010110
STOP BYTE = O0xA9; // 10101001

PACKAGE:

START BYTE 0x96

ADDRESS

DATALEN

[ DATA1] // if exists
[ DATAZ2] // if exists
[ DATA3] // if exists
CRC

STOP BYTE 0xA9

DATALEN bits
bit7 = 1 MASTER SENDS
0 SLAVE SENDS
bite =1 ADDRESS WAS XORed with 1, IT WAS EQUAL TO START BYTE or

0 ADDRESS UNCHANGED
bit5 = 0 FIXED
bitd = 1 DATA3 (if exists) WAS XORed with 1, IT WAS EQUAL TO
START BYTE or STOP BYTE

0 DATA3 (if exists) UNCHANGED
bit3 = 1 DATA2 (if exists) WAS XORed with 1, IT WAS EQUAL TO
START BYTE or STOP BYTE

0 DATA2 (if exists) UNCHANGED
bitz = 1 DATAl (if exists) WAS XORed with 1, IT WAS EQUAL TO
START BYTE or STOP BYTE

0 DATAl (if exists) UNCHANGED
bitlbit0 = 0 to 3 NUMBER OF DATA BYTES SEND

CRC generation

crc_send = datalen "~ address;
crc_send "= datal 0] ; // if exists
crc_send "= datal 1] ; // if exists
crc_send "= datal 2] ; // if exists
crc_send = ~crc_send;
if ((crc_send == START BYTE) || (crc_send == STOP BYTE))
crc_send++;
NOTE: DATALEN<4. .0> can not take the STARTiBYTE<4..O> or

STOP BYTE<4..0> values.
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SOFTWARE I’C LIBRARY

The mikroC PRO for PIC provides routines for implementing Software 12C commu-
nication. These routines are hardware independent and can be used with any MCU.

The Software 12C library enables you to use MCU as Master in 12C communication.
Multi-master mode is not supported.

Note: This library implements time-based activities, so interrupts need to be dis-
abled when using Software 12C.

Note: All Software 12C Library functions are blocking-call functions (they are waiting
for 12C clock line to become logical one).

Note: The pins used for the Software 12C communication should be connected to
the pull-up resistors. Turning off the LEDs connected to these pins may also be
required.

External dependecies of Soft_I2C Library

The following variables
must be defined in all

projects using Software Description: Example:

12c Library:
extern sbit s 2 . sbit Soft I2C Scl at
Soft I2C Scl; oft IC Clock line. RC3 bit;
I e
extern sbit Direction of the Soft sbit Soft I2C Scl Direction
Soft 12C scl Direction; ||2C Clock pin. at TRISC3_ bit;
extern sbit Direction of the Soft sbit Soft I2C Sda Direction
Soft 12C Sda Direction; ||2C Data pin. at TRISC4 bit;

Library Routines

- Soft_I2C_Init

- Soft_I2C_Start
- Soft_I12C_Read
- Soft_12C_Write
- Soft_12C_Stop
- Soft_12C_Break
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Soft_I2C_Init

Prototype |void soft I2C Init();

Returns Nothing.

Description |[Configures the software | C module.

Global variables:

- soft 12C scl: Soft ! C clock line
- Soft 12C sda: Soft | C data line

Requires N :
q - Soft I2C scl Pin Direction: Direction of the Soft | C clock pin

- Soft I2C sda Pin Direction: Direction of the Soft | C data pin
must be defined before using this function.
// Software I2C connections
sbit Soft I2C Scl at RC3_bit;
sbit Soft I2C Sda at RC4 bit;
sbit Soft I2C Scl Direction at TRISC3 bit;

Example sbit Soft I2C Sda Direction at TRISC4 bit;

// End Software I2C connections

Soft I2C Init();

Soft_I2C_Start

Prototype |[void soft I2C Start (void);

Returns Nothing.

Description |Determines if the I2C bus is free and issues START signal.

Software 12C must be configured before using this function. See Soft_[2C_Init

Requires ,
routine.

// Issue START signal

Example Soft I2C Start();
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Soft_12C_Read

Prototype unsigned short Soft I2C Read (unsigned int ack);

Returns One byte from the Slave.

Reads one byte from the slave.

Parameters:

Description

- ack: acknowledge signal parameter. If the ack==0 not
acknowledge signal will be sent after reading, otherwise the
acknowledge signal will be sent.

Soft | C must be configured before using this function. See Soft_12C _Init routine.
Requires Also, START signal needs to be issued in order to use this function. See
Soft_12C_Start routine.

unsigned short take;

Example // Read data and send the not acknowledge signal
take = Soft I2C Read(0);
Soft_12C_Write

Prokﬂype unsigned short Soft I2C Write (unsigned short Data );

- 0 if there were no errors.

Returns - 1 if write collision was detected on the | C bus.

Sends data byte via the | C bus.
Description |Parameters:

- Data: data to be sent

Soft | C must be configured before using this function. See Soft_12C _Init routine.
Requires Also, START signal needs to be issued in order to use this function. See
Soft 12C_Start routine.

unsigned short data, error;

Example error = Soft I2C Write (data);

error = Soft I2C Write (0xA3);
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Soft_12C_Stop

Prototype [void Soft 12C Stop (void);

Returns Nothing.

Description [Issues STOP signal.

Requires Soft I2C must be configured before using this function. See Soft_I2C_Init routine.

// Issue STOP signal
Soft I2C Stop();

Example

Soft_I12C_Break
Prototype void Soft I2C Break(void);

Returns Nothing.

All Software 12C Library functions can block the program flow (see note at the top
of this page). Calling this routine from interrupt will unblock the program execu-

. tion. This mechanism is similar to WDT.
Description

Note: Interrupts should be disabled before using Software 12C routines again
(see note at the top of this page).

Requires Nothing.

// Software I2C connections

sbit Soft I2C Scl at RCO _bit;
sbit Soft I2C Sda at RC1 bit;
sbit Soft I2C Scl Direction at TRISCO bit;
sbit Soft I2C Sda Direction at TRISC1 bit;
// End Software I2C connections

char counter = 0;

void interrupt {
Example
if (INTCON.TOIF) {
if (counter >= 20) {
Soft I2C Break();

counter = 0; // reset counter
}
else
counter++; // increment counter

INTCON.TOIF 0; // Clear Timer(0 overflow interrupt flag
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Example

void main () {

OPTION REG = 0x04; // TMRO prescaler set to 1:32

// try Soft I2C Init with blocking prevention mechanism

INTCON.GIE = 1; // Global interrupt enable
INTCON.TOIE = 1; // Enable TimerO overflow interrupt
Soft I2C Init();

INTCON.GIE = 0; // Global interrupt disable

Library Example

The example demonstrates Software | C Library routines usage. The PIC MCU is
connected (SCL, SDA pins) to PCF8583 RTC (real-time clock). Program reads date
and time are read from the RTC and prints it on Lcd.

char seconds, minutes, hours, day, month, year; // Global date/time
variables

// Software I2C connections

sbit Soft I2C Scl at RC3 bit;
sbit Soft I2C Sda at RC4 bit;
sbit Soft I2C Scl Direction at TRISC3 bit;
sbit Soft I2C Sda Direction at TRISC4 bit;
// End Software I2C connections

// LCD module connections
sbit LCD RS at RB4 bit;
sbit LCD EN at RB5 bit;
sbit LCD D4 at RBO bit;
sbit LCD D5 at RB1 bit;
sbit LCD D6 at RB2 bit;
sbit LCD D7 at RB3 bit;

sbit LCD RS Direction at TRISB4 bit;
sbit LCD EN Direction at TRISBS5 bit;
sbit LCD D4 Direction at TRISBO bit;
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sbit LCD D5 Direction at TRISB1 bit;
sbit LCD D6 Direction at TRISBZ bit;
sbit LCD D7 Direction at TRISB3 bit;
// End LCD module connections
Reads time and date information from RTC
(PCF8583)

void Read Time () {

Soft I2C Start(); // Issue start signal

();

Soft I2C Write (0xA0); // Address PCF8583, see PCF8583 datasheet

Soft I2C Write(2); // Start from address 2

Soft I2C Start(); // Issue repeated start signal

Soft I2C Write (0xAl); // Address PCF8583 for reading R/W=1

seconds = Soft I2C Read(l); // Read seconds byte

minutes = Soft I2C Read(l); // Read minutes byte

hours = Soft I2C Read(l); // Read hours byte

day = Soft I2C Read(l); // Read year/day byte

month = Soft I2C Read(0); // Read weekday/month byte

Soft I2C Stop(); // Issue stop signal
}
/)= mm e Formats date and time
void Transform Time () {

seconds = ((seconds & O0xFO0) >> 4)*10 + (seconds & O0xOF); //
Transform seconds

minutes = ((minutes & O0OxFO0) >> 4)*10 + (minutes & O0xOF); //
Transform months

hours = ((hours & OxFO0) >> 4)*10 + (hours & O0xO0F); //
Transform hours

year = (day & 0xCO) >> 6; //
Transform year

day = ((day & 0x30) >> 4)*10 + (day & 0xO0F); //
Transform day

month = ((month & 0x10) >> 4)*10 + (month & O0xOF); //
Transform month
}
/)= e s e Output values to LCD

void Display Time () {

Led Chr (1, 6,

variable

Led Chr (1, 7,

variable

Led Chr (1, 9,
Led Chr (1,10,
Led Chr (1,15,

(day / 10) + 48); // Print tens digit of day
(day % 10) + 48); // Print oness digit of day
(month / 10) + 48);
(month % 10) + 48);
year + 56); // Print year vaiable + 8

426 MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD



CHAPTER 7

mikroC PRO for PIC Libraries
(start from year 2008)
Led Chr(2, 6, (hours / 10) + 48);
Lcd Chr(2, 7, (hours % 10) + 48);
Led Chr(2, 9, (minutes / 10) + 48);
Lcd Chr (2,10, (minutes % 10) + 48);
Led Chr (2,12, (seconds / lO) + 48);
Lcd Chr (2,13, (seconds % 10) + 48);
}
[/ =—mmm e ——— Performs project-wide init
void Init Main() {
TRISB = 0;
PORTB = OXxFF;
TRISB = 0Oxff;
ANSEL = O0; // Configure AN pins as digital I/0
ANSELH = 0;
Soft I2C Init(); // Initialize Soft I2C communication
Led Init(); // Initialize LCD
Lcd Cmd ( LCD _CLEAR) ; // Clear LCD display
Lcd Cmd (_LCD _CURSOR OFF) ; // Turn cursor off
Lcdiout(l,l,"Date ") // Prepare and output static text on LCD
Led Chr(1,8,':');
Led Chr(1,11,':');
Lcdiout(2,l,"T1me:");
Led Chr (2, ' ) ;
Led Chr (2, ")
Lcd Out (1, 12 "200");
}
/)= e s Main procedure
void main () {
Delay ms (2000);
Init Main(); // Perform initialization
while (1) { // Endless loop
Read Time () ; // Read time from RTC (PCF8583)
Transform Time () ; // Format date and time
Display Time () ; // Prepare and display on LCD
Delay ms (1000); // Wait 1 second
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SOFTWARE SPI LIBRARY

The mikroC PRO for PIC provides routines for implementing Software SPI commu-
nication. These routines are hardware independent and can be used with any MCU.
The Software SPI Library provides easy communication with other devices via SPI:
A/D converters, D/A converters, MAX7219, LTC1290, etc.

Library configuration:

- SPI to Master mode

- Clock value = 20 kHz.

- Data sampled at the middle of interval.
- Clock idle state low.

- Data sampled at the middle of interval.
- Data transmitted at low to high edge.

Note: The Software SPI library implements time-based activities, so interrupts need
to be disabled when using it.

External dependencies of Software SPI Library

The following variables
must be defined in all

- . Description: Example:
projects using Software P P
SPI Library:
extern sfr sbit Data In line sbit SoftSpi SDI at
SoftSpi SDI; ' RC4 bit;
extern sfr sbit . sbit SoftSpi SDO at
SoftSpi SDO; Data Out line. RC5 bit;
extern sfr sbit . sbit SoftSpi CLK at
Clock line. -

SoftSpi CLK; RC3 bit;

sbit

Direction of the Data In pin. [SoftSpi SDI Direction
at TRISC4 bit;

sbit

Direction of the Data Out pin |SoftSpi SDO Direction
at TRISCS bit;

sbit

Direction of the Clock pin. [softsSpi CLK Direction
at TRISC3 bit;

extern sfr sbit
SoftSpi SDI Direction;

extern sfr sbit
SoftSpi SDO Direction;

extern sfr sbit
SoftSpi CLK Direction;
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Library Routines
- Soft_Spi_Init
- Soft_Spi_Read
- Soft_Spi_Write

Soft_Spi_Init

Prototype |void Soft SPI Init();

Returns Nothing.

Description |Configures and initializes the software SPI module.

Global variables:

- Chip select: Chip Select line

- softspi spi: Datain line

- softspi spo: Data out line

- softspi cLk: Data clock line

- Chip Select Direction: Direction of the Chip Select pin
- Softspi sDI Direction: Direction of the Data in pin

- Softspi sDO Direction: Direction of the Data out pin

- Softspi CLK Direction: Direction of the Data clock pin

Requires

must be defined before using this function.

// Software SPI module connections
sbit Chip Select at RCO bit;
sbit SoftSpi SDI at RC4 bit;
sbit SoftSpi SDO at RC5 bit;
sbit SoftSpi CLK at RC3 bit;

Example sbit Chip Select Direction at TRISCO bit;
sbit SoftSpi SDI Direction at TRISC4 bit;
sbit SoftSpi SDO Direction at TRISCS bit;
sbit SoftSpi CLK Direction at TRISC3 bit;
// End Software SPI module connections

Soft SPI_Init(); // Init Soft SPI
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Soft_Spi_Read

Prototype |unsigned short Soft SPI Read(char sdata);

Returns Byte received via the SPI bus.

This routine performs 3 operations simultaneously. It provides clock for the Soft-
ware SPI bus, reads a byte and sends a byte.

Description Parameters:

sdata: data to be sent.

Requires Soft SPI must be initialized before using this function. See Soft_SPI_lInit routine.

unsigned short data read;
char data send;

Example // Read a byte and assign it to data read variable
// (data send byte will be sent via SPI during the Read opera-
tion)

data read

Soft SPI Read(data send);

Soft_SPI_Write

Prototype |void Soft SPI Write (char sdata);

Returns Nothing.

This routine sends one byte via the Software SPI bus.
Description |Parameters:

sdata: data to be sent.

Requires Soft SPI must be initialized before using this function. See Soft_SPI_lInit routine.

// Write a byte to the Soft SPI bus

Example Soft SPI_Write (0xAR);
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Library Example

This code demonstrates using library routines for Soft SPI communication. Also,
this example demonstrates working with Microchip's MCP4921 12-bit D/A convert-
er.

// DAC module connections

sbit Chip Select at RCO bit;
sbit SoftSpi CLK at RC3 bit;
sbit SoftSpi SDI at RC4 bit;
sbit SoftSpi SDO at RC5 bit;

sbit Chip Select Direction at TRISCO bit;
sbit SoftSpi CLK Direction at TRISC3 bit;
sbit SoftSpi SDI Direction at TRISC4 bit;
sbit SoftSpi SDO Direction at TRISCS bit;
// End DAC module connections

unsigned int value;

void InitMain () {

TRISBO bit = 1; // Set RAO pin as input
TRISB1 bit = 1; // Set RAl pin as input
Chip Select = 1; // Deselect DAC
Chip Select Direction = 0; // Set CS# pin as Output
Soft SPI Init(); // Initialize Soft SPI

}

// DAC increments (0..4095) --> output voltage (0..Vref)

void DAC Output (unsigned int valueDAC) {
char temp;

Chip Select = 0; // Select DAC chip

// Send High Byte

temp = (valueDAC >> 8) & 0xOF;// Store valueDAC[ 11..8] to temp[ 3..0]
temp |= 0x30; // Define DAC setting, see MCP4921 datasheet
Soft SPI Write (temp); // Send high byte via Soft SPI

// Send Low Byte

temp = valueDAC; // Store valueDAC[ 7..0] to temp[ 7..0]
Soft SPI Write (temp); // Send low byte via Soft SPI
Chip Select = 1; // Deselect DAC chip
}
void main () {
ANSEL = 0; // turn off analog inputs
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ANSELH = 0;
InitMain () ; // Perform main initialization

value = 2048; // When program starts, DAC gives
// the output in the mid-range

while (1) { // Endless loop
if ((RAO bit) && (value < 4095)) { // If RAO button is pressed
value++; // increment value
}
else {
if ((RAl bit) && (value > 0)) { // If RALl button is pressed
value--; // decrement value
}
}
DAC Output (value) ; // Send value to DAC chip
Delay ms (1) ; // Slow down key repeat pace
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SOFTWARE UART LIBRARY

The mikroC PRO for PIC provides routines for implementing Software UART com-
munication. These routines are hardware independent and can be used with any
MCU. The Software UART Library provides easy communication with other devices
via the RS232 protocol.

Note: The Software UART library implements time-based activities, so interrupts
need to be disabled when using it.

Library Routines

- Soft_Uart_Init

- Soft_Uart_Read
- Soft_Uart_Write
- Soft_Uart_Break
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Soft_UART _Init

char Soft UART Init (char *port, char rx pin, char tx pin,
unsigned long baud rate, char inverted);

Prototype

- 2 - error, requested baud rate is too low
Returns - 1 - error, requested baud rate is too high
- 0 - successful initialization

Configures and initializes the software UART module.
Parameters:

- port: port to be used.

- rx pin: sets rx_pin to be used.

- tx pin: sets tx_pin to be used.

- baud rate: baud rate to be set. Maximum baud rate depends on the MCU’s
clock and working conditions.

- inverted: inverted output flag. When set to a non-zero value, inverted logic
on output is used.

Description

Software UART routines use Delay_Cyc routine. If requested baud rate is too low
then calculated parameter for calling belay cyc exceeeds pDelay Cyc argument
range.

If requested baud rate is too high then rounding error of be12y Cyc argument cor-
rupts Software UART timings.

Requires Nothing.

This will initialize software UART and establish the communication at 9600 bps:

Example char error;

error = Soft UART Init (&PORTC, 7, 6, 14400, 0); // Initialize
Soft UART at 9600 bps
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Soft_UART Read

Prototype

char Soft UART Read(char * error);

Returns

Byte received via UART.

Description

The function receives a byte via software UART.

This is a blocking function call (waits for start bit). Programmer can unblock it by

calling Soft. UART_Break routine.
Parameters:

- error: Error flag. Error code is returned through this variable.
0 - no error
1 - stop bit error
255 - user abort, Soft UART_Break called

Requires

Software UART must be initialized before using this function. See the
Soft UART _Init routine.

Example

char data, error;

// wait until data is received
do

data = Soft UART Read(&error);
while (error);

// Now we can work with data:
if (data) { ...}
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Soft UART_Write

Prototype void Soft UART Write (char udata);

Returns Nothing.
This routine sends one byte via the Software UART bus.
Description Parameters:

- udata: data to be sent.

Software UART must be initialized before using this function. See the
Soft UART _Init routine.

Requires . . . o
q Be aware that during transmission, software UART is incapable of receiving data —
data transfer protocol must be set in such a way to prevent loss of information.
char some byte = 0x0A;
Example // Write a byte via Soft Uart

Soft UART Write (some byte);

Soft_Uart_Break

Prototype |void Soft UART Break();

Returns Nothing.

Soft UART_Read is blocking routine and it can block the program flow. Calling
this routine from the interrupt will unblock the program execution. This mecha-
Description |nism is similar to WDT.

Note: Interrupts should be disabled before using Software UART routines again
(see note at the top of this page).

Requires Nothing.

char datal, error, counter = 0;
void interrupt() {
if (INTCON.TOIF) {

if (counter >= 20) {
Soft UART Break();

counter = 0; // reset counter
Example }
else
counter++; // increment counter
INTCON.TOIF = O; // Clear Timer(O overflow interrupt flag

}
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void main () {
OPTION REG = 0x04; // TMRO prescaler set to 1:32
if (Soft UART Init (&PORTC, 7, 6, 9600, 0) = 0)

Soft UART Write (0x55);

Example

// try Soft UART Read with blocking prevention mechanism

INTCON.GIE = 1; // Global interrupt enable
INTCON.TOIE = 1; // Enable Timer0O overflow interrupt
datal = Soft UART Read(&error);

INTCON.GIE = O0; // Global interrupt disable
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Library Example

This example demonstrates simple data exchange via software UART. If MCU is
connected to the PC, you can test the example from the mikroC PRO for PIC
USART Terminal Tool.

char i, error, byte read; // Auxiliary variables
void main (){
// Configure AN pins as digital I/0

ANSEL = O0;
ANSELH = 0;

TRISB = 0x00; // Set PORTB as output (error signalization)
PORTB = 0; // No error

error = Soft UART Init (&PORTC, 7, 6, 14400, 0); // Initialize Soft
UART at 9600 bps
if (error > 0) {
PORTB = error; // Signalize Init error
while (1) ; // Stop program
}
Delay ms (100);

for (i = 'z'; 1 >= 'A'; i--) { // Send bytes from 'z' downto 'A'
Soft UART Write(i);
Delay ms (100);

}

while (1) { // Endless loop
byte read = Soft UART Read(&error); // Read Dbyte, then
test error flag
if (error) // 1If error was detected
PORTB = error; // signal it on PORTB
else
Soft UART Write (byte read); // If error was not detect-

ed, return byte read
}
}
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SOUND LIBRARY

The mikroC PRO for PIC provides a Sound Library to supply users with routines necessary for
sound signalization in their applications. Sound generation needs additional hardware, such as
piezo-speaker (example of piezo-speaker interface is given on the schematic at the bottom of this

page).

Library Routines

- Sound_Init
- Sound_Play
Sound_Init
Prototype void Sound Init(char *snd port, char snd pin);
Returns Nothing.
Configures the appropriate MCU pin for sound generation.
i Parameters:
Description
- snd port: sound output port address
- snd pin: sound output pin
Requires Nothing.
// Initialize the pin RD3 for playing sound
Example Sound Init (&PORTD, 3);
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Sound_Play

Prototype void Sound Play (unsigned freg in hz, unsigned duration ms);

Returns Nothing.

Generates the square wave signal on the appropriate pin.

Parameters:

- freq in Hz: signal frequency in Hertz (Hz)

i - duration ms: signal duration in miliseconds (ms)
Description
Note: frequency range is limited by Delay Cyc parameter. Maximum frequency
that can be produced by this function is Freq max = Fosc/ (80*3). Minimum fre-
quency is Freg min = Fosc/ (80%255) . Generated frequency may differ from the
freg in hz parameter due to integer arithmetics.

In order to hear the sound, you need a piezo speaker (or other hardware) on des-
Requires ignated port. Also, you must call Sound_Init to prepare hardware for output before
using this function.

// Play sound of 1KHz in duration of 100ms

Example Sound Play(looo, IOO) 7

Library Example

The example is a simple demonstration of how to use the Sound Library for play-
ing tones on a piezo speaker.

void Tonel () {

Sound Play (659, 250); // Frequency = 659Hz, duration = 250ms
}
void Tone2 () {

Sound Play (698, 250); // Frequency = 698Hz, duration = 250ms
}
void Tone3 () {

Sound Play (784, 250); // Frequency = 784Hz, duration = 250ms
}
void Melody () { // Plays the melody "Yellow house"

Tonel (); Tone2(); Tone3(); Tone3();

Tonel (); Tone2(); Tone3(); Tone3();

Tonel (); Tone2(); Tone3();

Tonel (); Tone2(); Tone3(); Tone3();

Tonel (); Tone2(); Tone3();

Tone3(); Tone3(); Tone2(); Tone2(); Tonel();
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void ToneA() {

Sound Play( 880, 50);
}
void ToneC () {

Sound Play (1046, 50);
}
void ToneE () {

Sound Play (1318, 50);

void Melody2 () {
unsigned short i;

for (i = 9; i > 0; i--) {
ToneA(); ToneC(); ToneE();
}
}
void main () {
ANSEL = 0; // Configure AN pins as digital I/O
ANSELH = 0;
TRISB = 0xF 8 // Configure RB7..RB3 as input
TRISD = OxF // Configure RD3 as output

Sound Init (&PORTD, 3);
Sound Play (1000, 1000);

while (1) {

if (Button (&PORTB,7,1,1)) // RB7 plays Tonel

Tonel () ;
while (PORTB & 0x80); // Wait for button to be released
if (Button (&PORTB,6,1,1)) // RB6 plays Tone2

Tone?2 () ;
while (PORTB & 0x40); // Wait for button to be released
if (Button (&PORTB,5,1,1)) // RB5 plays Tone3

Tone3 () ;
while (PORTB & 0x20); // Wait for button to be released
if (Button (&PORTB,4,1,1)) // RB4 plays Melody?2

Melody2 () ;
while (PORTB & 0x10); // Wait for button to be released
if (Button (&PORTB,3,1,1)) // RB3 plays Melody

Melody () ;
while (PORTB & 0x08); // Wait for button to be released

}
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HW Connection
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SPI LIBRARY

SPI module is available with a number of PIC MCU models. mikroC PRO for PIC provides a
library for initializing Slave mode and comfortable work with Master mode. PIC can easily com-
municate with other devices via SPI: A/D converters, D/A converters, MAX7219, LTC1290, etc.
You need PIC MCU with hardware integrated SPI (for example, PIC16F877).

Note: Some PIC18 MCUs have multiple SPI modules. Switching between the SPI modules in the
SPI library is done by the SPI_Set_Active function (SPI module has to be previously initialized).

Note: In order to use the desired SPI library routine, simply change the number 1 in the prototype
with the appropriate module number, i.e. SPI12_Init();

Library Routines

- Spit_Init

- Spi1_Init_Advanced
- Spi1_Read

- Spi1_Write

- Spi_Set_Active

Spi_Init

Prototype |void SPI1 Init (void);

Returns Nothing.

This routine configures and enables SPI module with the following settings:

- master mode

- 8 bit data transfer

- most significant bit sent first

- serial clock low when idle

- data sampled on leading edge
- serial clock = fosc/4

Description

Requires You need PIC MCU with hardware integrated SPI.

Example SPI1 Init(); // Initialize the SPI module with default settings
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Spi1_Init_Advanced

void SPI1 Init Advanced (unsigned short master slav, unsigned short
data sample, unsigned short clock idle, unsigned short transmit edge);

Prototype

Returns Nothing.

Configures and initializes SPI. SPI1_Init or SPI1_Init_Advanced needs to be
called before using other functions of SPI Library.

Parameters mode, data sample and clock idle configure the SPI module,
and can have the following values:

Description Predefined library const
SPI work mode:
Mastey clock = Fosc/4 _SPI MASTER OSC DIV4
Master clock = Fosc/16 _SPI _MASTER _OSC DIV16
Master clock = Fosc/64 _SPI _MASTER _OSC DIV64
Master clock source TMR2 _SPI MASTER TMR2
Slave select enabled _SPI SLAVE SS ENABLE
Description ||siave select disabled _SPI_SLAVE 5SS _DIS

Data sampling interval:

SPI DATA SAMPLE MID-

Input data sampled in middle of interval e

Input data sampled at the end of interval | SPI DATA SAMPLE END

SPI clock idle state:
Clock idle HIGH SPI CLK IDLE HIGH

Clock idle LOW _SPI_CLK_IDLE_LOW

Transmit edge:
Data transmit on low to high edge | SPI LOW 2 HIGH

Data transmit on high to low edge | SPI _HIGH 2 LOW

Requires You need PIC MCU with hardware integrated SPI.

// Set SPI1 module to master mode, clock = Fosc/4, data sampled
at the middle of interval, clock idle state low and data trans-
Example mitted at low to high edge:

SPT1 Init Advanced( SPI MASTER OSC DIV4, SPI DATA SAMPLE MIDDLE,
_SPT CLK IDLE LOW, SPI LOW 2 HIGH);
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Spi1_Read
Prototype unsigned short SPI1 Read (unsigned short buffer);
Returns Returns the received data.
Reads one byte from the SPI bus.
e Parameters:
Description
- buf fer: dummy data for clock generation (see device Datasheet for SPI
modules implementation details)
You need PIC MCU with hardware integrated SPI.
Requires SPI must be initialized and communication established before using this func-
tion. See SPI1_Init_Advanced or SPI1_Init.
short take, buffer;
Example S
take = SPI1 Read (buffer);
Spi1_Write
Prototype void SPI1 Write (unsigned short data );
Returns Nothing.
Writes byte via the SPI bus.
Description |Parameters:
- wrdata: data to be sent
You need PIC MCU with hardware integrated SPI.
Requires SPI must be initialized and communication established before using this func-
tion. See SPI1_Init_Advanced or SPI1_Init.
Example SPI1 Write(1);
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SPI_Set_Active

Prototype void SPI Set Active(char (*read ptr) (char)

Returns Nothing.

Sets the active SPI module which will be used by the SPI routines.
Description |Parameters:

- read ptr: SPI1_Read handler

Routine is available only for MCUs with two SPI modules.
Requires Used SPI module must be initialized before using this function. See the
SPI1_Init, SPI1_Init_Advanced

Example SPI Set Active (&SPI2 Read); // Sets the SPI2 module active

Library Example

The code demonstrates how to use SPI library functions for communication between SPI module
of the MCU and Microchip's MCP4921 12-bit D/A converter

// DAC module connections

sbit Chip Select at RCO bit;

sbit Chip Select Direction at TRISCO bit;
// End DAC module connections

unsigned int value;

void InitMain () {

TRISBO bit = 1; // Set RAO pin as input
TRISB1 bit = 1; // Set RAl pin as input
Chip Select = 1; // Deselect DAC
Chip Select Direction = 0; // Set CS# pin as Output
SPI1 Init(); // Initialize SPI module
}
// DAC increments (0..4095) --> output voltage (0..Vref)

void DAC Output (unsigned int valueDAC) {
char temp;

Chip Select = 0; // Select DAC chip

// Send High Byte

temp = (valueDAC >> 8) & OxO0OF; // Store valueDAC[ 11..8] to temp[ 3..0]
temp |= 0x30; // Define DAC setting, see MCP4921 datasheet
SPI1 Write (temp); // Send high byte via SPI

// Send Low Byte
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temp = valueDAC; // Store valueDAC[ 7..0] to temp[ 7..0]
SPI1 Write (temp); // Send low byte via SPI
Chip Select = 1; // Deselect DAC chip

}

void main () {
ANSEL = 0;
ANSELH = 0;
InitMain () ; // Perform main initialization
value = 2048; // When program starts, DAC gives

// the output in the mid-range
while (1) { // Endless loop

if ((RAO bit) && (value < 4095)) { // If RAO button is pressed

value++; // increment wvalue
}
else {
if ((RAl bit) && (value > 0)) { // If RALl button is pressed
value--; // decrement value
}
}
DAC_Output (value) ; // Send value to DAC chip
Delay ms(1); // Slow down key repeat pace
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HW Connection
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SPI ETHERNET LIBRARY

The £nC28T60 is a stand-alone Ethernet controller with an industry standard Serial
Peripheral Interface (SPI™). It is designed to serve as an Ethernet network interface
for any controller equipped with SPI.

The enc28J60 meets all of the IEEE 802.3 specifications. It incorporates a number
of packet filtering schemes to limit incoming packets. It also provides an internal
DMA module for fast data throughput and hardware assisted IP checksum calcula-
tions. Communication with the host controller is implemented via two interrupt pins
and the SPI, with data rates of up to 10 Mb/s. Two dedicated pins are used for LED
link and network activity indication.

This library is designed to simplify handling of the underlying hardware (Enc28J60).
It works with any PIC with integrated SPI and more than 4 Kb ROM memory. 38 to
40 MHz clock is recommended to get from 8 to 10 Mhz SPI clock, otherwise PIC
should be clocked by enc28760 clock output due to its silicon bug in SPI hardware.
If you try lower PIC clock speed, there might be board hang or miss some requests.

SPI Ethernet library supports:

- IPv4 protocol.

- ARP requests.

- ICMP echo requests.

- UDP requests.

- TCP requests (no stack, no packet reconstruction).
- ARP client with cache.

- DNS client.

- UDP client.

- DHCP client.

- packet fragmentation is NOT supported.

Note: Due to PIC16 RAM/Flash limitations PIC16 library does NOT have ARP, DNS,
UDP and DHCP client support implemented.

Note: Global library variable sp1 Ethernet userTimersec is used to keep track of
time for all client implementations (ARP, DNS, UDP and DHCP). It is user responsi-
bility to increment this variable each second in it's code if any of the clients is used.

Note: For advanced users there are header files ("eth enc28560Libbef.h" and
"eth enc28j60LibPrivate.h")in Uses\P16 and Uses\P18 folders of the compiler
with description of all routines and global variables, relevant to the user, implement-
ed in the SPI Ethernet Library.
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Note: The appropriate hardware SPI module must be initialized before using any of
the SPI Ethernet library routines. Refer to SPI Library.

For MCUs with two SPI modules it is possible to initialize both of them and then
switch by using the spI set Active () routine.
External dependencies of SPI Ethernet Library

The following variables

must be defined in all Description: Example:
projects using SPI Eth- P ) ple:

ernet Library:

extern sfr sbit . . sbit SPI Ethernet CS
SPT_Ethernet CS ENC28J60 chip select pin. |, "¢, bit; -
extern sfr sbit . sbit SPI Ethernet Rst
SPI_Ethernet RST; ENC28J60 reset pin. at RCO bit; -
extern sfr sbit . . sbit

SPI Ethernet CS Direc Dtl:..eCtloln of t.he ENC28.J60 SPI Ethernet CS Direc
tion; chip select pin. tion at TRISC1 bit;
extern sfr sbit . . sbit

SPI Ethernet RST Dire DIreCthn of the ENC28.60 SPI Ethernet Rst Dire
ction; reset pin. ction at TRISCO bit;

The following routines must be

defined in all project using SPI Description: Example:
Ethernet Library:

unsigned int _ Refer to the library
SPI Ethernet UserTCP (gns:l.gned example at the bot-
char *remoteHost, unsigned .

. . ! TCP request handler. [tom of this page for
int remotePort, unsigned int .

localPort, unsigned int (?Ode implementa-
regLength) ; tion.

unsigned int ‘ _ Refer to the library
OileEheInitﬁUsirUDP (L_'lns:.ine_dt example at the bot-
? ar remo crost, unsigned 1nt ypp request handler. |tom of this page for
remotePort, unsigned int .

destPort, unsigned int C?Ode implementa-
regLength) ; tion.
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Library Routines
PIC16 and PIC18:

- SPI_Ethernet_Init

- SPI_Ethernet_Enable

- SPI_Ethernet_Disable

- SPI_Ethernet_doPacket

- SPI_Ethernet_putByte

- SPI_Ethernet_putBytes

- SPI_Ethernet_putString

- SPI_Ethernet_putConstString
- SPI_Ethernet_putConstBytes
- SPI_Ethernet_getByte

- SPI_Ethernet_getBytes

- SPI_Ethernet_UserTCP

- SPI_Ethernet_UserUDP

PIC18 Only:

- SPI_Ethernet_getlpAddress

- SPI_Ethernet_getGwlpAddress
- SPI_Ethernet_getDnslpAddress
- SPI_Ethernet_getlpMask

- SPI_Ethernet_confNetwork

- SPI_Ethernet_arpResolve

- SPI_Ethernet_sendUDP

- SPI_Ethernet_dnsResolve

- SPI_Ethernet_initDHCP

- SPI_Ethernet_doDHCPLeaseTime
- SPI_Ethernet_renewDHCP
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Spi_Ethernet_Init

void SPI Ethernet Init (unsigned char *mac, unsigned char *ip,
unsigned char fullDuplex);

Prototype

Returns Nothing.

This is MAC module routine. It initializes rnc28J60 controller. This function is
internaly splited into 2 parts to help linker when coming short of memory.

ENC28J60 controller settings (parameters not mentioned here are set to default):

- receive buffer start address : 0x0000.

- receive buffer end address : 0x19aD.

- transmit buffer start address: 0x19aE.

- transmit buffer end address : 0x1FFF.

- RAM buffer read/write pointers in auto-increment mode.

- receive filters set to default: CRC + MAC Unicast + MAC Broadcast in OR mode.

- flow control with TX and RX pause frames in full duplex mode.

- frames are padded to ¢0 bytes + CRC.

- maximum packet size is set to 1518.

Description |- Back-to-Back Inter-Packet Gap: 0x15 in full duplex mode; 0x12 in half duplex mode.
- Non-Back-to-Back Inter-Packet Gap: 0x0012 in full duplex mode; 0x0c12 in
half duplex mode.

- Collision window is set to 63 in half duplex mode to accomodate some -
ENC28J60 revisions silicon bugs.

- CLKOUT output is disabled to reduce EMI generation.

- half duplex loopback disabled.

- LED configuration: default (LEDA-link status, LEDB-link activity).

Parameters:

- mac: RAM buffer containing valid MAC address.

- ip: RAM buffer containing valid IP address.

- fullbuplex: ethernet duplex mode switch. Valid values: 0 (half duplex mode)
and 1 (full duplex mode).
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Global variables:
- spI Ethernet Cs: Chip Select line
- SPI Ethernet CS Direction: Direction of the Chip Select pin
- SPI Ethernet RST: Reset line
- SPI_Ethernet RST Direction: Direction of the Reset pin
Requires |[must be defined before using this function.
The SPlI module needs to be initialized. See the SPI1_Init and
SPI1_Init_Advanced routines.
#define SPI Ethernet HALFDUPLEX 0
#define SPI Ethernet FULLDUPLEX 1
// mE ehternet NIC pinout
sfr sbit SPI Ethernet Rst at RCO bit;
sfr sbit SPI Ethernet CS at RC1l bit;
sfr sbit SPI Ethernet Rst Direction at TRISCO bit;
sfr sbit SPI Ethernet CS Direction at TRISCIl bit;
Example // end ethernet NIC definitions
unsigned char myMacAddr[ 6] = {0x00, 0x14, OxA5, 0x76, 0x19,
0x3f}; // my MAC address
unsigned char myIpAddr = {192, 168, 1, 60 }; // my IP
addr
SPI1 Init();
SPIiEthernetiInit(myMacAddr, myIpAddr, SPIAEthernetiFULLDUPLEX);
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Spi_Ethernet_Enable

Prototype void SPI Ethernet Enable (unsigned char enFlt);

Returns Nothing.

This is MAC module routine. This routine enables appropriate network traffic on
the Enc28760 module by the means of it's receive filters (unicast, multicast,
broadcast, crc). Specific type of network traffic will be enabled if a corresponding
bit of this routine's input parameter is set. Therefore, more than one type of net-
work traffic can be enabled at the same time. For this purpose, predefined library
constants (see the table below) can be ORed to form appropriate input value.

Parameters:
- enFlt: network traffic/receive filter flags. Each bit corresponds to the appropri-
ate network traffic/receive filter:

Bit | Mask Description Predefined library const

MAC Broadcast traffic/receive filter
0 | 0x01 |flag. When set, MAC broadcast traf-
fic will be enabled.

MAC Multicast traffic/receive filter
1 | 0x02 |flag. When set, MAC multicast traffic

_SPI Ethernet BROAD-
CAST

_SPI Ethernet MULTI-

will be enabled. e

Description 2 | 0x04 [not used none
3 | 0x08 |not used none

4 | 0x10 |not used none

CRC check flag. When set, packets
with invalid CRC field will be discarded.

6 | 0x40 |not used none

5 | 0x20 _SPI_Ethernet CRC

MAC Unicast traffic/receive filter flag.
7 | 0x80 |When set, MAC unicast traffic will be | SPI_Ethernet UNICAST
enabled.

Note: Advance filtering available in the Enc28760 module such as pattern
Match, Magic Packet and Hash Table can not be enabled by this routine.
Additionaly, all filters, except CRC, enabled with this routine will work in OR mode,
which means that packet will be received if any of the enabled filters accepts it.

Note: This routine will change receive filter configuration on-the-fly. It will not, in
any way, mess with enabling/disabling receive/transmit logic or any other part of
the enc28360 module. The enc28J60 module should be properly cofigured by
the means of SPI_Ethernet_Init routine.

454 MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD



CHAPTER 7
mikroC PRO for PIC Libraries

Requires Ethernet module has to be initialized. See SPI_Ethernet_Init.

SPI Ethernet Enable( SPI Ethernet CRC | SPI Ethernet UNICAST);

Example // enable CRC checking and Unicast traffic

Spi_Ethernet_Disable

Prototype void SPI Ethernet Disable (unsigned char disFlt);

Returns Nothing.

This is MAC module routine. This routine disables appropriate network traffic on
the Enc28760 module by the means of it's receive filters (unicast, multicast,
broadcast, crc). Specific type of network traffic will be disabled if a corresponding
bit of this routine's input parameter is set. Therefore, more than one type of net-
work traffic can be disabled at the same time. For this purpose, predefined library
constants (see the table below) can be ORed to form appropriate input value.

Parameters:
- disFlt: network traffic/receive filter flags. Each bit corresponds to the appro-

priate network traffic/receive filter:

Bit | Mask Description Predefined library

const

o | ox01 MAC Broadcast traffic/receive filter flag. When  |spi Ethernet BrO
set, MAC broadcast traffic will be disabled. ADCAST

1 | oxo2 MAC Multicast traffic/receive filter flag. When [spi Ethernet MUL
set, MAC multicast traffic will be disabled. TICAST

2 | 0x04 |not used none

Description

3 | 0x08 [not used none

4 | 0x10 |not used none
CRC check flag. When set, CRC check will

5 | 0x20 |be disabled and packets with invalid CRC Spi_ Ethernet CRC
field will be accepted.

6 | 0x40 |not used none

7 | oxs0 MAC Unicast traffic/receive filter flag. When [spi Ethernet UNI
set, MAC unicast traffic will be disabled. CAST

Note: Advance filtering available in the rnc28J60 module such as pattern
Match, Magic Packet and Hash Table can not be disabled by this routine.

Note: This routine will change receive filter configuration on-the-fly. It will not, in
any way, mess with enabling/disabling receive/transmit logic or any other part of
the Enc28760 module. The Enc28J60 module should be properly cofigured by
the means of SPI_Ethernet_Init routine.
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Requires Ethernet module has to be initialized. See SPI_Ethernet_Init.

SPIiEthernetiDisable(7SP17Ethernet7CRC | SPI Ethernet UNICAST);

Example // disable CRC checking and Unicast traffic

Spi_Ethernet_doPacket

Prototype unsigned char SPI Ethernet doPacket();

- 0 - upon successful packet processing (zero packets received or received
packet processed successfully).

- 1 - upon reception error or receive buffer corruption. enc28760 controller

Returns needs to be restarted.

- 2 - received packet was not sent to us (not our IP, nor IP broadcast address).

- 3 - received IP packet was not IPv4.

- 4 - received packet was of type unknown to the library.

This is MAC module routine. It processes next received packet if such exists.
Packets are processed in the following manner:

- ARP & ICMP requests are replied automatically.

- upon TCP request the Spi_Ethernet UserTCP function is called for further
processing.

- upon UDP request the Spi_Ethernet _UserUDP function is called for further
processing.

Description

Note: spi Ethernet dopacket must be called as often as possible in user's code.

Requires Ethernet module has to be initialized. See Spi_Ethernet_Init.

if (SPI _Ethernet doPacket () == 0) (1) { // process received pack-

t
Example o

}

456 MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD



CHAPTER 7
mikroC PRO for PIC Libraries

Spi_Ethernet_putByte

Prototype void SPI Ethernet putByte (unsigned char v);

Returns Nothing.

This is MAC module routine. It stores one byte to address pointed by the cur-
rent ENC28J60 write pointer (EWRPT).

Description Parameters:

- v: value to store

Requires Ethernet module has to be initialized. See Spi_Ethernet_lInit.

char data;
Example

SPI Ethernet putByte(data); // put an byte into ENC28J60 buffer

Spi_Ethernet_putBytes

Prototype void SPI Ethernet putBytes (unsigned char *ptr, unsigned char n);
yp _ _

Returns Nothing.

This is MAC module routine. It stores requested number of bytes into Enc28760
RAM starting from current £nc28760 write pointer (EwrpT) location.

Description |Parameters:

- ptr: RAM buffer containing bytes to be written into enc28560 RAM.
- n: number of bytes to be written.

Requires Ethernet module has to be initialized. See Spi_Ethernet_Init.

char *buffer = "mikroElektronika";

Example SPI Ethernet putBytes (buffer, 16); // put an RAM array into

ENC28J60 buffer
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Spi_Ethernet_putConstBytes

void SPI Ethernet putConstBytes (const unsigned char *ptr, unsigned
char n);

Prototype

Returns Nothing.

This is MAC module routine. It stores requested number of const bytes into
ENC28J60 RAM starting from current Enc28J60 write pointer (EwreT) location.

Description |Parameters:

- ptr: const buffer containing bytes to be written into Enc28760 RAM.
- n: number of bytes to be written.

Requires Ethernet module has to be initialized. See Spi_Ethernet_Init.

const char *buffer = "mikroElektronika";

Exan“ﬂe SPI Ethernet putConstBytes (buffer, 16); // put a const array into

ENC28J60 buffer

Spi_Ethernet_putString

Prototype unsigned int SPI Ethernet putString(unsigned char *ptr);

Returns Number of bytes written into znc28560 RAM.

This is MAC module routine. It stores whole string (excluding null termination) into
ENC28J60 RAM starting from current enc28J60 write pointer (EwreT) location.

Description Parameters:

- ptr: string to be written into Enc28760 RAM.

Requires Ethernet module has to be initialized. See Spi_Ethernet_Init.

char *buffer = "mikroElektronika";

Exan“ﬂe SPI_Ethernet putString(buffer); // put a RAM string into ENC28J60

buffer
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Spi_Ethernet_putConstString

Prototype unsigned int SPI Ethernet putConstString(const unsigned char *ptr);

Returns Number of bytes written into enc28J760 RAM.

This is MAC module routine. It stores whole const string (excluding null termination)
into Enc28760 RAM starting from current Enc28J60 write pointer (EwrPT) location.

Description Parameters:

- ptr: const string to be written into Enc28760 RAM.

Requires Ethernet module has to be initialized. See Spi_Ethernet_lInit.

const char *buffer = "mikroElektronika";

Example SPI Ethernet putConstString(buffer); // put a const string into

ENC28J60 buffer

Spi_Ethernet_getByte

Prototype unsigned char SPI Ethernet getByte();

Returns Byte read from enc28760 RAM.

This is MAC module routine. It fetches a byte from address pointed to by cur-

Description .
rent ENC28760 read pointer (ERDPT).

Requires Ethernet module has to be initialized. See Spi_Ethernet_Init.

char buffer;

Example buffer = SPI Ethernet getByte(); // read a byte from ENC28J60

buffer
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Spi_Ethernet_getBytes

void SPI Ethernet getBytes (unsigned char *ptr, unsigned int addr,

PrOtOtype unsigned char n);

Returns Nothing.
This is MAC module routine. It fetches equested number of bytes from
ENC28J60 RAM starting from given address. If value of oxrrrr is passed as the
address parameter, the reading will start from current Exnc28J60 read pointer
(ErDPT) location.

Description

Parameters:

- ptr: buffer for storing bytes read from exc28760 RAM.
- addr: ENC28J60 RAM start address. Valid values: 0. .8192.
- n: number of bytes to be read.

Requires Ethernet module has to be initialized. See Spi_Ethernet_Init.

char buffer| 16] ;

Example SPI_Ethernet getBytes (buffer, 0x100, 16); // read 16 bytes,

starting from address 0x100
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Spi_Ethernet_UserTCP

unsigned int SPI Ethernet UserTCP (unsigned char *remoteHost,
Prototype unsigned int remotePort, unsigned int localPort, unsigned int
reqglLength) ;

- 0 - there should not be a reply to the request.

Returns - Length of TCP/HTTP reply data field - otherwise.

This is TCP module routine. It is internally called by the library. The user access-
es to the TCP/HTTP request by using some of the SPI_Ethernet_get routines.
The user puts data in the transmit buffer by using some of the SPI_Ethernet_put
routines. The function must return the length in bytes of the TCP/HTTP reply, or
0 if there is nothing to transmit. If there is no need to reply to the TCP/HTTP
requests, just define this function with return(0) as a single statement.

Description Parameters:
- remoteHost : client's IP address.

- remotePort : client's TCP port.

- localport : port to which the request is sent.

- reglLength : TCP/HTTP request data field length.

Note: The function source code is provided with appropriate example projects.
The code should be adjusted by the user to achieve desired reply.

Requires Ethernet module has to be initialized. See Spi_Ethernet_Init.

This function is internally called by the library and should not be called by the

Example
P user's code.
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Spi_Ethernet_UserUDP

unsigned int SPI Ethernet UserUDP (unsigned char *remoteHost,
Prototype unsigned int remotePort, unsigned int destPort, unsigned int
regLength) ;

- 0 - there should not be a reply to the request.

Returns - Length of UDP reply data field - otherwise.

This is UDP module routine. It is internally called by the library. The user access-
es to the UDP request by using some of the SPI_Ethernet_get routines. The user
puts data in the transmit buffer by using some of the SPI_Ethernet_put routines.
The function must return the length in bytes of the UDP reply, or 0 if nothing to
transmit. If you don't need to reply to the UDP requests, just define this function
with a return(0) as single statement.

Description |Parameters:

- remoteHost : client's IP address.

- remotePort : client's port.

- destport : port to which the request is sent.
- reglLength : UDP request data field length.

Note: The function source code is provided with appropriate example projects.
The code should be adjusted by the user to achieve desired reply.

Requires Ethernet module has to be initialized. See Spi_Ethernet_Init.

This function is internally called by the library and should not be called by the

Example
P user's code.

SPI_Ethernet_getipAddress
Prototype unsigned char * SPI Ethernet getIpAddress();

Returns Ponter to the global variable holding IP address.

This routine should be used when DHCP server is present on the network to fetch
assigned IP address.

Description [Note: User should always copy the IP address from the RAM location returned by
this routine into it's own IP address buffer. These locations should not be altered
by the user in any case.

Ethernet module has to be initialized. See SPI_Ethernet_Init.

Requires ; .
q Available for PIC18 family MCUs only.
unsigned char ipAddr[ 4] ; // user IP address buffer
Example ce
memcpy (1pAddr, SPI Ethernet getIpAddress(), 4); // fetch IP address
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SPI_Ethernet_getGwlpAddress

Prototype unsigned char * SPI Ethernet getGwIpAddress();

Returns Ponter to the global variable holding gateway |IP address.

This routine should be used when DHCP server is present on the network to fetch
assigned gateway IP address.

Description Note: User should always copy the IP address from the RAM location returned by
this routine into it's own gateway IP address buffer. These locations should not be
altered by the user in any case!

Requires Ethernet module has to be initialized. See SPI_Ethernet_|Init.

q Available for PIC18 family MCUs only.
unsigned char gwIpAddr] 4]; // user gateway IP address buffer

Example ﬁéﬁcpy<gwIpAddr, SPI _Ethernet getGwIpAddress(), 4); // fetch gate-

way IP address

SPI_Ethernet_getDnsipAddress

Prototype

unsigned char * SPI Ethernet getDnsIpAddress (

Returns

Ponter to the global variable holding DNS IP address.

Description

This routine should be used when DHCP server is present on the network to fetch
assigned DNS IP address.

Note: User should always copy the IP address from the RAM location returned by
this routine into it's own DNS IP address buffer. These locations should not be
altered by the user in any case.

Requires

Ethernet module has to be initialized. See SPI_Ethernet_lInit.
Available for PIC18 family MCUs only.

Example

unsigned char dnsIpAddr] 4] ; // user DNS IP address buffer

memcpy (dnsIpAddr, SPI Ethernet getDnsIpAddress(), 4); // fetch
DNS server address
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SPI_Ethernet_getipMask

Prototype unsigned char * SPI Ethernet getIpMask ()

Returns Ponter to the global variable holding IP subnet mask.

This routine should be used when DHCP server is present on the network to
fetch assigned IP subnet mask.

Description Note: User should always copy the IP address from the RAM location returned
by this routine into it's own IP subnet mask buffer. These locations should not
be altered by the user in any case.

Requires Ethernet module has to be initialized. See SPI_Ethernet_|Init.

q Available for PIC18 family MCUs only.
unsigned char IpMask[ 4] ; // user IP subnet mask buffer

Example %é%cpy(TpMask, SPI_Ethernet getIpMask(), 4); // fetch IP subnet

mask

SPI_Ethernet_confNetwork

void SPI Ethernet confNetwork (char *ipMask, char *gwIpAddr, char

Prototype *dnsIpAddr) ;

Returns Nothing.

Configures network parameters (IP subnet mask, gateway IP address, DNS IP
address) when DHCP is not used.

Parameters:
. - ipMask: IP subnet mask.

Description
- gwIpAddr gateway IP address.
- dnsIpaAddr: DNS IP address.
Note: The above mentioned network parameters should be set by this routine
only if DHCP module is not used. Otherwise DHCP will override these settings

Requires Ethernet module has to be initialized. See SPI_Ethernet_|Init.
Available for PIC18 family MCUs only.
char ipMask[ 4] = {255, 255, 255, 0 }; // network mask (for
example : 255.255.255.0)
char gwIpAddr| 4] = {192, 168, 1, 11} // gateway (router)
IP address

Example char dnsIpAddr[ 4] = {192, 168, 1, 11} // DNS server IP
address

SPI _Ethernet confNetwork (ipMask, gwIpAddr, dnsIpAddr); // set
network configuration parameters

464 MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD



CHAPTER 7
mikroC PRO for PIC Libraries

SPI_Ethernet_arpResolve

unsigned char *SPI Ethernet arpResolve (unsigned char *ip, unsigned
char tmax);

Prototype

- MAC address behind the IP address - the requested IP address was resolved.

Returns .
- 0 - otherwise.

This is ARP module routine. It sends an ARP request for given IP address and
waits for ARP reply. If the requested IP address was resolved, an ARP cash entry
is used for storing the configuration. ARP cash can store up to 3 entries. For ARP
cash structure refer to "eth enc28j60Libpef.h" header file in the compiler's
Uses/P18 folder.

Description |Parameters:

- ip: IP address to be resolved.
- tmax: time in seconds to wait for an reply.

Note: The Ethernet services are not stopped while this routine waits for ARP
reply. The incoming packets will be processed normaly during this time.

Ethernet module has to be initialized. See SPI_Ethernet_Init.

Requires | Available for PIC18 family MCUs only.

unsigned char IpAddr| 4] = {192, 168, 1, 1} // IP address

Example SPI_Ethernet arpResolve (IpAddr, 5); // get MAC address behind the

above IP address, wait 5 secs for the response
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SPI_Ethernet_sendUDP

unsigned char SPI Ethernet sendUDP (unsigned char *destIP, unsigned
Prototype int sourcePort, unsigned int destPort, unsigned char *pkt, unsigned
int pktLen);

- 1 - UDP packet was sent successfuly.

Returns .
- 0 - otherwise.

This is UDP module routine. It sends an UDP packet on the network.
Parameters:

Description |- dest1p: remote host IP address.

- sourceport: local UDP source port number.
- destprort: destination UDP port number.

- pkt: packet to transmit.

- pktLen: length in bytes of packet to transmit.

Ethernet module has to be initialized. See SPI_Ethernet_Init.

Requires ; .
q Available for PIC18 family MCUs only.
unsigned char IpAddr| 4] = {192, 168, 1, 11%}; // remote IP
address
Example SPI Ethernet sendUDP (IpAddr, 10001, 10001, "Hello", 5); // send

Hello message to the above IP address, from UDP port 10001 to
UDP port 10001
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SPI_Ethernet_dnsResolve

unsigned char * SPI Ethernet dnsResolve (unsigned char *host,
Prototype i - -
unsigned char tmax);
- pointer to the location holding the IP address - the requested host name was
Returns resolved.
- 0 - otherwise.
This is DNS module routine. It sends an DNS request for given host name and
waits for DNS reply. If the requested host name was resolved, it's IP address is
stored in library global variable and a pointer containing this address is returned
by the routine. UDP port 53 is used as DNS port.
Parameters:
i -host: host name to be resolved.
Description L .
-tmax: time in seconds to wait for an reply.
Note: The Ethernet services are not stopped while this routine waits for DNS
reply. The incoming packets will be processed normaly during this time.
Note: User should always copy the IP address from the RAM location returned by
this routine into it's own resolved host IP address buffer. These locations should
not be altered by the user in any case.
Requires Ethernet module has to be initialized. See SPI_Ethernet_Init.
q Available for PIC18 family MCUs only.
unsigned char * remoteHostIpAddr[ 4] ; // user host IP address
buffer
// SNTP server:
// Zurich, Switzerland: Integrated Systems Lab, Swiss Fed. Inst.
Example i
of Technology
// 129.132.2.21: swisstime.ethz.ch
// Service Area: Switzerland and Europe
memcpy (remoteHostIpAddr,
SPI Ethernet dnsResolve ("swisstime.ethz.ch", 5), 4);
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SPI_Ethernet_initDHCP

Prototype unsigned char SPI Ethernet initDHCP (unsigned char tmax);

- 1 - network parameters were obtained successfully.

Returns .
- 0 - otherwise.

This is DHCP module routine. It sends an DHCP request for network parameters
(IP, gateway, DNS addresses and IP subnet mask) and waits for DHCP reply. If
the requested parameters were obtained successfuly, their values are stored into
the library global variables.

These parameters can be fetched by using appropriate library IP get routines:
- SPI_Ethernet_getlpAddress - fetch IP address.

- SPI_Ethernet_getGwlpAddress - fetch gateway IP address.

- SPI_Ethernet_getDnslpAddress - fetch DNS IP address.

- SPI_Ethernet_getlpMask - fetch IP subnet mask.

Description [UDP port 638 is used as DHCP client port and UDP port 67 is used as DHCP serv-
er port.

Parameters:
- tmax: time in seconds to wait for an reply.

Note: The Ethernet services are not stopped while this routine waits for DNS
reply. The incoming packets will be processed normaly during this time.

Note: When DHCP module is wused, global Ilibrary variable
SPT Ethernet userTimerSec is used to keep track of time. It is user responsi-
bility to increment this variable each second in it's code.

Ethernet module has to be initialized. See SPI_Ethernet_Init.

Requires | \vailable for PIC18 family MCUs only.

SPI _Ethernet initDHCP(5); // get network configuration from DHCP

Exampl .
ample server, wait 5 sec for the response
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SPI_Ethernet_doDHCPLeaseTime

Prototype unsigned char SPI Ethernet doDHCPLeaseTime () ;

- 0 - lease time has not expired yet.

Returns - 1 - lease time has expired, it's time to renew it.

This is DHCP module routine. It takes care of IP address lease time by decre-
Description [menting the global lease time library counter. When this time expires, it's time to
contact DHCP server and renew the lease.

Ethernet module has to be initialized. See SPI_Ethernet_|Init.

Requires |\ \ailable for PIC18 family MCUs only.
while (1) {
Exanuﬂe if (SPI_Ethernet doDHCPLeaseTime ()

// it's time to renew the IP address lease

SPI_Ethernet_renewDHCP

Prototype unsigned char SPI Ethernet renewDHCP (unsigned char tmax);

- 1 - upon success (lease time was renewed).

Returns - 0 - otherwise (renewal request timed out).
This is DHCP module routine. It sends IP address lease time renewal request to
DHCP server.
Description Parameters:
- tmax: time in seconds to wait for an reply.
. Ethernet module has to be initialized. See SPI_Ethernet_Init.
Requires

Available for PIC18 family MCUs only.

while (1) {
if (SPI Ethernet doDHCPLeaseTime () )

Example SPI Ethernet renewDHCP(5); // it's time to renew the IP
address lease, with 5 secs for a reply

}
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Library Example
This code shows how to use the Ethernet mini library :

- the board will reply to ARP & ICMP echo requests
- the board will reply to UDP requests on any port :

returns the request in upper char with a header made of remote host IP &
port number

- the board will reply to HTTP requests on port 80, GET method with pathnames :
/ will return the HTML main page
/s will return board status as text string
/0 ... /t7 will toggle RDO to RD7 bit and return HTML main page
all other requests return also HTML main page.

// duplex config flags
#define Spi Ethernet HALFDUPLEX 0x00 // half duplex
#define Spi Ethernet FULLDUPLEX 0x01 // full duplex

// mE ehternet NIC pinout

sfr sbit SPI Ethernet Rst at RCO bit;

sfr sbit SPI Ethernet CS at RC1l bit;

sfr sbit SPI Ethernet Rst Direction at TRISCO bit;
sfr sbit SPI Ethernet CS Direction at TRISCI bit;
// end ethernet NIC definitions

/*‘k*‘k*‘k*‘k*‘k*‘k*‘k*‘k*‘k*‘k*‘k*‘k*‘k*‘k*‘k*‘k*‘k*‘k************************

* ROM constant strings

*/
const unsigned char httpHeader[] = "HTTP/1.1 200 OKnContent-type: "
; // HTTP header
const unsigned char httpMimeTypeHTMI[ ] = "text/htmlnn" ;
// HTML MIME type
const unsigned <char httpMimeTypeScript][ ] = "text/plainnn"

// TEXT MIME type
unsigned char httpMethod ] = "GET /";

/*

* web page, splited into 2 parts

* when coming short of ROM, fragmented data is handled more effi-
ciently by linker

*

* this HTML page calls the boards to get its status, and builds
itself with javascript

*/
const char *indexPage = // Change the IP address of the page to
be refreshed

"<meta http-equiv="refresh" content="3;url=http://192.168.20.60">
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<HTML><HEAD></HEAD><BODY>

<h1>PIC + ENC28J60 Mini Web Server</hl>

<a href=/>Reload</a>

<script src=/s></script>

<table><tr><td wvalign=top><table border=1 style="font-size:20px
;font-family: terminal ;">

<tr><th colspan=2>ADC</th></tr>
<tr><td>AN2</td><td><script>document.write (AN2)</script></td></tr>
<tr><td>AN3</td><td><script>document.write (AN3)</script></td></tr>
</table></td><td><table border=1 style="font-size:20px ;font-family:
terminal ;">

<tr><th colspan=2>PORTB</th></tr>

<script>

var str,i;

str="";

for (i=0;i<8;i++)

{ str+="<tr><td bgcolor=pink>BUTTON #"+i+"</td>";

if (PORTB& (1<<1i) ){ str+="<td bgcolor=red>ON";}

else { str+="<td bgcolor=#cccccc>OFF";}

str+="</td></tr>";}

document.write (str) ;

</script>

LU
’

const char *indexPage2 = "</table></td><td>
<table border=1 style="font-size:20px ;font-family: terminal ;">
<tr><th colspan=3>PORTD</th></tr>

<script>

var str,i;

str="";

for (i=0;i<8;i++)

{ str+="<tr><td bgcolor=yellow>LED #"+i+"</td>";

if (PORTD& (1<<1i) ){ str+="<td bgcolor=red>ON";}

else { str+="<td bgcolor=#cccccc>0OFF";}
str+="</td><td><a href=/t"+i+">Toggle</a></td></tr>";}
document.write (str) ;

</script>
</table></td></tr></table>
This is HTTP request

#<script>document.write (REQ)</script></BODY></HTMIL>

LU
’

/*‘k*‘k*‘k*‘k*‘k*************************

* RAM variables

*/
unsigned char myMacAddr] 6] = { 0x00, Ox14, OxA5, 0x76, 0x19, O0x3f};
// my MAC address
unsigned char myIpAddr[ 4] = {192, 168, 20, 60} ;
// my IP address
unsigned char getRequest] 15] ; // HTTP request buffer

MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD 471



CHAPTER 7

Libraries mikroC PRO for PIC
unsigned char dynal 30] ; // buffer for dynamic response
unsigned long httpCounter = 0; // counter of HTTP requests

/*‘k*‘k*‘k*‘k*‘k*‘k*‘k*‘k*‘k*************************

* functions

*/
/*
* put the constant string pointed to by s to the ENC transmit buffer.
*/
/*unsigned int putConstString (const char *s)
{
unsigned int ctr = 0;
while (*s)
{
Spi Ethernet putByte (*s++);
ctr++;
}
return(ctr);
yx/
/*
* it will be much faster to use library Spi Ethernet putConstString
routine

* instead of putConstString routine above. However, the code will
be a little

* bit bigger. User should choose between size and speed and pick the
implementation that

* suites him best. If you choose to go with the putConstString def-
inition above

* the #define line below should be commented out.
*

*/
#define putConstString SPI Ethernet putConstString
/*
* put the string pointed to by s to the ENC transmit buffer
*/
/*unsigned int putString (char *s)
{
unsigned int ctr = 0;
while (*s)

{
Spi Ethernet putByte (*s++);

ctr++;

}

return(ctr);

Pr/
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/*
* it will be much faster to use library Spi Ethernet putString rou-
tine
* 1instead of putString routine above. However, the code will be a
little

* bit bigger. User should choose between size and speed and pick the
implementation that

* suites him best. If you choose to go with the putString defini-
tion above

* the #define line below should be commented out.

*

*/

#define putString SPI Ethernet putString

/*
* this function is called by the library
* the wuser accesses to the HTTP request by successive calls to
Spi Ethernet getByte ()
* the user puts data in the transmit buffer by successive calls to
Spi Ethernet putByte ()
* the function must return the length in bytes of the HTTP reply,
or 0 if nothing to transmit
*
* 1f you don't need to reply to HTTP requests,
* just define this function with a return(0) as single statement
*
*/
unsigned int SPI Ethernet UserTCP (unsigned char *remoteHost,
unsigned int remotePort, unsigned int localPort, wunsigned int
reglength)
{
unsigned int len = 0; // my reply length
unsigned int i; // general purpose integer

if (localPort != 80) // I listen only to web request on port 80
{
return (0) ;

}

// get 10 first bytes only of the request, the rest does not
matter here
for(i = 0; i < 10; i++)
{

getRequest[ i] = SPI Ethernet getByte();
}
getRequest[ 1] = 0;
if (memcmp (getRequest, httpMethod, 5)) // only GET

method is supported here

{
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return (0) ;
}
httpCounter++; // one more request done
if (getRequest[ 5] == 's') // 1if request path name starts

with s, store dynamic data in transmit buffer

{

// the text string replied by this request can be
interpreted as javascript statements

// by browsers

len = putConstString (httpHeader) ; // HTTP header
len += putConstString(httpMimeTypeScript); // with
text MIME type

// add AN2 value to reply
IntToStr (ADC Read(2), dyna);

len += putConstString("var AN2=");
len += putString(dyna);

len += putConstString(";");

// add AN3 value to reply
IntToStr (ADC Read(3), dyna);

len += putConstString("var AN3=");
len += putString(dyna);

len += putConstString(";");

// add PORTB value (buttons) to reply
len += putConstString("var PORTB=");
IntToStr (PORTB, dyna);

len += putString(dyna);

len += putConstString(";");

// add PORTD value (LEDs) to reply
len += putConstString("var PORTD=");
IntToStr (PORTD, dyna);

len += putString(dyna);

len += putConstString(";");

// add HTTP requests counter to reply
IntToStr (httpCounter, dyna);
len += putConstString("var REQ=");
len += putString(dyna);
len += putConstString(";");
}
else if (getRequest[ 5] == 't') // if request path name starts
with t, toggle PORTD (LED) bit number that comes after
{
unsigned char bitMask = 0; // for bit mask
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if (isdigit (getRequest] 6] )) // if 0 <= bit number
<= 9, bits 8 & 9 does not exist but does not matter
{
bitMask = getRequest[ 6] - '0'; // convert
ASCII to integer
bitMask = 1 << bitMask; // create bit mask
PORTD "= bitMask; // toggle PORTD with xor
operator

if(len == 0) // what do to by default
{
len = putConstString (httpHeader); // HTTP header
len += putConstString (httpMimeTypeHTML); // with
HTML MIME type
len += putConstString (indexPage); // HTML page first
part
len += putConstString (indexPage?); // HTML page sec-
ond part

return(len); // return to the library with the number of
bytes to transmit

}

/*

* this function is called by the library

* the wuser accesses to the UDP request by successive calls to
Spi Ethernet getByte ()

* the user puts data in the transmit buffer by successive calls to
Spi Ethernet putByte ()

* the function must return the length in bytes of the UDP reply, or
0 if nothing to transmit

if you don't need to reply to UDP requests,
just define this function with a return(0) as single statement

L

/

unsigned int SPI Ethernet UserUDP (unsigned char *remoteHost,
unsigned int remotePort, unsigned int destPort, wunsigned int
reglLength)

{

unsigned int len; // my reply length

unsigned char *ptr; // pointer to the dynamic buffer

// reply is made of the remote host IP address in human read-
able format
ByteToStr (remoteHost[ 0] , dyna); // first IP address byte
dynal 3] = '.';
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ByteToStr (remoteHost[ 1] , dyna + 4); // second
dynal 7] = "'.';
ByteToStr (remoteHost[ 2] , dyna + 8); // third
dynal[ 11] = ".";
ByteToStr (remoteHost[ 3], dyna + 12); // fourth
dynal 15] = ':'; // add separator

// then remote host port number
WordToStr (remotePort, dyna + 16);

dyna[ 21] = '[ ';

WordToStr (destPort, dyna + 22);
dynal 27] = ']1"';

dynal 28] = 0;

// the total length of the request is the length of the
dynamic string plus the text of the request
len = 28 + reqglength;

// puts the dynamic string into the transmit buffer
SPI Ethernet putBytes(dyna, 28);

// then puts the request string converted into upper char
into the transmit buffer
while (regLength--)
{
SPI Ethernet putByte (toupper (SPI_Ethernet getByte()));
}

return(len); // back to the library with the length of the
UDP reply
}
/*
* main entry
*/
void main ()
{
ANSEL = 0x0C; // BN2 and AN3 convertors will be used
PORTA = 0;
TRISA = Oxff; // set PORTA as input for ADC
ANSELH = 0; // Configure other AN pins as digital I/O
PORTB = 0;
TRISB = Oxff; // set PORTB as input for buttons
PORTD = 0;
TRISD = 0; // set PORTD as output

/*
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* starts ENC28J60 with

* reset bit on RCO

* CS bit on RC1

* my MAC & IP address

* full duplex

*/

SPI1 Init();

SPI Ethernet Init (myMacAddr, myIpAddr, Spi Ethernet FULLDU-
PLEX) ;

while (1) // do forever

/*
* 1f necessary, test the return value to get error code
*/
SPI Ethernet doPacket () ; // process incoming
Ethernet packets

/*
* add your stuff here if needed
* Spi Ethernet doPacket () must be called as often as possible
* otherwise packets could be lost
*/
}
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SPI GRAPHIC LCD LIBRARY

The mikroC PRO for PIC provides a library for operating Graphic Lcd 128x64 (with
commonly used Samsung KS108/KS107 controller) via SPI interface.

For creating a custom set of Glcd images use Glcd Bitmap Editor Tool.

Note: The library uses the SPI module for communication. User must initialize SPI
module before using the SPI Graphic Lcd Library.

For MCUs with two SPI modules it is possible to initialize both of them and then
switch by using the spT set Active () routine.

Note: This Library is designed to work with the mikroElektronika's Serial Lcd/Glcd
Adapter Board pinout, see schematic at the bottom of this page for details.

External dependencies of SPI Graphic LCD Library

The implementation of SPI Graphic Lcd Library routines is based on Port Expander
Library routines.

External dependencies are the same as Port Expander Library external dependen-
cies.

Library Routines
Basic routines:

- SPI_Glcd_lInit

- SPI_Glcd_Set_Side

- SPI_Glcd_Set _Page
- SPI_Glcd_Set X

- SPI_Glcd_Read_Data
- SPI_Glcd_Write_Data

Advanced routines:

- SPI_Glcd_Fill

- SPI_Glcd_Dot

- SPI_Glcd_Line

- SPI_Glcd_V _Line

- SPI_Glcd_H_Line

- SPI_Glcd_Rectangle
- SPI_Glcd_Box

- SPI_Glcd_Circle
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- SPI_Glcd_Set_Font

- SPI_Glcd_Write_Char
- SPI_Glcd_Write_Text
- SPI_Glcd_Image

Spi_Glcd_Init

Prototype void SPI Glcd Init (char DeviceAddress);

Returns Nothing.

Initializes the GLCD module via SPI interface.

N Parameters:
Description

- DeviceAddress: Spi expander hardware address, see schematic at the
bottom of this page

Global variables:

- SPExpandercs: Chip Select line

- SPExpanderrRST: Reset line

- SPExpanderCs Direction: Direction of the Chip Select pin
Requires - SPExpanderRST Direction: Direction of the Reset pin

must be defined before using this function.

The SPI module needs to be initialized. See SPI1_Init and SPI1_Init_ Advanced
routines.

// Port Expander module connections

sbit SPExpanderRST at RCO bit;

sbit SPExpanderCS at RC1l bit;

sbit SPExpanderRST Direction at TRISCO bit;
sbit SPExpanderCS Direction at TRISC1l bit;

// End Port Expander module connections
Example

// If Port Expander Library uses SPI module
SPI1 Init(); // Initialize SPI module used w1th PortExpander
SPI Glcd Init(0);
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SPI_Glcd_Set_Side

Prototype void SPI Glcd Set Side(char x pos;

Returns Nothing.

Selects Glcd side. Refer to the Glcd datasheet for detail explanation.
Parameters:

- x pos: position on x-axis. Valid values: 0..127
Description
The parameter x pos specifies the Glcd side: values from 0 to 63 specify the
left side, values from 64 to 127 specify the right side.

Note: For side, x axis and page layout explanation see schematic at the bottom
of this page.

Requires Glcd needs to be initialized for SPI communication, see SPI_Glcd_Init routines.

The following two lines are equivalent, and both of them select the left side of

Glcd:
Example

SPI Glcd Set Side(0);
SPI Glcd Set Side(10);

SPI_Glcd_Set_Page

Prototype void SPI Glcd Set Page (char page);

Returns Nothing.

Selects page of Glcd.
Parameters:
Description | page: page number. Valid values: 0..7

Note: For side, x axis and page layout explanation see schematic at the bottom

of this page.
Requires Glcd needs to be initialized for SPI communication, see SPI1_Glcd_Init routines.
Example SPI _Glcd Set Page(5);
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SPI_Glcd_Set X

Prototype void SPI Glcd Set X(char x pos);

Returns Nothing.

Sets x-axis position to x pos dots from the left border of Glcd within the select-
ed side.

Parameters:
Description
- = pos: position on x-axis. Valid values: 0..63

Note: For side, x axis and page layout explanation see schematic at the bottom
of this page.

Requires Glcd needs to be initialized for SPI communication, see SPI_Glcd_Init routines.

Example SPI Glcd Set X(25);

Spi_Glcd_Read_Data
Prototype char SPI Glcd Read Data();

Returns One byte from Glcd memory.

Reads data from the current location of Glcd memory and moves to the next

Description location.

Gled needs to be initialized for SPI communication, see SP1_Glcd_Init routines.

Requires Glcd side, x-axis position and page should be set first. See the functions
SPI_Glcd_Set Side, SPI_Glcd_Set X, and SPI_Glcd_Set_Page.
char data;

Example

data = SPI Glcd Read Data();
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SPI_Glcd_Write_Data

Prototype void SPI Glcd Write Data (char Ddata);

Returns Nothing.
Writes one byte to the current location in Glcd memory and moves to the next
location.

Description Parameters:

- Ddata: data to be written

Glcd needs to be initialized for SPI communication, see SPI_Glcd_Init routines.

Requires Gled side, x-axis position and page should be set first. See the functions
SPI_Glcd_Set Side, SPI_Glcd_Set X, and SPI_Glcd_Set_Page.
char data;

Example S
SPI Glcd Write Data (data);

SPI_Glcd _Fill

Prokﬂype void SPI Glcd Fill (char pattern);

Returns Nothing.

Fills Glcd memory with byte pattern.
Parameters:

Description |- pattern: byte to fill Glcd memory with

To clear the Glcd screen, use sp1 Gled Fill(0).

To fill the screen completely, use sp1 Glcd Fill (0xEF).

Requires Glcd needs to be initialized for SPI communication, see SPI_Glcd_Init routines.

// Clear screen

Example SPI_Glcd Fill (0);
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SPI_Glcd_Dot

Prototype void SPI Glcd Dot (char x pos, char y pos, char color);

Returns Nothing.

Draws a dot on Glcd at coordinates (x pos, y pos).
Parameters:

- x_pos: X position. Valid values: 0..127
Description | v pos: Yy position. Valid values: 0..63
- color: color parameter. Valid values: 0..2

The parameter color determines the dot state: 0 clears dot, 1 puts a dot, and 2
inverts dot state.

Note: For x and y axis layout explanation see schematic at the bottom of this page.

Requires Glecd needs to be initialized for SPI communication, see SP1_Glcd_Init routines.

// Invert the dot in the upper left corner

Example SPI Glcd Dot (0, 0, 2);
SPI_Glcd_Line

void SPI Glcd Line(int x start, int y start, int x end, int
Prototype . - - - -

y _end, char color);

Returns Nothing.

Draws a line on Glcd.
Parameters:

- x start: X coordinate of the line start. Valid values: 0..127
- vy start:y coordinate of the line start. Valid values: 0..63
- x_end: x coordinate of the line end. Valid values: 0..127

- vy end: y coordinate of the line end. Valid values: 0..63

- color: color parameter. Valid values: 0..2

Description

Parameter color determines the line color: 0 white, 1 black, and 2 inverts each
dot.

Requires Glcd needs to be initialized for SPI communication, see SPI_Glcd_Init routines.

// Draw a line between dots (0,0) and (20,30)

Example SPI_Glcd Line(0, 0, 20, 30, 1);
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SPI_Glcd_V_Line

void SPI Glcd V Line (char start, char end, char x pos, char
Prototype C- - : Y- v P
color) ;
Returns Nothing.
Draws a vertical line on Glcd.
Parameters:
.. -y start:y coordinate of the line start. Valid values: 0..63
Description - ] . . . )
- v_end: y coordinate of the line end. Valid values: 0..63
- x_pos: X coordinate of vertical line. Valid values: 0..127
- color: color parameter. Valid values: 0..2
Parameter co1or determines the line color: 0 white, 1 black, and 2 inverts each dot.
Requires Glcd needs to be initialized for SPI communication, see SPI_Glcd_Init routines.
Example // Draw a vertical line between dots (10,5) and (10,25)
xamp SPI Glecd V Line(5, 25, 10, 1);
SPI_Glcd_H_Line
void SPI Glcd H Line(char x start, char x end, char y pos, char
Prototype - - - - -
color);
Returns Nothing.
Draws a horizontal line on Glcd.
Parameters:
- x start: X coordinate of the line start. Valid values: 0..127
Description |- x end: x coordinate of the line end. Valid values: 0..127
- v pos: Yy coordinate of horizontal line. Valid values: 0..63
- color: color parameter. Valid values: 0..2
The parameter color determines the line color: 0 white, 1 black, and 2 inverts
each dot.
Requires Glcd needs to be initialized for SPI communication, see SPI_Glcd_Init routines.
Exambple // Draw a horizontal line between dots (10,20) and (50,20)
P SPT_Glcd H Line(10, 50, 20, 1);
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SPI_Glcd_Rectangle

void SPI Glcd Rectangle(char x upper left, char y upper left,

Prototype char x bottom right, char y bottom right, char color);
Returns Nothing.
Draws a rectangle on Glcd.
Parameters:
- x upper left: X coordinate of the upper left rectangle corner. Valid values:
0..127
- v upper left:y coordinate of the upper left rectangle corner. Valid values: 0..63
e - x bottom right: X coordinate of the lower right rectangle corner. Valid val-
Description — -
ues: 0..127
- v bottom right:y coordinate of the lower right rectangle corner. Valid val-
ues: 0..63

- color: color parameter. Valid values: 0..2

The parameter color determines the color of the rectangle border: 0 white, 1
black, and 2 inverts each dot.

Requires GLCD needs to be initialized for SPI communication, see Spi_Glcd_Init routines.
// Draw a box between dots (5,15) and (20,40)

Example Spi_Gled Box (5, 15, 20, 40, 1);
SPI_Glcd_Box
void SPI Glcd Box (char x upper left, char upper left, char
Prototype Pl Gled Box | _UPPer_. Y_IPPer_
x bottom right, char y bottom right, char color);
Returns Nothing.

Draws a box on Glcd.

Parameters:

- x upper left: X coordinate of the upper left box corner. Valid values: 0..127
- v upper left:y coordinate of the upper left box corner. Valid values: 0..63
Description |- = bottom right: x coordinate of the lower right box corner. Valid values: 0..127
- v bottom right:y coordinate of the lower right box corner. Valid values: 0..63
- color: color parameter. Valid values: 0..2

The parameter color determines the color of the box fill: 0 white, 1 black, and 2
inverts each dot.

Requires Glcd needs to be initialized for SPI communication, see SPI_Glcd_Init routines.

// Draw a box between dots (5,15) and (20,40)

Example SPT_Glcd Box (5, 15, 20, 40, 1);
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SPI_Glcd_Circle

void SPI Glcd Circle(int x center, int y center, int radius, char
color) ;

Prototype

Returns Nothing.

Draws a circle on Glcd.

Parameters:

- x _center: X coordinate of the circle center. Valid values: 0..127
- v _center: y coordinate of the circle center. Valid values: 0..63

- radius: radius size

- color: color parameter. Valid values: 0..2

Description

The parameter color determines the color of the circle line: 0 white, 1 black,
and 2 inverts each dot.

Requires Glcd needs to be initialized for SPI communication, see SPI_Glcd_Init routine.

// Draw a circle with center in (50,50) and radius=10

Example SPI Glcd Circle(50, 50, 10, 1);

SPI_Glcd_Set Font

void SPI Glcd Set Font (const code char *activeFont, char

Prokﬂype aFontWidth, char aFontHeight, unsigned int aFontOffs);

Returns Nothing.
Sets font that will be used with SPI_Glcd_Write_Char and SPI1_Glcd_Write_Text
routines.
Parameters:

- activeFont: font to be set. Needs to be formatted as an array of char

- aFontwidth: width of the font characters in dots.

Description |- arontHeight: height of the font characters in dots.

- aFontOffs: number that represents difference between the mikroC PRO char-
acter set and regular ASCII set (eg. if 'A" is 65 in ASCII character, and 'A' is 45
in the mikroC PRO character set, aFontOffs is 20). Demo fonts supplied with
the library have an offset of 32, which means that they start with space.

The user can use fonts given in the file “*__Lib_Glcd_fonts” file located in the
Uses folder or create his own fonts..

Requires Glecd needs to be initialized for SPI communication, see SPI1_Glcd_Init routines.

// Use the custom 5x7 font "myfont" which starts with space (32):

Example SPI Glcd Set Font (myfont, 5, 7, 32);

MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD 487



CHAPTER 7
Libraries mikroC PRO for PIC

Spi_Glcd_Write_Char

void SPI Glcd Write Char(char chrl, char x pos, char page num,
char color);

Prototype

Returns Nothing.
Prints character on GLCD.

Parameters:

- chrl: character to be written

- x_pos: character starting position on x-axis. Valid values: 0..(127-FontWidth)
- page num: the number of the page on which character will be written. Valid
Description | values: 0..7

- color: color parameter. Valid values: 0..2

The parameter color determines the color of the character: 0 white, 1 black,
and 2 inverts each dot.

Note: For x axis and page layout explanation see schematic at the bottom of
this page.

Glcd needs to be initialized for SPI communication, see SPI_Glcd_Init routines.

Requires Use the SPI_Glcd_Set_Font to specify the font for display; if no font is specified, then
the default 5x8 font supplied with the library will be used.
Example // Write character 'C' on the position 10 inside the page 2:

SPI Glcd Write Char('C', 10, 2, 1);
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Spi_Glcd_Write_Text

void SPI Glcd Write Text (char text[], char x pos, char page num,
PrOtOtype char color);
Returns Nothing.
Prints text on GLCD.
Parameters:
- text: text to be written
- x_pos: text starting position on x-axis.
Description |~ P29 "ut the number of the page on which text will be written. Valid values: 0..7
P -color: color parameter. Valid values: 0..2
The parameter color determines the color of the text: 0 white, 1 black, and 2
inverts each dot.
Note: For x axis and page layout explanation see schematic at the bottom of
this page.
Glcd needs to be initialized for SPI communication, see SPI_Glcd_Init routines.
Requires Use the SPI_Glcd_Set Font to specify the font for display; if no font is specified, then
the default 5x8 font supplied with the library will be used.
E I // Write text "Hello world!"™ on the position 10 inside the page 2:
Xample SPI Glcd Write Text ("Hello world!", 10, 2, 1);
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Spi_Glcd_Image

Prototype void SPI Glcd Image (const code char *image);

Returns Nothing.

Displays bitmap on GLCD.
Parameters:

- image: image to be displayed. Bitmap array can be located in both code and
Description |RAM memory (due to the mikroC PRO for PIC pointer to const and pointer to
RAM equivalency).

Use the mikroC PRO’s integrated Glcd Bitmap Editor (menu option Tools >
Glcd Bitmap Editor) to convert image to a constant array suitable for display-
ing on Glcd.

Requires Gled needs to be initialized for SPI communication, see SPI_Glcd_Init routines.

// Draw image my image on Glcd

Exan“ﬂe SPI Glcd Image (my image);

Library Example

The example demonstrates how to communicate to KS0108 Glcd via the SPI module, using seri-
al to parallel convertor MCP23S17.

const code char truck bmp[ 1024] ;

// Port Expander module connections

sbit SPExpanderRST at RCO bit;

sbit SPExpanderCS at RC1 bit;

sbit SPExpanderRST Direction at TRISCO bit;
sbit SPExpanderCS Direction at TRISC1 bit;
// End Port Expander module connections

void Delay?2s (){ // 2 seconds delay function
Delay ms (2000) ;
}

void main () {
char *someText;
char counter;

// If Port Expander Library uses SPI1 module
SPI1 Init(); // Initialize SPI module used with PortExpander

// // If Port Expander Library uses SPI2 module
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// SPI2 Init(); // Initialize SPI module used with PortExpander

SPI Glcd Init(0); // Initialize Glcd via SPI

SPI Glcd Fill (0x00); // Clear Glcd

while (1) {
SPI Glcd Image (truck bmp) ; // Draw image
Delay2s(); Delay2s();
SPT Gled Fill (0x00); // Clear Glcd
DelayZ2s;
SPI Glcd Box(62,40,124,56,1); // Draw box
SPI Glcd Rectangle(5,5,84,35,1); // Draw rectangle
SPI Glcd Line(0, 63, 127, 0,1); // Draw line
Delay2s () ;
for (counter = 5; counter < 60; counter+=5 ) { // Draw horizon-

tal and vertical line
Delay ms (250);
SPI Glcd V Line(2, 54, counter, 1);
SPI Glcd H Line(2, 120, counter, 1);
}

Delay2s () ;
SPI Glcd Fill (0x00); // Clear Glcd
SPI Glcd Set Font (Character8x7, 8, 8, 32); // Choose font, see
~ Lib GLCDFonts.c in Uses folder
SPI Glcd Write Text ("mikroE", 5, 7, 2); // Write string
for (counter = 1; counter <= 10; counter++) // Draw circles
SPI Glcd Circle (63,32, 3*counter, 1);

Delay2s () ;
SPI Glcd Box (12,20, 70,63, 2); // Draw box
Delay2s () ;
SPT_Glcd Fill (OXFF); // Fill Gled
SPI Glcd Set Font(Character8x7, 8, 7, 32); // Change font
someText = "8x7 Font";
SPI Glcd Write Text (someText, 5, 1, 2); // Write string
Delay2s () ;

SPI Glcd Set Font(System3x5, 3, 5, 32); // Change font
someText = "3X5 CAPITALS ONLY";
SPI Glcd Write Text (someText, 5, 3, 2); // Write string
Delay2s () ;
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SPI Glcd Set Font(font5x7, 5, 7, 32); // Change font
someText = "5x7 Font";
SPI Glcd Write Text (someText, 5, 5, 2); // Write string
Delay2s () ;

SPI Glcd Set Font (FontSystem5x7 v2, 5, 7, 32); // Change font

someText = "5x7 Font (v2)";
SPI Glcd Write Text (someText, 5, 7, 2); // Write string
Delay2s () ;

}

HW Connection
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SPI LCD LIBRARY

The mikroC PRO for PIC provides a library for communication with Lcd (with
HD44780 compliant controllers) in 4-bit mode via SPI interface.

For creating a custom set of Lcd characters use Lcd Custom Character Tool.

Note: The library uses the SPI module for communication. The user must initialize
the SPI module before using the SPI Lcd Library.
For MCUs with two SPI modules it is possible to initialize both of them and then
switch by using the spI set Active () routine.

Note: This Library is designed to work with the mikroElektronika's Serial Lcd
Adapter Board pinout. See schematic at the bottom of this page for details.

External dependencies of SPI LCD Library

The implementation of SPI Lcd Library routines is based on Port Expander Library
routines.

External dependencies are the same as Port Expander Library external dependen-
cies.

Library Routines

- SPI_Lcd_Config
- SPI_Lcd_Out

- SPIl_Lcd Out Cp
- SPI_Lcd_Chr

- SPIl_Lcd _Chr_Cp
- SPIl_Lcd Cmd
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Spi_Lcd_Config

Prototype void SPI Lcd Config(char DeviceAddress);

Returns Nothing.

Initializes the LCD module via SPI interface.

.. Parameters:
Description

- DeviceAddress: Spi expander hardware address, see schematic at the
bottom of this page

Global variables:

- sPExpanderCs: Chip Select line

- sPExpanderRST: Reset line

- SPExpanderCS Direction: Direction of the Chip Select pin
Requires - SPExpanderRST Direction: Direction of the Reset pin

must be defined before using this function.

The SPI module needs to be initialized. See SPI1_Init and SPI1_Init_ Advanced
routines.

// Port Expander module connections

sbit SPExpanderRST at RCO bit;

sbit SPExpanderCs at RC1l bit;

sbit SPExpanderRST Direction at TRISCO bit;
sbit SPExpanderCS Direction at TRISC1 bit;
// End Port Expander module connections
Example

void main() {
// If Port Expander Library uses SPI module

SPI1 Init(); // Initialize SPI module used with PortExpander
SPI Lcd Config(0); // initialize Lcd over SPI interface
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Spi_Lcd _Out

Prototype void SPI Lcd Out (char row, char column, char *text);

Returns Nothing.

Prints text on the LCD starting from specified position. Both string variables and
literals can be passed as a text.

Description |Parameters:

- row: starting position row number

- column: starting position column number
- text: text to be written

Requires Lcd needs to be initialized for SPI communication, see SPI_Lcd_Config routines.

// Write text "Hello!"™ on Lcd starting from row 1, column 3:
SPI Lcd Out(l, 3, "Hello!");

Spi_Lcd Out Cp
Prototype |[void SPI Lcd Out CP(char *text);
Returns Nothing.

Example

Prints text on the LCD at current cursor position. Both string variables and liter-
als can be passed as a text.

Description
Parameters:

- text: text to be written

Requires Lcd needs to be initialized for SPI communication, see SPI_Lcd_Config routines.

// Write text "Here!" at current cursor position:

Example SPI Lcd Out CP("Here!");

Spi_Lcd _Chr

Prototype void SPI Lcd Chr (char Row, char Column, char Out Char);

Returns Nothing.

Prints character on LCD at specified position. Both variables and literals can be
passed as character.

i Parameters:
Description
- Row: Writing position row number
- Column: writing position column number
-out Char: character to be written
Requires Lcd needs to be initialized for SPI communication, see SPI_Lcd_Config routines.

// Write character "i" at row 2, column 3:
SPT Led Chr(2, 3, 'i');

Example
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Spi_Lcd Chr_Cp

Prototype void SPI Lcd Chr CP(char Out Char);

Returns Nothing.

Prints character on LCD at current cursor position. Both variables and literals
can be passed as character.

Description Parameters:

- Out Char: character to be written

Requires Lcd needs to be initialized for SPI communication, see SPI_Lcd_Config routines.

// Write character "e" at current cursor position:

Example SPT Led Chr Cp('e');

Spi_Lcd Cmd

Prototype void SPI Lcd Cmd(char out char);

Returns Nothing.

Sends command to LCD.

Parameters:

Description
P - out char: command to be sent

Note: Predefined constants can be passed to the function, see Available Lcd
Commands.

Requires Lcd needs to be initialized for SPI communication, see SPI_Lcd_Config routines.

// Clear Lcd display:

Example SPI Lcd Cmd( LCD CLEAR) ;
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Available LCD Commands

Lcd Command

Purpose

LCD_FIRST ROW

Move cursor to the 1st row

LCD_SECOND_ROW

Move cursor to the 2nd row

LCD_THIRD ROW

Move cursor to the 3rd row

LCD _FOURTH ROW

Move cursor to the 4th row

LCD_CLEAR

Clear display

LCD RETURN HOME

Return cursor to home position, returns a shifted display
to its original position. Display data RAM is unaffected.

LCD_CURSOR_OFF

Turn off cursor

LCD_UNDERLINE ON

Underline cursor on

LCD_BLINK CURSOR ON

Blink cursor on

LCD_MOVE CURSOR_LEFT

Move cursor left without changing display data RAM

LCD MOVE CURSOR RIGHT

Move cursor right without changing display data RAM

LCD_TURN ON

Turn LCD display on

LCD_TURN OFF

Turn LCD display off

LCD_SHIFT LEFT

Shift display left without changing display data RAM

LCD_SHIFT RIGHT

Shift display right without changing display data RAM
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Library Example

This example demonstrates how to communicate Lcd via the SPI module, using
serial to parallel convertor MCP23S17.

char *text = "mikroElektronika";

// Port Expander module connections

sbit SPExpanderRST at RCO bit;

sbit SPExpanderCS at RC1l bit;

sbit SPExpanderRST Direction at TRISCO bit;
sbit SPExpanderCS Direction at TRISC1 bit;
// End Port Expander module connections

void main () {

// 1If Port Expander Library uses SPI1 module
SPI1 Init(); // Initialize SPI module used with PortExpander

// 1If Port Expander Library uses SPI2 module

// SPI2 Init(); // Initialize SPI module used with PortExpander

SPI Lcd Config(0); // Initialize Lcd over SPI interface

SPI Lcd Cmd( LCD CLEAR) ; // Clear display

SPI Lcd Cmd( LCD CURSOR OFF);// Turn cursor off

SPI Lcd Out (1,6, "mikroE"); // Print text to Lcd, 1lst row, 6th col-
umn

SPI Led Chr CP('!'"); // Append '!'

SPI Lcd Out (2,1, text); // Print text to Lcd, 2nd row, 1st column

// SPI Lcd Out(3,1,"mikroE"); // For Lcd with more than two rows
// SPI Lcd Out(4,15,"mikroE"); // For Lcd with more than two rows
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HW Connection

MCP23317
—'flcemo  cear[]2
_z[ GPE1 GPAG }1 S
— B Hepm  eeas[ o I 1
E 4 28 [ I
—Im J[eres  ceaa [l i i
D5 sl PB4 ::: ]]E (] 1]
e —— Y0
i i %
ﬁ GPBT  GPAD ]I (] E 1
e 0—10[ VDD INTA }? [} O 1] N
] vss ]_]m RCO E — m ﬁ\“
Rc:nz[ o RESET L asowaren e O—| VEe (o] 1
——| sck Az
RCS 13 18 ] eno 1]
RC4 14[ = A { CLKIN L 1]
—1] =0 An i o i
[ S, (o I
facn =~ [
1l RCS
RC3 RC4
[] [l
[] 1

Adjustment

5K

FFEEFEEFFEEF RS

SPI LCD HW connection

MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD 499



CHAPTER 7
Libraries mikroC PRO for PIC

SPI LCD8 (8-BIT INTERFACE) LIBRARY

The mikroC PRO for PIC provides a library for communication with Lcd (with
HD44780 compliant controllers) in 8-bit mode via SPI interface.

For creating a custom set of Lcd characters use Lcd Custom Character Tool.

Note: Library uses the SPI module for communication. The user must initialize the
SPI module before using the SPI Lcd Library.

For MCUs with two SPI modules it is possible to initialize both of them and then
switch by using the spI set Active () routine.

Note: This Library is designed to work with mikroElektronika's Serial Lcd/Gled
Adapter Board pinout, see schematic at the bottom of this page for details.

External dependencies of SPI LCD Library

The implementation of SPI Lcd Library routines is based on Port Expander Library
routines.

External dependencies are the same as Port Expander Library external dependen-
cies.

Library Routines

- SPI_Lcd8 Config
- SPI_Lcd8_Out

- SPI_Lcd8 Out Cp
- SPI_Lcd8_Chr

- SPIl_Lcd8 Chr _Cp
- SPI_Lcd8_Cmd
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Spi_Lcd8_Config

Prototype void SPI Lcd8 Config(char DeviceAddress);

Returns Nothing.
Initializes the LCD module via SPI interface.

Description |Parameters:
- DeviceAddress: spi expander hardware address, see schematic at the
bottom of this page

Global variables:

- SPExpanderCS: Chip Select line

- SPExpanderrRST: Reset line

- SPExpanderCs Direction: Direction of the Chip Select pin

Requires o ;
q - SPExpanderRST Direction: Direction of the Reset pin

must be defined before using this function.
The SPI module needs to be initialized. See SPI1_Init and SPI1_Init_ Advanced
routines.
// Port Expander module connections
sbit SPExpanderRST at RCO bit;
sbit SPExpanderCS at RC1l bit;
sbit SPExpanderRST Direction at TRISCO bit;

Example sbit SPExpanderCS Direction at TRISC1 bit;

P // End Port Expander module connections

// I1f Port Expander Library uses SPI module
SPI1 Init(); // Initialize SPI module used with PortExpander
SPI Lcd8 Config(0); // intialize Lcd in 8bit mode via SPI

Spi_Lcd8 Out
void SPI Lcd8 Out (unsigned short row, unsigned short column, char

Prototype |, - -
text);

Returns Nothing.
Prints text on LCD starting from specified position. Both string variables and lit-
erals can be passed as a text.

e Parameters:
Description

- row: starting position row number
- column: starting position column number
- text: text to be written

Requires Lcd needs to be initialized for SPI communication, see SPI_Lcd8_Config routines.

// Write text "Hello!"™ on Lcd starting from row 1, column 3:

Example SPI Lcd8 Out (1, 3, "Hello!™);
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Spi_Lcd8 Out Cp

Prototype void SPI Lcd8 Chr CP(char out char);

Returns Nothing.

Prints character on Lcd at current cursor position. Both variables and literals
can be passed as character.

Description
P Parameters:
- text: text to be written
Requires Lcd needs to be initialized for SPI communication, see SPI_Lcd8_Config routines.
Exambple // Write text "Here!" at current cursor position:
X P SPI Lcd8 Out Cp("Here!");
Spi_Lcd8 Chr
void SPI Lcd8 Chr (unsigned short row, unsigned short column, char
Prototype - -
out char);
Returns Nothing.
Prints character on LCD at specified position. Both variables and literals can be
passed as character.
i Parameters:
Description

- row: writing position row number
- column: writing position column number
- out char: character to be written

Requires Lcd needs to be initialized for SPI communication, see SPI_Lcd8_Config routines.

// Write character "i" at row 2, column 3:

Example SPL7LCd87ChI(2, 3, 'i");
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Spi_Lcd8 Chr_Cp

Prototype void SPI Lcd8 Chr CP(char out char);

Returns Nothing.

Prints character on LCD at current cursor position. Both variables and literals
can be passed as character.

Description Parameters:

- out char : character to be written

Requires Lcd needs to be initialized for SPI communication, see SPI_Lcd8_Config routines.

“

Print “e” at current cursor position:

Example o ; L
// Write character "e" at current cursor position:
SPI Lcd8 Chr Cp('e');

Spi_Lcd8 Cmd

Prototype |void SPI Lcd8 Cmd(char out char);

Returns Nothing.

Sends command to LCD.

Parameters:

Description
P - out char: command to be sent

Note: Predefined constants can be passed to the function, see Available LCD
Commands.

Requires Lcd needs to be initialized for SPI communication, see SPI_Lcd8_Config routines.

// Clear Lcd display:

Example SPI Lcd8 Cmd( LCD CLEAR) ;
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Available LCD Commands

Lcd Command

Purpose

LCD_FIRST ROW

Move cursor to the 1st row

LCD_SECOND_ ROW

Move cursor to the 2nd row

LCD_THIRD ROW

Move cursor to the 3rd row

LCD_FOURTH_ROW

Move cursor to the 4th row

LCD_CLEAR

Clear display

LCD RETURN HOME

Return cursor to home position, returns a shifted display
to its original position. Display data RAM is unaffected.

LCD_CURSOR_OFF

Turn off cursor

LCD_UNDERLINE ON

Underline cursor on

LCD_BLINK CURSOR_ON

Blink cursor on

LCD_MOVE CURSOR_LEFT

Move cursor left without changing display data RAM

LCD_MOVE_CURSOR_RIGHT

Move cursor right without changing display data RAM

LCD_TURN _ON

Turn LCD display on

LCD_TURN OFF

Turn LCD display off

LCD_SHIFT LEFT

Shift display left without changing display data RAM

LCD SHIFT RIGHT

Shift display right without changing display data RAM
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Library Example

This example demonstrates how to communicate Lcd in 8-bit mode via the SPI mod-
ule, using serial to parallel convertor MCP23S17.

char *text = "mikroE";

// Port Expander module connections

sbit SPExpanderRST at RCO bit;

sbit SPExpanderCS at RC1l bit;

sbit SPExpanderRST Direction at TRISCO bit;
sbit SPExpanderCS Direction at TRISC1 bit;
// End Port Expander module connections

void main () {

// 1If Port Expander Library uses SPI1 module
SPI1 Init(); // Initialize SPI module used with PortExpander

// 1If Port Expander Library uses SPI2 module

// SPI2 Init(); // Initialize SPI module used with PortExpander

SPI Lcd8 Config(0); // Intialize Lcd in 8bit mode via SPI

SPI Lcd8 Cmd( LCD CLEAR); // Clear display

SPI Lcd8 Cmd( LCD CURSOR OFF) ; // Turn cursor off

SPI Lcd8 Out(l,6, text); // Print text to Lecd, 1st row, 6th column...
SPI Lcd8 Chr CP('!'"); // RAppend '!'

SPI Lcd8 Out (2,1, "mikroElektronika"); // Print text to Lcd, 2nd

row, 1lst column...
SPI_Lcd8 Out(3,1, text); // For Lcd modules with more than two rows
SPI Lcd8 Out (4,15, text);// For Lcd modules with more than two rows
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HW Connection
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SPI T6963C GRAPHIC LCD LIBRARY

The mikroC PRO for PIC provides a library for working with Glcds based on
TOSHIBA T6963C controller via SPI interface. The Toshiba T6963C is a very popu-
lar Lcd controller for the use in small graphics modules. It is capable of controlling
displays with a resolution up to 240x128. Because of its low power and small out-
line it is most suitable for mobile applications such as PDAs, MP3 players or mobile
measurement equipment. Although this controller is small, it has a capability of dis-
playing and merging text and graphics and it manages all interfacing signals to the
displays Row and Column drivers.

For creating a custom set of Glcd images use Glcd Bitmap Editor Tool.

Note: The library uses the SPI module for communication. The user must initialize
SPI module before using the SP1 T6963C Glcd Library.

For MCUs with two SPI modules it is possible to initialize both of them and then
switch by using the spT set Active () routine.

Note: This Library is designed to work with mikroElektronika's Serial Glcd 240x128
and 240x64 Adapter Boards pinout, see schematic at the bottom of this page for
details.

Note: Some mikroElektronika's adapter boards have pinout different from T6369C
datasheets. Appropriate relations between these labels are given in the table below:

Adapter Board|T6369C datasheet

RS C/D
R/W /RD
E /WR

External dependencies of Spi T6963C Graphic LCD Library

The implementation of SPI T6963C Graphic Lcd Library routines is based on Port
Expander Library routines.

External dependencies are the same as Port Expander Library external dependen-
cies.
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Library Routines

- SPI_T6963C_Config

- SPI_T6963C_writeData
- SPI_T6963C_writeCommand
- SPI_T6963C_setPtr

- SPI_T6963C_waitReady
- SPI_T6963C _fill

- SPI_T6963C_dot

- SPI_T6963C_write_char
- SPI_T6963C_write_text
- SPI_T6963C_line

- SPI_T6963C _rectangle
- SPI_T6963C_box

- SPI_T6963C _circle

- SPI_T6963C_image

- SPI_T6963C _sprite

- SPI_T6963C_set_cursor
- SPI_T6963C _clearBit

- SPI_T6963C_setBit

- SPI_T6963C_negBit

Note: The following low level library routines are implemented as macros. These
macros can be found in the sp1 T6963C.h header file which is located in the SPI
T6963C example projects folders.

- SPI_T6963C_displayGrPanel
- SPI_T6963C _displayTxtPanel
- SPI_T6963C_setGrPanel

- SPI_T6963C_setTxtPanel

- SPI_T6963C_panelFill

- SPI_T6963C_grFill

- SPI_T6963C_txtFill

- SPI_T6963C_cursor_height
- SPI_T6963C_graphics

- SPI_T6963C_text

- SPI_T6963C_cursor

- SPI_T6963C_cursor_blink
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Spi_T6963C_Config

void SPI T6963C Config(unsigned int width, unsigned char height,
Prokﬂype unsigned char fntW, char DeviceAddress, unsigned char wr,
unsigned char rd, unsigned char cd, unsigned char rst);

Returns Nothing.

Initalizes the Graphic Lcd controller.

Parameters:

- width: width of the GLCD panel

- height: height of the GLCD panel

- fntw: font width

- Deviceaddress: SPI expander hardware address, see schematic at the
bottom of this page

- wr: write signal pin on GLCD control port

- rd: read signal pin on GLCD control port

- cd: command/data signal pin on GLCD control port

- rst: reset signal pin on GLCD control port

Display RAM organization:
The library cuts RAM into panels : a complete panel is one graphics panel fol-
lowed by a text panel (see schematic below).

Description
schematic:
e + /\
+ GRAPHICS PANEL #0 + |
+ +
+ +
+ +
o + | PANEL O
+ TEXT PANEL #0 +
+ +\/
Fmm + /\
+ GRAPHICS PANEL #1 +
+ +
+ +
+ +
e e e T + | PANEL 1
+ TEXT PANEL #1 +
+ +
e e L L Lt + \/
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Requires

Global variables:

- SPExpandercs: Chip Select line

- sPExpanderRST: Reset line

- SPExpanderCs Direction: Direction of the Chip Select pin
- SPExpanderRST Direction: Direction of the Reset pin
must be defined before using this function.

The SPI module needs to be initialized. See the SPI1_Init and
SPI1_Init Advanced routines.

Example

// Port Expander module connections

sbit SPExpanderRST at RCO bit;

sbit SPExpanderCS at RCl bit;

sbit SPExpanderRST Direction at TRISCO bit;
sbit SPExpanderCS Direction at TRISC1 bit;
// End Port Expander module connections

// Initialize SPI module
SPTTiTnit();

SPI T6963C Config (240, 64, 8, 0, 0, 1, 3, 4);

Spi_T6963C_WriteData

Prototype void SPI T6963C writeData (unsigned char Ddata);
Returns Nothing.

Writes data to T6963C controller via SPI interface.
Description Parameters:

- bdata: data to be written
Requires Toshiba Glcd module needs to be initialized. See SPI_T6963C_Config routine.
Example SPI T6963C writeData (AddrlL) ;

Spi_T6963C_WriteCommand

Prototype [void SPI T6963C writeCommand (unsigned char Ddata);
Returns Nothing.

Writes command to T6963C controller via SPI interface.
Description Parameters:

- Ddata: command to be written
Requires Toshiba Glcd module needs to be initialized. See SPI_T6963C_Config routine.
Example SPI T6963C_writeCommand (SPI _T6963C_CURSOR_POINTER_ SET);
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Spi_T6963C_SetPtr

Prototype void SPI T6963C_setPtr (unsigned int p, unsigned char c);
Returns Nothing.
Sets the memory pointer p for command c.
Description Parameters:
- p: address where command should be written
- ¢: command to be written
Requires SToshiba Glcd module needs to be initialized. See SPI_T6963C_Config routine.
E I SPI T6963C setPtr (T6963C grHomeAddr + start,
Xample T6963C_ADDRESS POINTER SET);
Spi_T6963C_WaitReady
Prototype void SPI T6963C waitReady (void) ;
Returns Nothing.
Description [Pools the status byte, and loops until Toshiba Glcd module is ready.
Requires Toshiba Glcd module needs to be initialized. See SPI_T6963C_Config routine.
Example SPI T6963C waitReady () ;
Spi_T6963C_Fill
void SPI T6963C fill (unsigned char v, unsigned int start,
Prototype . -, —
unsigned int len);
Returns Nothing.
Fills controller memory block with given byte.
Parameters:
Description
- v: byte to be written
- start: starting address of the memory block
- len: length of the memory block in bytes
Requires Toshiba Glcd module needs to be initialized. See SPI_T6963C_Config routine.
Example SPI T6963C fill (0x33,0x00FF, 0x000F) ;
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Spi_T6963C_Dot

Prototype void SPI T6963C dot(int x, int y, unsigned char color);

Returns Nothing.

Draws a dot in the current graphic panel of GLCD at coordinates (x, y).

Parameters:

Description |_ % : dot position on x-axis

- v: dot position on y-axis

- color: color parameter. Valid values: Spi_T6963C_BLACK and
Spi_T6963C_WHITE

Requires Toshiba Glcd module needs to be initialized. See SPI_T6963C_Config routine.

Example SPI T6963C dot(x0, y0, pcolor);
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Spi_T6963C_Write_Char

void SPI T6963C write char (unsigned char c, unsigned char x,
unsigned char y, unsigned char mode);

Prototype

Returns Nothing.

Writes a char in the current text panel of GLCD at coordinates (X, y).
Parameters:

- c¢: char to be written

- x: char position on x-axis

- v: char position on y-axis

- mode: mode parameter. Valid values:

SPI_T6963C_ROM_MODE_OR, SPI_T6963C_ROM_MODE_XOR,
SPI_T6963C_ROM_MODE_AND and
SPI_T6963C_ROM_MODE_TEXT

Description [Mode parameter explanation:

- OR Mode: In the OR-Mode, text and graphics can be displayed and the data
is logically “OR-ed”. This is the most common way of combining text and
graphics for example labels on buttons.

- XOR-Mode: In this mode, the text and graphics data are combined via the
logical “exclusive OR”. This can be useful to display text in negative mode,
i.e. white text on black background.

- AND-Mode: The text and graphic data shown on display are combined via
the logical “AND function”.

- TEXT-Mode: This option is only available when displaying just a text. The
Text Attribute values are stored in the graphic area of display memory.

For more details see the T6963C datasheet.

Requires Toshiba Glcd module needs to be initialized. See SPI_T6963C_Config routine.

Example SPI_T6963C write char ("A",22,23,AND);
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Spi_T6963C_write Text

void SPI T6963C write text (unsigned char *str, unsigned char x,
unsigned char y, unsigned char mode) ;

Prototype

Returns Nothing.

Writes text in the current text panel of GLCD at coordinates (x, y).
Parameters:

- str: text to be written

- x: text position on x-axis

- v: text position on y-axis

- mode : mode parameter. Valid values:
SPI_T6963C_ROM_MODE_OR, SPI_T6963C_ROM_MODE_XOR,
SPI_T6963C_ROM_MODE_AND and
SPI_T6963C_ROM_MODE_TEXT

Description Mode parameter explanation:
- OR Mode: In the OR-Mode, text and graphics can be displayed and the data
is logically “OR-ed”. This is the most common way of combining text and

graphics for example labels on buttons.

- XOR-Mode: In this mode, the text and graphics data are combined via the
logical “exclusive OR”. This can be useful to display text in negative mode,
i.e. white text on black background.

- AND-Mode: The text and graphic data shown on the display are combined
via the logical “AND function”.

- TEXT-Mode: This option is only available when displaying just a text. The
Text Attribute values are stored in the graphic area of display memory.

For more details see the T6963C datasheet.

Requires Toshiba Glcd module needs to be initialized. See SPI_T6963C_Config routine.

SPI T6963C write text ("Glcd LIBRARY DEMO, WELCOME !", 0, 0,

Example T6963C_ROM_MODE_EXOR) ;
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Spi_T6963C_line

void SPI T6963C line(int x0, int y0, int x1, int yl, unsigned

PrOtOtype char pcolor);
Returns Nothing.
Draws a line from (x0, y0) to (x1, y1).
Parameters:
i - x0: X coordinate of the line start
Description

- y0: y coordinate of the line end

- x1: x coordinate of the line start

- y1: y coordinate of the line end

- pcolor: color parameter. Valid values:
SPI_T6963C_BLACK and SPI_T6963C_WHITE

Requires Toshiba Glcd module needs to be initialized. See SPI_T6963C_Config routine.

Example SPI_T6963C line (0, 0, 239, 127, T6963C_WHITE);

Spi_T6963C_rectangle

void SPI T6963C rectangle(int x0, int y0, int x1, int yl,

Prototype unsigned char pcolor);
Returns Nothing.
Draws a rectangle on GLCD.
Parameters:
Description |” =0 : x coordinate of the upper left rectangle corner

- y0: y coordinate of the upper left rectangle corner
- x1: x coordinate of the lower right rectangle corner
- y1: y coordinate of the lower right rectangle corner
- pcolor: color parameter. Valid values:
SPI_T6963C_BLACK and SPI_T6963C_WHITE

Requires Toshiba Glcd module needs to be initialized. See SPI_T6963C_Config routine.

Example SPI T6963C rectangle (20, 20, 219, 107, T6963C WHITE);

MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD 515



CHAPTER 7
Libraries mikroC PRO for PIC

Spi_T6963C_box

void SPI T6963C box(int x0, int y0, int x1, int yl, unsigned char

Prototype pcolor) ;
Returns Nothing.
Draws a box on the GLCD
Parameters:
i - x0: x coordinate of the upper left box corner
Description

- y0: y coordinate of the upper left box corner

- x1: x coordinate of the lower right box corner

- y1: y coordinate of the lower right box corner

- pcolor: color parameter. Valid values:
SPI_T6963C_BLACK and SPI_T6963C_WHITE

Requires Toshiba Glcd module needs to be initialized. See SPI_T6963C_Config routine.

Example SPI_T6963C box (0, 119, 239, 127, T6963C _WHITE);

Spi_T6963C_circle

void SPI T6963C circle(int x, int y, long r, unsigned char pcol-
or);

Prototype

Returns Nothing.

Draws a circle on the GLCD.
Parameters:

Description |- x: x coordinate of the circle center

- v: y coordinate of the circle center

- r: radius size

- pcolor: color parameter. Valid values:
SPI_T6963C_BLACK and SPI_T6963C_WHITE

Requires Toshiba Glcd module needs to be initialized. See SPI_T6963C_Config routine.

Example SPI _T6963C circle (120, 64, 110, T6963C WHITE) ;
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Spi_T6963C_image

Prototype void SPI T6963C_image (const code char *pic);

Returns Nothing.

Displays bitmap on GLCD.

Parameters:

- pic: image to be displayed. Bitmap array can be located in both code and
RAM memory (due to the mikroC PRO for PIC pointer to const and pointer to
Description |RAM equivalency).

Use the mikroC PRO’s integrated Glcd Bitmap Editor (menu option Tools »
Glcd Bitmap Editor) to convert image to a constant array suitable for display-
ing on Glcd.

Note: Image dimension must match the display dimension.

Requires Toshiba Glcd module needs to be initialized. See SPI_T6963C_Config routine.

Example SPI T6963C image (my image);

Spi_T6963C_Sprite

void SPI T6963C sprite (unsigned char px, unsigned char py, const
code char *pic, unsigned char sx, unsigned char sy);

Prototype

Returns Nothing.

Fills graphic rectangle area (px, py) to (px+sx, py+sy) with custom size picture.
Parameters:

- px: X coordinate of the upper left picture corner. Valid values: multiples of the
font width

Description |- pv: y coordinate of the upper left picture corner

- pic: picture to be displayed

- sx: picture width. Valid values: multiples of the font width

- sy: picture height

Note: If px and sx parameters are not multiples of the font width they will be
scaled to the nearest lower number that is a multiple of the font width.

Requires Toshiba Glcd module needs to be initialized. See SPI_T6963C_Config routine.

Example SPI T6963C sprite(76, 4, einstein, 88, 119); // draw a sprite
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Spi_T6963C_set_cursor

Prototype void SPI T6963C set cursor (unsigned char x, unsigned char vy);

Returns Nothing.

Sets cursor to row x and column y.

o Parameters:
Description

- x: cursor position row number
- yv: cursor position column number

Requires Toshiba Glcd module needs to be initialized. See SPI_T6963C_Config routine.

Example SPI T6963C set cursor (cposx, cposy);

Spi_T6963C_clearBit

Prototype void SPI T6963C clearBit (char D) ;

Returns Nothing.

Clears control port bit(s).
Description |Parameters:

- b: bit mask. The function will clear bit =< on control port if bit x in bit mask is set to 1.

Requires Toshiba Glcd module needs to be initialized. See SPI_T6963C_Config routine.

// clear bits 0 and 1 on control port
SPI T6963C clearBit (0x03);

Example

Spi_T6963C_setBit

Prototype void SPI T6963C_setBit (char b);

Returns Nothing.

Sets control port bit(s).
Description |Parameters:

- b: bit mask. The function will set bit x on control port if bit x in bit mask is set to 1.

Requires Toshiba Glcd module needs to be initialized. See SPI_T6963C_Config routine.

// set bits 0 and 1 on control port

Example SPT_T6963C_setBit (0x03) ;
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Spi_T6963C_negBit

Prototype [void SPI T6963C negBit (char b);
Returns Nothing.
Negates control port bit(s).
i Parameters:
Description
- b: bit mask. The function will negate bit x on control port if bit x in bit mask is
setto 1.
Requires Toshiba Glcd module needs to be initialized. See SPI_T6963C_Config routine.
E I // negate bits 0 and 1 on control port
Xample SPI_T6963C negBit (0x03);
Spi_T6963C_DisplayGrPanel
Prototype void SPI T6963C displayGrPanel (char n);
Returns Nothing.
Display selected graphic panel.
Description |Parameters:
- n: graphic panel number. Valid values: 0 and 1.
Requires Toshiba Glcd module needs to be initialized. See SPI_T6963C_Config routine.
// display graphic panel 1
Example SPI_T6963C displayGrPanel (1) ;
Spi_T6963C_displayTxtPanel
Prototype void SPI T6963C displayTxtPanel (char n);
Returns Nothing.
Display selected text panel.
Description |[Parameters:
- n: text panel number. Valid values: 0 and 1.
Requires Toshiba Glcd module needs to be initialized. See SPI_T6963C_Config routine.
Example // display text panel 1

SPI T6963C displayTxtPanel (1);
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Spi_T6963C_setGrPanel

Prototype void SPI T6963C setGrPanel (char n);
Returns Nothing.
Compute start address for selected graphic panel and set appropriate internal
pointers. All subsequent graphic operations will be preformed at this graphic
panel.
Description
Parameters:
- n: graphic panel number. Valid values: 0 and 1.
Requires Toshiba Glcd module needs to be initialized. See SPI_T6963C_Config routine.
// set graphic panel 1 as current graphic panel.
Exan“ﬂe SPI T6963C setGrPanel(1l);
Spi_T6963C_setTxtPanel
Prototype void SPI T6963C_setTxtPanel (char n);
Returns Nothing.
Compute start address for selected text panel and set appropriate internal point-
ers. All subsequent text operations will be preformed at this text panel.
Description Parameters:
- n: text panel number. Valid values: 0 and 1.
Requires Toshiba Glcd module needs to be initialized. See SPI_T6963C_Config routine.
Example // set text panel 1 as current text panel.

SPI T6963C setTxtPanel (1) ;
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Spi_T6963C_panelFill

Prototype void SPI T6963C panelFill (unsigned char v);
Returns Nothing.
Fill current panel in full (graphic+text) with appropriate value (0 to clear).
Description |Parameters:
- v: value to fill panel with.
Requires Toshiba Glcd module needs to be initialized. See SPI_T6963C_Config routine.
E I clear current panel
xample SPI T6963C panelFill(0);
Spi_T6963C_GrFill
Prototype void SPI T6963C grFill (unsigned char v);
Returns Nothing.
Fill current graphic panel with appropriate value (0 to clear).
Description |Parameters:
- v: value to fill graphic panel with.
Requires Toshiba Glcd module needs to be initialized. See SPI_T6963C_Config routine.
// clear current graphic panel
Example SPI T6963C grFill (0);
Spi_T6963C_txtFill
Prototype void SPI T6963C txtFill (unsigned char v);
Returns Nothing.
Fill current text panel with appropriate value (0 to clear).
Description |Parameters:
- v: this value increased by 32 will be used to fill text panel.
Requires Toshiba Glcd module needs to be initialized. See SPI_T6963C_Config routine.
Example // clear current text panel

SPT_T6963C_txtFill(0);
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Spi_T6963C_cursor_height

Prototype void SPI T6963C cursor height (unsigned char n);
Returns Nothing.
Set cursor size.
Description |Parameters:
- n: cursor height. Valid values: 0. . 7.
Requires Toshiba Glcd module needs to be initialized. See SPI_T6963C_Config routine.
Example SPI T6963C cursor height(7);
Spi_T6963C_graphics
Prototype void SPI T6963C graphics(char n);
Returns Nothing.
Enable/disable graphic displaying.
e Parameters:
Description
- n: graphic enable/disable parameter. Valid values: o (disable graphic
dispaying) and 1 (enable graphic displaying).
Requires Toshiba Glcd module needs to be initialized. See SPI_T6963C_Config routine.
// enable graphic displaying
Example SPI T6963C graphics(1l);
Spi_T6963C_text
Prototype void SPI T6963C text (char n);
Returns Nothing.
Enable/disable text displaying.
Description Parameters:
- n: text enable/disable parameter. Valid values: 0 (disable text dispaying) and 1
(enable text displaying).
Requires Toshiba Glcd module needs to be initialized. See SPI_T6963C_Config routine.
Example // enable text displaying

SPT_T6963C_text (1);
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Spi_T6963C_cursor

Prototype void SPI T6963C cursor (char n);
Returns Nothing.
Set cursor on/off.
Description |Parameters:
- n: on/off parameter. Valid values: 0 (set cursor off) and 1 (set cursor on).
Requires Toshiba Glcd module needs to be initialized. See SPI_T6963C_Config routine.
E I // set cursor on
xample SPI T6963C cursor (1);
Spi_T6963C_cursor_blink
Prototype void SPI T6963C cursor blink(char n);
Returns Nothing.
Enable/disable cursor blinking.
Description Parameters:
- n: cursor blinking enable/disable parameter. Valid values: 0 (disable cursor
blinking) and 1 (enable cursor blinking).
Requires Toshiba Glcd module needs to be initialized. See SPI_T6963C_Config routine.
E I // enable cursor blinking
xample SPI T6963C cursor blink(1l);

Library Example

The following drawing demo tests advanced routines of the SPI T6963C Glcd library. Hardware
configurations in this example are made for the T6963C 240x128 display, EasyPIC5 board and

16F887.
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#include " SPIT6963C.h"
/*
* bitmap pictures stored in ROM
*/

extern const code char me[ ] ;
extern const code char einstein[];

// Port Expander module connections

sbit SPExpanderRST at RCO _bit;

sbit SPExpanderCS at RCl bit;

sbit SPExpanderRST Direction at TRISCO bit;
sbit SPExpanderCS Direction at TRISC1 bit;
// End Port Expander module connections

void main () {

char txtl[] = " EINSTEIN WOULD HAVE LIKED mE";

char txt[] = " GLCD LIBRARY DEMO, WELCOME !'";

unsigned char panel; // current panel

unsigned int i; // general purpose register
unsigned char curs; // cursor visibility

unsigned int CposSx, CpoOsy; // cursor x-y position

TRISA = OxFF; // Configure PORTA as input

ANSEL = O0; // Configure AN pins as digital I/0
ANSELH = O0;

// 1If Port Expander Library uses SPI1 module
SPI1 Init(); // Initialize SPI module used with PortExpander

// // 1f Port Expander Library uses SPI2 module
// SPI2 Init(); // Initialize SPI module used with PortExpander

S~
*

init display for 240 pixel width and 128 pixel height

8 bits character width

data bus on MCP23S17 portB

control bus on MCP23S17 portA

bit 2 is !WR

bit 1 is !RD

bit 0 is !CD

bit 4 is RST

chip enable, reverse on, 8x8 font internaly set in library

* % ok ok ok X b % X

SPI T6963C Config(240, 128, 8, 0, 2, 1, 0, 4);
Delay ms (1000);
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/*

* Enable both graphics and text display at the same time
*/

SPI T6963C graphics(1l);

SPI T6963C text (1l);

panel = 0;
i = 0;
curs = 0;
cposx = cposy = 0;
/*
* Text messages
*/

SPI _T6963C write text(txt, 0, 0, SPI_T6963C_ROM MODE_ XOR) ;
SPI_T6963C write text (txtl, 0, 15, SPI_T6963C_ROM MODE_XOR) ;

/*

* Cursor

*/

SPI T6963C cursor height (8); // 8 pixel height

SPI T6963C_set cursor (0, 0); // move cursor to top left
SPI T6963C_cursor (0); // cursor off

/*

* Draw rectangles
*/

SPI T6963C rectangle
SPI T6963C rectangle
SPI T6963C rectangle
SPI T6963C rectangle

0, 0, 239, 127, SPI_T6963C_WHITE);
20, 20, 219, 107, SPI_T6963C_WHITE) ;
40, 40, 199, 87, SPI_T6963C WHITE);
60, 60, 179, 67, SPI_T6963C_WHITE);

/*

* Draw a cross

*/

SPI T6963C line (0, 0, 239, 127, SPI T6963C WHITE);
SPI T6963C line(0, 127, 239, 0, SPI T6963C WHITE);

/*

* Draw solid boxes

*/

SPI T6963C box (0, 0, 239, 8, SPI T6963C WHITE);

SPI T6963C box (0, 119, 239, 127, SPI T6963C WHITE);

/*

* Draw circles

*/

SPI T6963C circle(120, 64, 10, SPI T6963C WHITE);
SPI T6963C circle(120, 64, 30, SPI T6963C WHITE);
SPI T6963C circle(120, 64, 50, SPI T6963C WHITE);
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SPI T6963C circle
SPI T6963C circle
SPI T6963C circle
SPI T6963C circle

120, 64, 70, SPI_T6963C_WHITE);
120, 64, 90, SPI_T6963C_WHITE);
120, 64, 110, SPI_T6963C_WHITE)
120, 64, 130, SPI_T6963C_WHITE)

’

’

SPI T6963C sprite(76, 4, einstein, 88, 119); // Draw a sprite

SPI T6963C_setGrPanel (1); // Select other graphic panel
SPI T6963C_image (me) ; // Fill the graphic screen with a picture
while (1) { // Endless loop

/*

* If PORTA O is pressed, toggle the display between graphic
panel 0 and graphic 1
*/

if (RAO bit) |
panel++;
panel &= 1;
SPI T6963C displayGrPanel (panel);
Delay ms (300);
}

/*
* If PORTA 1 is pressed, display only graphic panel
*/
else if (RA1l bit) {
SPI T6963C graphics(1l);
SPI T6963C text (0);
Delay ms (300);
}

/*
* If PORTA 2 is pressed, display only text panel
*/
else if (RA2 bit) {
SPI T6963C graphics(0);
SPI T6963C text (1l);
Delay ms (300);
}

/*
* If PORTA 3 is pressed, display text and graphic panels
*/
else if (RA3 bit) {
SPI T6963C graphics(1l);
SPI T6963C text (1l);
Delay ms (300);
}

/*
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* If PORTA 4 is pressed, change cursor
*/
else if (RA4 bit) {
curs++;
if(curs == 3) curs = 0;
switch (curs) {
case 0:
// no cursor
SPI T6963C cursor (0);
break;
case 1:
// blinking cursor
SPI T6963C cursor(l);
SPI T6963C cursor blink(1l);
break;
case 2:
// non blinking cursor
SPI T6963C cursor(1l);
SPI T6963C cursor blink(0);
break;
}
Delay ms (300);
}
/*
* Move cursor, even if not visible
*/
cposx++;
if (cposx == SPI T6963C txtCols) ({
cposx = 0;
cposy++;
if (cposy == SPI_T6963C_grHeight / SPI T6963C_CHARACTER HEIGHT)
{
cposy = 0;

}
}

SPI T6963C set cursor (cposx, cposy);

Delay ms (100);
}
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HW Connection
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T6963C GRAPHIC LCD LIBRARY

The mikroC PRO for PIC provides a library for working with Glcds based on
TOSHIBA T6963C controller. The Toshiba T6963C is a very popular Lcd controller
for the use in small graphics modules. It is capable of controlling displays with a res-
olution up to 240x128. Because of its low power and small outline it is most suitable
for mobile applications such as PDAs, MP3 players or mobile measurement equip-
ment. Although small, this contoller has a capability of displaying and merging text
and graphics and it manages all the interfacing signals to the displays Row and Col-
umn drivers.

For creating a custom set of Glcd images use Glcd Bitmap Editor Tool.
Note: ChipEnable(CE), FontSelect(FS) and Reverse(MD) have to be set to appro-
priate levels by the user outside of the T6963c init function. See the Library

Example code at the bottom of this page.

Note: Some mikroElektronika's adapter boards have pinout different from T6369C
datasheets. Appropriate relations between these labels are given in the table below:

Adapter Board|T6369C datasheet
RS C/D
R/W /RD
E /WR
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External dependencies of T6963C Graphic LCD Library

The following variables must
be defined in all projects

. . Description: Example:
using T6963C Graphic LCD P P
library:
extern sfr char char T6963C dataPort at
T6963C dataPort; T6963C Data Port. PORTD;
extern sfr sbit Write signal sbit T6963C ctrlwr at
T6963C ctrlwr; 9 ) RC2 bit;
extern sfr sbit . sbit T6963C ctrlrd at
Read signal -
T6963C_ctrlrd; gna. RC1 bit;
extern sfr sbit Command/Data sbit T6963C ctrlecd at
T6963C ctrlcd; signal. RCO bit;
extern sfr sbit . sbit T6963C ctrlrst at
Reset signal -
T6963C ctrlrst; gna. RCA bit;
extern sfr sbit Direction of the ;23230 s bireeion
T6963C ctrlwr Direction; Write pin. = -
- - at TRISC2 bit;
. . bit
extern sfr sbit Direction of the ;6;6% e led bireeion
T6963C ctrlrd Direction; Read pin_ - L
- - at TRISCI bit;
. . it
extern sfr sbit Direction of the sbi . .
T6963C ctrled Direction: Dat . T6963C ctrlcd Direction
— - ' ata pin. at TRISCO bit;
extern sfr sbit Direction of the sbit

T6963C ctrlrst Direction

T6963C ctrlrst Di tion; i ‘
_ctrlrst Direction Reset pin. at TRISC4 bit;
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Library Routines

- T6963C_init

- T6963C_writeData
- T6963C_writeCommand
- T6963C_setPtr

- T6963C_waitReady
- T6963C _fill

- T6963C_dot

- T6963C_write_char
- T6963C_write_text
- T6963C_line

- T6963C_rectangle

- T6963C_box

- T6963C_circle

- T6963C_image

- T6963C_sprite

- T6963C_set_cursor

Note: The following low level library routines are implemented as macros. These
macros can be found in the T6963c.nh header file which is located in the T6963C
example projects folders.

- T6963C_clearBit

- T6963C_setBit

- T6963C_negBit

- T6963C_displayGrPanel
- T6963C_displayTxtPanel
- T6963C_setGrPanel

- T6963C_setTxtPanel

- T6963C_panelFill

- T6963C_grFill

- T6963C_txtFill

- T6963C_cursor_height

- T6963C_graphics

- T6963C_text

- T6963C_cursor

- T6963C_cursor_blink
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T6963C_Init
Prototype void T6963C init (unsigned int width, unsigned char height,

unsigned char fntwW);

Returns Nothing.

Initalizes the Graphic Lcd controller.

Parameters:

- width: width of the GLCD panel

- height: height of the GLCD panel
- fntw: font width

Display RAM organization:
The library cuts the RAM into panels: a complete panel is one graphics panel
followed by a text panel (see schematic below).

schematic:

fm e + /\
Description |+ GRAPHICS PANEL #0 +

+ +

- : \

+ +

e + | PANEL 0

I TEXT PANEL #0 Foo

+ + \/

e e L et + /\

+ GRAPHICS PANEL #1 Foo

+ +

+ +

- : \

L + | PANEL 1

+ TEXT PANEL #1 +

- : \

- + \/

Global variables:

- T6963C dataport: Data Port

- T6963C ctrlwr: Write signal pin

- T6963C ctrlrd: Read signal pin

- T6963C ctrlcd: Command/Data signal pin

- T6963C ctrlrst: Reset signal pin

- T6963C ctrlwr Direction: Direction of Write signal pin

- T6963C ctrlrd Direction: Direction of Read signal pin

- T6963C ctrled Direction: Direction of Command/Data signal pin
- T6963C ctrlrst Direction: Direction of Reset signal pin

Requires

must be defined before using this function.
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// T6963C module connections

char T6963C dataPort at PORTD;

sbit T6963C ctrlwr at RC2 bit;

sbit T6963C ctrlrd at RCl bit;

sbit T6963C ctrlcd at RCO bit;

sbit T6963C ctrlrst at RC4 bit;

sbit T6963C ctrlwr Direction at TRISC2 bit;
sbit T6963C ctrlrd Direction at TRISCl bit;
sbit T6963C ctrlcd Direction at TRISCO bit;
sbit T6963C ctrlrst Direction at TRISC4 bit;
// End of T6963C module connections

// Signals not used by library, they are set in main function

sbit T6963C ctrlce at RC3 bit; // CE signal

Example sbit T6963C ctrlfs at RC6 bit; // FS signal
sbit T6963C ctrlmd at RC5 bit; // MD signal
sbit T6963C ctrlce Direction at TRISC3 bit;// CE signal direc-
tion
sbit T6963C ctrlfs Direction at TRISC6 bit; // FS signal
direction
sbit T6963C ctrlmd Direction at TRISCS5 bit; // MD signal
direction

// End T6963C module connections

// init display for 240 pixel width, 128 pixel height and 8 bits
character width
T6963C init (240, 128, 8);

T6963C_writeData

Prototype void T6963C writeData (unsigned char mydata);

Returns Nothing.

Writes data to T6963C controller.
Description |Parameters:

-mydata: data to be written

Requires Toshiba Glcd module needs to be initialized. See the T6963C _init routine.

Example T6963C_writeData (AddrlL) ;
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T6963C_WriteCommand

Prototype void T6963C writeCommand (unsigned char mydata);
Returns Nothing.
Writes command to T6963C controller.
Description [Parameters:
- mydata: command to be written
Requires Toshiba Glcd module needs to be initialized. See the T6963C init routine.
Example T6963C writeCommand(T6963C CURSOR POINTER SET) ;

T6963C_SetPtr

Prototype void T6963C_setPtr (unsigned int p, unsigned char c);
Returns Nothing.
Sets the memory pointer p for command c.
i Parameters:
Description
- p: address where command should be written
- ¢: command to be written
Requires Toshiba Glcd module needs to be initialized. See the T6963C _init routine.
Exambple T6963C setPtr (T6963C grHomeAddr + start,
P T6963C_ADDRESS POINTER SET) ;

T6963C_waitReady

Prototype void T6963C waitReady (void) ;

Returns Nothing.

Description |Pools the status byte, and loops until Toshiba GLCD module is ready.
Requires Toshiba Glcd module needs to be initialized. See the T6963C _init routine.
Example T6963C waitReady();
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T6963C_fill
void T6963C fill (unsigned char v, unsigned int start, unsigned
Prototype int len);
Returns Nothing.

Fills controller memory block with given byte.

Parameters:
Description
- v: byte to be written

- start: starting address of the memory block
- len: length of the memory block in bytes

Requires Toshiba Glcd module needs to be initialized. See the T6963C _init routine.

Example T6963C_fill (0x33,0x00FF, 0x000F) ;

T6963C_Dot

Prototype void T6963C_dot (int x, int y, unsigned char color);

Returns Nothing.

Draws a dot in the current graphic panel of GLCD at coordinates (x, y).

Parameters:
Description
- x: dot position on x-axis
- v: dot position on y-axis
- color: color parameter. Valid values: T6963C_BLACK and T6963C_WHITE

Requires Toshiba Glcd module needs to be initialized. See the T6963C _init routine.

Example T6963C_dot (x0, y0, pcolor);
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T6963C_write_Char

void T6963C write char (unsigned char c, unsigned char x, unsigned
char y, unsigned char mode) ;

Prototype

Returns Nothing.

Writes a char in the current text panel of GLCD at coordinates (x, y).
Parameters:

- c: char to be written

- x: char position on x-axis

- v: char position on y-axis

- mode: mode parameter. Valid values: T6963C_ROM_MODE_OR,
T6963C_ROM_MODE_XOR, T6963C_ROM_MODE_AND and
T6963C_ROM_MODE_TEXT

Mode parameter explanation:
Description OR Mode: In the OR-Mode, text and graphics can be displayed and the data
is logically “OR-ed”. This is the most common way of combining text and

graphics for example labels on buttons.

- XOR-Mode: In this mode, the text and graphics data are combined via the
logical “exclusive OR”. This can be useful to display text in the negative
mode, i.e. white text on black background. - AND-Mode: The text and graph-
ic data shown on display are combined via the logical “AND function”.

- TEXT-Mode: The text and graphic data shown on display are combined via
the logical “AND function”.

- TEXT-Mode: This option is only available when displaying just a text. The
Text Attribute values are stored in the graphic area of display memory.

For more details see the T6963C datasheet.

Requires Toshiba Glcd module needs to be initialized. See the T6963C _init routine.

Example T6963C write char('A',22,23,AND);
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T6963C_write_text

void T6963C write text (unsigned char *str, unsigned char x,
unsigned char y, unsigned char mode);

Prototype

Returns Nothing.

Writes text in the current text panel of GLCD at coordinates (X, y).
Parameters:

- str: text to be written

- x: text position on x-axis

- v: text position on y-axis

- mode: mode parameter. Valid values: T6963C_ROM_MODE_OR,
T6963C_ROM_MODE_XOR, T6963C_ROM_MODE_AND and
T6963C_ROM_MODE_TEXT

Mode parameter explanation:

Description

- OR Mode: In the OR-Mode, text and graphics can be displayed and the data
is logically “OR-ed”. This is the most common way of combining text and
graphics for example labels on buttons.

- XOR-Mode: In this mode, the text and graphics data are combined via the
logical “exclusive OR”. This can be useful to display text in the negative
mode, i.e. white text on black background.

- AND-Mode: The text and graphic data shown on display are combined via
the logical “AND function”.

- TEXT-Mode: This option is only available when displaying just a text. The
Text Attribute values are stored in the graphic area of display memory.

For more details see the T6963C datasheet.

Requires Toshiba Glcd module needs to be initialized. See the T6963C _init routine.

T6963C write text (" Glcd LIBRARY DEMO, WELCOME !", 0, O,

Example | 543 Rom mODE xOR) ;
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T6963C line
void T6963C line(int x0, int y0, int x1, int yl, unsigned char
Prototype peolor) ;
Returns Nothing.

Draws a line from (x0, y0) to (x1, y1).
Parameters:

- x0: x coordinate of the line start

- v0: y coordinate of the line end

- x1: x coordinate of the line start

- y1: y coordinate of the line end

- pcolor: color parameter. Valid values:
T6963C_BLACK and T6963C_WHITE

Requires Toshiba Glcd module needs to be initialized. See the T6963C _init routine.

Description

Example T6963C_line(0, 0, 239, 127, T6963C _WHITE);

T6963C_rectangle

void T6963C rectangle(int x0, int y0, int x1, int yl, unsigned char
pcolor) ;

Prototype

Returns Nothing.

Draws a rectangle on GLCD.
Parameters:

Description |- x0: x coordinate of the upper left rectangle corner

- y0: y coordinate of the upper left rectangle corner

- x1: x coordinate of the lower right rectangle corner

- y1: y coordinate of the lower right rectangle corner

- pcolor: color parameter. Valid values: T6963C_BLACK and T6963C_WHITE

Requires Toshiba Glcd module needs to be initialized. See the T6963C _init routine.

Exanuﬂe T6963C rectangle, 20, 219, 107, T6963C WHITE);
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T6963C_box
Prototype void T6.963C7box (int x0, int y0, int x1, int yl, unsigned char
pcolor) ;
Returns Nothing.
Draws a box on GLCD
Parameters:
Description |- x0: x coordinate of the upper left box corner
- y0: y coordinate of the upper left box corner
- x1: x coordinate of the lower right box corner
- y1: y coordinate of the lower right box corner
- pcolor: color parameter. Valid values: T6963C_BLACK and T6963C_WHITE
Requires Toshiba Glcd module needs to be initialized. See the T6963C init routine.
Example T6963C box (0, 119, 239, 127, T6963C WHITE);
T6963C circle
Prototype void T6963C _circle(int x, int y, long r, unsigned char pcolor);
Returns Nothing.
Draws a circle on GLCD.
Parameters:
Description |_ = : x coordinate of the circle center
- v: y coordinate of the circle center
- r: radius size
- pcolor: color parameter. Valid values: T6963C_BLACK and T6963C_WHITE
Requires Toshiba Glcd module needs to be initialized. See the T6963C _init routine.
Example T6963C circle (120, 64, 110, T6963C_WHITE);
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T6963C_image

Prototype void T6963C_image (const code char *pic);

Returns Nothing.

Displays bitmap on GLCD.
Parameters:

- pic: image to be displayed. Bitmap array can be located in both code and
RAM memory (due to the mikroC PRO for PIC pointer to const and pointer to

Use the mikroC PRO’s integrated Glcd Bitmap Editor (menu option Tools »
Glcd Bitmap Editor) to convert image to a constant array suitable for display-
ing on Glcd.

Note: Image dimension must match the display dimension.

Requires Toshiba Glcd module needs to be initialized. See the T6963C _init routine.

Example T6963C_ image (mc) ;

T6963C_sprite

void T6963C sprite(unsigned char px, unsigned char py, const code
char *pic, unsigned char sx, unsigned char sy);

Prototype

Returns Nothing.

Fills graphic rectangle area (px, py) to (px+sx, py+sy) with custom size picture.
Parameters:

- px: X coordinate of the upper left picture corner. Valid values: multiples of the
font width

Description |- pov: y coordinate of the upper left picture corner

- pic: picture to be displayed

- sx: picture width. Valid values: multiples of the font width

- sy: picture height

Note: If px and sx parameters are not multiples of the font width they will be
scaled to the nearest lower number that is a multiple of the font width.

Requires Toshiba Glcd module needs to be initialized. See the T6963C _init routine.

Example T6963C sprite(76, 4, einstein, 88, 119); // draw a sprite
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T6963C_set_cursor

Prototype void T6963C_set cursor (unsigned char x, unsigned char y);
Returns Nothing.

Sets cursor to row x and column y.
Description Parameters:

- x: cursor position row number

- y: cursor position column number
Requires Toshiba Glcd module needs to be initialized. See the T6963C init routine.
Example T6963C_set cursor (cposx, cposy);

T6963C _clearBit

Prototype void T6963C_clearBit (char b);
Returns Nothing.
Clears control port bit(s).
Description |Parameters:
- b: bit mask. The function will clear bit = on control port if bit x in bit mask is set to 1.
Requires Toshiba Glcd module needs to be initialized. See the T6963C _init routine.
// clear bits 0 and 1 on control port
Example

T6963C clearBit (0x03);

T6963C_setBit

Prototype [void T6963C setBit (char b);
Returns Nothing.
Sets control port bit(s).
Description |[Parameters:
- b: bit mask. The function will set bit < on control port if bit = in bit mask is set to 1.
Requires Toshiba Glcd module needs to be initialized. See the T6963C _init routine.
// set bits 0 and 1 on control port
Example

T6963C setBit (0x03);
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T6963C_negBit

Prototype |void T6963C negBit (char Db);

Returns Nothing.

Negates control port bit(s).

o Parameters:
Description

- b: bit mask. The function will negate bit < on control port if bit < in bit mask is
set to 1.

Requires Toshiba Glcd module needs to be initialized. See the T6963C _init routine.

// negate bits 0 and 1 on control port

Example T6963C_negBit (0x03) ;

T6963C_displayGrPanel

Prototype void T6963C displayGrPanel (char n);

Returns Nothing.

Display selected graphic panel.
Description |Parameters:

- n: graphic panel number. Valid values: 0 and 1.

Requires Toshiba Glcd module needs to be initialized. See the T6963C _init routine.

// display graphic panel 1

Exan“ﬂe T6963C displayGrPanel (1) ;

T6963C_displayTxtPanel

Prototype void T6963C_displayTxtPanel (char n);

Returns Nothing.

Display selected text panel.
Description |Parameters:

- n: text panel number. Valid values: 0 and 1.

Requires Toshiba Glcd module needs to be initialized. See the T6963C _init routine.

// display text panel 1

Example T6963C displayTxtPanel (1);
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T6963C_setGrPanel

Prototype void T6963C_setTxtPanel (char n);

Returns Nothing.

Compute start address for selected graphic panel and set appropriate internal pointers.
All subsequent graphic operations will be preformed at this graphic panel.

Description

Parameters:

- n: graphic panel number. Valid values: 0 and 1.
Requires Toshiba Glcd module needs to be initialized. See the T6963C init routine.
Example // set text panel 1 as current text panel.

T6963C setTxtPanel (1) ;

T6963C_SetTxtPanel

Prototype void T6963C_setTxtPanel (char n);

Returns Nothing.

Compute start address for selected text panel and set appropriate internal point-
ers. All subsequent text operations will be preformed at this text panel.

Description | o meters:

- n: text panel number. Valid values: 0 and 1.
Requires Toshiba GLCD module needs to be initialized. See the T6963C_Init routine.

// set text panel 1 as current text panel.

Exan“ﬂe T6963C setTxtPanel (1);

T6963C_PanelFill

Prototype void T6963C panelFill (unsigned char v);

Returns Nothing.

Fill current panel in full (graphic+text) with appropriate value (0 to clear).
Description |Parameters:

- v: value to fill panel with.

Requires Toshiba Glcd module needs to be initialized. See the T6963C _init routine.

//clear current panel

Example T6963C_panelFill (0);
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T6963C_grFill

Prototype void T6963C grFill (unsigned char v);

Returns Nothing.

Fill current graphic panel with appropriate value (0 to clear).
Description |Parameters:

- v: value to fill graphic panel with.

Requires Toshiba Glcd module needs to be initialized. See the T6963C _init routine.

// clear current graphic panel

Example T6963C grFill (0);

T6963C_txtFill

Prototype void T6963C txtFill (unsigned char v);

Returns Nothing.

Fill current text panel with appropriate value (0 to clear).
Description |Parameters:

- v: this value increased by 32 will be used to fill text panel.

Requires Toshiba Glcd module needs to be initialized. See the T6963C _init routine.

// clear current text panel

Example T6963C txtFill(0);

T6963C_cursor_height

Prototype void T6963C cursor height (unsigned char n);

Returns Nothing.

Set cursor size.
Description |Parameters:

- n: cursor height. Valid values: 0. . 7.

Requires Toshiba Glcd module needs to be initialized. See the T6963C _init routine.

Example T6963C cursor height (7);
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T6963C_Graphics

Prototype void T6963C graphics (char n);
Returns Nothing.
Enable/disable graphic displaying.
_— Parameters:
Description
- n: on/off parameter. Valid values: 0 (disable graphic dispaying) and 1 (enable
graphic displaying).
Requires Toshiba Glcd module needs to be initialized. See the T6963C _init routine.
Example // enable graphic displaying

T6963C7qrap'ﬁ cs(1);

T6963C_text

Prototype |[void T6963C text (char n);
Returns Nothing.
Enable/disable text displaying.
Description Parameters:
- n: on/off parameter. Valid values: 0 (disable text dispaying) and 1 (enable text
displaying).
Requires Toshiba Glcd module needs to be initialized. See the T6963C _init routine.
Example // enable text displaying

T6963C text(1l);

T6963C_cursor

Prototype void T6963C_cursor (char n);
Returns Nothing.

Set cursor on/off.
Description |Parameters:

- n: on/off parameter. Valid values: 0 (set cursor off) and 1 (set cursor on).
Requires Toshiba Glcd module needs to be initialized. See the T6963C _init routine.
Example // set cursor on

T6963C cursor (1) ;
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T6963C_Cursor_Blink

Prototype void T6963C_cursor blink(char n);

Returns Nothing.

Enable/disable cursor blinking.

. Parameters:
Description

- n: on/off parameter. Valid values: 0 (disable cursor blinking) and 1 (enable
cursor blinking).

Requires Toshiba Glcd module needs to be initialized. See the T6963C _init routine.

// enable cursor blinking

Example T6963C_cursor blink(1);

Library Example

The following drawing demo tests advanced routines of the T6963C Glcd library. Hardware con-
figurations in this example are made for the T6963C 240x128 display, EasyPIC5 board and
16F887.

#include " T6963C.h"

// T6963C module connections

char T6963C dataPort at PORTD; // DATA port

sbit T6963C ctrlwr at RC2 bit; // WR write signal

sbit T6963C ctrlrd at RC1 bit; // RD read signal

sbit T6963C ctrlcd at RCO bit; // CD command/data signal
sbit T6963C ctrlrst at RC4 bit; // RST reset signal

sbit T6963C ctrlwr Direction at TRISC2 bit; // WR write signal

sbit T6963C ctrlrd Direction at TRISC1l bit; // RD read signal

sbit T6963C ctrlcd Direction at TRISCO bit; // CD command/data signal
sbit T6963C ctrlrst Direction at TRISC4 bit; // RST reset signal

// Signals not used by library, they are set in main function

sbit T6963C ctrlce at RC3 bit; // CE signal
sbit T6963C ctrlfs at RC6 bit; // FS signal
sbit T6963C ctrlmd at RC5 bit; // MD signal
sbit T6963C ctrlce Direction at TRISC3 bit; // CE signal direction
sbit T6963C ctrlfs Direction at TRISC6 bit; // FS signal direction
sbit T6963C ctrlmd Direction at TRISCS bit; // MD signal direction

// End T6963C module connections
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/*

* bitmap pictures stored in ROM
*/

const code char m(C[ ] ;

const code char einstein[];

void main () {

char txtl[] = " EINSTEIN WOULD HAVE LIKED mE";
char txt[] = " GLCD LIBRARY DEMO, WELCOME !'";
unsigned char panel; // Current panel
unsigned int i; // General purpose register
unsigned char curs; // Cursor visibility
unsigned int cposx, cposy; // Cursor x-y position
TRISAO bit = 1; // Set RAO as input
TRISAL bit = 1; // Set RAl as input
TRISA2 bit = 1; // Set RA2 as input
TRISA3 bit = 1; // Set RA3 as input
TRISA4 bit = 1; // Set RA4 as input
T6963C ctrlce Direction = 0;
T6963C ctrlce = 0; // Enable T6963C
T6963C ctrlfs Direction = 0;
T6963C ctrlfs = 0; // Font Select 8x8
T6963C ctrlmd Direction = 0;
T6963C ctrlmd = 0; // Column number select
ANSEL = 0; // Configure AN pins as digital I/O
ANSELH = 0;
// Initialize T6369C
T6963C init (240, 128, 8);
/*
* Enable both graphics and text display at the same time
*/

T6963C graphics(1);
T6963C text (1)

panel = 0;
i = 0;
curs = 0;
cposx = cposy = 0;
/*
* Text messages
*/

T6963C write text(txt, 0, 0, T6963C ROM MODE XOR) ;
T6963C write text(txtl, 0, 15, T6963C ROM MODE XOR);
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/*
* Cursor
*/
T6963C_cursor height (8); // 8 pixel height
T6963C _set cursor (0, 0); // Move cursor to top left
T6963C_cursor (0); // Cursor off
/*
* Draw rectangles
*/

T6963C _rectangle
T6963C _rectangle
T6963C rectangle
T6963C rectangle

0, 0, 239, 127, T6963C _WHITE) ;

20, 20, 219, 107, T6963C WHITE);
40, 40, 199, 87, T6963C WHITE);
60, 60, 179, 67, T6963C WHITE);

/*

* Draw a cross

*/

T6963C line(0, 0, 239, 127, T6963C WHITE);
T6963C line(0, 127, 239, 0, T6963C WHITE);

/*

* Draw solid boxes

*/

T6963C box (0, 0, 239, 8, T6963C WHITE)
T6963C box (0, 119, 239, 127, T6963C WHITE);

/*

* Draw circles

*/

T6963C circle (120, 64, 10, T6963C WHITE)

T6963C circle (120, 64, 30, T6963C WHITE)

T6963C circle (120, 64, 50, T6963C WHITE)

T6963C circle (120, 64, 70, T6963C WHITE)

T6963C circle (120, 64, 90, T6963C WHITE)
( E
( E

’

’

’

’

T6963C circle (120, 64, 110, T6963C WHIT
T6963C circle (120, 64, 130, T6963C WHIT

)
) i
T6963C sprite(76, 4, einstein, 88, 119); // Draw a sprite

T6963C_setGrPanel (1); // Select other graphic panel

T6963C image (mC) ;

for (;;) { // Endless loop
/*
* If RAO is pressed, display only graphic panel
*/

if (RAO bit) {
T6963C graphics(1l);
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T6963C text (0);
Delay ms (300);
}

/*
* If RAl is pressed, toggle the display between graphic panel
0 and graphic panel 1
*/
else if (RA1l bit) {
panel++;
panel &= 1;
T6963C displayGrPanel (panel);
Delay ms (300);
}

/*
* If RA2 is pressed, display only text panel
*/
else if (RA2 bit) {
T6963C graphics (0);
T6963C text(l);
Delay ms (300);
}

/*
* If RA3 is pressed, display text and graphic panels
*/
else if (RA3 bit) {
T6963C graphics (1);
T6963C text(l);
Delay ms (300);
}

/*
* If RA4 is pressed, change cursor
*/
else if (RA4 bit) {
curs++;
if (curs == 3) curs = 0;
switch (curs) {

case 0:
// no cursor
T6963C cursor (0);
break;

case 1:
// blinking cursor
T6963C cursor (1l);
T6963C cursor blink(1l);
break;

case 2:

MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD 549




CHAPTER 7
Libraries mikroC PRO for PIC

// non blinking cursor
T6963C cursor (1l);
T6963C cursor blink(0);
break;
}
Delay ms (300);
}

/*
* Move cursor, even if not visible
*/
cposx++;
if (cposx == T6963C_txtCols) ({
cposx = 0;
cposy++;
if (cposy == T6963C grHeight / T6963C CHARACTER HEIGHT) ({
cposy = 0;
}
}
T6963C set cursor (cposx, cposy);

Delay ms (100);
}
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HW Connection

Toshiba TE363C Graphic LCD (240x128)
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UART LIBRARY

UART hardware module is available with a number of PIC MCUs. mikroC PRO for
PIC UART Library provides comfortable work with the Asynchronous (full duplex)
mode.

You can easily communicate with other devices via RS-232 protocol (for example
with PC, see the figure at the end of the topic — RS-232 HW connection). You need
a PIC MCU with hardware integrated UART, for example 16F887. Then, simply use
the functions listed below.

Note: Some PIC18 MCUs have multiple UART modules. Switching between the
UART modules in the UART library is done by the UART_Set_Active function (UART
module has to be previously initialized).

Note: In order to use the desired UART library routine, simply change the number 1
in the prototype with the appropriate module number, i.e. UART2 Tnit (2400);

Library Routines

- UART1_Init

- UART1_Data_Ready
- UART1_Tx_Idle

- UART1_Read

- UART1_Read_Text

- UART1_Write

- UART1_Write_Text

- UART_Set_Active
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Uart_Init
Prototype void UART1 Init (unsigned long baud rate);
Returns Nothing.
Initializes desired hardware UART module with the desired baud rate. Refer to the
Description [device data sheet for baud rates allowed for specific rosc. If you specify the
unsupported baud rate, compiler will report an error.
You need PIC MCU with hardware UART.
UART1 Tnit needs to be called before using other functions from UART Library.
Parameters:
Requires - baud rate: requested baud rate
Refer to the device data sheet for baud rates allowed for specific Fosc.
Note: Calculation of the UART baud rate value is carried out by the compiler, as
it would produce a relatively large code if performed on the libary level.
Therefore, compiler needs to know the value of the parameter in the compile time.
That is why this parameter needs to be a constant, and not a variable.
This will initialize hardware UART1 module and establish the communication at
Example 2400 bps:
UART1 Init(2400);
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Uart_Data_Ready

Prototype |char UART1 Data Ready();

- 1 if data is ready for reading

Returns - 0 if there is no data in the receive register

Description |[Use the function to test if data in receive buffer is ready for reading.

UART HW module must be initialized and communication established before

Requires using this function. See UART1_Init.
// If data is ready, read it:
Exanuﬂe if (UART1 Data Ready() == 1) {

receive = UART1 Read();
}

UART1_Tx_lIdle

Prototype char UART1 Tx Idle();

- 1 if data is ready for reading

Returns - 0 if there is no data in the receive register

Description |Use the function to test if the transmit shift register is empty or not.

UART HW module must be initialized and communication established before

Requires ; : . .
q using this function. See UART1_Init.
// If the previous data has been shifted out, send next data:
if (UART1 Tx Idle() == 1) {
Exan“ﬂe UART1 Write( data);
}
UART1_Read

Prototype char UART1 Read();

Returns Returns the received byte.

Function receives a byte via UART. Use the function UART1_Data_Ready to

Description test if data is ready first.

UART HW module must be initialized and communication established before

Requires using this function. See UART1_Init.
// If data is ready, read it:
Example if (UART1 Data Ready() == 1) {

receive = UART1 Read();
}
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UART1_Read_Text

Prototype void UART1 Read Text (char *Output, char *Delimiter, char
yp Attempts) ;
Returns Nothing.
Reads characters received via UART until the delimiter sequence is detected.
The read sequence is stored in the parameter output; delimiter sequence is
stored in the parameter delimiter.
Description L . o . .

P This is a blocking call: the delimiter sequence is expected, otherwise the proce-
dure exits (if the delimiter is not found). Parameter 2t tempts defines number of
received characters in which pe1imiter sequence is expected. If At tempts is set
to 255, this routine will continuously try to detect the pe1imiter sequence.

Requires UART HW module must be initialized and communication established before
9 using this function. See UART1_Init.
Read text until the sequence “OK” is received, and send back what’ s
been received:
UART1 Init (4800); // initialize UART1 module
Delay ms (100);
Example while (1) {
if (UART1 Data Ready() == 1) { // 1f data is received
UART1 Read Text (output, "delim", 10); // reads text until
'delim' is found
UART1 Write Text (output); // sends back text
}
}
UART1_Write
Prototype void UART1 Write (char data);
Returns Nothing.
The function transmits a byte via the UART module.
Description
P Parameters:
_data: data to be sent
Requires UART HW module must be initialized and communication established before
q using this function. See UART1_Init.
unsigned char data = O0x1E;
Example

UART1 Write( data);
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UART1_Write_Text

Prototype void UART1 Write Text (char * UART text);

Returns Nothing.

Description |[Sends text (parameter UART _text) via UART. Text should be zero terminated.

UART HW module must be initialized and communication established before
using this function. See UART1_Init.

Read text until the sequence “OK” is received, and send back
what’ s been received:

Requires

UART1 Init (4800); // initialize UART1 module
Delay ms (100);

Example while (1) {
if (UART1 Data Ready() == 1) { // if data 1is received
UART1 Read Text (output, "delim", 10); // reads text until
'delim' is found

UART1 Write Text (output); // sends back text
}
}
UART_Set_Active
void UART Set Active (char (*read ptr) (), wvoid
Prokﬂype (*write ptr) (unsigned char data ), char (ready ptr) (), char

(*tx idle ptr) ()

Returns Nothing.

Sets active UART module which will be used by the UART library routines.

Parameters:
Description | | ... UART1_Read handler
-write ptr: UART1_Write handler

- ready ptr: UART1_Data_Ready handler
- tx idle ptr: UART1_Tx_ldle handler

Routine is available only for MCUs with two UART modules.

Requires ;o4 UART module must be initialized before using this routine. See

UART1_Init routine

// Activate UART2 module
Example UART Set Active (§UART1 Read, &UART1 Write, &UART1 Data Ready,
§UART1 Tx Idle);
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Library Example

The example demonstrates a simple data exchange via UART. When PIC MCU
receives data, it immediately sends it back. If PIC is connected to the PC (see the
figure below), you can test the example from the mikroC PRO for PIC terminal for
RS-232 communication, menu choice Tools » Terminal.

char uart rd;

void main () {

UART1 Init (9600); // Initialize UART module at 9600
bps
Delay ms (100); // Wait for UART module to stabi-
lize
while (1) { // Endless loop
if (UART1 Data Ready()) { // If data is received,
uart rd = UART1 Read(); // read the received data,
UART1 Write(uart rd); // and send data via UART

}
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HW Connection
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USB HID LIBRARY

Universal Serial Bus (USB) provides a serial bus standard for connecting a wide
variety of devices, including computers, cell phones, game consoles, PDA's, etc.

mikroC PRO for PIC includes a library for working with human interface devices via
Universal Serial Bus. A human interface device or HID is a type of computer device
that interacts directly with and takes input from humans, such as the keyboard,
mouse, graphics tablet, and the like.

Descriptor File

Each project based on the USB HID library should include a descriptor source file
which contains vendor id and name, product id and name, report length, and other
relevant information. To create a descriptor file, use the integrated USB HID termi-
nal of mikroC PRO for PIC(Tools » USB HID Terminal). The default name for
descriptor file is UsBdsc.c, but you may rename it.

The provided code in the “Examples” folder works at 48MHz, and the flags should
not be modified without consulting the appropriate datasheet first.

Library Routines

- Hid_Enable
- Hid_Read
- Hid_Write
- Hid_Disable
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Hid_Enable

Prototype void Hid Enable (unsigned readbuff, unsigned writebuff);

Returns Nothing.
Enables USB HID communication. Parameters readbuff and writebuff are
the Read Buffer and the Write Buffer, respectively, which are used for HID com-

Description |munication.
This function needs to be called before using other routines of USB HID Library.

Requires Nothing.

Example Hid Enable(&rd, &wr);

Hid_Read

Prototype unsigned char Hid Read (void);

Returns Number of characters in the Read Buffer received from the host.

Description Receives message from host and stores it in the Read Buffer. Function returns

P the number of characters received in the Read Buffer.

Requires USB HID needs to be enabled before using this function. See Hid_Enable.

Example get = Hid Read();

Hid_Write

Prototype unsigned short Hid Write (unsigned writebuff, unsigned short len);

Returns 1 if data was successfuly sent, 0 if not.
Function sends data from Write Buffer writebuff to host. Write Buffer is the
same parameter as used in initialization; see Hid_Enable. Parameter 1en

Description |should specify a length of the data to be transmitted.
Function call needs to be repeated as long as data is not successfuly sent.

Requires USB HID needs to be enabled before using this function. See Hid_Enable.

E I // retry until success.

xample while (!Hid Write (&my Usb Buff, 1));
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Hid_Disable

Prototype

void Hid Disable (void) ;

Returns

Nothing.

Description [Disables USB HID communication.

Requires

USB HID needs to be enabled before using this function. See Hid_Enable.

Example

Hid Disable();

Library Example

The following example continually sends sequence of numbers 0..255 to the PC via Universal Ser-
ial Bus. usbdsc.c must be included in the project (via mikroC PRO for PIC IDE tool or via
#include mechanism in source code).

unsigned short m, k;
unsigned short userRD buffer 64] ;
unsigned short userWR buffer[ 64] ;

void interrupt () {
asm CALL Hid InterruptProc

asm nop

}

void Init Main() {
// Disable all interrupts
// Disable GIE, PEIE, TMROIE, INTOIE,RBIE
INTCON = 0;

INTCONZ2
INTCON3

= 0xF5;
= 0xCO;

// Disable Priority Levels on interrupts
RCON.IPEN = 0;

PIE1l =
PIE2 =
PIR1 =
PIR2 =

0;

0;
0;
O.

’

// Configure all ports with analog function as digital

ADCON1

// Port
TRISA =
TRISB =
TRISC =
TRISD =

TRISE =

|= 0xO0F;

s Configuration
0;
0;
OxFF;
OxFF;
0x07;
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LATA =
LATB =
LATC =
LATD =
LATE =

~.

~. . o~

O O O O o
~

~.

// Clear user RAM

// Banks [ 00 .. 07] ( 8 x 256 = 2048 Bytes )
asm {

LFSR FSRO, 0x000

MOVLW 0x08

CLRF POSTINCO, O

CPFSEQ FSROH, O

BRA S - 2

}

// Timer O

TOCON = 0x07;

TMROH = (65536-156) >> 8;

TMROL = (65536-156) & OxFF;

INTCON.TOIE = 1; // Enable TOIE

TOCON.TMROON = 1;

/** Main Program Routine **/

void main () {
Init Main();
Hid Enable (&userRD buffer, &userWR buffer);

do {
for (k = 0; k < 255; k++) {
// Prepare send buffer
userWR buffer[ 0] = k;

// Send the number via USB
Hid Write (&userWR buffer, 1);
}
} while (1);

Hid Disable();
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STANDARD ANSI C LIBRARIES

- ANSI C Ctype Library
- ANSI C Math Library

- ANSI C Stdlib Library
- ANSI C String Library

ANSI C Ctype Library

The mikroC PRO for PIC provides a set of standard ANSI C library functions for test-
ing and mapping characters.

Note: Not all of the standard functions have been included.

Note: The functions have been mostly implemented according to the ANSI C stan-
dard, but certain functions have been modified in order to facilitate PIC program-
ming. Be sure to skim through the description before using standard C functions.

Library Functions

- isalnum
- isalpha
- iscntrl

- isdigit

- isgraph
- islower

- ispunct
- isspace
- isupper
- isxdigit

- toupper
- tolower
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isalnum
Prototype unsigned short isalpha (char character);
. . Function returns 1 if the character is alphanumeric (A-Z, a-z, 0-9), otherwise
Description
returns zero.
isalpha
Prototype unsigned short isalpha(char character);
o Function returns 1 if the character is alphabetic (A-Z, a-z), otherwise returns
Description
zero.
iscntrl
Prototype unsigned short iscntrl (char character);
e Function returns 1 if the character is a control or delete character(decimal O-
Description .
31 and 127), otherwise returns zero.
isdigit
Prototype unsigned short isdigit (char character);
Description [Function returns 1 if the character is a digit (0-9), otherwise returns zero.
isgraph
Prototype unsigned short isgraph(char character);
e Function returns 1 if the character is a printable, excluding the space (decimal
Description .
32), otherwise returns zero.
islower
Prototype int islower (char character);
.. Function returns 1 if the character is a lowercase letter (a-z), otherwise returns
Description
zero.
ispunct
Prototype unsigned short ispunct (char character);
- Function returns 1 if the character is a punctuation (decimal 32-47, 58-63, 91-
Description

96, 123-126), otherwise returns zero.
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isspace
Prototype unsigned short isspace(char character);
- Function returns 1 if the charzcter is a white space (space, tab, CR, HT, VT,
Description .
NL, FF), otherwise returns zero.
isupper
Prototype unsigned short isupper (char character);
i Function returns 1 if the character is an uppercase letter (A-Z), otherwise
Description
returns zero.
isxdigit
Prototype unsigned short isxdigit (char character);
i Function returns 1 if the character is a hex digit (0-9, A-F, a-f), otherwise
Description
returns zero.
toupper
Prototype unsigned short toupper (char character);
Describtion If the character is a lowercase letter (a-z), the function returns an uppercase
P letter. Otherwise, the function returns an unchanged input parameter.
tolower
Prototype unsigned short tolower (char character);
i If the character is an uppercase letter (A-Z), function returns a lowercase let-
Description . . .
ter. Otherwise, function returns an unchanged input parameter.
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ANSI C Math Library

The mikroC PRO for PIC provides a set of standard ANSI C library functions for
floating point math handling.

Note: Not all of the standard functions have been included.

Note: The functions have been mostly implemented according to the ANSI C stan-
dard, but certain functions have been modified in order to facilitate PIC program-
ming. Be sure to skim through the description before using standard C functions.

Library Functions

- acos
- asin
- atan
- atan2
- ceill

- COS

- cosh
- eval_poly
- exp

- fabs
- floor
- frexp
- Idexp
- log

- log10
- modf
- pow
- sin

- sinh

- sqrt

- tan

- tanh
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acos
Prototype |double acos (double x);
Function returns the arc cosine of parameter x; that is, the value whose cosine
Description |is x. The input parameter x must be between -1 and 1 (inclusive). The return
value is in radians, between 0 and I1 (inclusive).
asin
Prototype double asin (double x);
Function returns the arc sine of parameter x; that is, the value whose sine is x.
Description |The input parameter = must be between -1 and 1 (inclusive). The return value is
in radians, between -1/2 and /2 (inclusive).
atan
Prototype double atan (double f);
Description Function computes the arc tangent of parameter f; that is, the value whose tan-
P gentis f. The return value is in radians, between -I1/2 and I1/2 (inclusive).
atan2
Prototype double atan? (double y, double x);
This is the two-argument arc tangent function. It is similar to computing the arc
Describtion tangent of v/x, except that the signs of both arguments are used to determine
P the quadrant of the result and x is permitted to be zero. The return value is in
radians, between -1 and I1 (inclusive).
ceil
Prototype |double ceil (double x);
Description |Function returns value of parameter x rounded up to the next whole number.
cos
Prototype double cos (double f);
Description |Function returns the cosine of  in radians. The return value is from -1 to 1.
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cosh
Prototype double cosh (double x);
D e Function returns the hyperbolic cosine of x, defined mathematically as (e*+e™%) /2. If
escription . . . .
the value of x is too large (if overflow occurs), the function fails.
eval_poly
Prototype static double eval poly(double x, const double code * d, int n);
. Function Calculates polynom for number x, with coefficients stored in 4/ ], for
Description
degree n.
exp
Prototype double exp (double x);
. Function returns the value of « — the base of natural logarithms — raised to the
Description ,
power x (i.e. ex).
fabs
Prototype |double fabs (double d);
Description |Function returns the absolute (i.e. positive) value of d.
floor
Prototype double floor (double x);
Description |Function returns the value of parameter x rounded down to the nearest integer.
frexp
Prototype double frexp(double value, int *eptr);
Function splits a floating-point value into a normalized fraction and an integral
Description |power of 2. The return value is the normalized fraction and the integer exponent
is stored in the object pointed to by eptr.
Idexp
Prototype double ldexp (double value, int newexp) ;
Description Function returns the result of multiplying the floating-point number num by 2

raised to the power n (i.e. returns = * 2n).
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log

Prototype double log(double x);

Description |Function returns the natural logarithm of x (i.e. 1oge (x)).

log10

Prototype double 1lo0gl0 (double x);

Description |Function returns the base-10 logarithm of x (i.e. 10910 (x)).

modf

Prototype double modf (double val, double * iptr);

Returns argument vz 1 split to the fractional part (function return val) and integer

Description part (in number iptr).

pow

Prototype double pow (double x, double vy);

Function returns the value of x raised to the power y (i.e. xv). If x is negative,

Description . . . .
P the function will automatically cast v into unsigned long.

sin

Prototype double sin(double f);

Description |Function returns the sine of ¢ in radians. The return value is from -1 to 1.

sinh

Prototype double sinh (double x);

Function returns the hyperbolic sine of %, defined mathematically as (ex-e-

Description =) /2. If the value of x is too large (if overflow occurs), the function fails.

sqrt

Prototype double sgrt (double x);

Description |Function returns the non negative square root of x.
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tan

Prototype double tan (double x);

Function returns the tangent of = in radians. The return value spans the

Description allowed range of floating point in the mikroC PRO for PIC.

tanh

Prototype double tanh (double x);

Function returns the hyperbolic tangent of x, defined mathematically as

Description
esc IptIO sinh (x) /cosh (x).

ANSI C Stdlib Library
The mikroC PRO for PIC provides a set of standard ANSI C library functions of general utility.
Note: Not all of the standard functions have been included.

Note: Functions have been mostly implemented according to the ANSI C standard, but certain
functions have been modified in order to facilitate PIC programming. Be sure to skim through the
description before using standard C functions.

Library Functions

- abs
- atof
- atoi
- atol
- div

- Idiv
- uldiv
- labs
- max
- min
- rand
- srand
- xtoi
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abs
Prototype int abs (int a);
Description |Function returns the absolute (i.e. positive) value of .
atof
Prototype double atof (char *s)
Function converts the input string s into a double precision value and returns the
value. Input string s should conform to the floating point literal format, with an
Description |optional whitespace at the beginning. The string will be processed one character
at a time, until the function reaches a character which it doesn’t recognize (includ-
ing a null character).
atoi
Prototype int atoi (char *s);
Function converts the input string s into an integer value and returns the value.
The input string s should consist exclusively of decimal digits, with an optional
Description |whitespace and a sign at the beginning. The string will be processed one charac-
ter at a time, until the function reaches a character which it doesn’t recognize
(including a null character).
atol
Prototype |long atol (char *s)
Function converts the input string s into a long integer value and returns the
value. The input string s should consist exclusively of decimal digits, with an
Description |optional whitespace and a sign at the beginning. The string will be processed one
character at a time, until the function reaches a character which it doesn’t recog-
nize (including a null character).
div
Prototype div_t div(int number, int denom);
Function computes the result of division of the numerator number by the denom-
Description |inator denom; the function returns a structure of type div t comprising quotient
(quot) and remainder (remn), see Div Structures.
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Idiv

Prototype ldiv_t 1ldiv(long number, long denom) ;

Function is similar to the div function, except that the arguments and result
structure members all have type 1ong.

Description Function computes the result of division of the numerator number by the denom-
inator denom; the function returns a structure of type 1div t comprising quo-
tient (quot) and remainder (rem), see Div Structures.

uldiv

Prototype uldiv_t uldiv (unsigned long number, unsigned long denom) ;

Function is similar to the div function, except that the arguments and result
structure members all have type unsigned long.

Description |rynction computes the result of division of the numerator numoe - by the denom-
inator denom; the function returns a structure of type u1div t comprising quo-
tient (quot) and remainder (rem), see Div Structures.

labs

Prototype long labs(long x);

Description |Function returns the absolute (i.e. positive) value of long integer x.

max

Prototype int max (int a, int b);

Description |Function returns greater of the two integers, a2 and o.

min

Prototype int min(int a, int b);

Description |Function returns lower of the two integers, = and b.

rand

Prototype int rand();

Function returns a sequence of pseudo-random numbers between 0 and 32767.

Description |The function will always produce the same sequence of numbers unless srand

is called to seed the start point.
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srand

Prototype void srand(unsigned x);

Function uses x as a starting point for a new sequence of pseudo-random num-
Description |bers to be returned by subsequent calls to rand. No values are returned by this
function.

xtoi

Prototype unsigned xtoi (register char *s);

Function converts the input string s consisting of hexadecimal digits into an inte-
ger value. The input parameter s should consist exclusively of hexadecimal dig-
Description |its, with an optional whitespace and a sign at the beginning. The string will be
processed one character at a time, until the function reaches a character which it
doesn’t recognize (including a null character).

Div Structures

typedef struct divstruct {
int quot;
int rem;
}odiv_t;

typedef struct ldivstruct {
long quot;
long rem;
}oldiv_t;

typedef struct uldivstruct {
unsigned long quot;
unsigned long rem;
}ouldiv_t;
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ANSI C String Library

The mikroC PRO for PIC provides a set of standard ANSI C library functions useful
for manipulating strings and RAM memory.

Note: Not all of the standard functions have been included.

Note: Functions have been mostly implemented according to the ANSI C standard,
but certain functions have been modified in order to facilitate PIC programming. Be
sure to skim through the description before using standard C functions.

Library Functions

- memchr
- memcmp
- memcpy
- memmove
- memset
- strcat

- strchr

- strcmp

- strcpy

- strlen

- strncat

- strncpy

- strspn

- strncmp
- strstr

- strcspn

- strpbrk

- strrchr
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memchr

Prototype void *memchr (void *p, char n, unsigned int v);
yp

Function locates the first occurrence of n in the initial v bytes of memory area
starting at the address p. The function returns the pointer to this location or o if
the n was not found.

For parameter p you can use either a numerical value (literal/variable/constant)
indicating memory address or a dereferenced value of an object, for example
&mystring Or &PO.

Description

memcmp

Prototype int memcmp (void *sl, wvoid *s2, int n);

Function compares the first n characters of objects pointed to by s1 and s2 and
returns zero if the objects are equal, or returns a difference between the first dif-
Description [fering characters (in a left-to-right evaluation).

Accordingly, the result is greater than zero if the object pointed to by s1 is greater
than the object pointed to by s2 and vice versa.

memcpy

Prototype void *memcpy (void *dl, woid *sl, int n);

Function copies n characters from the object pointed to by s1 into the object point-
Description |ed to by d1. If copying takes place between objects that overlap, the behavior is
undefined. The function returns address of the object pointed to by d1.

memmoyve

Prototype void *memmove (void *to, void * from, register int n);

Function copies n characters from the object pointed to by rrom into the object
Description |pointed to by to. Unlike memcpy, the memory areas to and from may overlap.
The function returns address of the object pointed to by to.

memset

Prototype void *memset (void *pl, char character, int n)

Function copies the value of the character into each of the first n characters of
Description |[the object pointed by p1. The function returns address of the object pointed to

by 1.
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strcat
Prototype char *strcat(char *to, char *from);
Function appends a copy of the string from to the string to, overwriting the null
character at the end of to. Then, a terminating null character is added to the
Description [result. If copying takes place between objects that overlap, the behavior is unde-
fined. to string must have enough space to store the result. The function returns
address of the object pointed to by to.
strchr
Prototype char *strchr (char *ptr, char chr);
Function locates the first occurrence of character chr in the string pt r. The func-
o tion returns a pointer to the first occurrence of character chr, or a null pointer if
Description | . L . .
chr does not occur in ptr. The terminating null character is considered to be a
part of the string.
strcmp
Prototype int strcmp(char *sl, char *s2);
Function compares strings s1 and s2 and returns zero if the strings are equal, or
Description returns a difference between the first differing characters (in a left-to-right evalu-
P ation). Accordingly, the result is greater than zero if s1 is greater than s2 and vice
versa.
strcpy
Prototype char *strcpy(char *to, char *from);
Function copies the string from into the string to. If copying is successful, the
Description [function returns to. If copying takes place between objects that overlap, the
behavior is undefined.
strlen
Prototype int strlen(char *s);
o . Function returns the length of the string s (the terminating null character does not
Description

count against string’s length).
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strncat

Prototype char *strncat (char *to, char *from, int size);

Function appends not more than size characters from the string fromto to. The
Description [initial character of from overwrites the null character at the end of to. The termi-
nating null character is always appended to the result. The function returns to.

strncpy

Prototype char *strncpy(char *to, char *from, int size);

Function copies not more than size characters from string from to to. If copy-
ing takes place between objects that overlap, the behavior is undefined. If from
is shorter than size characters, then o will be padded out with null characters to
make up the difference. The function returns the resulting string +o.

Description

strspn

Prototype int strspn(char *strl, char *str2);

Function returns the length of the maximum initial segment of st 1 which consists
Description |entirely of characters from str2. The terminating null character at the end of the
string is not compared.

strncmp

Prototype int strncmp (char *sl, char *s2, char len);

Function lexicographically compares not more than 1en characters (characters
that follow the null character are not compared) from the string pointed by =1 to
the string pointed by s2. The function returns a value indicating the s1 and s2

relationship:
Description
Value Meaning
< 0 sl "less than" s2
=0 sl "equal to" s2
> 0 sl "greater than" s2
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strstr

Prototype char *strstr(char *sl, char *s2);

Function locates the first occurrence of the string s2 in the string s1 (excluding
the terminating null character).

Description
The function returns pointer to first occurrence of s2 in s1; if no string was found,
function returns 0. If s2 is a null string, the function returns 0.

strcspn

Prototype char *strcspn(char * sl, char *s2);

Function computes the length of the maximum initial segment of the string point-
ed to by s1 that consists entirely of characters that are not in the string pointed
Description [to by s2.

The function returns the length of the initial segment.

strpbrk

Prototype char *strpbrk(char * sl, char *s2);

Function searches s1 for the first occurrence of any character from the string s2.
The terminating null character is not included in the search. The function returns
pointer to the matching character in s1. If s1 contains no characters from s2, the
function returns o.

Description

strrchr

Prototype char *strrchr (char * ptr, unsigned int chr);

Function searches the string ptr for the last occurrence of character chr. The
null character terminating ot is not included in the search. The function returns
pointer to the last chr found in ptr; if no matching character was found, function
returns o.

Description
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MISCELLANEOUS LIBRARIES

- Button Library

- Conversions Library
- Sprint Library

- Setjmp Library

- Time Library

- Trigonometry Library
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BUTTON LIBRARY

The Button library contains miscellaneous routines useful for a project development.

Library Routines

- Button
Button
Prototype uns%gned short Bgtton(unsigned short *pgrt, unsig?ed short pin,
unsigned short time, unsigned short active state);
Returns Returns 0 or 255.

Function eliminates the influence of contact flickering upon pressing a button
(debouncing).

Description |Parameter port specifies the location of the button; parameter pin is the pin
number on designated port and goes from 0..7; parameter time is a debounce
period in milliseconds; parameter active state can be either 0 or 1, and it deter-
mines if the button is active upon logical zero or logical one.

Requires Button pin must be configured as input.

Example reads RBO, to which the button is connected; on transition from 1 to 0
(release of button), PORTD is inverted:

do {
if (Button (&PORTB, 0, 1, 1)) oldstate = 1;
if (oldstate && Button (&PORTB, 0, 1, 0)) {
PORTD = ~PORTD;
oldstate = 0;
}
} while (1) ;

Example
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CONVERSIONS LIBRARY

The mikroC PRO for PIC Conversions Library provides routines for numerals to
strings and BCD/decimal conversions.

Library Routines

You can get text representation of numerical value by passing it to one of the follow-
ing routines:

- ByteToStr

- ShortToStr

- WordToStr

- IntToStr

- LongToStr

- LongWordToStr
- FloatToStr

The following functions convert decimal values to BCD and vice versa:
- Dec2Bcd

- Becd2Dec16
- Dec2Bcd16
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ByteToStr

Prototype void ByteToStr (unsigned short input, char *output);

Returns Nothing.

Converts input byte to a string. The output string has fixed width of 4 characters
including null character at the end (string termination). The output string is right
justified and remaining positions on the left (if any) are filled with blanks.

Description Parameters:

- input: byte to be converted
- output: destination string

Requires Destination string should be at least 4 characters in length.

unsigned short t = 24;

h txt[ 4] ;
Example char i 4]

ByteToStr (t, txt); // txt is " 24" (one blank here)

ShortToStr

Prototype void ShortToStr (short input, char *output);

Returns Nothing.

Converts input signed short number to a string. The output string has fixed width
of 5 characters including null character at the end (string termination). The output
string is right justified and remaining positions on the left (if any) are filled with
blanks.

Description
Parameters:

- input : short number to be converted
- output : destination string

Requires Destination string should be at least 5 characters in length.

short t = -24;

char txt[ 5] ;
Example o

ShortToStr (t, txt); // txt is " -24" (one blank here)
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WordToStr

Prototype void WordToStr (unsigned input, char *output);

Returns Nothing.

Converts input word to a string. The output string has fixed width of 6 characters
including null character at the end (string termination). The output string is right
justified and the remaining positions on the left (if any) are filled with blanks.

Description Parameters:

- input: word to be converted
- output: destination string

Requires Destination string should be at least 6 characters in length.

unsigned t = 437;

char txt[ 6] ;
Example ol

WordToStr (t, txt); // txt is " 437" (two blanks here)

IntToStr

Prokﬂype void IntToStr (int input, char *output);

Returns Nothing.

Converts input signed integer number to a string. The output string has fixed width
of 7 characters including null character at the end (string termination). The output
string is right justified and the remaining positions on the left (if any) are filled with
blanks.

Description
Parameters:

- input: signed integer number to be converted
- output: destination string

Requires Destination string should be at least 7 characters in length.

int § = -4220;

char txt[ 7] ;
Example A

IntToStr(j, txt); // txt is " -4220" (one blank here)
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LongintToStr

Prototype void LongToStr (long input, char *output);

Returns Nothing.

Converts input signed long integer number to a string. The output string has fixed
width of 12 characters including null character at the end (string termination). The
output string is right justified and the remaining positions on the left (if any) are
filled with blanks.

Description
Parameters:

- input :signed long integer number to be converted
- output: destination string

Requires Destination string should be at least 12 characters in length.

long jj = -3700000;

char txt[ 12] ;
Example S

LongToStr (jj, txt);

// txt is " -3700000"™ (three blanks here)
LongWordToStr

Prototype void LongWordToStr (unsigned long input, char *output);

Returns Nothing.

Converts input unsigned long integer number to a string. The output string has
fixed width of 11 characters including null character at the end (string termination).
The output string is right justified and the remaining positions on the left (if any)
are filled with blanks.

Description
Parameters:

- input: unsigned long integer number to be converted
- output : destination string

Requires Destination string should be at least 11 characters in length.

unsigned long jj = 3700000;
char txt[ 11] ;

Example S
LongToStr (jj, txt);

// txt is " 3700000"™ (three blanks here)
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FloatToStr

Prototype unsigned char FloatToStr (float fnum, unsigned char *str);

- 3 if input number is NaN
- 2 if input number is -INF
- 1 if input number is +INF
- 0 if conversion was successful

Returns

Converts a floating point number to a string.
Parameters:

- input: floating point number to be converted
Description |- cutput: destination string

The output string is left justified and null terminated after the last digit.

Note: Given floating point number will be truncated to 7 most significant digits
before conversion.

Requires Destination string should be at least 14 characters in length.

float ffl = -374.2;
float ff2 = 123.456789;
float f£f3 = 0.000001234;
char txt[ 15];

Example L
FloatToStr (ff1, txt); // txt is "-374.2"
FloatToStr (ff2, txt); // txt is "123.4567"
FloatToStr (ff3, txt); // txt is "1.234e-6"
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Dec2Bcd
Prokﬂype unsigned short Dec2Bcd (unsigned short decnum) ;
Returns Converted BCD value.
Converts input unsigned short integer number to its appropriate BCD represen-
tation.
Description Parameters:

- decnum: unsigned short integer number to be converted

Requires Nothing.

unsigned short a, b;

Example o= 22,

b = Dec2Bcd(a); // b equals 34

Bcd2Dec16

Prototype unsigned Bcd2Decl6 (unsigned bcdnum) ;

Returns Converted decimal value.

Converts 16-bit BCD numeral to its decimal equivalent.
Description |[Parameters:

- bednum: 16-bit BCD numeral to be converted

Requires Nothing.

unsigned a, b;

Example 0x1234; // a equals 4660

Bcd2Declé6 (a) ; // b equals 1234

a
b
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Dec2Bcd16
Prototype unsigned Dec2Bcdl6 (unsigned decnum) ;
Returns Converted BCD value.
Converts unsigned 16-bit decimal value to its BCD equivalent.
Description |Parameters:
- decnum unsigned 16-bit decimal number to be converted
Requires Nothing.
unsigned a, b;
Example s = 2345;
b = Dec2Bcdlé6 (a); // b equals 9029
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PRINTOUT LIBRARY
The mikroC PRO for PIC provides the PrintOut routine for easy data formatting and printing.
Note: Library works with PIC18 family only.
Library Routines
- PrintOut

PrintOut

Prototype void PrintOut (void (*prntoutfunc) (char ch), const char *f,...);

Returns Nothing.

printout is used to format data and print them in a way defined by the user
through a print handler function.

Parameters:

- prntout func: print handler function
- £:format string

The £ argument is a format string and may be composed of characters, escape
sequences, and format specifications. Ordinary characters and escape
sequences are copied to the print handler in order in which they are interpreted.
Format specifications always begin with a percent sign (%) and require additional
arguments to be included in the function call.

Description The format string is read from left to right. The first format specification encoun-
tered refers to the first argument after the £ parameter and then converts and out-
puts it using the format specification. The second format specification accesses
the second argument after £, and so on. If there are more arguments than format
specifications, the extra arguments are ignored. Results are unpredictable if there
are not enough arguments for the format specifications. The format specifications
have the following format:

s [ flags] [ width] [ .precision] [{ 1 | L }] convetsionityoe

Each field in the format specification can be a single character or a number which
specifies a particular format option. The conversion type field is where a single
character specifies that an argument is interpreted as a character, string, number,
or pointer, as shown in the following table:
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conversion type|lArgument Type Output Format
d int Signed decimal number
u unsigned int |Unsigned decimal number
o unsigned int |Unsigned octal number
" neianed ine [Unsigned hexadecimal number using
o 0123456789abcdef
% eioned int Unsigned hexadecimal number using
o 0123456789ABCEDF

Floating-point number using the format [-
f doubile ldddd.dddd

Floating-point number using the format [-
e double 1d.ddddel-]dd

Floating-point number using the format [-
E double 1d.ddddE[-]dd

Floating-point number using either e or f
g double format, whichever is more compact for the

Description specified value and precision

c int int is converted to an unsigned char,

and the resulting character is written
S char * String with a terminating null character
" void * Pointer value, the X format is used

A % is written. No argument is converted.
% <none> The complete conversion specification

shall be %%.

590 MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD



CHAPTER 7
mikroC PRO for PIC Libraries

The ri1ags field is where a single character is used to justify the output and to
print +/- signs and blanks, decimal points, and octal and hexadecimal prefixes, as
shown in the following table.

flags Meaning
+ Left justify the output in the specified field width.
- Prefix the output value with + or - sign if the output is a signed type.

space |Prefix the output value with a blank if it is a signed positive value.

(' ') |Otherwise, no blank is prefixed.

Prefix a non-zero output value with 0, 0x, or 0x when used with o, =,
and x field types, respectively. When used withthe ¢, &, £, g, andc
field types, the # flag forces the output value to include a decimal
point. In any other case the # flag is ignored.

Ignore format specifier.

The width field is a non-negative number that specifies a minimum number of
printed characters. If a number of characters in the output value is less than width,
blanks are added on the left or right (when the - flag is specified) in order to pad
to the minimum width. If the width is prefixed with O, then zeros are padded
instead of blanks. The width field never truncates a field. If the length of the out-
put value exceeds the specified width, all characters are output.

Description |The rccision field is a non-negative number that specifies the number of char-
acters to print, number of significant digits, or number of decimal places. The pre-
cision field can cause truncation or rounding of the output value in the case of a
floating-point number as specified in the following table.

flags MeaningMeaning of the precision field

The precision field is where you specify the minimum number of
digits that will be included in the output value. Digits are not trun-
d, u, o, |cated if the number of digits in an argument exceeds that defined
%, X in the precision field. If the number of digits in the argument is
less than the precision field, the output value is padded on the
left with zeros.

The precision field is where you specify the number of digits to

: the right of the decimal point. The last digit is rounded.
I The precision field is where you specify the number of digits to
! the right of the decimal point. The last digit is rounded.
B The precision field is where you specify the maximum number of
N significant digits in the output value.
c, C The precision field has no effect on these field types.

The precision field is where you specify the maximum number of
characters in the output value. Excess characters are not output.
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The optional characters 1 or . may immediately precede conversion type to
respectively specify long versions of the integer types d, i, u, o, x, and x.
Description You must ensure that the argument type matches that of the format specifica-
tion. You can use type casts to ensure that the proper type is passed to print-
out.

Requires Nothing.

Print mikroElektronika example's header file to UART.
void PrintHandler (char c){

UART1 Write(c);
}
void main (){

UART1 Init (9600);

Delay ms (100);

PrintOut (PrintHandler, "/*\r\n"
" * Project name:\r\n"

PrintOutExample (Sample usage

of PrintOut () function)\r\n"
" * Copyright:\r\n"
" (c) MikroElektronika,
2006.\r\n"
Example " * Revision History:\r\n"

" 20060710:\r\n"

- Initial release\r\n"
" * Description:\r\n"

" Simple demonstration on usage
of the PrintOut () function\r\n"

" * Test configuration:\r\n"

" MCU:
PIC18F8520\r\n"
" Dev.Board: BigPIC5\r\n"
" Oscillator: HS,
$10.3fMHz\ r\n"
" Ext. Modules: None.\r\n"
" SW: mikroC PRO

for PIC\r\n"
" * NOTES:\r\n"

None.\r\n"
" */\r\n", Get Fosc kHz()/1000.);
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SETJMP LIBRARY

This library contains functions and types definitions for bypassing the normal function call and
return discipline. The type declared is smp but which is an array type suitable for holding the infor-
mation needed to restore a calling environment.

Type declaration is contained in sejmp16.h and setjmp18.h header files for PIC16 and PIC18 fam-
ily mcus respectively. These headers can be found in the include folder of the compiler. The imple-
mentation of this library is different for PIC16 and PIC18 family mcus. For PIC16 family Setjmp
and Longjmp are implemented as macros defined in setjimp16.h header file and for PIC18 family
as functions defined in setjmp library file.

Note: Due to PIC16 family specific of not being able to read/write stack pointer, the program exe-
cution after Longjmp ivocation occurs depends on the stack content. That is why, for PIC16 fam-
ily only, implementation of Setjmp and Longjmp functions is not ANSI C standard compliant.

Library Routines

- Setjmp
- Longjmp

Setjmp

Prototype int setjmp (jmp_buf env);

if the return is from direct invocation it returns 0

Returns if the return is from a call to the longjmp it returns nonzero value

This function saves calling position in smp buf for later use by longjmp. The
Description |parameter cnv: array of type (jmp_buf) suitible for holding the information need-
ed for restoring calling environment.

Requires Nothing.

Example setjmp (buf) ;
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Longjmp

Pl'OtOtype void longjmp (jmp_buf env, int val);

Returns longjmp causes setjmp to return val, if val is O it will return 1.

Restores calling environment saved in jmp buf by most recent invocation of
setjmp macro. If there has been no such invocation, or function conatinig the invo-
Description [cation of setjmp has terminated in the interim, the behaviour is undefined.Param-
eter env: array of type (jmp_buf) holding the information saved by corresponding
setjmp invocation, va1: char value, that will return corresponding setjmp.

Invocation of Longjmp must occur before return from the function in which Setjmp

Requires
was called encounters.

Example longjmp (buf, 2);
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Library Example

Example demonstrates function cross calling using setjmp and longjmp functions.
When called, Setjmp() saves its calling environment in its jmp_buf argument for later
use by the Longjmp(). Longjmp(), on the other hand, restores the environment
saved by the most recent invocation of the Setjmp() with the corresponding jmp_buf
argument. The given example is for P16.

#include <Setjmp16.h>

#include <Setjmpl6.h>
jmp buf buf; // Note: Program flow diagrams are indexed

according
// to the sequence of execution

void func33(){ /] 2<———————— ‘
// |
asm nop; // |
longjmp (buf, 2); /] Bmmmmm—m—m——— - >
asm nop; // | ‘
// | \
} // \ |
// | \
void func (){ /) 1<—————-— ‘ | |
1/ \ \ \
portb = 3; // ‘ ‘ ‘
if (setjmp(buf) == 2) // 3<—mmmmmmmm———— o
portb = 1; /] A-=>| [ \
else // ‘ ‘ ‘
func33(); Y —— >
asm nop; // ‘ [
/] A<——| \
} /] 5=====m= | —===—= >depends on stack content
// |
void main () { // ‘
// |
PORTB = 0; // ‘
TRISB = 0; // |
// |
asm nop; // |
// |
func (), Y/ R —— > |
//
asm nop; //
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SPRINT LIBRARY

The mikroC PRO for PIC provides the standard ANSI C Sprintf function for easy data formatting.
Note: In addition to ANSI C standard, the Sprint Library also includes two limited versions of the
sprintf function (sprinti and sprint1). These functions take less ROM and RAM and may be
more convenient for use in some cases.
Functions

- sprintf

- sprintl

- sprinti

sprintf

Prototype sprintf (char *wh, const char *f,...);

The function returns the number of characters actually written to destination
string.

sprintf is used to format data and print them into destination string.

Returns

Parameters:

- wh: destination string
- £: format string

The  argument is a format string and may be composed of characters, escape
sequences, and format specifications. Ordinary characters and escape
sequences are copied to the destination string in the order in which they are inter-
preted. Format specifications always begin with a percent sign (3) and require
Description |additional arguments to be included in the function call.

The format string is read from left to right. The first format specification encoun-
tered refers to the first argument after £ and then converts and outputs it using
the format specification. The second format specification accesses the second
argument after £, and so on. If there are more arguments than format specifica-
tions, then these extra arguments are ignored. Results are unpredictable if there
are not enough arguments for the format specifications. The format specifications
have the following format:

5 [ flags] [ width] [ .precision] [{ 1 | L }] conversion type
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Each field in the format specification can be a single character or a number which

specifies a particular format option. The conversion type field is where a single
character specifies that the argument is interpreted as a character, string, num-

ber, or pointer, as shown in the following table:

conversion type|lArgument Type Output Format
d int Signed decimal number
u unsigned int |Unsigned decimal number
o unsigned int [Unsigned octal number
" cioned int Unsigned hexadecimal number using
N 0123456789abcdef
e neioned ine  [Unsigned hexadecimal number using
R 0123456789ABCEDF
, Floating-point number using the format [-
f poubie Jdddd.dddd
L Floating-point number using the format [-
© coubie 1d.dddde]-]dd
, Floating-point number using the format [-
E poubie 1d.ddddE[-]dd
Floating-point number using either e or f
g double format, whichever is more compact for the
specified value and precision
o int int is converted to an unsigned char,
) and the resulting character is written
S char * String with a terminating null character
p void * Pointer value, the X format is used
A % is written. No argument is converted.
Y% <none> The complete conversion specification
shall be %%.
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The f1ags field is where a single character is used to justify the output and to
print +/- signs and blanks, decimal points, and octal and hexadecimal prefixes,
as shown in the following table.

flags Meaning

+ Left justify the output in the specified field width.

- Prefix the output value with + or - sign if the output is a signed type.
space |Prefix the output value with a blank if it is a signed positive value.

(" ') |Otherwise, no blank is prefixed.

Prefix a non-zero output value with 0, 0x, or 0x when used with o, x,
and x field types, respectively. When used withthe e, &, £, o, andc
field types, the # flag forces the output value to include a decimal
point. In any other case the # flag is ignored.

i Ignore format specifier.

The width field is a non-negative number that specifies a minimum number of
printed characters. If a number of characters in the output value is less than width,
blanks are added on the left or right (when the - flag is specified) in order to pad
to the minimum width. If the width is prefixed with 0, then zeros are padded
instead of blanks. The width field never truncates a field. If the length of the out-
put value exceeds the specified width, all characters are output.

Description |The ;rccision field is a non-negative number that specifies the number of char-
acters to print, number of significant digits, or number of decimal places. The pre-
cision field can cause truncation or rounding of the output value in the case of a
floating-point number as specified in the following table.

flags MeaningMeaning of the precision field

The precision field is where you specify the minimum number of
digits that will be included in the output value. Digits are not trun-
d, u, o, |[cated if the number of digits in an argument exceeds that defined
%, X in the precision field. If the number of digits in the argument is
less than the precision field, the output value is padded on the
left with zeros.

The precision field is where you specify the number of digits to

: the right of the decimal point. The last digit is rounded.
I The precision field is where you specify the number of digits to
' the right of the decimal point. The last digit is rounded.
; [The precision field is where you specify the maximum number of

significant digits in the output value.
c, C The precision field has no effect on these field types.

[The precision field is where you specify the maximum number of
characters in the output value. Excess characters are not output.
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The optional characters 1 or . may immediately precede conversion type to
respectively specify long versions of the integer types ¢, i, u, o, x, and x.

You must ensure that the argument type matches that of the format specification.
You can use type casts to ensure that the proper type is passed to sprintf.

sprintl
Prototype sprintl (char *wh, const char *f,...);
The function returns the number of characters actually written to destination
Returns .
string.
Description |The same as sprintf, except it doesn't support float-type numbers.
sprinti
Prototype sprinti(char *wh, const char *f,...);
The function returns the number of characters actually written to destination
Returns .
string.
Description gz;essame as sprintf, except it doesn't support long integers and float-type num-
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Library Example

This is a demonstration of the standard C library sprintf routine usage. Three differ-
ent representations of the same floating poing number obtained by using the sprintf
routine are sent via UART.

double ww = -1.2587538e+1;
char buffer[ 15];

// Function for sending string to UART
void UartWriteText (char *txt) {
while (* txt)
UART1 Write (*txt++);

// Function for sending const string to UART
void UartWriteConstText (const char *txt) {
while (* txt)
UART17Write(*txt++);

void main (){

UART1 Init (4800); // Initialize UART module at 4800 bps
Delay ms (10);

UartWriteConstText ("Floating point number representation"); //
Write message on UART

sprintf (buffer, "%12e", ww); // Format ww and store it to buffer
UartWriteConstText ("\r\ne format:"); // Write message on UART
UartWriteText (buffer); // Write buffer on UART

sprintf (buffer, "$12f", ww); // Format ww and store it to buffer
UartWriteConstText ("\r\nf format:"); // Write message on UART
UartWriteText (buffer); // Write buffer on UART

sprintf (buffer, "%12g", ww); // Format ww and store it to buffer
UartWriteConstText ("\r\ng format:"); // Write message on UART
UartWriteText (buffer); // Write buffer on UART
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TIME LIBRARY

The Time Library contains functions and type definitions for time calculations in the
UNIX time format which counts the number of seconds since the "epoch". This is
very convenient for programs that work with time intervals: the difference between
two UNIX time values is a real-time difference measured in seconds.

What is the epoch?
Originally it was defined as the beginning of 1970 GMT. ( January 1, 1970 Julian day
) GMT, Greenwich Mean Time, is a traditional term for the time zone in England.

The TimeStruct type is a structure type suitable for time and date storage. Type
declaration is contained in timelib.h which can be found in the mikroC PRO for PIC
Time Library Demo example folder.

Library Routines
- Time_dateToEpoch

- Time_epochToDate
- Time_dateDiff
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Time_dateToEpoch

Prototype long Time dateToEpoch (TimeStruct *ts);

Returns Number of seconds since January 1, 1970 0hOOmnQO0s.
This function returns the unix time : number of seconds since January 1, 1970
0h0OmMnNQOO0s.

Description Parameters:

- ts: time and date value for calculating unix time.

Requires Nothing.

#include "timelib.h"
TimeStruct tsl;
long epoch;
Example S
/*
* what is the epoch of the date in ts ?
*/

epoch = Time dateToEpoch (&tsl);

Time_epochToDate

Prototype void Time epochToDate (long e, TimeStruct *ts);

Returns Nothing.

Converts the unix time to time and date.

. Parameters:
Description

- e: unix time (seconds since unix epoch)
- ts: time and date structure for storing conversion output

Requires Nothing.

#include "timelib.h"
TimeStruct ts2;
long epoch;

Example }*’ ’
* what date is epoch 1234567890 2
*/

epoch = 1234567890;
Time epochToDate (epoch, &ts2);
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Time_dateDiff

Prokﬂype long Time dateDiff (TimeStruct *tl, TimeStruct *t2);

Returns Time difference in seconds as a signed long.

This function compares two dates and returns time difference in seconds as a
signed long. Result is positive if t1 is before t2, result is null if £1 is the same as
t2 and result is negative if 1 is after 2.

Parameters:
Description
- £1: time and date structure (the first comparison parameter)

- £2: time and date structure (the second comparison parameter)

Note: This function is implemented as macro in the timelib.h header file which
can be found in the mikroC PRO for PIC Time Library Demo example folder.

Requires Nothing.

#include "timelib.h"
TimeStruct tsl, ts2;
long diff;

Example }*' ’

* how many seconds between these two dates contained in tsl and
ts2 buffers?

*/
diff

Time dateDiff (&tsl, &ts2);
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Library Example

This example demonstrates Time Library usage.
#include "timelib.h"

TimeStruct tsl, ts2;
long epoch;
long diff;

void main () {
tsl.ss = 0;
tsl.mn = 7;
tsl.hh = 17;
tsl.md = 23;
tsl.mo = 5;
tsl.yy = 2006;

/*

* What is the epoch of the date in ts ?
*/

epoch = Time dateToEpoch (&tsl);

/*

* What date is epoch 1234567890 2
*/

epoch = 1234567890;

Time epochToDate (epoch, &ts2);

/*

* How much seconds between this two dates ?
*/

diff = Time dateDiff (&tsl, &ts2);
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TRIGONOMETRY LIBRARY

The mikroC PRO for PIC implements fundamental trigonometry functions. These functions are
implemented as look-up tables. Trigonometry functions are implemented in integer format in order
to save memory.

Library Routines

- sinE3
- cosE3

sinE3

Prototype int sinE3 (unsigned angle deq);

Returns The function returns the sine of input parameter.

The function calculates sine multiplied by 1000 and rounded to the nearest integer:
result := round(sin(angle deg)*1000)

Description |Parameters:

- angle deg: input angle in degrees

Note: Return value range: -1000..1000.

Requires Nothing.

int res;
Example S
res = sinE3(45); // result is 707
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cosE3

Prototype int cosE3 (unsigned angle degq);

Returns The function returns the cosine of input parameter.

The function calculates cosine multiplied by 1000 and rounded to the nearest
integer:

result := round(cos(angle deg)*1000)
Description
P Parameters:

- angle deg: input angle in degrees

Note: Return value range: -1000..1000.

Requires Nothing.

int res;
Example cee
res = coskE3(196); // result is -193
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